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A. These show precautions based on Labor Health and Safety Regulations (Articles 36, 104, 150, 
151). 
 
  

For the sake of safety, teaching work should only be performed by workers who have 
received special education. 
(The same is true for any maintenance work done with the power source not cut off.) 
→Implementation of safety education 

  
For teaching work, prepare work regulations concerning robot operation methods 
and procedures, measures for when there is an abnormality and when restarting, etc. 
Perform teaching work according to these regulations. 
(The same is true for any maintenance work done with the power source not cut off.) 
→Prepare work regulations. 

  
For teaching work, set up a device that can stop operation immediately. 
(The same is true for any maintenance work done with the power source not cut off.) 
→Emergency stop switch setting 

  
During teaching work, label the start switch etc. to indicate that teaching work is 
underway. 
(The same is true for any maintenance work done with the power source not cut off.) 
→Display that teaching work is underway 

  
In operation, prevent contact between workers and robots by preparing a fence and a 
barrier. 
→ Setting up a safety fence 

 
  

Determine a uniform signal to relevant staff for the start of operation and use that 
signal. 
→ Signal for the start of operation 

  
For maintenance work, in principle, cut off the power and label the start switch etc. to 
indicate that maintenance work is underway. 
→Display that maintenance work is underway 

  
Before starting work, check the robot, emergency stop switches, related devices, etc. 
and make sure there are no abnormalities. 
→ Check before the start of work 

 

 

 

 

 

 

 

 

 

Before using the robot, always carefully read the
precautions below and the separate "Safety Manual" and
take all necessary safety measures. 

Safety Precautions 
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 Danger 
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 Warning 



B. This shows precaution points given in the separate "Safety Manual". 
For details, please read the text of the "Safety Manual". 
 
  

Use the robot in an environment that is within the range of its specifications. Failure 
to do this can cause a drop in reliability and breakdown. 
(Temperature, humidity, atmosphere, noise, etc.) 

 
When transporting the robot, put it into its specified transport posture. 
Failure to do this can cause a drop in reliability and breakdown. 

  
Install the robot on a solid platform. 
If the robot is in an unstable posture, this can cause positional deviation and 
vibration. 

  
Wire cables away from noise sources as much as possible. 
If cables are brought too close to noise sources, this can cause positional deviation 
and malfunction. 

  
Do not apply excess force to a connector or bend a cable excessively. 
Doing so can cause a contact defect or cut line. 

  
Set work masses, including hands, so that they do not excess rated load or permitted 
torque. 
Exceeding either of these can cause an alarm or breakdown. 

  
Install hands and tools and hold work securely. 
Failure to do this can cause objects to fly loose during operation and cause personnel 
injury or damage. 

  
Ground the robot and controller reliably. 
Failure to do this can cause malfunction due to noise or in an extreme case, electrical 
shock. 

  
Display the operating state while the robot is operating. 
Lack of such a display can result in someone coming too close to the robot by mistake 
or mistaken operation. 

  
Always secure the priority right for control of the robot before doing any teaching work 
within the robot's operating range. Failure to do this can allow the robot to start upon 
instruction from the outside and cause personnel injury or damage. 

  
Make the jog speed as slow as possible and do not take your eyes off the robot. 
Failure to do this may cause a collision between a work piece and peripheral devices. 

  
After completing program editing but before starting automatic operation, always 
check operations with step operation. Failure to do this may cause a collision with a 
peripheral device due to a programming mistake or the like. 

  
Set up the safety fence in such a way that, while the equipment is running on 
automatic, either the safety fence door is locked or if anyone tries to open the door, 
the robot is stopped. Failure to take these protective measures can cause an accident 
resulting in injury. 
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Never on your own judgment make an alterations or use maintenance parts other than 
those designated. Doing so can cause breakdown and problems. 
  
When moving the robot arm from the outside, never stick a hand or finger into an 
opening. Depending on the posture, the hand or finger could get caught in the 
equipment. 

  
Do not switch the robot Off or make an emergency stop of the robot by switching Off 
the robot controller's main power supply. 
If the robot controller's main power supply is switched Off during automatic operation, 
this can reduce the robot's precision. It could also cause the arm to fall or allow inertia 
to result in collisions with peripheral device or the like. 

  
When rewriting a program, parameters, or other internal information within the robot's 
controller, do not switch Off the robot controller's main power supply. 
If the robot controller's main power supply is switched Off during automatic operation 
or while a program or parameter is being rewritten, there is a danger of the internal 
information in the robot controller being destroyed. 

  
For using RH-5AH/10AH/15AH series or RH-6SH/12SH/18SH series. 
While pressing the brake releasing switch on the robot arm, beware of the arm which 
may drop with its own weight. 
Dropping of the hand could lead to a collision with the peripheral equipment or catch 
the hands or fingers.  

 
 
 

 

 

 

 

 

 Caution 

 Warning 

 Caution 

 Caution 

 Warning 



 
 



 
User's Manual Revision History 

Printing Date Manual No. Revision Contents 
2008/04 BFP-A8618-* First edition (Corresponds to the Ver.1.1) 
2008/08 BFP-A8618-A Corresponds to the Ver.1.2 (Refer to the software revision history.) 
2008/10 BFP-A8618-B Corresponds to the Ver.1.3 (Refer to the software revision history.) 
2009/01 BFP-A8618-C Corresponds to the Ver.1.3.1 
2009/06 BFP-A8618-D Corresponds to the Ver.1.4 (Refer to the software revision history.) 
2009/10 BFP-A8618-E Corresponds to the Ver.1.5 (Refer to the software revision history.) 
2010/04 BFP-A8618-F Corresponds to the Ver.1.6 (Refer to the software revision history.) 
2010/06 BFP-A8618-G Corresponds to the Ver.1.6.1 (Refer to the software revision history.) 
2010/10 BFP-A8618-H Corresponds to the Ver.1.7 (Refer to the software revision history.) 
2011/05 BFP-A8618-J Corresponds to the Ver.1.8 (Refer to the software revision history.) 
2011/07 BFP-A8618-K Corresponds to the Ver.2.00A (Refer to the software revision history.) 
2011/11 BFP-A8618-M Corresponds to the Ver.2.10L (Refer to the software revision history.) 
2012/05 BFP-A8618-N Corresponds to the Ver.2.20W (Refer to the software revision history.) 
2012/08 BFP-A8618-P Corresponds to the Ver.2.30G (Refer to the software revision history.) 
2013/02 BFP-A8618-Q Corresponds to the Ver.2.40S (Refer to the software revision history.) 
2013/04 BFP-A8618-R Corresponds to the Ver.2.50C (Refer to the software revision history.) 
2013/09 BFP-A8618-S Corresponds to the Ver.3.00A (Refer to the software revision history.) 
2014/01 BFP-A8618-T Corresponds to the Ver.3.01B (Refer to the software revision history.) 
2014/03 BFP-A8618-U Corresponds to the Ver.3.10L (Refer to the software revision history.) 
2014/10 BFP-A8618-V Corresponds to the Ver.3.20W (Refer to the software revision history.) 

   



 
Software Revision History 

Version Release Date Revision Contents 
1.0 2008/01 Initial release (Japanese version only) 
1.1 2008/04 CRnQ Communications:  Added the GOT transparent function. 

Parameter editing:  Added the Multiple CPU setting screen. 
1.2 2008/08 [Communication Setting] 

- Changed the Initial value of USB, TCP/IP and RS-232 setting. 
- Added the CRnQ communication routes when "Ethernet" is selected. 

(Added the Ethernet port communications.) 
[Program editor] 
- Added “Comment Selection”/”Uncomment Selection” function. 
- Added the function to edit the backed up program data. 
[Project] 
- Added the function to import the project. 
[Parameter] 
- Added the function to display the parameter changed from initial value. 
[Restore] 
- Added the function to restore individually data backed up by selecting 

"All files". 
etc. 

1.3 2008/10 [Operation of Project Tree] 
- Added the function to copy the robot program by drag and drop. 
[Operation of Workspace] 
- Added the "Edit project" screen when the new workspace is made. 
[Parameter] 
- Added the function to print the parameter changed from initial value. 
- Added the screen of setting the CC-Link parameter and PROFIBUS 

parameter. 
[Backup] 
- Added the function to save data from all robot controllers by batch 

processing. 
etc. 

1.4 2009/06 [Parameter] 
- Added the function to edit by offline. 
[Program editor] 
- Added the function to remove comments from all line in the program. 

1.5 2009/10 [Communication Setting] 
- Added the screen of setting GOT communication. 
[Parameter] 
- Added the screen of editing the Work coordinate parameters. 
[SQ Direct] 
- Added the screen of editing the SQ Direct positions. 

1.6 2010/04 [Program editor] 
- Added the function to check the program name when creating it by 

offline. 
- Added the function to rename the positional data. 
- Changed an initial value of the position data to the present location. 
- Added the function of jumping to the specified positional data. 
- Added the function of searching the positional data. 
- Added the function of distinguishing online editing and offline editing of 

program by color. 
[Simulation] 
- Added the function of the Tool-JOG and Work-JOG on the simulation. 
- Added the function of displaying the User defined area and the Free 

Plane Limit in 3D viewer of simulation. 
[Program Management]  
- Added the function of changing the window size. 
[Monitor] 
- Added the function of stopping the program of all task-slots. 



Version Release Date Revision Contents 
1.6.1 2010/06 [Parameter] 

- Added the function of editing the “Temp in RC” parameters. 
 

1.7 2010/10 [Communication Setting] 
- Added the GOT(Ethernet) transparent mode. 
[Simulation] 
- Added the “3D Monitor” button to the screen of simulation operation. 
- "3-axis XYZ" and "Cylinder" are added to JOG mord. 
[Monitor] 
- Added the function of error record. 
[Computer syastem] 
- Corresponded to Windows 7. 

1.8 2011/05 [Workspace]  
- Added the function to change the name of the workspace. 
[Servo monitor] 
- Added the "ABS", "Speed", "Current", and "Power" of servo monitor. 

2.00A 2011/07 [Operating Environment] 
- Added the the Operating systems for which operation is warranted. 
[Maintenance] 
- Added the security function of the robot controller (Setup the password).
[Others] 
- Changed the icon. 
- Corresponded to iQ Works(MELSOFT Navigator). 
etc. 

2.10L 2011/11 [Simulator] 
- A maximum of eight simulators can be started. 
[Tool] 
- Added the function “Force control log viewer”. 
[Parameter] 
- Added the “IO unit parameter”. 
- Added buttons “Force initial setting”, “Force control mode”, “Force 

control feature“, and “Force log setting”. 
[Monitor] 
- Added the IO unit monitor. 
- Added the display of 3D monitor of several robots. 
- Added the Encoder temp in the display of Load. 

2.20W 2012/05 [Parameter] 
- Added “Mode switch judgment/Speed reference” tab in “Force control 

feature” screen. 
[Maintenance] 
- Added the function “Tool automatic calculation”. 
- Added the File manager 
 [Communications Settings] 
- Corresponded to CC-Link/IE 
[Tool] 
- Added the user definition screen editing function. 
[Simulator] 
- Added the function to manage the parts of layout by using a group.. 
- Added the reading function of 3D model parts. 
- Added the function of designing a robot hand and of displaying it on "3D 

view" screen. 
etc. 

2.30G 2012/08 [Parameter] 
- Added buttons “Force initial setting”, “Force control mode”, “Force 

control feature“, and “Force log setting”. 
 

2.40S 2013/02 [Parameter] 
- Added the function of editing the “Collision avoidance area” parameters.

2.50C 2013/04 Correspond to Windows 8 



Version Release Date Revision Contents 
3.00A 2013/09 [Computer syastem] 

- Corresponded to Windows 8.1. 
[Parameter] 
- Changed the project tree.  
- Added “PROFINET”, “DeviceNet”, “EtherNet/IP” parameters.  
- Added the function “Realtime monitor” to the “Ethernet” parameter.  
[Tool] 
- Added the function “Oscillograph”.  
[Simulator] 
- Added the supported 3D model formats “3DS”, “PLY”, and “VRML”.  
- The function of designing a robot hand: supported the 3D model parts.
- Added the function of setting robot flange direction un-display/display. 
- Added the function of servo monitor. 
- Added the function of calculation of axis load level. 
[MELFA-3D Vision]  
- Added the function of setting MELFA-3D Vision.  

3.01B 2014/01 [Parameter] 
- Added the function of "Load profile” in the “Robot additional axis” 

screen.  
[Tool] 
- Added the function of “gray scale” in the “Oscillograph” screen.  
- When the simulation started, the real-time function use was enabled 

with the oscillograph.  
[Simulator] 
- Added the function to set 5%, 2% and 1% to OVRD. 
- Added the function of enlargement/reduction with the mouse wheel, 

and function of enlargement/reduction to the screen center.  
- Added the function of the display on the floor and the function of the 

background color setting.  
- Added the function of Click movement. 
- Added the function of Operation by slider bar. 

3.10L 2014/03 [Spline] 
- Added the function of “Spline file edit”. 
[Tool] 
- The color of a detailed dialog of the oscillograph is changed. 
[MELFA-3D Vision]  
- Corresponded to MELFA-3D Vision Ver.1.1. 

3.20W 2014/10 [Program editor] 
- Corresponded to multiple undo/redo 
[Maintenance] 
- Added the function of “2D vision calibration” 
[Operation panel] 
- The automatic driving function is added.  
- Open/Close operation of the hand is added. 
- The function that moves specifying the coordinate value is added. 
[Simulator] 
- Added the detailed robot model. 
- Corresponded to Z direction of the travel base 
- Corresponded to 3D monitor in the offline mode 
- Changed the line weight of XYZ positions in 3D monitor 
- Added function of display/hide the coordinate axes and the robot model 

in 3D monitor 
- Added function of display the spline curve in 3D monitor 
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PREFACE 

Thank you for purchasing this MELFA Mitsubishi Electric industrial robot. 
This document is the user's manual for the MELSOFT "RT ToolBox2" and "RT ToolBox2 mini". 
This document will help you to use the functions of this software to the maximum over a wide range of 
stages, from initial robot start to program writing, editing, and management. 
In order to operate the robot safely, carefully read this document and the safety manual that comes with the 
robot main unit before operating the robot. Also, store this manual carefully so that you can take it out and 
read it whenever needed. 

Target versions for this document 
This document is for the MELSOFT "RT ToolBox2" and "RT ToolBox2 mini" Version 3.20W and supports the 
following robot controllers. 

・ CRn-500 series controllers 
・ CR750-Q/CRnQ-700 series controllers 
・ CR750-D/CRnD-700 series controllers 

In this manual, these also have the part written as “CR750/700/500 series”. 

Target readers for this document 
This document assumes that the reader understands basic Microsoft Windows operation methods and the 
robot controller. 
Those who have not mastered basic computer operation methods should read the user's manual for their 
computer. 

Notation method in this document 

 

This indicates an item for which incorrect handling could present imminent danger 
of death or injury. 

 

This indicates an item for which incorrect handling could present a danger of 
death or injury. 

 

This indicates an item for which incorrect handling could present a danger of 
impairment. It could also present a danger of just physical damage. 

 
 
This document uses the following general terms and abbreviations 

General Term/Abbreviation Contents 
RT ToolBox2 General name for the RT ToolBox2 and RT ToolBox2 mini 

To distinguish them in explanations, these two are called the "standard 
edition" and "mini edition". 

Universal model QCPU General term for Mitsubishi PLC CPU modules of Q02U, Q03UD, 
Q03UDE, Q04UDH, Q04UDEH, Q06UDH, Q06UDEH, Q13UDH, 
Q13UDEH, Q26UDH and Q26UDEH. 

Built-in Ethernet port QCPU General term for Mitsubishi PLC CPU modules of Q03UDE, Q04UDEH, 
Q06UDEH, Q13UDEH and Q26UDEH. 

GX Developer Abbreviation of SW D5C-GPPW-E(-EV) / SW D5F-GPPW-E type of 
Mitsubishi PLC programming software package. 

 
 
 
 
The Microsoft® Windows® operating system is a registered trademark of the Microsoft Corp. of the United States in the United States 
and other countries. 
Adobe® and Acrobat® are registered trademarks of Adobe Systems Incorporated. 
 
The system names, product names, etc. in this manual are generally trademarks and registered trademarks of their respective 
companies. In the main text, the ©, ®, and TM marks are omitted. 
 
Transfer of all or part of the contents of this document without permission is prohibited. 
The contents of this document are subject to change without notice. 
Every effort has been made to ensure the accuracy of the contents of this document, but if you should notice any unclear point, mistake, 
or omission, please notify Mitsubishi Electric. 
 
Copyright(C)2008-2014 MITSUBISHI ELECTRIC CORPORATION 
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1. Usage 
 
This explains precautions you need to know before using this software.  

 
 

1.1. How to Use this Document 

The manual is in the CR-ROM as the Adobe PDF file.  
D:/Doc/BFP-A8618.pdf   (Example for the CD-ROM drive is “D:”.)  

 
For reading the manual, Adobe Acrobat Reader Ver.5.0 or more is required. 
If Adobe Acrobat Reader isn’t installed, please download from following Adobe Systems Incorporated URL (As 
of September, 2009) 

URL: http://www.adobe.com/ 
 
 
 

1.2. Checking the Product 

1.2.1. Checking the package 

Please check if all items shown below are included in the package.  
- CD-ROM "RT ToolBox2" 
- Setup Guide 
- END-USER SOFTWARE LICENSE AGREEMENT 
- License Certification 

(Please make sure Product ID is printed on it.) 
* Please contact the branch office or the agency if there is some shortage in the package.  
 
 
1.2.2. Checking the CD-ROM contents 

The CD-Rom has the following configuration.  

 
 
 
1.2.3. About the "MelfaRXM.ocx" communications middleware 

MelfaRXM.ocx is the ActiveX control that communicates to robot-controller. You can create the Windows 
Application of "MELFA ROBOT" by using this control. 
You can use "MelfaRXM.ocx" in only standard version of this software.  
For information on how to set up "MelfaRXM.ocx", refer to "20 MelfaRXM.ocx Communications Middleware 
Setup". 
In case of using only the function of “RT ToolBox2”, you don't need to install this software. 
 

Doc 

/: 

The files for installagion of this software

This manual (pdf) ・・・・・・・

Utility The folder for setup of the communication middleware "MelfaRXM.ocx" ・・・・・・・

: 
: 

Sample The sample data (Layout, Hand model)  ・・・・・
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1.3. Items to be prepared by the customer 

This explains what the customer needs to prepare in order to use this software 
 
 
1.3.1. Computer system 

Use a computer that meets the specifications given in: "1.4 Operating Environment". 
 
 
1.3.2. Computer cable 

Prepare the cable for connecting the controller and the computer. The cable required depends on the 
connection specifications and controller used, as shown below.  
For the RS-232 cable refer to the "Standard Specifications" for your robot.  
 
 

Table 1-1 CR750-D/CRnD-700/CRn500 Series Communication Cables 

Method Description Model name Manufacturer 
USB USB A type, USB mini B type - - 
Ethernet 10BASE-T, 100BASE-TX - - 

CRnD-700 
series 

2D-232CBL03M Mitsubishi Electric 

For controller front panel 
CRn-500 
series 

RS-MAXY-CBL 
RS-AT-RCBL 
(for expansion serial 
interface (option)) 

Mitsubishi Electric 
RS-232 

For expansion option box (CR1-EB3) RS-AT-RCBL Mitsubishi Electric 
 

Table 1-2 CR750-Q/CRnQ-700 Series Communication Cables 

Cables confirmed by Mitsubishi Electric to operate 
properly Method Description 

Model name Manufacturer 
ZUM-430 Loas Co. 
USB-M53 Elecom Co. 

GT09-C20USB-5P 
Mitsubishi Electric System 
Service 

USB USB A type to mini B type 

MR-J3USBCBL3M Mitsubishi Electric 
Ethernet 10BASE-T, 100BASE-TX   

RS-232 

For connecting by personal computer - 
PLC CPU 
(when Personal computer connector is 
D-sub, 9-pin) 

QC30R2 Mitsubishi Electric 

 

 

Use of USB to RS-232 does not guarantee normal operation.  
 

When you use USB to RS-232 cable, normal operation is not guaranteed.  
If you want to use RS-232 as a communication port, use of computer with serial ports is 
recommended.  

Caution 
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1.4. Operating Environment 

This explains the operating environment.  
 
 
1.4.1. Connectable robot controllers 

 
This software can be connected with the robot controllers shown below 
 

Table 1-3 Connectable Robot Controllers and Communications Types 

Robot controller Communications (*1) Remark 

USB (*2) 

The commercial item such as computer and 
cable might be unsuitable to compatibility with 
our equipment or the FA environments of the 
temperature and the noise, etc. 
When it is used, please confirm the operation 
enough, because you might have to take 
measures against noise such as EMI measure 
or addition of ferrite core. 

Ethernet (TCP/IP)  

RS-232 Only CRnD-700 series 

CR750-D/CRnD-700 
series 

 
(The photo is a robot 
 controller of CR3D-700.) 

GOT communications 

Communicate with CR750-D/CRnD-700series 
controller connected with the GOT via Ethernet 
by USB / RS-232. 
GOT 1000 series and the Ethernet 
communication unit (GT15-J1E71-100) are 
needed. (*4) 

USB (*2)  

Ethernet 
(TCP/IP) 

The PLC Ethernet interface module or Built-in 
Ethernet port QCPU (*3) is required. 

CR750-Q/CRnQ-700 
series 

 
(The photo is a robot 
 controller of CR3Q-700.) 

CRnQ 
communications

RS-232 

 

Ethernet (TCP/IP) 
The robot controller must have the "Ethernet 
interface" option. 

CRn-500 series  

 

RS-232  

(*1) The computer must have each ports for communications.  
(*2) When using USB connection, 1 computer can connect to only 1 robot controller.  
(*3) Built-in Ethernet port QCPU can be used with this software Ver.1.2 or later.  
(*4) GOT communications can be used with this software Ver.1.5 or later.  

 
This software can be connected to a maximum of 32 controllers at the same time.  These controllers may be 
different models. 
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1.4.2. Computer system 

 
This software operates on PC/AT compatible computers that meet the following specifications.  
 

Item Recommended environment 

CPU 
Pentium III 1 GHz or higher 
Simulation simplicity model: Pentinum IV 2 GHz or higher. 
Simulation details model: Core2 Duo, Core i3 3 GHz or higher. 

Main memory 
512 MB min. 
Simulation: 2 GB min. 

Hard disk Available capacity 300 MB min. 
Display XGA (1024x768) or higher 
Optical device CD-ROM drive 
Keyboard PC/AT compatible keyboard 
Pointing device Must operate on Windows 

Communications 
functions 
Communications port 

- USB2.0 
(Caution: This cannot be used for connection with the CRn-500 series 
controller.) 

- LAN: 100Base-TX/10Base-T 
- RS-232 communications port that operates on Windows (Minimum 

9600bps: 1 port) 
Must have one of the above interfaces 

OSs for which 
operation is warranted 

Windows 2000 Professional (32-bit version) (*2) 
Windows XP Professional (32-bit version) 
Windows XP Home Edition (32-bit version) 
Windows Vista Ultimate (32-bit version) 
Windows Vista Business (32-bit version) 
Windows Vista Home Premium (32-bit version) 
Windows Vista Home Basic (32-bit version) 
Windows 7 Starter (32-bit version)  
Windows 7 Home Premium (32/64-bit version) (*1) 
Windows 7 Professional(32/64-bit version) (*1) 
Windows 7 Enterprise (32/64-bit version) (*1) 
Windows 7 Ultimate (32/64-bit version) (*1) 
Windows 8 (32/64-bit version) (*3) 
Windows 8 Pro (32/64-bit version) (*3) 
Windows 8 Enterprise (32/64-bit version) (*3) 
Windows 8.1 (32/64-bit version) (*3) 
Windows 8.1 Pro (32/64-bit version) (*3) 
Windows 8.1 Enterprise (32/64-bit version) (*3) 

*1: Windows 7 is corresponded with Version 1.7 or later of software. The 64-bit version of 
Windows 7 can be used with version 2.00A or later of this software.  

*2 :  When you use Windows 2000, it is necessary to install Service Pack4 and internet Explorer 
version 5.5 or later. 

*3: Windows 8 and Windows 8.1 are corresponded with Version 2.50C or later of software. When 
you install this software, [.NET Framework 3.5 (includes .NET 2.0 and 3.0)] feature should be 
turned on. Refer to Chapter 1.5.1.1 for the method of a present state confirmation and 
turning on. 
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1.5. Installation, Uninstallation 

This section explains the method for installing the software and the method for uninstalling it.  
 

 
 
 
1.5.1. Installation 

 
 
Install this software with the procedure below.  
 

(1) When you insert this product into the computer's CD-ROM drive, the setup screen is displayed 
automatically. 

 
(2) If the setup screen is not displayed when you insert this product into the computer's CD-ROM drive, 

display the setup screen with the following method. 
 

1) Display the [Run] dialog. 
Table 1-4 Method of displaying the [Run] dialog 

OS Start method 
Windows 2000 / XP / 7 Select [Start] button -> [Run]. 
Windows Vista < In Windows Vista, when using the [Start] menu with the classic 

display> 
Select [Start] button -> [Run]. 

< In Windows Vista, when not using the [Start] menu with the 
classic display > 

Click [Start] button -> [All Programs] -> [Accessories], then select 
[Run]. 

Windows 8 Press the [Windows] + [R] key. 
 
2) Check the CD-ROM drive name, then input "drive name":\Setup.exe.  

(If the CD-ROM drive is "D:", input "D:\Setup.exe".) 
 

When installing, log in as a user with administrator authority.  
 

When installing, log in as a user with administrator authority. The system will not let you install if 
you log in as a user who does not have administrator authority.  

Please input product ID attached to RT ToolBox2 again when you install a 
standard version of RT ToolBox2 in the personal computer in which “iQ 
Works(MELSOFT Navigator" is installed. 

When RT ToolBox2 is installed in the personal computer in which “iQ Works(MELSOFT 
Navigator)" is installed, product ID for “iQ Works(MELSOFT Navigator)” is displayed on "Input 
Product ID" screen. RT ToolBox2 is installed in the personal computer as mini version when this 
software is installed with this Product ID. Please input product ID attached to RT ToolBox2 
product again when you install a standard version of RT ToolBox2. 

Caution 

Caution 

Uninstall RT ToolBox2 before installing.  
 

If "RT ToolBox2" has already been installed in the personal computer, it is necessary to uninstall 
it before "RT ToolBox2" is installed. 

Caution 
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Figure 1-1 Specify the File Name and Execute 

 
With Windows Vista, when using the classic display, when not using the [Start] menu with the classic 
display, you can use the [Start] menu Search box instead of executing the [Run] command. 

 

 
* Product ID is printed on the Certificate of License permission 
* After the installation is completed, the computer should be likely to be rebooted.  

 

 Start 

(f) Input Product ID 

(i) Start the program, and confirm whether 
the product was installed correctly 

(h) Installation Wizard Complete 

Finish 

(a) Set the CD-ROM in PC's CD-ROM drive. 

(b) Open "Setup.exe" in CD-ROM. 
(when it is not started automatically) 

(c) Starting installation Wizard 

(d) License Agreement 

(g) Choose Destination Location 

(e) Input "Customer Information" 
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About the confirmation and warning message displayed during 
installation (version 1.8 or earlier of this software) 

 

During installation on Windows XP or Windows Vista, the following confirmation and warning 
messages are displayed, but select to continue installation. If you select not to install, please 
execute the installation again.  

 
(1) Installation confirmation message for USB driver software (for Windows XP)  

      
 

(2) Installation confirmation message for USB driver software (for Windows Vista)  

   
 

(3) Installation warning message for USB driver software (for Windows Vista)  

   
<Remark> 
       We have confirmed operation at our company. No problem occurs after installation.  

Caution 
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1.5.1.1. Installation on Windows 8 or Windows8.1 

When you install this software on Windows 8 or Windows8.1, you will need to turn on ".NET Framework Version 
3.5 (includes .NET 2.0 and 3.0)” feature of the PC you want to install. If you install this software during turn off 
the feature, the installation will stop and show the following dialog. 
 

 
 

About the confirmation and warning message displayed during 
installation (version 2.0 or later of this software) 

 

During installation on Windows XP or Windows Vista, the following confirmation and warning 
messages are displayed, but select to continue installation. If you select not to install, please 
execute the installation again.  

 

Installation confirmation message for USB driver software（ro Windows Vista） 

   
 

When “Always trust software from MITSUBISHI ELECTRIC CORPORATION” is checked, the alert 
message will not be displayed after next time.  

Caution 
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If the dialog is shown, install this software again after you turn on ".NET Framework Version 3.5 (includes .NET 
2.0 and 3.0)” feature as following steps. 
 
(1) Be ready to connect the PC to the Internet. 
 
(2) Select [Programs] – [Turn Windows features on or off] from the Control Panel. 

 
 

 
 
(3) Check [.NET Framework 3.5 (includes .NET 2.0 and 3.0)] check box on Turn Windows features on or off 

screen and click [OK]. 
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(4) Select [Download files from Windows Update] when the following screen is shown. 

 
 
(5) This process is complete when the following screen is shown. 

 
 
 



 

1-30  1-30 

 
1.5.2. Uninstall 

 
Uninstall with the following method.  

 
- Windows 2000 / XP 

Execute [Start] – [Control Panel] [Program Add and Delete]. 
 
- Windows Vista 

Open [Start] – [Control Panel].  
 

When not using the classic display 
With [Control Panel] [Program], execute [Uninstall Program].

 
For classic display 
With [Control Panel] [Program Functions], select the 
application name, then execute the uninstallation. 

 
- Windows 7 

Execute [Start] – [Program Functions] or [Uninstall Program], 
select the application name, then execute the uninstallation. 

 
- Windows 8 / 8.1 

Press the [Windows] + [X] key, and select the [Program 
Functions] from the displayed menu. 
 
With [Program Functions], select the application name, then 
execute the uninstallation. 
 

 Start uninstallation. 

From [Start] – [Control Panel], display the 
control panel and select "Add/Remove 
Programs". 

Select the product to delete, then click the 
"Change or Remove Programs". 

Completion 

 
 

RT ToolBox2 

 
Table 1-2 Uninstalling Applications (WindowsXP) 
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1.5.3. USB driver (CR750-D/CRnD-700 series robot controller) installation  

 
Connecting the CR750-D/CRnD-700 series robot controller with USB requires installation of the robot USB 
driver.  Install with the following procedure.  
 
 
1.5.3.1. When using Windows 2000 

When you connect the CR750-D/CRnD-700 robot controller and the computer with a USB cable, installation 
starts and completes automatically.  
 
 
1.5.3.2. When Using Windows XP 

Below is the installation procedure for the USB driver using Windows XP (Professional).  

 

1) When you connect the computer and 
CR750-D/CRnD-700 series robot 
controller with a USB cable, the 
screen on the left is displayed. Select 
"Install the software automatically 
(Recommended)", then click the [Next] 
button. Installation of the USB driver 
starts. 

↓  

 

2) When the screen on the left is 
displayed, the installation is complete.
Click the [Finish] button to end the 
installation. 

↓ 
(Completed) 

 

 
 
1.5.3.3. When using Windows Vista 

When you connect the CR750-D/CRnD-700 robot controller and the computer with a USB cable, installation 
starts and completes automatically.  
 
 
 
1.5.3.4. When using Windows 7 / 8 / 8.1 

When you connect the CR750-D/CRnD-700 robot controller and the computer with a USB cable, installation 
starts and completes automatically.  
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1.5.4. CRnQ communications USB driver installation  

 
Connecting the CR750-Q/CRnQ-700 series robot controller with USB requires installation of the robot USB 
driver.  Install with the following procedure.  
 
 

 
 
 
1.5.4.1. When using Windows 2000 

The following indicates the procedure for installing the USB driver when using Windows 2000.  

 

1) The screen shown on the left appears 
when you connect the personal 
computer and Universal model QCPU 
by the USB cable. 

Click the [Next] button. 

↓  

 

2) Choose "Search for a suitable driver 
for my device [recommended]" and 
click the [Next] button. 

↓  

If the USB driver cannot be installed, check the following setting.  
 

<When Windows 2000 is used> 
If you have selected "Block-Prevent installation of unsigned files" after [Control Panel] - [System] 
- [Hardware] - [Driver Signing], the USB driver may not be installed.  
Choose "Ignore-Install all files, regardless of file signature" or "Warn-Display a message before 
installing an unsigned file" for [Driver Signing], and install the USB driver.  

 
<When Windows XP is used> 

If you have selected "Block-Never install unsigned driver software" after [Control Panel] - 
[System] - [Hardware] - [Driver Signing], the USB driver may not be installed.  
Choose "Ignore-Install the software anyway and don't ask for my approval" or "Warn-Prompt me 
each time to choose an action" for [Driver Signing], and install the USB driver.  

Caution 
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3) Check "Specify a location" and click 
the [Next] button. 

↓  

 

4) As the left screen appears, set the 
“C:\Melsec\EasySocket\USBDrivers” 
and  
If volume MELSOFT products have 
been installed, browse the installation 
destination “EasySocket\USBDrivers” 
of the first installed product. 
After setting, click the [OK] button. 

↓  

 

5) The screen on the left appears to 
indicate completion of installation. 
Click the [Finish] button. 

↓ 
(Completed) 
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1.5.4.2. When using Windows XP 

The following indicates the procedure for installing the USB driver when using Windows XP (Professional).  

 

1) The screen shown on the left appears 
when you connect the personal 
computer and Universal model QCPU 
by the USB cable. 
Choose "Yes, now and every time I 
connect a device" and click the [Next] 
button. 

↓  

 

2) As the screen on the left appears, 
choose "Install from a list or specific 
location [Advanced]" and click the 
[Next] button. 

↓  

 

3) As the screen on the left appears, 
choose "Search for the best driver in 
these locations". 
Check "Include this location in the 
search" and set the 
“C:\Melsec\EasySocket\USBDrivers”. 
If volume MELSOFT products have 
been installed, browse the installation 
destination "EasySocket\USBDrivers" 
of the first installed product. 
After setting, click the [Next] button. 

↓  
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4) As the screen on the left appears, 
click the [Continue Anyway] button to 
continue the installation of the USB 
driver. 
(No problem will occur after 
installation of the USB driver.) 

 

↓  

 

5) The screen on the left appears to 
indicate completion of installation. 
Click the [Finish] button. 

↓ 
(Completed) 

 

 
 
 
1.5.4.3. When using Windows Vista 

The following indicates the procedure for installing the USB driver when using Windows Vista (Business).  

 

1) The screen shown on the left appears 
when you connect the personal 
computer and Universal model QCPU 
by the USB cable. 
Select "Locate and install driver 
software (recommended)" and wait for 
the search to end. 

 

↓  
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2) The screen on the left is displayed, so 
select "Browse my computer for driver 
software (advanced)". 

↓  

 

3) The screen on the left is displayed, 
so select 
“C:\Melsec\EasySocket\USBDrivers”. 
If volume MELSOFT products have 
been installed, browse the installation 
destination "EasySocket\USBDrivers" 
of the first installed product. 
After setting, click the [Next] button. 

↓  

 

4) The screen on the left is displayed, so 
select "Install this driver software 
anyway". 

↓  

 

5) The screen on the left appears to 
indicate completion of installation. 
Click the [Finish] button. 

↓ 
(Completed) 
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1.5.4.4. When using Windows 7 / 8 / 8.1 

The following indicates the procedure for installing the USB driver when using Windows 7 / 8 / 8.1.  
 

 
↓ 

1) When "Control panel" is selected 
from the start menu with the USB 
cable connected, the following 
screens are displayed.  
The screen on the left is displayed, 
clicking the red circle part in this 
screen. 

↓ 

2) The screen on the left is displayed, 
clicking the red circle part in this 
screen. 
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↓ 

3) The screen on the left is displayed, 
right-clicks on “Unknown device” is 
displayed on this screen. 
Select "Update Driver Software" of 
the menu that right-clicks on this 
item and is displayed. 

 
↓ 

4) The screen on the left is displayed, 
click lower "Browse my computer 
for driver software". 
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↓ 

5) The screen on the left is displayed, 
set "C:\Melsec\Easysocket 
\USBdrivers". 
If volume MELSOFT products have 
been installed, browse the  
installation destination  
"EasySocket\USBDrivers" of the 
first installed product. 
After setting, click the "Next" button. 

 
↓ 

6) The screen on the left is displayed, 
click "install". 

 
↓ 

(Completed) 

7) The screen on the left appears to 
indicate completion of installation. 
Click the [Finish] button. 
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1.5.5. CRnQ Communications USB driver for GOT transparent function / GOT 

communitation installation 

 
Connecting the CR750-Q/CRnQ-700 series robot controller with USB via GOT transparent mode (Bus, Direct 
coupled or Ethernet) and connecting the CR750-D/CRnD-700 series robot controller with USB via GOT 
communication requires installation of the USB driver for the GOT transparent function. Install with the following 
procedure.  
CRnQ communication GOT transparent mode is available from RT ToolBox2 Ver.1.1 or later. GOT 
communication is available from RT ToolBox2 Ver.1.5 or later. Ethernet is available from RT ToolBox2 Ver.1.7 or 
later. 
 
 
1.5.5.1. When using Windows 2000 

When you connect the GOT and the computer by the USB cable, installation starts and completes 
automatically.  

 
If the USB driver cannot be installed, click the following setting. 

If you have selected "Block-Prevent installation of unsigned files" after [Control Panel] - [System] - 
[Hardware] - [Driver Signing], the USB driver may not be installed. 
Choose "Ignore-Install all files, regardless of file signature" or "Warn-Display a message before installing an 
unsigned file" for [Driver Signing], and install the USB driver. 

 
 
1.5.5.2. When using Windows XP 

The following indicates the procedure for installing the USB driver when using Windows (Professional)  

 

1) The screen shown on the left appears 
when you connect the personal 
computer and GOT by the USB cable.
Choose "Yes, now and every time I 
connect a device" and click the [Next] 
button. 

  ↓  

 

2) As the screen on the left appears, 
select "Install the software 
automatically (Recommended)", then 
click the [Next] button. 

↓  
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3) As the screen on the left appears, 
click the [Continue Anyway] button to 
continue the installation of the USB 
driver. 
(No problem will occur after 
installation of the USB driver.) 

↓  

 

4) The screen on the left appears to 
indicate completion of installation. 
Click the [Finish] button to terminate 
installation. 

↓ 
(Completed) 

 

 
If the USB driver cannot be installed, click the following setting. 

If you have selected "Block-Never install unsigned driver software" after [Control Panel] - [System] - 
[Hardware] - [Driver Signing], the USB driver may not be installed. 
Choose "Ignore-Install the software anyway and don't ask for my approval" or "Warn-Prompt me each time 
to choose an action" for [Driver Signing], and install the USB driver. 

 
 
1.5.5.3. When using Windows Vista 

When you connect the GOT and the computer by the USB cable, installation starts and completes 
automatically.  
 
 
1.5.5.4. When using Windows 7 / 8 / 8.1 

When you connect the GOT and the computer by the USB cable, installation starts and completes 
automatically.  
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1.6. When Starting at the Same Time as Another Product 

When starting this software and another one of our products at the same time, follow the following precaution.  
Correct communications and screen display are sometimes not possible.  
 

Table 1-5 Precautions for Starting at the Same Time with Another Product 

Product name Explanation Precaution 
RT ToolBox  
computer support software 

Older version of this 
software 

Can not be used at the same time as 
this software 

MELFA-Works 3D robot simulator 

MELFA-Works Ver.3.0 or lator can be 
used at the same time as this 
software.  
Earlier version than Ver.3.0 can not be 
used. 

MELFA-Vision 
Network vision sensor 
software 

Start this software first. 

E/EN series computer support 
software for Windows 

E/EN series software 
Can not be used at the same time as 
this software 

P/P-2 
R-250R/R-300R series 
software  

Can be used at the same time as this 
software 

 
 
 
 

1.7. Upgrade of software 

It is possible to download the latest version from MITSUBISHI ELECTRIC FA site where information on 
MITSUBISHI ELECTRIC Corporation FA equipment product is offered. (It is only a Japanese site.)   
 

http://wwwf2.mitsubishielectric.co.jp/melfansweb/robot/index.html 
 
It is necessary to register to FA members for downloading the software.  
 
Difference update of robot model information can be performed after Ver.3.00A. 
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2. RT ToolBox2 Usage  
 
This explains the usage of this software simply.  
 
 

2.1. Starting RT ToolBox2 

When you install this software, a shortcut is prepared on the desktop.  Start RT ToolBox2 by double clicking 
this short cut.  

 
Figure 2-1 RT ToolBox2 Shortcut 

 
From [Start] button -> [All Programs] -> [MELSOFT Applications], select [RT ToolBox2] and start it.  
 

 
Figure 2-2 RT ToolBox2 Initial Screen  

 
When you start RT ToolBox2, "Communications Server 2" is started up as an icon.   
This Communications Server 2 has functions for connecting with a robot controller or during a simulation, a 
virtual controller.  Do not close Communications Server 2.  
 

 
Figure 2-3 Communication Server 2 

Version 1.8 or earlier Version 2.00A or later 
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2.2. Explanation of RT ToolBox2 Screens 

The composition of the main RT ToolBox2 screen is as follows.  
 

 
 

Figure 2-4 Explanation of Main Screen 
 
 
(1) Title bar  

Displays the name of the workspace currently being edited.  
 

 

After the size is changed, you can close RT ToolBox2. 

Displays the name of the workspace currently being 
edited. 

Minimize RT ToolBox2. 

Maximize/Minimize RT ToolBox2. 

The status of the connection with the robot is displayed.  The 
connection statuses are online, offline, and simulation. 

Click to close RT ToolBox2. 

The screen currently active 
is displayed on top. 

(1) Title bar (2) Menu bar 

(4) Tool bar 

(5) Project tree 

(6) Property window 
(8) Status bar 

(4) ツールバー (7) Screens 

(7) Screens 
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(2) Menu bar 

Displays the names of the menus that can be used in RT ToolBox2. 
When a menu is selected, a dropdown menu is displayed from which you can use various functions.  
 

 
 
The menu bar display contents and their enabled/disabled status depend on which screen is currently 
active.  

 
 
(3) Dropdown menu 

Displays the names of the functions you can use in RT ToolBox2.  
When you click a function name, it displays a screen with the settings etc. for the selected function.  
When " " is displayed at the right end of a dropdown menu, a dropdown menu for the selected function is 
displayed 

 

 
 
 
(4) Tool bar 

Displays buttons for the functions assigned to the menu bar.  
 

 
 
The tool bar display depends on which screen is currently active and on the robot connection status.  

 

Click to display the screen. 

Displays a 
dropdown menu.
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(5) Project tree 

Displays a list of all the projects registered in the workspace and by functions.  
From this tree, the program edit screen, monitor screen, etc. can be started.  

 
 

The project tree is a docking window.  By dragging the title section with the mouse, you can dock the 
project tree at the top, bottom, left, or right edge of the main screen.  

 
 

When the project tree is closed, you can display it again by clicking on the menu bar [View] -> [Project 
Tree].  

 
 
(6) Property window 

You can reference various attributes of the workspace being edited.   
If you click an item on the project tree, its attributes are displayed.  

 
 

The property window is a docking window.  By dragging the title section with the mouse, you can dock the 
project tree at the top, bottom, left, or right edge of the main screen.  

 
The default setting for the property window is not to be displayed.  You can display the property window 
with the menu bar [View] -> [Property].  

 

The attributes are being displayed. 
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(7) Screens 

Displays the screens that can be started from the project tree, including the program edit screen and 
monitor screen.  The currently active screen is displayed on top.  

 

 
 

To close a screen, click the [ ] button in the upper-right corner of the screen.   
You can also change the screen size with the button in the upper-right of the screen.  

 
 
 
(8) Status bar  

Displays RT ToolBox2 status information.  
 

 
 
 
(9) Handy menu display 

By clicking the right button on the mouse, you can display the right button menu, depending on the work 
contents.  Using this menu can increase work efficiency.  
During program editing, the right button menu includes such functions as [Copy], [Paste], and [Cut].  

 

During program editing, displays the cursor position. 

The status of the connection with the robot is displayed.   
The connection statuses are online, offline, and simulation. 

Displays the Caps 
Lock status.  

Displays the Num 
Lock status. 

Minimize the screen. Close the screen. 

Maximize/Minimize the screen. 
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2.3. Communications Server 2 

When you start RT ToolBox2, "Communications Server 2" is started up as an icon.   
This Communications Server 2 has functions for connecting with a robot controller or during a simulation, a 
virtual controller.  

 
Figure 2-5 Communications Server 2 as Icon 

 

 
When you return Communications Server 2 from an icon to its original size, you can check the status of the 
connection with the robot. 

 
 

Figure 2-6  Communication Server2 
 
(1) Title bar 

(AA/BB)  AA: shows the number of robot controllers with which connections are established and BB: 
shows the number of projects switched online.  

 
(2) Line State 

The connection status of the communication line with the robot is displayed. The status color indicates the 
status of the robot controller that is currently being selected.  

 
Table 2-1 Line State 

Status Content Color 

Connecting Indicates that the connection with the robot has been established. 
Light blue

or 
Blue 

Connection wait 

Indicates that a communication to verify connection is being made in the 
case of RS-232 connection. 
Indicates the wait status for communication port connection in the case of 
TCP/IP and USB connection. 

Green 

Connection 
error 

Displayed when the data reception enable signal cannot be detected 
because a cable has been disconnected or the robot has not been started 
in the case of RS-232 connection. 
Displayed when the communication port cannot be opened in the case of 
TCP/IP and USB connection. 
In the case of USB connection, if the USB driver has not been installed, it 
is also displayed in red. 

Red 

Communication Displayed when the communication port cannot be opened in the case of Red 

(1) Title bar 

(2) Line State 

(3) Communication 
State 

(4) Robot 
controller 

(5) Robot 
Information 

Do not close Communication Server 2 manually.  
 

Communication Server 2 has functions for connecting to a robot controller or during simulation, a virtual 
controller.  Do not close Communication Server 2.  Communication Server 2 closes automatically 
when RT ToolBox2 is closed.  
 

Turn Communication Server 2 into an icon.  
Turn Communication Server 2 into an icon with the  button.

Caution 
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Status Content Color 
Setting error RS-232 connection. This is not displayed in the case of TCP/IP 

connection 
Waiting Indicates the idling status displayed at the start of remote maintenance. Yellow 

 
(3) Communication State 

The contents of communication with the robot controller are displayed.  
 
(4) Robot 

This changes the robot controller for which the "Line status" and "Communication status" are displayed.  
This is only displayed for robot controllers that are online or have been switched to simulation status.  

 
(5) Robot Information 

Information on the currently connected robot can be referenced.  

 
Figure 2-7 Connected Robot Information 

 
This software Ver.1.5 or later can communicate with robot controller by higher reliability communication. In this 
case, line state color (connecting) of communication server 2 is “Blue”. 
 

Table 2-2 Conbination of higher reliability communication 

Robot controller software version 
CRn-500 CR750-D/CRnD-700 CR750-Q/CRnQ-700 

 

All versions Ver.P7a or former Ver.P8 or later Ver.N7a or former Ver.N8 or later
Ver.1.4.1 
or former 

○ ○ ○ ○ ○ This 
software 
verion Ver.1.5 

or later 
○ ○ ◎ ○ ◎ 

○ : Conventional communication (line state color (connecting) : light bule) 
◎ : Higher reliability communication (line state color (connecting) : blue) 

 

Cautions when connected on USB with CRnQ communications 
When connected on USB with CRnQ communications, after connecting normally, if the 
communications are cut off due to any of the following external causes, the line status display 
remains "Connected". If this happens, return this software offline, remove the cause of the cutoff, 
and then go back online.  

・ The robot controller power supply went off. 
・ The communication cable was disconnected. 

Caution 
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2.4. About Operation panel 

 
 
You can show the operation panel for operating the robot controller or the simulator connected to RT ToolBox2. 
You can run the robot program opened in debug mode by step execution. 
When RT ToolBox2 connects to the robot controller or the simulator, you can run the robot program with Ver. 
3.20W or later of this software. 
 

 
Figure 2-8 Operating a controller screen 

 

 
Figure 2-9 Operating a simulation screen 

 

(1) Task slot status and select 
(2) Override 

(3) Operation panel 

(4) Step 

(7) D-EXEC 

(8) Monitor 

(5) HAND 

(6) JOG 

(1) Task slot status and select 
(2) Override 

(3) Operation panel 

(4) Step 

(7) D-EXEC 

(8) Monitor 

With program running or debugging, the robot may operate at 100% 
speed. Watch out for the safety around the robot. 

Also, prepare a T/B at hand and use the robot in a status in which an 
emergency stop can be made at any time. 

Danger 

Caution when connected on TCP/IP with higher reliability 
communication 

When connected on TCP/IP with higher reliability communication, connect only one line of one port 
number. 
If two or more lines are connected to the same port number, the communication error might occur. 

Caution 
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(1) Task slot status and select 
This shows the task slot status, the program of selecting or the line number of running for simulation. 
You can select the robot program to execute by clicking [Select] button. 
You can set the line nummber of the robot program to start by clicking [Jump] button. 

 
(2) Override 

This displays and sets the robot speed override. 
You can set by operating the drop down list with Version 3.01B or later of this software. 5%, 2%, and 1% 

can be selected too in this operation. 
 
(3) Operation panel 

Control the robot. You can start / stop / reset / finish the robot program and servo ON / OFF. 
 
(4) Step 

Control the robot program on debugging. 
- [FORWD] or [BACKWD] execute a line of the running program and move to forward or backward line. 
- [CONT] executes a robot program which stops by breakpoint or stop command continuously from 

stopped line. 
 

 
(5) HAND 

Control hands of simulation. Show the hand operating screen by clicking this button. 
You can open / close each hand, align hand or move the robot to home position. 

 
(6) JOG 

This conducts jog operations for the simulation robot. When you click this button, the jog operation screen 
is displayed. 

 
(7) D-EXEC 

You can execute any command without relationship to the robot program. 
 
(8) Monitor 

You can display 3D monitor of the robot. Show “Error monitor” screen or “Program monitor” screen by 
clicking [Error] or [Program] button. 

 
 
 
2.4.1. How to show Operating panel for a controller 

If you click [Online] – [Operation panel] when RT ToolBox2 connecting to the robot controller, “Operating panel” 
screen is shown. 

 
Figure 2-10 Showing the operation panel 

 
 

2.5. Closing RT ToolBox2 

To close RT ToolBox2, on the menu bar, click [Workspace] -> [Close Application].  You can also close with the 
[ ] button in the upper-right of the screen.  
When you close RT ToolBox2, Communications Server 2 also closes automatically. 
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3. Notes of when RT ToolBox2 is used with iQ Works 
(MELSOFT Navigator) 

There are some limitations when robot controller's workspace is made by using iQ Works(MELSOFT 
Navigator) or RT ToolBox2 is started from iQ Works(MELSOFT Navigator). Please refer to the following notes 
when you use iQ Works(MELSOFT Navigator).  

RT ToolBox2 corresponding to iQ Works(MELSOFT Navigator) is version 2.00A or later.  
 

 
 

3.1. Notes of when RT ToolBox2 is installed 

Notes 1-1： Please input product ID attached to the product again when you install a 
standard version of RT ToolBox2 in the personal computer in which “iQ 
Works(MELSOFT Navigator" is installed. 

 
When RT ToolBox2 is installed in the personal computer in which “iQ Works(MELSOFT Navigator)" is 

installed, product ID for “iQ Works(MELSOFT Navigator)” is displayed on "Input Product ID" screen. RT 
ToolBox2 is installed in the personal computer as mini version when this software is installed with this 
Product ID. Please input product ID attached to RT ToolBox2 product again when you install a standard 
version of RT ToolBox2. 

 
 

3.2. Notes concerning workspace operation 

Notes 2-1： The workspace name and the workspace title cannot be changed. 
 

When RT ToolBox2 is started from iQ Works(MELSOFT Navigator), the workspace name and the 
workspace title cannot be changed.  "Edit workspace" in the dropdown menu of the workspace name is 
displayed in the gray and cannot be selected. (Refer to “Figure 3-1 Menu of [Workspace] and 
Dropdown-menu of the Workspace”) 

 
 
Notes 2-2： Please close RT ToolBox2 once when you edit another workspace.  

 
The another workspace cannot be opened after closing the editing workspace when RT ToolBox2 is 

started from iQ Works (MELSOFT Navigator). [New] of the [Workspace] menu and [Open] are displayed 
in the gray, and cannot be selected. (Refer to “Figure 3-1 Menu of [Workspace] and Dropdown-menu 
of the Workspace”)  When you edit another workspace, please exit RT ToolBox2 once and start RT 
ToolBox2 specifying another workspace from iQ Works(MELSOFT Navigator).  

 
 
Notes 2-3： It is not possible to save as another name when the workspace is edited. 

 
The editing workspace cannot be saved as another name when RT ToolBox2 is started from iQ Works 

(MELSOFT Navigator). [Save As] in [Workspace] menu is displayed in the gray and cannot be selected.  

 
Figure 3-1 Menu of [Workspace] and Dropdown-menu of the Workspace 

Dropdown-menu of Workspace 
(online) 

Menu of [Workspace] 
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3.3. Notes concerning Project operation 

Notes 3-1： It is not possible to delete,or and import a project. 
 

When RT ToolBox2 is started from iQ Works(MELSOFT Navigator), it is not possible to add a new 
project, import a project, or delete an existing project. [Add project] and [Import project] ( in the dropdown 
menu by selecting a workspace name) and [Delete project] ( in the dropdown menu by selecting a project 
name ) are display in the gray and cannot be selected.  

 
Figure 3-2 Menu of [Workspace] and Dropdown-menu of the Workspace 

 
 
Notes 3-2： It is not possible to change a project name. 

 
When RT ToolBox2 is started from iQ Works(MELSOFT Navigator), it is not possible to chage the 

project in the editing workspace. "Project name" in "Edit project" screen is displayed in the gray, and 
cannot be selected. 

 
Figure 3-3 Edit project 

 
 

Dropdown-menu of the 
Workspace 

(online) 

Menu of [Workspace] 

Dropdown-menu of the 
Project 
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3.4. Notes to edit the workspace created by iQ Works(MELSOFT 
Navigator)  

 
Notes 4-1： Do not change the composition of the workspace created by iQ 

Works(MELSOFT Navigator). 
 

The composition (changing a workspace name, changing a title, adding a project,  deleting a project 
or changing a project name) of the workspace made with iQ Works(MELSOFT Navigator) cannot be 
changed with RT ToolBox2 started from iQ Works(MELSOFT Navigator).  These information can be 
edited with RT ToolBox2 started directly by the start menu etc. However, it becomes impossible to take 
the correspondence in iQ Works(MELSOFT Navigator) when these information is changed. Please do 
not change the composition (changing a workspace name, changing a title, adding a project, deleting a 
project or changing a project name) of workspace when editing them with RT ToolBox2 started directly.   

 
Prohibited matter in RT ToolBox2 started directly 

・ Change the workspace name. Workspace 

・ Change the title. 
・ Add a project 
・ Import a project 
・ Delete a project 

Project 

・ Change the project name 
 
 

The workspace name made with iQ Works (MELSOFT Navigator) is set as follows.  Please note the 
handling of this workspace. 

 

Workspace name RT Workspace This is fixation. 
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4.  Basic Functions 
 
The basic functions of this software are shown below.  
 

Table 4-1 RT ToolBox2 Basic Functions 

Function Explanation 

Offline Targets files on the computer. 
Robot model Displays the model of the robot used. 
Program Displays the names of the robot programs written on the computer. 
SQ Direct Displays the SQ Direct files written on the computer. (*2) 

 

Parameter It is possible to set the parameters by offline and save them to the files. 
(*1) 
The saved files can be sent to the robot controllers. 

Online These are used with the robot controller connected. 
Robot model Displays the model of the robot connected to the robot controller. 
Program Displays the names of the programs stored on the robot controller. 
SQ Direct It is possible to edit SQ Direct variables in the robot controllers. (*2) 
Parameters It is possible to set the parameters and preserve them to the file without 

connecting the robot controller. (*1) 
And, the preserved parameter file can be forwarded to the robot controller.

 Parameter list The parameters can be set individually. 
The parameters can be set by robot function individually. 
The functions are as follows. 

 Parameter 
settings by 
function 
 

・ Operating range 
・ Jog 
・ Hand  
・ Weight and size 
・ Tool 
・ Slot table 
・ Output signal reset pattern 
・ Dedicated input/output signal 

allocation 
・ RS-232 settings 
・ User-defined area 
・ Free plane limit 
・ Evacuation point 
・ Robot language 
 

・ Added axes 
・ Collision detection 
・ Heater operation 
・ Operation parameters 
・ Program parameters 
・ User error 
・ Ethernet setting 
・ CC-Link parameter setting 
・ PROFIBUS setting 
・ IO unit (*4) 
・ Work coordinate (*2) 
・ Force control (*4) 
・ Collision avoidance (*6) 

Monitors 
Operation 
monitor 

You can reference the slot status, program, monitor, operation status, and 
current errors. 

Signal monitor You can check the statuses of signals input to the robot and signals output 
from the robot. 

 

Work monitor You can check the robot work time and production information for each 
robot program. 

Maintenance 
Home position 
data 

This sets the robot home position. 

Initialization This sets the robot controller's internal time, deletes all the programs in the 
controller, initializes the battery time remaining, and sets the serial number 
for the connected robot. 

Maintenance 
forecast 

Forecasts the time for maintenance. 

Position repair Supports recovery from home position deviation 
Tool automatic 
calculation 

The tool length is calculated automatically and the value of a tool parameter is set 
up. (*5)  

Servo monitor Monitors servo system information. 

 

 

Password Setup The password to limit controller's right of access is registered, changed or 
deleted. (*3) 
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Function Explanation 

File Manager You can copy, delete and rename the file in the robot controller. (*5)  
 2D Vision 

Calibration 
Run the 2D vision calibration.(*8) 

Option card You can check information on option cards mounted in the robot controller.
Tool 

Force control log 
viewer 

This function can display the graph of log data of force control in PC and 
robot controllers. 

User definition screen It is possible to edit the user definition screen which can be operated by 
highly efficient T/B. (*5)  

 

Oscillograph The data of a robot controller is displayed in a graph. (*7) 
Simulation This can be used connected with a virtual robot. 

*This can only be used with the standard edition. 
Same functions as 
online 

The same functions can be used with a virtual robot controller as with an 
online one. 

 

Tact time measurement The tact time for the robot program with the specified contents can be 
measured in the simulation. 

Backup, restore You can back up the information in the robot controller and restore backed 
up information into the controller. 

MELFA 3D-Vision You can do a setup of MELFA-3D Vision. (*7) 
I/O Simulator Simulates the signal communication between robots.(*8) 
(*1) This function can be used with Version 1.4 or later of this software.  
(*2) This function can be used with Version 1.5 or later of this software.  
(*3) This function can be used with Version 2.00A or later of this software. 
(*4) This function can be used with Version.2.10L or later of this software. 
(*5) This function can be used with Version 2.20W or later of this software.  
(*6) This function can be used with Version 2.40S or later of this software.  
(*7) This function can be used with Version 3.00A or later of this software.  
(*8) This function can be used with Version 3.20W or later of this software.  
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5. Workspaces and Projects 
 
This explains about workspaces and projects.  
 

5.1. Workspaces and Projects 

This software has workspaces and projects.  
The information for one controller is managed as one project. A workspace can manage up to 32 projects. If 
Ethernet is used for communications, you can simultaneously reference information on multiple projects (robot 
controllers) registered in the workspace.  
When using multiple robot controllers, it is convenient to manage with separate workspaces for each 
manufacturing line and installation location.  
 
(1) Using multiple robot controllers (up to 32) 
 

 
Figure 5-1 Using Multiple Robot Controllers 

 
(2) Using 1 robot controller 

 
Figure 5-2 Using One Robot Controller 

 

 

You cannot edit multiple workspaces at the same time.  
With this software, you cannot edit multiple workspaces at the same time.  Register into a 
single workspace all the projects (controllers) you want to reference at the same time.  
 

Simultaneous connection with 32 units 
The maximum of 32 robot connections is a theoretical value.  It does not guarantee that if you 
actually connect 32 robots, you will achieve the same performance as when only 1 robot is 
connected. For example, if you monitor all the robots when 32 are connected, status updating is 
slower than for when 1 robot is connected.  

Caution 

Workspace 

Project 
1 

Communication

RT ToolBox2 

Workspace 

Project 
1 ・・・

Project 
2 

Project 
32 

RT ToolBox2 

... 

You can connect multiple 
controllers at the same time.CommunicationCommunicationCommunication 

You can reference 
the information for 
multiple controllers 
at the same time. 
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Workspace editing and storage and project addition etc. are explained from the next section on. 
 
  

 
 

Update workspaces and projects offline.  
 

In the online status or while a simulation is running, you can not perform the following 
operations.  Switch offline, then perform the operations.  
・ Opening an existing workspace 
・ Saving the workspace with a different name 
・ Adding a project 
・ Changing a project name 
・ Deleting a project 

 
For details on switching offline, see "5.14 Offline/Online/Simulation". 

Caution 
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5.2. Creating a New Workspace 

Click [Workspace] -> [New Workspace］ or click  (Ctrl + N). Creating a New Workspace screen is displayed. 
Input the workspace name and title, and then click the [OK] button. The project edit screen is displayed, so set 
the project name (arbitrary name), the communication method and the robot model for offline (both are the 
information of the robot that you want to connect.), then click the [OK] button.  
When you use the software Version 1.2 or earlier, the project edit screen is not displayed.  
When you use the software Version 3.20W or later, you can change the robot model of 3D monitor to the simple 
model. Please refer to "12.1.5 3D Monitor" for the content of simple model. 

 
Figure 5-3 Creating a New Workspace 
 
The project tree is displayed in the workspace and the "RC1" project is created as the default value.  
This project name can be change later.  For details, see "5.9 Changing a Project Name". 
If you want to display robot model of the simple model in the 3D monitor, check the checkbox of same label. 

Version 1.2 or earlier 

Version 1.3
 or later 
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Workspace names 
 

Workspace names are used as folder names in Windows, so you cannot use characters that 
cannot be used in Windows folders names ( \ / : * ? “ < > | ).  

Once a workspace has been created,  
you cannot change its name with version 1.7 or earlier of this 
software.  
Be aware that once a workspace has been created, you can not change its name with version 

1.7 or earlier of this software.  
When you use version 1.7 or earlier of this software, to change the name of a workspace, 

select "Workspace" on the menu → "Save As", save with the name you want to change to, then 
delete the original workspace with the old name.

Caution 
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5.3. Opening an Existing Workspace 

To open an already existing workspace, click [Workspace] -> [Open] or click  (Ctrl + O).  After selecting 
the workspace to edit, click the [OK] button.  
 

 
Figure 5-4 Opening a Workspace 

 
The names of the last up to four workspaces used are added to [Workspace] on the menu bar.  You can open 

one of these workspaces by clicking its name here.  

 
Figure 5-5 Recently Used Workspace Names 

 
 

5.4. Closing a Workspace 

To close the workspace being edited, click [Workspace] -> [Close].  Note that to delete a workspce, you must 
close it first.  
 

The recently used 
workspaces are added. 
When you click one of these 
workspace names, the 
workspace is opened. 
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5.5. Deleting a Workspace 

Click [Workspace] -> [Delete].  The "Delete Workspace" screen is displayed, so check the name of the 
workspace to delete, and then click the [OK] button.  
 

 
Figure 5-6 Deleting a Workspace 

 

 
 
 

5.6. Saving a Workspace 

The information added to the workspace is saved automatically.  
 
You can also save a workspace with a different name. Click [Workspace] -> [Save As], input the new 

workspace name and title, then click the [OK] button. 
 

 
Figure 5-7 Save As 

Deleting a workspace 
 

To delete a workspace, close that workspace. You can not delete a workspace that is being 
edited.  

Caution 
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5.7. Changing a Workspace 

It is possible to change directly the workspace with version 1.8 or later of this software. 
When you use the software Version 3.20W or later, you can change the robot model of 3D monitor to the simple 
model. Please refer to "12.1.5 3D Monitor" for the content of simple model. 

 
 

Click the name of the workspace with the right button on the mouse, then click "Edit workspace" on the right 
button menu.  The “Change Workspace” screen is displayed, so input the new workspace name and new 
workspace title, then click the [OK] button. 

 
 Figure 5-8 Changing the name of the workspace and workspace title 

 
Once a workspace has been created, you can not directly change its name with version 1.7 or earlier of this 

software.  When you use this software of these version, to change a workspace name, use the menu bar 
[Workspace] -> [Save As] to save the workspace with the desired new name, then delete the old workspace.  

When the workspace title is changed, click the name of the workspace with the right button on the mouse, 
then click "Edit workspace title" on the right button menu.  The workspace title screen is displayed, so input the 
new workspace title, and then click the [OK] button.  
If you want to display robot model of the simple model in the 3D monitor, check the checkbox of same label. 

Don’t change the workspace name and the workspace title  
made with iQ Works(MELSOFT Navigator).  

 

Don’t change the workspace name and the workspace title made with iQ Works(MELSOFT 
Navigator). It becomes impossible to take the correspondence in iQ Works(MELSOFT Navigator) when 
these information is changed. 

Caution 
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Figure 5-9 Changing the title of the workspace (version 1.7 or earlier) 
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5.8. Adding a Project 

You can create up to 32 projects in one workspace.  
Click [Workspace] -> [Add Project].  
 

 
Figure 5-10 Adding a Project 

 
After setting the project name, information on the robot connected, and the communication method, then click 
the [OK] button. 
The project is added to the workspace. 
 
Projects can also be added from a project tree. 
After selecting the workspace, use the mouse right button to select [Add project]. Or, double click the workspace 
name on the project tree. (Note that this function can be used with Version 1.3 or later of this software)  
 

 
Figure 5-11 Adding a Project from a Project Tree 

 

 

Add a new projects offline.  
 

It is possible to add a new project offline. A new project cannot be added, when the status of either of 
project is "Online" or "Simulation". 

 
Don’t add a project to the workspace made with iQ Works(MELSOFT Navigator).

Don’t add a project to the workspace made with iQ Works(MELSOFT Navigator). It becomes impossible 
to take the correspondence in iQ Works(MELSOFT Navigator) when these information is changed. 

Caution 



 

5-66  5-66 

 

5.9. Changing a Project Name 

You can change the name of a project even after it has been created.  
Click the name of the project with the right button on the mouse, then click "Edit Project" on the right button 
menu.  The project edit screen is displayed, so input the new workspace title, then click the [OK] button. 
 
 

 

 
Figure 5-12 Changing a Project Name 

 

 

Don’t change a project name in the workspace  
made with iQ Works(MELSOFT Navigator). 

Don’t change a project name in the workspace made with iQ Works(MELSOFT Navigator). It becomes 
impossible to take the correspondence in iQ Works(MELSOFT Navigator) when these information is 
changed. 

Caution 



 

5-67  5-67 

 

5.10. Deleting a Project 

A project can not be deleted when it is running a simulation or has a robot connected online.  
Click the name of the project with the right button on the mouse, then click "Delete Project" on the right button 
menu.  The deletion confirmation message is displayed, so check that you have clicked the correct project 
name, then click the [OK] button. 
 

  
Figure 5-13 Deleting a Project 

 

 
 

Don’t delete a project in the workspace  
made with iQ Works(MELSOFT Navigator). 

Don’t delete a project in the workspace made with iQ Works(MELSOFT Navigator). It becomes 
impossible to take the correspondence in iQ Works(MELSOFT Navigator) when these information is 
changed. 

Caution 
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5.11. Contents of Project Tree 

A project tree shows the current workspace's project configuration in a hierarchical manner.  You can start all 
functions from the project tree, including program editing, monitor, etc.  
The contents of the project tree depend on the state of connection with the robot controller.  

 
Figure 5-14 Structure of Project Tree in Workspace 

  
(1) Offline 

Displays the information stored in computer.  
Displays the robot model set up currently and the name of robot programs created.  

 
(2) Online 

The "Online" section is displayed when a robot is switched into being connected online with its controller or 
starts a simulation.  This section displays the connected robot model and the information items that can be 
referenced in the controller or a simulation controller.  

 
(3) Backup 

Controls the information backed up from the controller.  
 
(4) Tool 

Other functions are displayed. 
 

Items are displayed for 
each project. 

(1) Offline 

(3) Backup 

(2) Online 
Project 1 
<Project name:  RC1> 

Be connected with the controller. 

Project 2 
<Project name:  RC2> 

Not connected with the controller. 

(4) Tool 



 

5-69  5-69 

 

 
 
 
 
 
 

5.12. Copying Programs Between Projects  

To copy or move a created robot program to another project, do this with program management.  For details on 
the operation methods, see "8.10 Program Management", "8.10.2 Copy", or "8.10.3 Move". 
 
With this software Version 1.3 or later, It is possible to copy by drag and drop the project name on the project 
tree.  
Please refer to "8.10 Program Management" in this manual for details.  
 
 

It is possible to change the order of the display 
 of the project in the tree.  

It is possible to change the order of the display of the project in the tree with version 1.3 or later. 
Drag the project with the mouse, and drop it to the transportation destination. The project is 
moved to the upper part of the dropped project.  

 

Memo 

Drag and drop 
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5.13. Import of project 

It is possible that the project in other workspace is imported to the current workspace. Note that this function can 
be used with Version 1.2 or later of this software.  
 
The project can be imported only at offline. Please operate after change to offline when current mode is online 
or simulation.  

 
 
Click [Work space]->[Import project] on the menu bar.  
After "Select Workspace" window is displayed, select the workspace including the project that you want to 
import, and click [OK] button. The list of the project in selected workspace is displayed on "Select the projects" 
window. Check the project, and click [OK] button.  
 

Don’t import a project to the workspace  
made with iQ Works(MELSOFT Navigator). 

Don’t import a project to the workspace made with iQ Works(MELSOFT Navigator). It becomes 
impossible to take the correspondence in iQ Works(MELSOFT Navigator) when these information is 
changed. 

Caution 
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Figure 5-15 Import of project 
 
The maximum number of the projects in one workspace is 32.  
 

Check the project. 
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5.14. Offline/Online/Simulation 

The project status are offline, online, and simulation.  The meaning of each status and the contents displayed 
in the project tree are shown below.  
 

Table 5-1 RT ToolBox2 Status 

Status Explanation Project tree display 
Offline Targets files stored on the computer. 

When a robot is offline, the icon displayed on the left of 
the project name on the project tree turns green and 
Offline and Backup are displayed on the project tree.  

Online The robot is connected to the robot controller and you can 
check and change the information in the controller  
When a robot is online, the icon displayed on the left of 
the project name on the project tree turns blue and 
Offline, Online, and Backup are displayed on the project 
tree. 

Simulation 
*This can only be 
used with the 
standard edition. 

This targets a virtual robot controller running on the 
computer and you can check and change the information 
in the virtual controller  
When a simulation is running, the icon displayed on the 
left of the project name on the project tree turns blue and 
Offline, Online, and Backup are displayed on the project 
tree. 

 

 
When this software starts, it goes into "Offline" status.  
You can change a workspace or a project only in the "Offline" status.  
 

 
 
 
 
To switch among offline, online, and simulation, do so from [Online] on the menu bar or from the tool bar.  With 
the tool bar, you can switch as follows. 
 

 
Figure 5-16 Explanation of Tool Bar 

 
 
 
The current status and the statuses into which the current status can be switched are as followed.  

Switch to "Offline". 
 
Switch to "Online". 
 
Switch to "Simulation". 

The simulation function only supports the "RT ToolBox2" standard edition. It can not be used with the 
mini edition.  
Also, please be aware that even with the standard edition, the simulation function can not be used when 
Movemaster commands are selected.  

Caution 
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Table 5-2 Current Status and Switchable Status 

Current status Switchable status Menu bar [Online] display Tool bar display 
Offline Can be switched to online or 

simulation. 

 

 

Online Can only be switched to offline. 

 
Simulation Can only be switched to offline. 

 

 

 
The current status is displayed checked at [Online] on the menu bar.  
 
When switching to online or simulation, if multiple projects are registered in the workspace being edited, the 
project selection screen is displayed as in "Figure 5-17 Screen for Selecting Project to Switch Online".  
Check only the project to be switched online or to simulation, then click [OK].  Only one project can be 
switched to simulation.  
This screen is not displayed if there is just one project in the workspace.  
 

 
Figure 5-17 Screen for Selecting Project to Switch Online  
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6. Connecting with the Robot 
This explains the method for connecting the robot controller and the computer. 
With this software, you must make the communication settings for each project. 

 
 

6.1. Robots Connected and Types of Communication 

When connecting the robot controller and computer, there are the methods shown below.  Be aware that the 
connection method that can be used is restricted by the robot controller connected.  
 

Table 6-1 Robot Controllers That Can Be Connected and Types of Communication 

Robot Controller Communication Type Remarks 

USB (*4) 

The commercial item such as computer and cable 
might be unsuitable to compatibility with our 
equipment or the FA environments of the 
temperature and the noise, etc. 
When it is used, please confirm the operation 
enough, because you might have to take measures 
against noise such as EMI measure or addition of 
ferrite core. 

Ethernet(TCP/IP) (*1)  
RS-232 Only CRnD-700 

CR750-D/CRnD-700 
series 

 
(The photo is a robot 
 controller of CR3D-700.) 

GOT communications

Communicate with CR750-D/CRnD-700 series 
controller connected with the GOT via Ethernet by 
USB / RS-232. 
GOT 1000 series and the Ethernet communication 
unit (GT15-J1E71-100) are needed. (*6) 

USB  

Ethernet 
(TCP/IP) 

The PLC Ethernet interface module or Built-in 
Ethernet port QCPU (*5) is required. 

CR750-Q/CRnQ-700 
series 

(The photo is a robot 
 controller of CR3Q-700.) 

CRnQ 
commu
nication
s 
(*2) 

RS-232  

Ethernet(TCP/IP) (*3)
The robot controller must have the "Ethernet 
interface" option. 

CRn-500 series 

 
RS-232  

(*1)  For details on the communication settings on the robot controller side for CR750-D/CRnD-700 series controllers, 
see " Detailed explanations of functions and operations" and "Standard Specifications" in the user's manual 
for the robot controller. 

(*2)  For details on the communication settings on the robot controller side for CR750-Q/CRnQ-700 series controllers, 
see " Detailed explanations of functions and operations" and "Standard Specifications" in the user's manual 

Please do not pull out the cable while communicating.  
 

Please never pull out the cable while communicating with the robot controller. If the communication 
cable is removed while communicating, the status of the robot controller or the computer might 
become abnormal. Please remove the cable when the status is not “Online” or this software exited. 

 

Also when communicating by using the USB, please do not pull out 
the USB cable until the communication is completed.  

Caution 
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for the robot controller. 
Moreover, please use the “GX Developer” to set the communication setting of PLC. 

(*3)  For details on Ethernet connections on the robot controller side for CRn-500 series controllers, see the "Ethernet 
Interface Option User's Manual". 

(*4)  When using USB connection, 1 computer can connect to only 1 robot controller. 
(*5)  Built-in Ethernet port QCPU can be used with this software Ver.1.2 or later. 
(*6)  The GOT communication can be used with this software Ver.1.5 or later. 
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6.2. Connection Settings 

Click the name of the project to display the project tree for with the right button of the mouse, then from the right 
button menu, click [Edit Project].  The project edit screen is displayed. 
 

 

 
Figure 6-1 Connection Settings 

 
Select the controller to connect to and the communications method, then click the "Detailed Settings" button 

to set the details. 
Normally, the offline robot settings and the travel platform settings for display are also set according to the 
controller connected to. 

After you complete the details settings, click the [OK] button. 
 

The detailed settings screen will be explained from the next item. 
 

 
 

Do not connect from multiple projects to 1 controller at the same 
time. 

 

Do not connect from multiple projects to 1 controller at the same time. 
Data might not be able to be read correctly referring to the same data. 
 

Do not connect USB to multiple controllers from 1 computer. 
 

When using USB connection, 1 computer can connect to only 1 robot controller. It is also not 
possible to connect to multiple controllers by using the USB hub. 

Caution 
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6.2.1. USB Communication Settings 

 
Figure 6-2 USB Communication Settings  

 
Table 6-2 TCP/IPCommunication Setting Items and Default values 

Default value 
Item Explanation Ver.1.1 

or earlier 
Ver.1.2 
or later 

Send timeout Timeout time for sending 
Range that can be set (*1) 
 Minimum value :  1000 msec 
 Maximum value : 30000 msec 

3000 msec 5000 msec 

Receive 
timeout 

Timeout time for receiving 
Range that can be set (*1) 
 Minimum value :  5000 msec 
 Maximum value :120000 msec 

3000 msec 30000 msec

Retries Number of communication retries 
Range that can be set (*1) 
 Minimum value :  0 
 Maximum value : 10 

3 3 

(*1) The setting range of Send timeout, Receive timeout and Retries are limited function of this 
software Ver.1.2 or later. 
 

When the USB cable is connected to the computer, the screen for installing the USB driver may be displayed. 
For details on USB driver installation, see "1.5.3 USB driver (CR750-D/CRnD-700 series robot controller) 
installation ". 
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6.2.2. TCP/IP (Ethernet) Communication Settings 

Input the IP address assigned to the robot controller connected to, then click the [OK] button. 
 

 
Figure 6-3 TCP/IP Communication Settings 

 
Table 6-3 TCP/IP Communication Setting Items and Default Values 

Default value 
Item Explanation Ver.1.1 

or earlier 
Ver.1.2 
or later 

IP address Sets the IP address of the robot controller 
connected to. 

Blank 

Port used Number of the port used for communications 10001 
Send timeout Timeout time for sending 

Range that can be set (*1) 
 Minimum value :  1000 msec 
 Maximum value : 30000 msec 

1000 msec 5000 msec

Receive 
timeout 

Timeout time for receiving 
Range that can be set (*1) 
 Minimum value :  5000 msec 
 Maximum value :120000 msec 

20000 msec 30000 msec

Retries Number of communication retries 
Range that can be set (*1) 
 Minimum value :  0 
 Maximum value : 10 

3 0 

(*1) The setting range of Send timeout, Receive timeout and Retries are limited function of this 
software Ver.1.2 or later. 

 
For help with the computer side network settings (IP address, subnet mask, default gateway, etc.), ask the 
network administrator.   
Moreover, for details on the communication settings on the robot controller side, please refer as follow. 

CR750/700 : See "Detailed explanations of functions and operations" and "Standard 
Specifications" in the user's manual for the robot controller. 

CRn-500  : See "Ethernet Interface Option User's Manual". 
 
 

 
 

When connecting to 10 or more robot controllers at the same time. 
 

When connecting to 10 or more robot controllers at the same time, set the reception timeout 
time to at least 10000 msec, because it takes time to connected processing. 

Caution 
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When the following screen is displayed connecting by Ethernet. 
 

When the following screen is displayed connecting by Ethernet, click [Allow access] button with 
checking all the checkboxes in the screen. 

 

 

Caution 

Caution for connecting with robot controller by Ethernet. 
 

In the program edit function, please change “Receive timeout” and “Retries” of TCP/IP 
communication setting when it corresponds to all of the following use conditions, and the 
program is written to robot controller. 

 

<< Use conditions >> 
1. You use Ethernet . 

(* In CRn-500 controller, Ethernet is an option.) 
2. When you write only command line in the controller. 

(Only “Command lines” is selected when the program is written to robot controller.)  
3. The number of lines of the command line of the robot program is 1600 or more. 
4. In TCP/IP Communication Settings, the both value of “Receive timeout” and “Retries” 

are numbers except 0. 

 
 
 

item Value 

Receive timeout (msec) 30000 or more 

Retries 0 

 
When using it on the condition of corresponding without changing the communication setting, 

the robot program might not be correctly written or the error might occur while writing the robot 
program. Therefore, it is necessary to check all content of the robot program. So please change 
the communication setting. 

Caution 
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6.2.3. RS-232 Communication Settings  

 
Change the RS-232 communication settings to match the robot controller side communications settings. 
 

 
Figure 6-4 RS-232 Communication Settings 

 
 

Table 6-4 RS-232 Communication Setting Items and Default Values 

Item Explanation Default value 

Port used COM1 – COM10 can be selected. COM1 

Communications 
speed 

Select from 4800, 9600, and 19200. 
+ It is possible to select Baud rate 38400 only when 
connecting this software with CRnD-700 controller.  

9600 

Character size 7 or 8 can be selected, but select 8. 8 
Parity None, Odd, or Even can be selected. EVEN 
Stop bit Select from 1, 1.5, and 2. 2 
Send timeout Timeout time for sending 

Range that can be set (*1) 
 Minimum value :  1000 msec 
 Maximum value : 30000 msec 

5000 msec 

Receive timeout Timeout time for receiving 
Range that can be set (*1) 
 Minimum value :  5000 msec 
 Maximum value : 120000 msec 

30000 msec 

Retries Number of communication retries 
Range that can be set (*1) 
 Minimum value :  0 
 Maximum value : 10 

3 

Usage protocol Non-Procedural or Procedural can be selected. Procedural 
(*1) The setting range of Send timeout, Receive timeout and Retries are limited function of this 

software Ver.1.2 or later. 
 
Set the following to perform a high-speed, stable communication. 

Baud rate : 19200 bps 
Protocol used : Procedural 

It is also necessary to change the communication settings to the same value of the robot controllers at 
this time. 

 

 

Use of USB to RS-232 does not guarantee normal operation.  
 

When you use USB to RS-232 cable, normal operation is not guaranteed. 
If you want to use RS-232 as a communication port, use of computer with serial ports is 

recommended. 

Caution 
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6.2.4. GOT Communications Settings 

The GOT Communications is the method to connect with the CR750-D/CRnD-700 series controller by using the 
RS-232 / USB on the GOT which is connected with the controller via Ethernet. 
GOT Communication can be used with this software Ver.1.5 or later. 

 
 

Table 6-5 GOT Communication Setting Items and Default Values 

Item Explanation Default value 
COM (*1) COM1 - COM10 can be selected. COM1 
Baud (*1) Select from 9.6Kbps、19.2Kbps、38.4Kbps、57.6Kbps、

115.2Kbps. 
19.2Kbps 

Network No. 1 - 239 can be set. Be matched to Network No. of the 
GOT. 

1 

Station No. (PC side 
I/F setting) 

1 - 64 can be set. Be matched to Station No. of the GOT. 
Set a value different from the Station No. of Robot 
controller side I/F setting. 

64 

Controller IP address Set the IP address of the controller connected with GOT. 192.168.0.20 
Station No. (Robot 
controller side I/F 
setting) 

1 - 64 can be set. Be matched to Station No. set by 
GOT. 1 

Check at 
communication time 

1 - 9999 can be set. Set the timeout after transmits.  
Note: If too short time is set, the timeout error occurs. 

30 seconds 

(*1) COM and Baud are available only that RS-232 is selected. 
 
 



 

6-82  6-82 

 
6.2.5. CRnQ Communications Settings 

 
The CRnQ communication is the method to connect with the CR750-Q/CRnQ-700 series controller by using 

the PLC Universal model QCPU module or the PLC Ethernet Interface module. 
When using RS-232 or USB, please connect to connector of the PLC Universal model QCPU module. 
When using Ethernet, please connect to connector of the PLC Ethernet Interface module or Built-in Ethernet 

port QCPU. (*Built-in Ethernet port QCPU can be used with this software Ver.1.2 or later.)  
 

 
Figure 6-5 CRnQ Communications Settings 

 
On the CRnQ communications setting screen, when you select the computer interface, the communications 

routes using the selected interface are displayed at the bottom of the screen. Select the communications route, 
then press the [Detailed Settings] button. The detailed settings screen corresponding to the selected 
communications route is displayed. These detailed settings will be explained from the next item. 
 
 

The communication routes are displayed here. 
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6.2.5.1. When RS-232 is selected 

When "RS-232" is selected as the computer interface, the communications routes that can be selected are as 
follows. 
 

Table 6-6 Communications Routes That Can Be Selected for "RS-232" 

No. Communications routes 
1 Serial communications CPU unit connection 
2 Serial communications Serial communications other station access through CPU unit 
3 Serial communication NET/-0(H) other station access through CPU unit 
4 Serial communication CC-Link other station access through CPU unit 
5 Serial communication Ethernet other station access through CPU unit 
6 Serial communication Serial communication through CPU unit - NET/10(H), CC IE other station 

access 
7 Serial communication Serial communication through CPU unit-Ethernet other station access 
8 Serial communication NET/10(H), CC IE through CPU unit - serial communication other station 

access 
9 Serial communication NET/10(H), CC IE through CPU unit - CCLink other station access 

10 Serial communication Other station access CCLink - NET/10(H), CC IE through CPU unit 
11 Serial communication CCLink through CPU unit - Ethernet other station access 
12 Serial communication Ethernet through CPU unit - serial communication other station access 
13 Serial communication Ethernet through CPU unit - CCLink other station access 
14 Serial communication Serial communication connection 
15 Serial communication Other station access serial communication through serial communication 
16 Serial communication Other station access NET/10(H), CC IE through serial communication 
17 Serial communication Other station access CC-Link through serial communication 
18 Serial communication Other station access Ethernet communication through serial communication 
19 Serial communication Serial communication through serial communication - NET/10(H), CC IE other 

station access 
20 Serial communication Serial communication through serial communication - Ethernet other station 

access  
21 Serial communication NET/10(H), CC IE through serial communication - serial communication other 

station access   
22 Serial communication NET/10(H), CC IE through serial communication - CCLink other station access
23 Serial communication CCLink through serial communication - NET/10(H), CC IE other station access
24 Serial communication CCLink through serial communication - Ethernet other station access 
25 Serial communication Ethernet through serial communication - serial communication other station 

access 
26 Serial communication Ethernet through serial communication - CCLink other station access 
27 Serial communication CC-Link other station access through G4 
28 Serial communication CCLink through G4 - NET/10(H), CC IE other station access 
29 Serial communication CC-Link through G4 – Ethernet other station access 
30 Serial communication Serial communication other station access through NET/10(H), CC IE remote 
31 Serial communication NET/10(H), CC IE other station access through NET/10(H), CC IE remote 
32 Serial communication CC-Link other station access through NET/10(H), CC IE remote 
33 Serial communication Ethernet other station access through NET/10(H), CC IE remote 
34 Serial communication Serial communication other station access through NET/10(H), CC IE remote 
35 Serial communication Serial communication through NET/10(H), CC IE remote - Ethernet other 

station access 
36 Serial communication NET/10(H), CC IE through NET/10(H), CC IE remote - Serial communication 

other station access 
37 Serial communication NET/10(H), CC IE through NET/10(H), CC IE remote - CC-Link other station 

access 
38 Serial communication CC-Link through NET/10(H), CC IE remote - NET/10(H), CC IE other station 

access 
39 Serial communication CC-Link through NET/10(H), CC IE remote - Ethernet other station access 
40 Serial communication Ethernet through NET/10(H), CC IE remote - Serial communication other 

station access 
41 Serial communication Ethernet through NET/10(H), CC IE remote - CC-Link other station access 

 
 



 

6-84  6-84 

 
Figure 6-6 RS-232 (Serial Communication 

NET/10(H), CC IE through CPU Unit – CCLink Other Station Access) Detailed Settings 
 
For some communications routes that you can select, "(5)Network communication route setting of MNET/10" 
and "(6)Coexistence network route setting of C24" can not be set. 
GOT(Ethernet) transparent mode can be used with Version 1.7 or later of software. When you use 
GOT(Ethernet) transparent mode, please display a set screen clicking the “Setting” button, and set the 
communication item. 
 
 

Only Version 1.7 or later.
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6.2.5.2. When USB is selected 

When "USB" is selected as the computer interface, the communications routes that you can select are the same 
as for RS-232.  See "Table 6-6 Communications Routes That Can Be Selected for "RS-232"". 
 

 
Figure 6-7 USB (Serial Communication 

NET/10(H), CC IE through CPU Unit – Serial Communication Other Station Access) Detailed Settings 
 
For some communications routes that you can select, "(5)Network communication route setting of MNET/10" 
and "(6)Coexistence network route setting of C24" can not be set. 
GOT(Ethernet) transparent mode can be used with Version 1.7 or later of software. When you use 
GOT(Ethernet) transparent mode, please display a set screen clicking the “Setting” button, and set the 
communication item. 

Only Version 1.7 or later.
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6.2.5.3. When NET/10(H), CC IE is selected 

In this software version 2.20W or later, it is possible to communicate using "CC-Link IE controller network 
port" or "CC-Link IE field network port" newly established in QnCPU. 
 
When "NET/10, CC IE" is selected as the computer interface, the communications routes that you can select 
are as follows. 
 

Table 6-7 Communications Routes That Can Be Selected for "NET/10(H), CC IE" 

No. Communications Route 
1 NET/10(H), CC IE board communication   Other station access through NET/10(H), CC IE 

unit  
2 NET/10(H), CC IE board communication      NET/10(H), CC IE through NET/10(H), CC IE 

unit – CC-Link other station access 
3 NET/10(H), CC IE board communication   NET/10(H), CC IE through NET/10(H), CC IE unit - 

Serial communication other station access 
 

 
Figure 6-8 NET/10(H), CC IE (NET/10(H), CC IE Board Communication 

NET/10(H), CC IE through NET/10(H), CC IE Unit – CC-Link Other Station Access) Detailed Settings 
 
For some communications routes that you can select, "(5)Network communication route setting of MNET/10" 
and "(6)Coexistence network route setting of C24" can not be set. 
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6.2.5.4. When CC-Link is selected 

When "CC-Link" is selected as the computer interface, the communications routes that you can select are as 
follows. 
 

Table 6-8 Communications Routes That Can Be Selected for "CC-Link" 

No. Communications Route 
1 CC-Link board communication   Other station access through CC-link unit 
2 CC-Link board communication   CC-Link through CC-link unit – NET/10(H), CC IE 

other station access 
3 CC-Link board communication   CC-Link through CC-link unit – Ethernet other station 

access 
 

 
Figure 6-9 CC-Link (CC-Link Board Communication 

CC-Link through CC-Link Unit – NET/10(H), CC IE Other Station Access) Detailed Settings 
 
For some communications routes that you can select, "(5)Network communication route setting of MNET/10" 
and "(6)Coexistence network route setting of C24" can not be set. 
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6.2.5.5. When Ethernet is selected 

When "Ethernet" is selected as the computer interface, the communications routes that you can select are as 
follows. 
 

Table 6-9 Communications Routes That Can Be Selected for "Ethernet" 

No. Communications Route Special mention
1 Ethernet board communication Access other station via Ethernet module  
2 Ethernet board communication Access Ethernet-serial communication other 

station via Ethernet module 
 

3 Ethernet board communication Access Ethernet-CC-Link other station via 
Ethernet module 

 

4 Ethernet port direct communication PLC module connection 
5 Ethernet port direct communication Access serial communication other station 

via PLC module 
6 Ethernet port direct communication Access CC-Link other station via PLC 

module 
7 Ethernet port IP address designate communication PLC module connection 
8 Ethernet port IP address designate communication Access serial 

communication other station via PLC module 
9 Ethernet port IP address designate communication Access CC-Link other 

station via PLC module 

Ver.1.2 or later 

 
 

 
Figure 6-10 Ethernet (Ethernet board communication Access Ethernet-serial communication other station via 

Ethernet module) Detailed Settings 
 
For some communications routes that you can select, “(1)PC side I/F Ethernet board setting”, “(2)Network 
communication route setting Ethernet”, "(5)Network communication route setting of MNET/10" and 
"(6)Coexistence network route setting of C24" can not be set. 
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6.2.5.6. When Q series bus is selected 

When the "Q series bus" is selected as the computer interface, the communication route that can be selected is 
as follows. 
 

Table 6-10 Communication Route That Can Be Selected with the "Q Series Bus" 

No. Communications Route 
1 Q bus communications CPU unit connection 

 
 

 
Figure 6-11 Q Series Bus (Q Bus Communications CPU Unit Connection) Detailed Settings 
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6.2.6. Travel base setting for display 

Set the traveling axis for display. You can set J7 and J8 axes to the traveling axis.  

 
Figure 6-12 Travel base setting for display 

 
6.2.6.1. Travel base setting 

Click the [Detail] button, Travel axis setting dialog is displayed.  

 
Figure 6-13 Travel axis setting dialog 

 
 
Select the [Use travel axis] checkbox, you can set Travel Joint, Travel direction, Movement limit and Travel 
base information.  
Travel direction is as followings. Note that [Z +direction]/[Z -direction] can be set with version 3.20W or later of 
this software. When [Z +direction]/[Z -direction] is set to Travel direction, the travel base does not display.  
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Figure 6-14 Travel direction (When setting the J8 axis to the traveling axis) 

 
 

J8

Travel direction: 
X +direction 

J8

J8

J8

J8

J8

Travel direction: 
X -direction 

Travel direction: 
Y +direction 

Travel direction: 
Y -direction 

Travel direction: 
Z +direction 

Travel direction: 
Z -direction 
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6.2.6.2. Robot additional axis parameter setting 

Select the [Set the additional axis parameter of the simulation automatically by the content of the above 
setting] checkbox, the setting content of the traveling axis is applied to robot additional axis parameters of the 
simulation. To use setting parameters in the simulation, clear the checkbox.  
In the case of using version 3.10L or earlier, the setting content is applied to the parameters at all times. This 
function can not be used with the mini edition.  
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7. Robot Program Language Setting 
 

This switches the robot program language used.  The languages you can switch to are as follows. 
 

Table 7-1 Robot Program Languages for Each Controller 

Robot program language 
Robot controller 

MELFA-BASIC V MELFA-BASIC IV
Movemaster 
command 

CR750-D/CRnD-700 ○ ○ ○ 

CR750-Q/CRnQ-700 ○ ○ ○ 

CRn-500  × ○ ○ 

 
The Movemaster commands are restricted by the robot models that can be used. Before trying to use 

Movemaster commands, check in the "Standard Specifications" that the model you are using supports 
Movemaster commands. 

Also, this software allows you to select Movemaster commands for CR750-D/CRnD-700 series and 
CR750-Q/CRnQ-700 series robot controllers, but these robot controllers themselves do not actually support 
Movemaster commands. (As of December 2007) 

 
 

 
On the project tree, click the desired project name with the right mouse button, then from the right button menu, 
select "Edit Project".  The project edit screen is displayed. 
 

 

 
Figure 7-1 Connection Settings 

 
Select the controller connected, the robot model, and the robot language used, then click the [OK] button 
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8. Writing Programs 
 
This chapter explains robot program editing methods.  You can directly edit programs in the robot controller or 
edit programs stored on the computer. 

 
 

Program names that can not be handled on the computer 
 

If a program name in the robot controller is the same as a "reserved term" in Windows, when you 
try to open that program for program editing, this causes an error. In this case, it is necessary to 
change the program name in the controller. 

"Reserved terms" are special character strings that the Windows system uses and therefore can 
not be used as file names. These "reserved terms" are character strings such as the following. 

 
AUX, COM1 to COM9, CON, LPT1 to 9, NUL, PRN 

 
 

Program names that can not be handled on the robot controller. 

It is not possible to use the program name of the following. 
1. The program name is too long. (13 characters or more). 
2. The program name contains the character other than the alphabet or number. 
3. The top of the program name is "0"(Zero). 

Warning is displayed when you input the program name including these conditions in the following 
operation.  

- Writing a New Program 
- Copying the program 
- Renaming the program name 
- Drag and drop operation 
This function corresponds with Version 1.6 or later of software. 
 
 

When the password is registered in “program“ by robot controller's 
security function, the program in the robot controllers cannot be read, 
cannot be saved, cannot be copied, cannot be renamed or cannot be 
deleted.  

When the password is registered in “program“ by robot controller's security function, the program 
among the robot controllers cannot be operated as follows.  

○ : Enable、 × : Disable 
Item to which password of security function is registered.   

Program Parameter File 
Reading of programs. 
Saving programs 
Copying programs 
Renaming programs 

× ○ ○ 

 
Please delete the password of robot controller's security function when you operate these. 

Please refer to "13.7.3 Delete the Password" for the method of deleting the password.  
The setting(register the password) and the release(delete the password) of robot controller's 

security function can be used with this software version 2.00A or later. Please refer to "Table 
13-15 Compliant version of this function and controller" for robot controller's compliant 
version. 

Caution 
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8.1. Writing a New Program 

8.1.1. Writing a new program on the computer 

 
For the new program you are going to write, select [Offline] -> [Program], then click the right mouse button.  
The right button menu is displayed, so click [New]. 
 

 
 

Figure 8-1 Writing a New Program on the Computer 
 
Input the robot program name, then click the [OK] button. 
 
 

 
 

Folder in which programs are stored  
 

Programs on the computer are managed in units of workspace projects. The folder they are stored 
into is workspace writing folder\project name\Program. 

To store into any other folder, first store in this folder, then copy into the desired folder with the 
program management copy function. 

Caution 
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8.1.2. Writing a new program in the robot controller 

 
For the new program you are going to write, select [Online] -> [Program], then click the right mouse button.   
The right button menu is displayed, so click [New]. 
 

 
Figure 8-2 Writing a New Program in a Robot Controller 

 
 
Input the robot program name, then click the [OK] button.  The "Read Item" screen is displayed, so check the 
read items, then click the [OK] button.  For details on the read items, see "8.2.3 Read Items when opening 
program in robot controller". 
 

 
Figure 8-3 Editing a New Program 
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8.2. Opening an Existing Program 

8.2.1. Opening an existing program on the computer 

 
Open the target project in the project tree with [Offline] -> [Program].  The stored programs are displayed on 
the project tree, so double click the program you want to edit. 

 
 

Figure 8-4 Opening a Program on the Computer 
 
 
8.2.2. Opening a program in a robot controller 

Open the target project in the project tree with [Online] -> [Program].  The stored programs are displayed on 
the project tree, so double click the program you want to edit. 
 

 
 

Figure 8-5 Opening a Program in a Robot Controller 
 
Input the robot program name, then click the [OK] button.  The "Read Item" screen is displayed, so check the 
read items, then click the [OK] button.  For details on the read items, see "8.2.3 Read Items when opening 
program in robot controller". 
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8.2.3. Read Items when opening program in robot controller  

 
You can set the robot program read items divided into command lines, position variables, and program external 
position variables.  This function is displayed after H1 edition on CRn-500 series controller. 
 
The default values of read items are as follows. 

 
Figure 8-6 Read Items 

 
The program external position variable read operations are shown in "Table 8-1 ".  (For details on program 
external position variables, see "Detailed explanations of functions and operations" in the robot controller's 
user's manual.) 
 

Table 8-1 Program External Position Variable Read Operations 

Read Item  

C
om

m
an

d 

P
os

iti
on

 

E
xt

er
na

l 
po

si
tio

n 
va

ria
bl

e 

Position variable, joint variable 
(P_01, J_02, etc.) 

(MOVEMASTER command : 
901-999) 

Position array variable, 
joint array variable 

(P_100( ), J_102( ), etc.) 

   

   

Reads only the external position 
variables (position variables, joint 
variables) used in instruction 
statements. (*1) 

Reads all elements used in 
instruction statements. (*2) 
 

   

CR750/700 
series robot 
controller 

   

Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables). 

   

   

Reads only the external position 
variables (position variables, joint 
variables) used in instruction 
statements. (*1) 

Reads all elements used in 
instruction statements. (*2) 
 

   

V
er

.J
1 

or
 la

te
r 

   

Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables). 

   

   

   

V
er

.H
1 

to
 H

7 

   

Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables). 
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ro
bo

t c
on

tr
ol

le
r's
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n 

V
er
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9 
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This screen is not displayed. 

*1: When Movemaster commands are used, all external position variables are read. 
*2: When only P_100(1) is used in the command statement, P_100(1) to P_100(10) are all read.  However, the number 

of valid elements depends on the robot controller software version used. 
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8.2.4. Opening a program in the backup data 

Program data backed up on the personal computer by the backup function can be opened by the program edit. 
Note that this function can be used with Version 1.2 or later of this software. 
 
Open the target project in the project tree with [Backup]. Select the backup data (All files or Program) stored the 
program you want to edit. From the right mouse button menu, click [Open Backup program]. The stored 
programs are displayed on “Open Backup Program” window, so select the program you want to edit, and click 
[OK] button. 
The extension of program data file in the backup data is “*.MB5” or “*.MB4”. 
 

 
 

Figure 8-7 Opening a program in the backup data 
 
The opened program in the backup data can be saved as a usual program (text type file whose extension is 
“*.prg”). 
 

 

Notes of opening the program backed up. 
The notes of when the program backed up is opened are as follows, 
(1) The program that can be opened is only a program made in the robot program language 

specified by the current project. 
(2) The program external position variables used in the program cannot be read. 
(3) If the program is opened from Program backup data, the values of the user definition 

external variables become 0. 
(4) If the program is opened from Program backup data or the data of unsupported robot, joint 

position variables, the values of the additional axis, and the values of the direct-driven axis 
used might be not converted correctly. 

Caution 
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8.3. Explanation of Program Edit screen 

This explains the program edit screen. 
 

 
Figure 8-8 Explanation of Program Edit screen 

 
The top part of the screen is the program command statement edit screen and the bottom part is the 

position variable edit screen. 
To change the position dividing the top and bottom screens, drag the border line with the mouse. This is 

handy when you want to expand the command edit screen, for example because there are many lines of 
commands.  

This edit screen display area can be customized. For details, see "8.5.1 Changing the display area". 
 
Also, the background color for the command edit screen depends on the robot language used. 
 

Table 8-2 Command Edit Screen Background Color 

Background color Robot language 
Normal Debugging 

MELFA-BASIC V White 
MELFA-BASIC IV Light yellow
Movemaster commands Light green

Light blue 

Debugging means when the program is opened in debugging status. 
 

Position variable edit screen

Command edit screen 

Moves up and down. 
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8.4. Program Editing Menu Bar 

During program editing "File", "Edit", "Debug", and "Tool" are added to the menu bar. 

 
Figure 8-9 Program Editing Menu Bar 

 
The menus are as follows. 

Menu item Explanation Menu item
Save Saves the program being edited with 

its current name. 
8.7.1 

Save As -> PC Saves the program being edited with 
its current name on the PC 

8.7.2 

Save As -> 
Robot 

Saves the program being edited with 
its current name on Robot controller 

8.7.3 

File 

  
Page Setup You can customize the pages the 

program is printed with. 
8.8.3 

Undo Cancel the edition by the command 
and return to the previous state 

 

Redo Redo the edition by the command  
Undo - Position 
variable 

Cancel the edition by the position 
variable and return to the previous 
state  

 

Redo - Position 
variable 

Redo the edition by the position 
variable 

 

Cut Cuts a character string from the 
command being edited. 

8.6.4.2 

Copy  Copies a character string in the 
command being edited. 

8.6.4.1 

Paste Pastes the copied or cut character 
string to the specified location. 

8.6.4.3 

Copy - Position 
variable 

Copies position data. 8.6.4.4 

Paste - Position 
variable 

This pastes the copied position data. 8.6.4.5 

Find This searches for the specified 
character string. 

8.6.4.6 

Find in Files This searches for the specified 
character string in the program files.  

8.6.4.7 

Replace This replaces the specified 
character string with another 
character string. 

8.6.4.8 

Jump Jumps to the specified step number 
or label. 

8.6.4.9 

Transfer all to 
the controller 

Write the all lines of the program to 
the robot controller. 
This can not be used when the 
program is opened in debugging 
status. 

8.6.4.11 

Transfer to the 
controller 
partially 

Writes the selected program lines to 
the robot controller. 
This can not be used when the 
program is opened in debugging 
status. 

8.6.4.10 

Comment 
Selection 

The selected lines are exchanged by 
the batch as a comment. 

Uncommnet 
Selection 

The comment on the selected lines 
are released by the batch. 

8.6.4.17 

Edit 

 
 

*  The function of  
“Comment Selection” 
 / ”Uncomment Selection” can be 
used in version 1.2 or later. 
* The function of “Remove 
comments from all lines” can be 
used in version 1.4 or later. 
*  The function of “Transfer all to 
the controller” can be used in 
version 1.6 or later. 
* Multiple undo/redo can be used in 
version 3.20W or later.  

Remove all 
comments 

It is possible to remove comments 
from all lines in the program. 

8.6.4.18 
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Menu item Explanation Menu item
Edit Command 
line - Online 

Edit the command lines for a 
program pened in debugging status. 

Insert Command 
line - Online 

Insert the command lines for a 
program opened in debugging 
status. 

8.9.3 

Delete 
Command line - 
Online 

Delete the command lines for a 
program opened in debugging 
status. 

8.9.3 

 
Menu item Explanation Menu item

Set a 
Breakpoint 

You can set a breakpoint in a 
program opened in debugging 
status. 

Delete a 
Breakpoint 

You can delete a breakpoint in a 
program opened in debugging 
status. 

Delete all 
Breakpoints 

You can delete all breakpoints in a 
program opened in debugging 
status 

8.9.4 Debug 

  
 
(This can only operate when the 
program has been opened in debugging 
status.) 

Show the 
executed line 
always 

You can set to dispplay/not to 
display the executed line always to 
the program opened in debugging 
status. 

8.9.1 

Renumber The renumbering function can only 
be used with MELFA-BASIC IV and 
Movemaster commands. 
You can renumber line numbers in 
a batch. 

8.6.4.15 

Sort The sorting function can only be 
used with MELFA-BASIC IV and 
Movemaster commands. 
This sorts the edited program by 
line number. 

8.6.4.16 

Syntax 
Check 

You can check whether or not the 
edited robot program is 
syntactically correct. 

8.6.4.12 

Command 
Template 

You can display a list of the 
commands and make insertions on 
the program command edit screen. 

8.6.4.13 

XYZ Position 
variable 
Batch Edit 
Joint 
Position 
variable 
Batch Edit 

You can change the position 
variables in the program being 
edited in a batch and can sum up 
all the values 

8.6.4.14 

Tact time 
calculation 

Tact time calculation can only be 
used in a simulation. 
Tact time of the program can be 
calculated. 

17.12 

Tool 

 
  
(This can not operate when the program 
has been opened in debugging status.) 
 
Renumbering and sorting can only be 
used with MELFA-BASIC IV and 
Movemaster commands. 
 
Tact time calculation can only be used 
in a simulation. 

Option You can customize the program 
edit area, screen display area and 
syntax check before saving a 
program  

8.5 
8.7.5 
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8.5. Customizing the Program Edit Screen 

You can customize the program edit screen. 
With the program opened, on the menu bar, click [Tool] -> [Option] and set the program edit screen as you want 
with the displayed option screen. 

Clicking the [Restore Defaults] button restores the default settings. 
The "Save and Read of the program" function and the "Background color" function can be used with version 1.6 
or later of software. 
 

 
Figure 8-10 Option Screen 

 
 
8.5.1. Changing the display area 

In the "Display area" group, you can set the command display area and position edit area display ratios and for 
the position edit area, the XYZ (P) variable and joint (J) variable proportions. 
 

Figure 8-11 Program Edit Screen Display Area Change 
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8.5.2. Command format hints 

You can use pop-up hint display to display the format for the robot program command, system functions, and 
system status variables displayed in the command edit area. 

 
 

Figure 8-12 Command Edit Area Command Format Hint Display Settings 
 
 
 
8.5.3. Character colors 

You can assign the colors for displaying robot program command, system functions, and system status 
variables displayed in the command edit area. 

 
 

Figure 8-13 Command Edit Area Character Color Settings 
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8.5.4. Changing the font 

You can change the font displayed in the command edit area.   
Click the option screen font [Change] button.  The font setting screen is displayed, so after setting the font 
name, style, and size, click the [OK] button. 

 
Figure 8-14 Command Edit Area Font Setting 

 
 
 
8.5.5. Save and Read of program 

In the reading item at the time of the writing item when the program is preserved and reading, the screen can be 
started with the check entered "Outside program positional variable". 
This function can be used with version 1.6 or later of software. 

 
 

Figure 8-15 Initial setting of “Program external position variables” in the [Read Items] and the [Save Items]. 

[Read Items] - Reading the program 

[Save Items] - Saving the program 
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8.5.6. Get current position 

When adding a position variable, the current position can be got in automatically if connected to the robot. 
This function can be used with version 1.6 or later of software. 

 
 

Figure 8-16Setting the get current position. 
 
 
8.5.7. Setting the background color of the program editor 

It is possible to set the the background color of the command area in the program editor.  
This function can be used with version 1.6 or later of software.  

 
  

Figure 8-17Setting the background color of the program editor. 
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Please note that it becomes easy to make a mistake in off-line and online, etc. if the same color is used 
by the background color. 

Caution 
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8.6. Program Editing 

This chapter explains the methods for editing MELFA-BASIC V programs. 
For RT ToolBox2 command statement editing, you can input in the same way as with a general editor like a 

notebook. There is no need to input the [Enter] key for each line as was the case with RT ToolBox.  
 
 
 
8.6.1. MELFA-BASIC V command statement editing 

When writing a program using MELFA-BASIC V, you do not use line numbers, unlike MELFA-BASIC IV or 
Movemaster commands.  Instead the step position is displayed on the left end. These step numbers are 
automatically displayed with the keyboard [Enter] key. 
 

 
Figure 8-18 MELFA-BASIC V Command Edit Screen 

 
Even if you input MELFA-BASIC V commands with all lowercase characters, when the program is written to 

the robot controllers, the commands are converted into the correct mixture of uppercase and lowercase letters. 
 

 
Figure 8-19 MELFA-BASIC V Character Input 

 

When this is written to the robot 
controller, it is converted into 
uppercase and lowercase 
characters in correct 
MELFA-BASIC V format. 

Step number 
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8.6.2. MELFA-BASIC IV and Movemaster command command statement editing  

When writing a program using MELFA-BASIC IV or Movemaster commands, step numbers like those of 
MELFA-BASIC V are not displayed. Input the line number at the front of the command statement. 

 
Figure 8-20 MELFA-BASIC IV Command Edit screen 

 
 
There is a function for sorting commands in order of line number even if you do not input them in order of line 
numbers. For details, see "8.6.4.16 Sorting". 

 
Figure 8-21 Sorting 

 
There is a function for reordering commands in order of line number even if you do not input them in order of 

line numbers. For details, see  

 
Figure 8-22 MELFA-BASIC IV Character Input 

 

When this is written to the 
controller, it is converted 
into all uppercase 
characters, which is correct 
MELFA-BASIC IV format in 
the controller. 

For MELFA-BASIC IV and Movemaster commands, input line numbers. 
Step numbers are not displayed on the MELFA-BASIC IV and Movemaster command edit screen. 

When using MELFA-BASIC IV and Movemaster commands, always input line numbers. 
If there are no line numbers, this is a syntax error. 

OK
Line numbers 

Syntax error

Caution 
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8.6.3. Position variable editing 

Position variables are edited on the position edit screen. The upper list is a list of XYZ coordinate variables 
and the lower list is a list of joint coordinate variables. 

 
Figure 8-23 Position Variable Edit Screen 

 
Array variables are displayed developed in their own lists. 
 

 
Figure 8-24 Array Variable Display 

 

 

About uppercase characters and lowercase characters 
 in position variables names 

With MELFA-BASIC V, you can use lowercase letters in variable names. 
This software does not differentiate between uppercase letters and lowercase letters in variable 

names. For example, the position variables PA and pa are recognized as the same position 
variables. 

The controller converts all later variables to match the first position variable name defined.  For 
example, if you write a program like that below, the position variable "pa" is used and "PA" is 
converted into "pa". 

         
 

When this is written to the controller, it is 
converted in the controller as on the right. 

Caution 

XYZ position variables

Joint position 
variables
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8.6.3.1. Adding/changing position variables 

To add a position variable, click the [Add] button. The position variable adding screen is displayed. At this time, if 
position data is selected in the list, the contents of that position data (XYZ/joint, position information) are 
displayed. When "Get current position automatically" of the option screen is checked and connected to the robot, 
the current position of the robot is displayed with version 1.6 or later of software. However, the variable name 
remains blank. The current position is not displayed when not connected to the robot. 
 

To revise a position variable, select the position variable to be revised in the list, then click the [Change] 
button. 
The position name can be changed with version 1.6 or later of software. However, it is not possible to use it in 
the following cases. 

- In case of opening the program in debugging status. 
- With SQ Direct. 
- With version 1.5.1 or earlier of this software. 

 
Select either XYZ coordinate type or joint coordinate type, input the values of each element of the position 

data, input the position variable name, then click the [OK] button.  
While editing an online program in online status or simulation status, you can read the current robot position 

by pressing the [Read Current Position] button. 
 

 
Figure 8-25 Position Data Variables 

 
 

 
 

The validity of the elements is 
checked.  For some robot 
models, some elements are not 
checked. 



 

8-112  8-112 

 
8.6.3.2. Deleting position variables 

After selecting the target position variable, click the [Delete] button. The selected position variable is deleted. 
You can also delete multiple position variables at the same time. You can select multiple position variables by 
clicking position variables while holding down the [Ctrl] key or the [Shift] key on the keyboard. However, you 
cannot select XYZ position variables and joint position variables at the same time. 
 

 
  
 
8.6.4. Edit assist functions 

This explains the edit assist functions, which help in command editing. 
 
Edit assist functions such as copy, cut, find, replace, and jump are used from [Edit] and [Tool] on the menu 

bar. 
 
 
8.6.4.1. Copy 

Copies a character string in the command being edited.  You can also copy multiple lines. 
Selecting the character string to copy, click on the menu bar [Edit] -> [Copy]. 
You can use the paste function, explained below, to paste this copied character string to another location in 

the program. 
For details on position data copying, see "8.6.4.4 Copy position data". 

 
 
 
8.6.4.2. Cut 

Cuts a character string from the command being edited. You can also cut multiple lines. 
Selecting the character string to cut, click on the menu bar [Edit] -> [Cut]. 
You can use the paste functio 
n, explained below, to paste this cut character string to another location in the program.  

 
8.6.4.3. Paste 

Pastes the copied or cut character string to the specified location. 
Put the cursor where you want to paste, then click on the menu bar [Edit] -> [Paste]. The copied or cut 

character string is inserted at the specified location. 
For details on position data pasting, see "8.6.4.5 Pasting position data". 

 
 
 
8.6.4.4. Copy position data 

Copies position data. You can also copy multiple position data items. 
Selecting the position data to copy, click on the menu bar [Edit] -> [Copy – Position data]. 

 

To delete a position array variable, delete the command statement. 
"Dim" declaration. 

With this software, even if a position variable is deleted, if a program with a "Dim" declaration is 
written to a robot controller, the position array variables declared with the "Dim" are left with 0 for all 
their components. 

Caution 
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8.6.4.5. Pasting position data 

This pastes the copied position data. 
Make active the program you want to paste into, then click on the menu bar [Edit] -> [Paste – Position data]. 
The copied position data is inserted into the specified program. 

At this time, if there is already position data with the same name in that program, a confirmation message is 
displayed. 

 

 
Figure 8-26 Paste Position Data Confirmation Message 

 
 
8.6.4.6. Find 

This searches for the specified character string. 
Click on the menu bar [Edit] -> [Find].  The find screen is displayed. 
 

 
Figure 8-27 Find Screen  

 
Input the character string to find, and then click [Find Next] or [Find Previous]. The character string search 
starts. 

 
If you click [Display List], all the instances of the specified character string are found from programs and 
displayed in a list. 
 

 
Figure 8-28 Find Results List Display 

 
When you select an item from the find results list and click the [Jump] button, the display jumps to the line that 
includes the selected item. 
 
It is possible to search the name of position variables with version 1.6 or later of software. 
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8.6.4.7. Find in Files 

This searches for the specified character string in the "Online" or "Offline" program files registered in the current 
project. 
Click on the menu bar [Edit] -> [Find in Files]. The find in files screen is displayed.   
You can also display this screen by clicking the program management [Find in Files] button. 
 

 
Figure 8-29 Find in Files Screen 

 
Input the character string to find and select the location to search. 
When "PC" is selected as the location to search, all the offline programs registered in the current project are 

searched. 
When "Robot" is selected as the location to search, all the online programs registered in the current project are 
searched. In other words, all the programs in robot controllers in the "online" status connected to a robot are 
searched. If a simulation is running, all the programs in the virtual controller are searched. When you search in 
controllers, the communications with the controllers may take time. 
 

 
Figure 8-30 Results of Search from File 

 

 
 
 
With the [Open with Program edit] button, you can open the program that includes the contents of the line 
selected from the list of search results. 
 

C:/・・・・・・/RC1/Program/P01.prg (2): 2 Mov P02 

Folder in which workspace 
is created 

Line 
conten

Number of lines from 
head

Project name 

Fixed

Program 
name 

Number of 
steps
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8.6.4.8. Replace 

This replaces the specified character string with another character string.   
Click on the menu bar [Edit] -> [Replace]. The Replace Screen is displayed. 

 

 
Figure 8-31 Replace Screen 

 
[Find Next] : Searches for the next instance of the character string to be replaced. 
[Replace] : Replaces the found character string. 
[Replace All] : An item is displayed for specifying the range in which to replace all instances of the 

specified character string. 
 

 
With Replace All, you can specify a range in which to replace. 
When you click the [Replace All] button, all the instances in the specified range are replaced. 

 

 
Figure 8-32 Replace All Setting Screen 

 
 
8.6.4.9. Jump to specified line 

Jumps to the specified step number or label. 
Click on the menu bar [Edit] -> [Jump]. The jump screen is displayed. 
 

 
Figure 8-33 Jump Screen 

 
Input the step number or label to jump to, then click the [OK] button. Display jumps to the specified step 

number or label. 
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8.6.4.10. Partial writing 

Writes the selected program lines to the robot controller. 
This is handy for reflecting the contents of the partially revised program in the robot controller, but be careful.  

Only the selected part of the program is written. 
Select the lines to be written to the robot controller, then click on the menu bar [Edit] -> [Partial Write]. 

Check the contents to be written, then click [Yes]. 
 
 

 
Figure 8-34 Partial Writing 

 
 
 
8.6.4.11. Transfer all lines of the program 

Write the all lines of the program to the robot controller. 
Click on the menu bar [Edit] -> [Transfer all to the controller] after opening the program. After displaying the 
confirmation message, and then click “Yes”. 
 
This function can be used with version 1.6 or later of software.  
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8.6.4.12. Syntax check 

You can check whether or not the edited robot program is syntactically correct. Execute this before writing the 
program to the robot controller.  
Click on the menu bar [Tool] -> [Check Syntax]. If there is a syntax error, the error location and details are 
displayed. 
 

 
Figure 8-35 Syntax Check Results Screen 

 
If you select the detected error and click the [Jump] button, it jumps to the command statement with the error. 
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8.6.4.13. Command template 

You can display a list of the commands and make insertions on the program command edit screen. 
Click on the menu bar [Tool] -> [Command Template]. 
 

 
Figure 8-36 Command Template 

 
When you select the template for the selected command from the list, then either click the [Insert Template] 
button or double click, the command is inserted onto the program command edit screen. 
 
 
8.6.4.14.  XYZ position data batch editing/joint position data editing 

You can change the position variables in the program being edited in a batch and can sum up all the values. 
For example, you can add 10.00 to the X components of the P00, P01, P02, P03, and P04. 
 
To batch edit XYZ position variables, click on the menu bar [Tool] -> [Batch Edit XYZ Position Data]. 
To batch edit joint position variables, click on the menu bar [Tool] -> [Batch Edit Joint Position Data]. 
All the position variables of the respective type are displayed. 

The positional variables selected are displayed in the “Target” with version 1.6 or later of software. 
 

 
Figure 8-37 XYZ Position Data Variable Editing 

 
From the position variable list, select the position variable to change, then add it to the change list with the [->] 
button. 

Input the change value, select the change method [Add] / [Change], then click the [OK] button. You can not 
set both [Add] and [Change] for the same element. 

 
You can cancel the registration of a position variable for change with the [<-] button. 
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8.6.4.15. Renumbering 

The renumbering function can only be used with MELFA-BASIC IV and Movemaster commands. 
You can renumber line numbers in a batch. You can specify the range for renumbering. 
With the setting dialog, you can specify the start and end lines numbers, the new starting line number, and the 

line number interval. 
 

While editing a program created with MELFA-BASIC IV or Movemaster commands, click the tool bar [Tool] -> 
[Renumber]. The renumber set screen is displayed. 
 

 
Figure 8-38 Renumber Setting Screen 

 

 
 
 

8.6.4.16. Sorting 

The sorting function can only be used with MELFA-BASIC IV and Movemaster commands. 
This sorts the edited program by line number. 

While editing a program created with MELFA-BASIC IV or Movemaster commands, click the tool bar [Tool] -> 
[Sort]. The confirmation message is displayed, then the line numbers are sorted in ascending order. 

 
Figure 8-39 Sorting 

 

 
 

Sorting can only be used with MELFA-BASIC IV and Movemaster 
commands. 

 

The sorting function can only be used with MELFA-BASIC IV and Movemaster commands. It can 
not be used with standard MELFA-BASIC V. 

Caution 

Renumbering can only be used with MELFA-BASIC IV and 
Movemaster commands. 

 

The renumbering function can only be used with MELFA-BASIC IV and Movemaster commands. 
It can not be used with standard MELFA-BASIC V. 

Caution 
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8.6.4.17. Comment Selection/Uncomment Selection 

The selected lines are exchanged as a comment by the batch. Or the comments in the selected lines are 
removed comment by the batch. 
This function can be used in Ver. 1.2 or later. 
 
In command edit screen, after selecting the lines you want to change into the comment, click [Edit]->[Comment 
Selection] on menu bar. Comment character “ ’ “ is added to the head of the selected lines. 
Moreover, after selecting the lines you want to release the comment, click [Edit]->[Uncomment Selection] on 
menu bar. Then the comments in the selected lines are removed comment. 
However, even if you select the line where "Rem" command is included, "Rem" is not removed.  

 
 

Figure 8-40 Comment Selection / Uncomment Selection 
 
 
Example for setting / removing of comment is as follows; 
 

Table 8-3 Example for setting / removing comment 

program language Set comment Remove comment 
 
MELFA-BASIC V 

 
MELFA-BASIC IV 

 
 
 

 
 
 

Caution for comment in the robot program in debugging status 
 

When the program is opened in debugging status, it is written as soon as the comment is set or 
removed. At this time, when the robot controller is driving, it becomes an error. 

Caution 

Comment Selection 

Uncomment Selection 
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8.6.4.18.  Removing comments from all lines in the program 

It is possible to remove comments from all lines in the program. 
This function can be used with the software Ver.1.4 or later. 

 
Open the program that removes all the comments, and click [Edit]->[Remove comments from all lines] in the 
menu bar.  All comments in the program are removed excluding "'" (single quotation) and "Rem" command. 

 
 

Figure 8-41 Removing comments from all lines in the program 
 

 

Removal processing of special comment command "Rem" 
 

Space division between comment command “Rem” and line number or other command need to 
inserted. In the case of Robot Controller, it may judge comment command “Rem” as a comment 
without space division. But this software judges comment command “Rem” as a comment if 
“Rem” is devided by the space. 

 
If there is a character “Rem” in the command line, this software doesn’t remove comment 

contents. After the processing, these command lines are displayed in the command editing 
screen. Confirm the contents and remove comment contents in the screen. When you select 
displayed command line and click [Jump] button, you can jump to command line in the command 
editing screen. 

 
 

Figure 8-42 List of command line which includes “Rem” that cannot take as the comment 
 

Caution 

Remove comments from all line 
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8.7. Saving Programs 

Always save the edited program. 
There are three methods for saving:  saving, saving to computer, saving to robot controller. 

 
 

 
 
 
8.7.1. Save  

Saves the program being edited with its current name.  
When you click on the menu bar [File] -> [Save], the program is saved, overwriting the older version of itself. 
 
If you are editing a program on a robot controller, the "Save Items" setting screen is displayed. Set the items 

to write, and then click the [OK] button. 
For details on the "save items", see"8.7.4 Items written when saving in robot". 

 

 
Figure 8-43 Writing Items 

 

Do not write a program to the controller  
with duplicate step numbers. 

 

Even programs with duplicate step numbers or that are still being edited and are not yet 
syntactically correct can be saved on the computer. However, be careful not to copy or otherwise 
transfer such a program to a robot controller with the program management functions. 

If a program with duplicate step numbers is written to the robot controller, the duplicate step lines 
are written over each other. 

Caution 
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8.7.2. Saving on computer 

Saves the program being edited to the computer. At this time, you can set a new program name. 
Click on the menu bar [File] -> [Save to PC]. 
 

 
Figure 8-44 Saving on Computer 

 
Input the robot program name, and then click the [OK] button. 
 

 
 

 

About the program name which is disable on PC 
 

Windows, error is occurred in the Program editing tool when opening that program. To solve this 
problem, it is necessary to change the program name in the robot controller. 

The “Reserved words” are the special words used by Windows system. Therefore, it is 
impossible to use these words as the file name on PC. The following words are in “Reserved 
words”. 

 
AUX, COM1 to 9, CON, LPT1 to 9, NUL, PRN 

Caution 

Folder in which programs are stored 
 

Programs on the computer are managed in units of workspace projects. The folder they are 
stored into is workspace writing folder/project name/Program. 

To store into any other folder, first store in this folder, then copy into the desired folder with the 
program management copy function. 

Caution 
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8.7.3. Saving in robot controller 

Saves the program being edited to the robot controller with a new name. At time, you can set a new program 
name. 

Click on the menu bar [File] -> [Save in Robot]. The "Save Items" setting screen is displayed, so set the save 
items, then click the [OK] button. 
For details on the "save items", see "8.7.4 Items written when saving in robot". 

 
 

Figure 8-45 Saving on Robot Controller 
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8.7.4. Items written when saving in robot 

When saving a robot program in a robot controller, write items can be set by categorizing them into 
instructions, position variables and program external position variables. 

This function is displayed on CRn-500 series robot controllers from the H1 edition on. 
 

This save item default values for when you have read a robot controller program are the same as the "Read 
Items" when you read the program.   When you have created a new program or opened a program on the 
computer, the display becomes as in "Save Items". 

 

 
Figure 8-46 Save Items 

 
 We will explain the operations for saving to a robot when only command lines or only position variables 

are specified, using the following example for illustration. 
 

 

Example:  When there are programs in program editing on the computer or in 
the robot controller 

 

 

 

 

 

 

 

 

 
(1) When only command line written 

 

 

 

 

 

 

 

 

 
(2) When writing position variable only 

 
<<Program in the robot controller >> 

10 Mov  P1 
20 Mov  P2 
30 Mov  P3 
40 End 
P1=( 400.000,   0.000, 100.000,,,-90.000)(4,0) 
P2=(   0.000, 400.000, 150.000,,,  0.000)(4,0) 
P3=(-351.700, -49.370,  22.000,,,-95.170)(0,0) 
P4=( 276.500,-599.070, 264.970,,, 29.170)(0,0) 
P5=( 535.790, 295.020, 102.000,,,148.420)(0,0) 

<<Program in the robot controller>> 
10 Mov  P1 
20 Mov  P2 
30 Mov  P3 
40 End 
P1=( 400.000,   0.000, 100.000, , , 90.000)(4,0) 
P2=(   0.000, 400.000, 150.000, , ,  0.000)(4,0) 
P3=(-351.704, -49.369,  22.000, , ,-95.168)(0,0) 
P4=( 276.499,-599.066, 264.966, , , 29.170)(0,0) 

<< Program on computer >> 
100 Mov  P1 
200 Mov  P2 
300 Mov  P5      ‘ <- Change 
400 End 
P1=( 400.000,   0.000, 100.000, , ,-90.000)(4,0) 
P2=(   0.000, 400.000, 150.000, , ,  0.000)(4,0) 
P3=(-351.704, -49.369,  22.000, , ,-95.168)(0,0) 
P5=( 535.786, 295.021, 102.000, , ,148.420)(0,0) 

<<Program in the robot controller>> 
100 Mov  P1 
200 Mov  P2 
300 Mov  P5 
400 End 
P1=( 400.000,   0.000, 100.000,,, 90.000)(4,0) 
P2=(   0.000, 400.000, 150.000,,,  0.000)(4,0) 
P3=(-351.700, -49.370,  22.000,,,-95.170)(0,0) 
P4=( 276.500,-599.070, 264.970,,, 29.170)(0,0) 

Changing only the command line

The position variables are not 
changed. 

The command line is not changed.

The position variables on the computer are 
overwritten.  However, position variables 
that are in the robot controller, not on the 
computer, are left as is.  (Reference) 
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Timing from which program external position variables is written. 
 

Timing from which the program external position variable is possible to back up comes to be 
going to turn on the power supply next time.  

Please turn on controller's power supply again when you use the program external position 
variable written in the controller. 

Caution 
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8.7.5. Setting the syntax check for before program saving 

You can set whether or not to have the syntax checked when you save a program and whether or not to 
display a message when there are no syntax errors. 

With the program opened, on the menu bar, click [Tool] -> [Option] and set with the option screen. 
The default setting is automatic syntax checks with no message displayed if there is no syntax error. 
 

 
Figure 8-47 Settings for Syntax Check Before Saving 
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8.8. Program Printing 

You can print programs you have written.  
 
 
8.8.1. Checking a print image 

You can display a print image of the program on the screen. 
Make active the program you want to print, then click on the menu bar [Workspace] -> [Print Preview]. The print 
image for currently active program is displayed. 
 
8.8.2. Printing a program 

Make active the program you want to print, then click on the menu bar [Workspace] -> [Print].  The currently 
active program can be printed. 
 
 
8.8.3. Setting to print a program 

You can customize the pages the program is printed with. 
When you click on the menu bar [File] -> [Page Setup], the page setup screen is displayed. 

You can set whether or not to print the file name, print date and time, and page numbers, the space between 
lines and the margin sizes. 

 
Figure 8-48 Page Setup for Printing 
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8.9. Program Debugging 

You can debug robot programs you have written. 
 

 
 
 
The function of the “Position Jump” can be used with version 1.6 or later of software. 
 
 
 
8.9.1. Starting debugging 

Open the robot program in debugging status. From the project tree [Online] -> [Program], select the program, 
then click the right mouse button. From the right mouse button menu, click [Debug Open]. 

 
Figure 8-49 Opening a Program in Debug Status 

 
The specified robot program is opened in debugging status. The execution line cursor " " is displayed at the 

left end of the command edit area. The line on which this execution line cursor is displayed is the line currently 
being executed. 

The display of this execution line cursor can be switched on/off with the menu bar [Debug] -> [Display/Do not 
display Execution Line]. 
 

Debugging is for programs on a controller or on a virtual controller 
with a simulation running. 

 

When debugging, use a program on a controller or on a virtual controller with a simulation running.
You can not debug a program stored on a computer. 

Caution 
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8.9.2. Executing programs step by step 

 

 
 

A program that has been opened in debugging status can be run step by step. 
When a program opened by debug mode, operate with the [Operating panel] screen which is shown at the 

same time. 
 
Refer to chap.2.4 "About Operation panel” to understand how to operate [Operation panel]. 

 
 
8.9.3. Revising programs 

The command statements for a program that has been opened in debugging status can not be edited in the 
command edit area. You can revise command statements from [Edit] on the menu bar. Click on the menu bar 
[Edit] -> [Edit Command line (Online)], [Insert Command line (Online)], and [Delete Command line (Online)]. 
Position variables can be edited as usual. 
 

 
 
 

(1) Edit command line 
You can edit the contents of the specified command line. 
Click the command line to be edited with the mouse, click on the menu bar [Edit] -> [Edit Command line 

(Online)]. The screen for editing the command line is displayed. 
 

 
Figure 8-50 Command Line Editing (Online) 

 
Revise the command line, and then click the [OK] button. 

 
 
(2) Insert command line 

You can insert a command statement at the specified line. 
Click the line at which the command statement is to be inserted with the mouse, then click on the menu 

bar [Edit] -> [Insert Command line (Online)]. The screen for inserting the command line is displayed. 
 

 
Figure 8-51 Command Line Insertion (Online) 

 

With program debugging, the robot may operate at 100% speed. 
Watch out for the safety around the robot. 
Also, prepare a T/B at hand and use the robot in a status in which an 

emergency stop can be made at any time. 

Danger 



 

8-131  8-131 

 
(3) Delete command line 

You can delete the specified command line. 
Click the line at the line with the command statement to be deleted with the mouse, then click on the 

menu bar [Edit] -> [Delete Command line (Online)]. The confirmation screen for the command line deletion 
is displayed. 

 

 
Figure 8-52 Confirming Command Line Deletion 
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(4) Edit position variables 

For details on the method for editing the position variable, "8.6.3 Position variable editing". 
 

 
 

 
 
 
 
8.9.4. Setting and deleting breakpoints 

You can set a breakpoint in a program that has been opened in debugging status. 
If you set a breakpoint, when you open the program in debugging status, you can stop the program at the 

line while executing the Continuous execution. After stops, you can execute the program continuously. 
 

Breakpoints can be set up to 128. Moreover, when the program is quitted, every breakpoint is deleted. 
There are the following two types of breakpoints. 

Permanent breakpoint  : After stopping, the breakpoint keeps being set. 
One-time breakpoint  : After stopping, the breakpoint is automatically deleted at the same time 

as stopping. 
 

 
 
(1) Set a Breakpoint 

The breakpoint is set according to the following procedure. 
1) Click the command line where breakpoint is set with the mouse, then click on the menu bar 

[Debug] -> [Set Breakpoint]. 
 

2) The breakpoint setting screen is displayed. 
Select the type of breakpoint to set, then click the [OK] button. The breakpoint is set at the 
specified command line. 

 
Figure 8-53 Setting a Breakpoint 

 

Breakpoints can only be used with MELFA-BASIC V. 
Caution 

Partial writing can not be performed while editing a program in 
debugging status. 

Caution 

Be careful when changing the value of a variable. 
 

When you change the value of a variable, the operation target position of the robot may change and 
result in a collision. This is particularly dangerous during robot operation, so check carefully before 
changing the value of a parameter. 

Caution 
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3) " " is displayed at the left end of command lines at which breakpoints are set. 

 
Figure 8-54 Display of Lines with Breakpoints Set  

 
(2) Delete a Breakpoint 

To delete a breakpoint, click the command line with the breakpoint to be deleted with the mouse. And 
then click on the menu bar [Debug] -> [Delete a Breakpoint]. 
To delete all the breakpoints set in this program, click on the menu bar [Debug] -> [Delete All 
Breakpoints]. 

 
You can also perform the breakpoint setting and deleting operations with tool bar buttons. 
 

 
Figure 8-55 Setting/Deleting a Breakpoint with theToolbar 

 
 
 
8.9.5. Position jump 

It is possible to move the robot to the position with the specified interpolation movement. 
This function can be used with version 1.6 or later of software.  

 
Figure 8-56 Position jump 

 
The operation of "Position jump" function is as follows. 

(1) Select the robot.(In case of multiple robots) 
(2) Select the interpolation movement.(MOV:Joint interpolation movement, MVS:Linear interpolation 

movement) 
(3) Select the target position. 
(4) Click [Pos. jump] button. 
(5) In case of moving the actual robot, attention message is displayed.In case of moving the robot in the 

simulation, it is moved without attention message. 
 
 

This deletes the breakpoint at the 
command line under the mouse cursor. 

This deletes the breakpoint at the 
command line under the mouse cursor.
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8.9.6. Ending debugging 

To end debugging, close the program with the " " button at the upper-right of the edit screen for the program 
opened in debugging status.  

 
Figure 8-57 Closing a Program Opened in Debug Status 

 
 
At this time, if the program has been changed, a confirmation message is displayed asking if you want to save 
the changed contents. 
 

 
Figure 8-58 Confirmation Message for Saving the Changed Contents 

 
Here, if you select "No", the changed contents are all thrown out.  To put the changed contents into effect, 

always select "Yes". 
 

This closes the program 
opened in debugging status. 
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8.10. Program Management 

You can copy, move, delete, compare the contents of, rename, and set protection for robot programs. 
 
From the project tree, select the target project program, then click the right mouse button. 
The right button menu is displayed, so select [Manage Programs]. The manage programs screen is 

displayed. 
 

 
Figure 8-59 Starting Program Management 

 

 
 

All the operations of these functions are for robot programs. 
Caution 
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8.10.1. Program list display 

On the left and right lists, the lists are programs of the displayed in the robot controller and the specified folder. 
 
(1) Project You can specify projects in the workspace. 
(2) Robot You can specify a robot controller that is currently connected. 
(3) […] button When you select [Project], you can specify any folder on the computer. 
 
 

 
Figure 8-60 Program List Display 

 
 

(1) Project 

(2) Robot 

(3) When you select 
a folder on the 
computer 
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8.10.2. Copy 

The program files are copied. Copying of the entire program file or only the command statements or only the 
position variables is possible. 

Select the transmission source program names from the list at the left, and designate the transmission 
destination folder on the right side. The multiple transmission source programs can be selected at the same 
time, but for copying with changing its name, only one program must be selected. Copying is executed when 
the [Copy] button is clicked on and [Setting for copy] dialog is set. 

 
Figure 8-61 Copy Setting Screen 

 
It is possible to copy by using the project tree with this software Version 1.3 or later.  
 

 
Figure 8-62 Copying the program by using the project tree(Version 1.3 or later). 
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With this software Version 1.3 or later, it is possible to copy by drag and drop the project name on the project 
tree. 
 

 
 

Figure 8-63 Copying the program by drag and drop in the project tree(Version 1.3 or later) 
 
 

 
 
 
8.10.3. Move 

The program files can be moved. 
Select the transmission source program names from the list at the left, and designate the transmission 

destination folder on the right side. The multiple programs can be selected at the same time. Movement is 
executed when the [Move] button is clicked on. 
 
 

An operation possible by drag and drop is only a copy of the program. 
However, the copy that changes the name cannot be done. 

 

An operation possible by drag and drop is only a copy of the program. However, the copy that 
changes the name cannot be done. 

Please operate it on the program management screen when the name of the program is changed, or 
the program is moved. 

Caution 

Drag and drop 
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8.10.4. Delete 

The program files can be deleted. 
Select the names of the programs to be deleted from the lists. The multiple programs can be selected at the 

same time. The programs can be selected at the both lists. Delete is executed when the [Delete] button is 
clicked on. The deletion confirmation message is displayed. 

 
 

Figure 8-64 Deleting the program 
 
It is possible to delete the program by operating shown blow with RT ToolBox2 version 1.3 or later.  
After selecting the program name in the project tree, click the right button of mouse and select the "Delete 
Program" of right button menu.  The deletion confirmation message is displayed.  
 

 
Figure 8-65 Program deletion by using the project tree(Version 1.3 or later). 

 

 
 

 
 

That once the program files are deleted, they cannot be recovered. 
Caution 

It is not possible to delete the program which is editing.  

When you delete the program which is editing, the error message is displayed. Please go after 
completing the edit when you delete the program. 

Caution 
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8.10.5. Rename 

A program file name is renamed. 
Select the name of the only one program to be renamed from the lists. The program can be selected at the 

both lists. Rename is executed when the [Rename] button is clicked on and a new file name is set at the 
[Setup for ReName] dialog. 
 

 
Figure 8-66 Rename Screen 

 
 
 
8.10.6. Protect settings 

The program files in the controller can be protected. The entire program file can be protected, or just the 
command statements or position variables can be protected. 

You cannot move, delete, or rename a protected file. Release the protection before any of these operations. 
Select the names of the programs to be protected from the lists. The multiple programs can be selected at 

the same time. The programs can be selected at the both lists. Protect is executed when the [Protect] button is 
clicked on and [Setting for protect] dialog is set. 
 

 
Figure 8-67 Protect Settings Dialog 

 

 

The only programs to which protect operations apply are programs in robot 
controllers. 

Caution 
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8.10.7. Comparison 

The program files can be compared. Comparison of only the command statements or only the position 
variables is possible. Select the names of the programs to be compared from the left and right lists. A dialog 
displaying the corresponding comparison results will appear when the [Compare] button is clicked on and 
[Setting for compare] dialog is set. 
 

 
Figure 8-68 Program Comparison Settingsand Comparison Results 

 
When both files are the same, the result dialog displays nothing. 
 

 
 

After this software Ver.1.5, the comparison methods of the position 
variable are changed. 

Comparing the program before this software Ver.1.4, It was judged to be different in the notation 
of the value of each ingredient of the position variable that I showed below with different position 
variables. After Ver.1.5, the thing that the value of each ingredient of the position variable accords 
is changed to judge it to be the same position variable. 

 
# A variable example for the comparison 

1 
P1=(1.00,2.00,3.00,4.00,5.00,6.00)(7,0) 
P1=(1.000,2.000,3.000,4.000,5.000,6.000)(7,0) 

2 
P1=(1.00,2.00,3.00,4.00,5.00,6.00)(7,0) 
P1=(+1.00,+2.00,+3.00,+4.00,+5.00,+6.00)(7,0) 

3 
P1=(1.00,2.00,3.00,4.00,5.00,6.00)(7,0) 
P1=(1.00, 2.00, 3.00, 4.00, 5.00, 6.00)(7, 0) 

Caution 
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8.11. Program Conversion 

You can convert existing robot programs written in a different program language into the currently set program 
language. 

Table 8-4 Combination list of program conversion 

No. Source Target Content 

1 MELFA-BASIC III MELFA-BASIC IV 

2 MELFA-BASIC III MELFA-BASIC V 

The position data is converted. 
If “MELFA-BASIC V” is chosen for the 
target, the lines No. are also converted in 
addition to this conversion. 

3 MELFA-BASIC IV MELFA-BASIC V The lines No. are converted. 

4 
MOVEMASTER command 
(CR-116/356) 

MOVEMASTER command 
The position data is converted. 

 
There are the following two types of conversion. 
For details, see "8.11.2 Line number conversion (from MELFA-BASIC IV to MELFA-BASIC V", 

"8.11.3 Position data conversion (from E/EN/M1/M2 series to CR750/700/500 series". 
 
(1) Conversion of the lines No. 

Convert the line No. and relevant command line, because the deal of line No. in MELFA-BASIC IV is 
different from MELFA-BASIC V. 

 
(2) Conversion of the position data 

Convert the format of position data and relevant command, because the configuration of the 
E/EN/M1/M2 E/EN/M1/M2 series controller’s position data is different from the CR750/700/500 series 
controller’s. 

 

 
 
8.11.1. Starting program conversion 

From the project tree, select the conversion destination project with [Offline] -> [Program], then click the 
right mouse button. From the right mouse button menu, click [Program Convert]. 

The destination is in the program language set for this project. 
 

 
Figure 8-69 Starting Program Conversion 

Only programs on the computer can be converted. 
 

Program conversion is only possible for programs on the computer.  It is not possible to directly 
convert a program on a controller or on a virtual controller with a simulation running.  To convert a 
program on a controller or on a virtual controller with a simulation running, first use program 
management to copy it onto the computer, then convert it there. 

Caution 
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8.11.2. Line number conversion (from MELFA-BASIC IV to MELFA-BASIC V) 

Convert the lines No. and relevant command line, because the deal of line No. in MELFA-BASIC IV is different 
from MELFA-BASIC V. 
 
 
For the MELFA-BASIC V, convert as follows. 
- The line No. is converted to the step No. (sequential No. which starts from 1). 
 

 
 

- The command line using line No. jump is converted to the command line using label jump. 

 
 
 
Convert the program according to the following procedure. 

 
Figure 8-70 Conversion from MELFA-BASIC IV to MELFA-BASIC V 

 
 

(1) Select the program language of the source and target for conversion. 
Start program conversion with the project set with "MELFA-BASIC V" 
Choose “MELFA-BASIC IV” for the source and choose “MELFA-BASIC V” for the target. 
It is NOT necessary to select the axis of robot. 

(2) 

(3) 

(4) 

(1) 

100 MOV P1 
110 MVS P2 
120 GOTO 100 

: 

1 *LB00001 : MOV P1 
2 MVS P2 
3 GOTO *LB00001 

: 

*LB00001 is the label name created automatically by this conversion.

100 MOV P1 
110 MVS P2 
120 MOV P3 

: 

1 MOV P1 
2 MVS P2 
3 MOV P3 

: 
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(2) Select the file as source. 

Click the [Select] button of the source, and select the file of MELFA-BASIC IV program. 
 

 
 

Input the name of the file to save the converted program into. 
 
 

(3) After designating the conversion source file and the conversion destination file, click the [Convert] 
button or the [Convert & Open] button. 
When [Convert] button is clicked, the designated selected file is converted and written in the target 
file. 
When [Convert & Open] button is clicked, the file is converted, written in the target file and opened 
through at Program edit tool. 
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8.11.3. Position data conversion (from E/EN/M1/M2 series to CR750/700/500 series) 

This function converts the format of position data and relevant command (DJ, MP and PD command of 
MOVEMASTER command), because the configuration of the E/EN/M1/M2 series controller’s position data is 
different from the CR750/700/500 series controller’s. 
 
 
 
Note1: The program conversion converts the position data as well as the commands related to the position 

data. 
It is not possible to convert commands automatically. Be sure to make grammatical check using this 
software before using the program of E/EN/M1/M2 series by the CR750/700/500 series, and change 
the commands if necessary. 

 
Note2: The position data of the MOVEMASTER command program for M1/M2 series has the 

base-coordinate rotated 90º. When using the program for M1/M2 by the CR750/700/500 series, 
convert M1/M2 program into EN program with the E/EN/M1/M2 series support software DOS version, 
before carrying out the program conversion. 

 
Note3: In the case of the E/EN/M1/M2 series support software DOS version and E/EN series Robot 

programming supporter for Windows, the data can be saved separately such as command sentence 
only, position data only or command sentence and position data. In this program conversion, it is 
possible to convert the file of command sentence only and the file of position data only to one 
program. The other combinations occurs error. (As following case 3 to 7.) 

 

Position data only

Command sentence only

Program

OK

NG

Case 1:

Case 2:

Case 3:

Case 4:

Program
conversionPosition data

Command
sentence

+ Program

OK

Program
conversion

Program
conversion

Program
conversion NG

Case 5:

Program
conversion NG

Case 6:
Program

conversion NG

Case 7:
Program

conversion NG

Position data

Command
sentence

+

Case 3:

Position data

Command
sentence

+

Case 4:Case 3:

Position data

Command
sentence

+

Case 5:Case 4:Case 3:

Position data

Command
sentence

+

Command sentence only

Command sentence only

Command sentence only

Position data only

Position data only

Position data only

Case 3:

Case 4:

Case 5:
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Convert the program according to the following procedure. 

 
Figure 8-71 Conversion from MELFA-BASIC III to MELFA-BASIC IV 

 
(1) Select the program language of the source and target for conversion. 

Start program conversion with a project set for "MELFA-BASIC V" or "MELFA-BASIC IV". 
For the source, choose “MELFA-BASIC III” or “MOVEMASTER (CR-116/356)” which is the program 
language of the E/EN/M1/M2 series. 
If “MELFA-BASIC V” is chosen for the target, the lines No. are also converted in addition to this 
conversion. 
 

(2) Select the axis of robot. 
Select the correct number of axes, so that the configuration of the E/EN/M1/M2 series controller’s 
position data is different depending on the number of axes. 

 
(3) Select the file(s) as source. 

Click the [Select] button of the source, and select the file(s) of E/EN/M1/M2 series program. 
When selecting the multiple files, click the file while pushing the [Ctrl] key. 
 

 
 

(4) This specifies the file to write the converted program into. 
Input the name of the file to save the converted program into. 

 
(5) After designating the conversion source file and the conversion destination file, click the [Convert] 

button or the [Convert & Open] button. 
When [Convert] button is clicked, the designated selected file is converted and written in the target 
file. 
When [Convert & Open] button is clicked, the file is converted, written in the target file and opened 
through at Program edit tool. 

(2) 

(3) 

(4) 

(5) 

(1) 
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9. Position data editing for SQ Direct 
SQ Direct(PLC Direct Function) can be used with Version 1.5 or later of this software. 
This function can be used with software version P8 or later of CR750-Q/CRnQ-700 series controller. 
To use this function, you must set the parameter of controller. 
Available position data for SQ Direct is only 999 points of XYZ-origin whose position number is 1 to 999. 
These numbers are used as external position number P_DM(1) to P_DM(999) in controller. 
 
SQ Direct position data can edit online and offline. 
Edit screen of SQ Direct position data is different from edit screen of program in command line and 
orthogonal(J) number being omitted. 
 

 
Figure 9-1 Program editing and position data editing screen for SQ Direct  

 

 

As edit operation of SQ Direct is similar to XYZ coordinate edit of program editing, the following page 
explains only different function. For details on the operations for opening a program, see 8.6 Program 
Editing. 

Caution 

When the password is registered in “program” by robot controller's 
security function, the position data for SQ Direct cannot be read, or cannot 
be write. 

When the password is registered in “program” by robot controller's security function, the position 
data for SQ Direct cannot be read from the robot controller, or cannot be write to the robot controller. 

 
○ : Enable、 × : Disable 

Item to which password of security function is 
registered. 

  

Program Parameter File 
Writing the position data. 
Reading the position data. 

× ○ ○ 

 
Please delete the password of robot controller's security function when you operate these. Please 

refer to "13.7.3 Delete the Password" for the method of deleting the password.  
The setting(register the password) and the release(delete the password) of robot controller's security 
function can be used with this software version 2.0 or later. Please refer to "Table 13-15 Compliant 
version of this function and controller" for robot controller's compliant version. 

Caution 
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9.1. Diffence from program editting 

9.1.1. Add/Edit position data 

When you want to add positiondata, please click [Add] button. 
Position data editing screen is displayed. 
When position number is selected, those data are displayed. 
When "Get current position automatically" of the option screen is checked and connected to the robot, the 
current position of the robot is displayed with version 1.6 or later of software. However, the variable name 
remains blank. The current position is not displayed when not connected to the robot. 
 
When you want to revise position data, and select the position data and click [Edit] button. 
Selected position data is displayed. 
You cannot change the position number. 
 
Please input each element of position data and the number name (1 to 999). 

And click [OK] button. 
When you connect to controler as online mode or simuration mode, you can load current robot position by 
clicking [Get current position] button. 

 

 
Figure 9-2 position number data 

 
 
9.1.2. Delete position data 

After you selected position data which you want to delete, please click [Delete] button. 
Selected position data is deleted. 
You can delete plural position data. 
When you click position number with [Ctrl] or [Shift] key pushing, you can select plural position data. 

 
 
 
9.1.3. Editing supporting function 

Editing supporting function supports only copy of position data and paste of position data. 
 

After you delete position data, position numbers are not disappear. 
 
Element of variables are cleared. 

Caution 

Input 1 to 999. 

Cannot change variable type. 
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9.2. Online editing 

When you connect to controller suppoeted SQ Direct, [SQ Direct] menu is added to [Online] menu in 
project-tree. 
When you doubleclick [Online] - [SQ Direct] in the target project, 
SQ Direct screen is displayed with position data 1 to 999 loaded. 
 

 
Figure 9-3 position edit screen for SQ Direct (Online) 

 

 
 

Timing from which position data is written. 
 

Timing from which position data is written by the controller comes to be going to turn on the 
power supply next time.  

Please turn on controller's power supply again when you use controller's position data after 
online edit. 

Caution 
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9.3. Offline editing 

You can edit SQ Direct position data in offline. 
 
Set [R/C-Type] to [CRnQ-7xx/CR75x-Q] and set [Language] to [MELFA-BASIC V] in [Edit Project], then [SQ 
Direct] menu is added to [Offline] menu in project-tree. 
You can manage plural SQ Direct files in offline editing. 
 
9.3.1. Creating the new SQ Direct file 

 
Select [Offline] – [SQ Direct] menu in the project you want to create the new SQ Direct File. 
And click a right button with the mouse. 
Then right button menu is displayed, and click [New]. 
 

 
Figure 9-4 position edit screen for SQ Direct (Online) 

 
After you input SQ Direct file name, and click [OK] button. 
 
 
 
 
 
 
 
 
 
 
 
 

About SQ Direct restoration folder. 
 
SQ Direct Files are managed by each project in the personal computer. The folder named 
automatically as follows. 
  Workspace folder/project name/Program 
If you want another folder, please use copy function in program management.  

Caution 
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9.4. Program management 

You can copy, delete, compare and rename SQ Direct file. 
 
After selecting target program in project-tree, and click right button with the mouse. 
Then right button menu is displayed, and click [Program Manager]. 
Then the program manager screen is displayed. 
 
 

 
Figure 9-5 Launch program manager 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

As the edit operation is similar to the program management, the following page explains only different 
part.  

Caution 

1 to 999 Position data in the robot files for SQ Direct is shown as [*SQ Direct] in program manager. 
“ * ” means that it prevent costomer to use as a file name by mistake. 
“ * ” NOT means almighty. 

Caution 
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9.4.1. List of SQ Direct files indication 

When you can use SQ Direct, there are some differents in program management screen. 
1. SQ Direct files in the project are displayed with [sdp] extention. 
2. SQ Direct file in the robot file is displayed as [*SQ Direct]. 
3. [SQ Direct position(*.sdp)] is added in file type. 

 

 
Figure 9-6 List of SQ Direct files indication 

 

2. SQ Direct file 
in the robot files. 

1. SQ Direct 
files in the 
project. 

3. File type 
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 Restrictions 
 
SQ Direct files in the personal computer can treat as robot program files similarly, 
But there are some restrictions. 
 

 
 

There are some limitations to operate SQ Direct Files. 
 
SQ Direct file name is fixed as [*SQ Direct] in the controller.  
In theproject, file name can set freely. But extention name is only sdp. 
 
 
○ : operatable × : NOT operatable 
 

operatable 
function robot project 

new × ○ 

open ○ ○ 

delete × ○ 

init ○ × 

protect × × 

rename × ○ 

compare ○ ○ 

 

function operatable remarks 

robot to robot ×  

robot to project ○ 
If rename file, you can copy. 
Plural files cannot copy. 

project to robot ○ 
File name of controller is fixed as [*SQ 
Direct]. 
Plural files cannot copy. 

copy 

project to project ○ 
If you want to copy to same project, you 
must rename file. 

robot to robot ×  

robot to project ×  

project to robot ×  
move 

project to project ○  
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10. Creating the spline files 
 
The methods for creating the spline files for use in the spline interpolation function are explained below. This 

function can be used with version 3.10L or later this software.  
For details, refer to the instruction manual “Detailed explanations of functions and operations 7.6 

Spline interpolation”.  
 
 

10.1. New file 

10.1.1. Creating a new file on the computer 

Select [Offline] -> [Spline] for the project to be newly created, and click the right mouse button. The context 
menu will open, so click [New] and open the spline file edit screen. 

 

  
Figure 10-1 Creating a new file on the computer 

 
10.1.2. Creating a new file in the robot controller 

Select [Online] -> [Spline] for the project to be newly created, and click the right mouse button. The context 
menu will open, so click [New] and open the spline file edit screen. 

 

  
Figure 10-2 Creating a new file in the robot controller 
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10.2. Open file 

10.2.1. Opening a spline file saved on the computer 

Select [Offline] -> [Spline] for the target project and expand it. The saved spline files will appear in the 
project tree, so double-click the spline file to be edited. 

 

  
Figure 10-3 Opening a spline file saved on the computer 

 
10.2.2. Opening a spline file saved in the robot controller 

Select [Online] -> [Spline] for the target project and expand it. The spline files saved in the controller will 
appear in the project tree, so double-click the spline file to be edited. 

  
Figure 10-4 Opening a spline file saved in the robot controller 

 
10.2.3. Selecting and opening a spline file from the list 

Select [Spline] from the project tree and click the right mouse button. The context menu will open, so click 
[Open]. A list of saved spline files will appear. Select the target spline file and click the [Open] button.  
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Figure 10-5 Selecting and opening a spline file from the list 

 
 

10.3. Save file 

10.3.1. Save 

Click menu [File] -> [Save], the edited details will be saved in the spline file. When a new spline file is 
created, the Save spline file screen will open.  

 
10.3.2. Save as 

Click menu [File] -> [Save as], the Save spline file screen will open.  

 
Figure 10-6 Save spline file screen 

 
Select the destination from [PC] (save to the computer) or [Robot] (save to the robot controller). Select the 

number of the spline file to be saved from the [Spline file list], and click the [Save] button.  
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11. Setting Parameters 
 
You can reference and rewrite parameter information set in a robot controller. 
You can set parameters with the method of specifying parameter names and setting them or with the method 
of making the settings arranged by function. 

 
 

When the password is registered in "parameter" by robot controller's 
security function, it is not possible to write the parameters to the robot 
controller. 

When the password is registered in "parameter" by robot controller's security function, it is not 
possible to write the parameters to the robot controller. 

○ : Enable、 × : Disable  
Item to which password of security function is registered.   

Program Parameter File 

Writing paraemters ○ × ○ 

 
Please delete the password of robot controller's security function when you operate these. Please 

refer to "13.7.3 Delete the Password" for the method of deleting the password.  
Even if the security function has been turned on, it is possible to read the parameters. 
The setting (register the password) and the release (delete the password) of robot controller's 

security function can be used with this software version 2.0 or later. Please refer to "Table 13-15 
Compliant version of this function and controller" for robot controller's compliant version. 

Caution 
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11.1. Editing from parameter list 

You can reference and rewrite individual items of parameter information set in a robot controller by specifying 
the name of the parameter. 

 
11.1.1. Starting 

This is used in the state with the robot controller connected. 
From the project tree, double-click [Online] -> [Parameter] -> [Parameter List]. 
 

 
Figure 11-1 Starting the Parameter List 

 
At this time, a confirmation message like the following concerning the parameter list is displayed. 
 

 
Figure 11-2 Confirmation Message for Parameter List 

 
This window will appear in the following cases. 

- When there is no parameter list information in the personal computer. 
- When the parameter list used in the robot controller is newer than the parameter list already stored in 

the personal computer. 
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When parameter list reading is specified, the screen for selecting where to read it from is displayed. 
 

 
Figure 11-3 Parameter List Select Screen 

 
Select either "Read from RC" or "Read from file", set the parameter list to be read, then click the [OK] button. 
 

What is the parameter list? 
The parameter list is a list of parameter information comprised of parameter names, explanatory 

text, etc. displayed on the parameter list screen.  This parameter list can be downloaded from the 
controller.  The version of the parameter list may vary with the version of the software on the 
controller. We recommend that you download the latest parameter list from the controller. 

Memo 
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11.1.2. Parameter editing 

Double-click a parameter displayed in the list or input its name, then click the [Read] button. The specified 
parameter information in the robot controller is displayed. 
 

 
Figure 11-4 Parameter Editing 

 
After you change a parameter, you can rewrite the specified parameter information in the robot controller by 
clicking the "Write" button. 
 
You can print the displayed parameter information by clicking the [Print] button. 
 

 
 

Use upper case letters when naming the programs 
 in alphabetic characters. 

Lower case alphabetic characters can be used in this parameter setting. 
Use upper case letters when naming the programs in alphabetic characters for the parameters of 

the base program (PRGUSR) or slot table (SLT*), etc. All of the program names within the robot 
controller will be expressed in upper case letters. 

If lower case letters are used, the programs will not be properly recognized. 
 

To put a changed parameter value into effect,  
switch the robot controller power Off, then On again. 

To validate the rewritten parameter information in the robot controller, the robot controller power 
must be turned ON again. 

Caution 
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11.1.3. Edit of parameter changed from initial value 

It is possible to confirm the changed parameter by displaying the list of parameter changed from an initial 
value. This function has the limitation in this software version and the software version of the connected 
controller. Please refer to the table as follows. 
 

Table 11-1 Compliant version of this function and controller 

Software version of robot controller  
 CR750-D/CRnD-700 CR750-Q/CRnQ-700 CRn-500 

Ver.1.1  
or earlier 

not use not use not use Version of 
this software Ver.1.2  

or later 
Ver.P6 or later Ver.N6 or later not use 

When combination of “not use”, the button for the display switch is not displayed in the upper part of the 
screen 

 
When the parameter list is displayed after connecting with the controller of corresponding version, the button 
for the display switch is displayed in the upper part of the screen. 
When the parameter list screen is started, "All" has been selected. When "Changed" is selected, the list of the 
parameters that have been changed from initial value is displayed.  
(However, according to the specification of the robot type, some parameters might be changed before 
shipment.) 
 

 
Figure 11-5 List of parameter changed from initial value 

 
It is possible to print only the parameters changed from initial value with RT ToolBox2 version 1.3 or later.  
Please refer to "11.9. Parameter printing” in this manual for details. 
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11.1.4. Parameter list reading 

If no parameter name is displayed on the parameter list screen, you can read the parameter list. 
Click the parameter list [Read] button in the upper-right of the parameter list screen. The parameter list select 
screen is displayed. 
 

 
Figure 11-6 Parameter List Reading 

 
Select the source to read from ("Read from RC" or "Read from file"), then set the parameter list to read and 
click the [OK] button. 

 
 
11.1.5. Finding parameters 

You can find a character string in the displayed parameter list. With the "Parameter List" screen active, click on 
the menu bar [Parameter] -> [Find]. The character string find screen is displayed. 
 

 
Figure 11-7 Finding a Character String 

 
Input the character string to search for, and then click the [Find] button.  Parameters that include the input 
character string are displayed. 
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11.2. Robot Controller Operation Modes for Parameter Writing 

With CRn-500 series robot controllers, when you write parameters to the robot controller, controller software 
version may place restrictions on the operating mode in which you can write. For details, see below. 

 
However, parameters cannot be written while any program with any startup condition other than Always has 
been started. In such a case, stop the program, then write the parameters. 

 
Table 11-2 Download Operating Modes for Writing (for CRn-500 series only) 

Operating mode CRn-500 series robot 
controller TEACH Auto (OP) Auto (Ext) 

J1 edition or later ○ ○ ○ 

H7 edition or earlier ○ × × 

○: Writing possible   ×: Writing impossible 
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11.3. Movement Parameters 

 
11.3.1. Motion limit parameter 

Set the operating range of the robot 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Motion limit]. 
After you change the parameter value, you can rewrite the operating range parameter in the robot controller by 
clicking the [Write] button. 

 

 
Figure 11-8 Motion limit parameter (Ver.1.2 or later) 

 

 
Figure 11-9 Motion limit parameter (Ver.1.1 or earlier) 

 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
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11.3.2. Jog parameter 

Set the speeds for joint jogging and orthogonal jogging.  
Set parameters while connected to the robot controller.  From the project tree, double click the target project 
[Online] -> [Parameter] -> [Movement parameter] -> [Jog]. 
After you change the parameter value, you can rewrite the jog parameter in the robot controller by clicking the 
[Write] button.   
 

 
Figure 11-10 Jog parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
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11.3.3. Parameters of the Hand 

Set the parameters about the Hand of the robot. 
 
 
11.3.3.1. Hand parameter 

Set the type of the hand (single solenoid/double solenoid, etc.) and work holding/non-holding when 
HOPEN* (open hand) and HCLOSE* (close hand) are executed. 

Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 

[Hand] -> [Hand parameter]. 
After you change the parameter value, you can rewrite the parameters concerning the hand in the robot 

controller by clicking the [Write] button. 
 

 
Figure 11-11 Hand parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
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Hand macro function 

 
You can specify the macro name of UMACA – UMACZ to HANDTYPE parameters, by providing a 

subroutine L_UMACA – L_UMACZ the appropriate user base program (PRGUSR parameter), you run the 
hand macro open and close operation from TB.  

 

 
Figure 11-12 Hand macro settings 

 
 
 
 

HANDTYPE = UMACA/UMACB, , , , , , , 

1. Parameter setting 

1 *L_UMACA  ‘ Open Hand 1 

2 M_Out(900)=1 

3 M_Out(901)=0 

4 Return 

5 *L_UMACB  ‘ Close Hand 1 

6 M_Out(900)=0 

7 M_Out(901)=1 

8 Return 

2. Macro programing (User base program)  

L_MACA subroutine is executed on 
the open operation of the hand 1 

L_MACB subroutine is executed on 
the close operation of the hand 1 

It is possible to subroutine, to describe signal output (e.g. M_Out(900)=1), variable assignment 
(e.g. M_Data=1) and the timer (Dly 0.5).  
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11.3.4. Weight and size parameter 

You can set the conditions for the hand mounted on the robot and the conditions for the work the robot grasps. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Weight and size]. 
After you change the parameter value, you can rewrite the weight and size parameters in the robot controller 
by clicking the [Write] button. 

 
Figure 11-13 Weight and size parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
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11.3.5. Tool parameter 

Set the standard tool coordinates and standard base coordinates.  Set parameters while connected to the 
robot controller.  

From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Tool]. 

After you change the parameter value, you can rewrite the tool parameters in the robot controller by clicking 
the [Write] button. 

 
Figure 11-14 Tool parameter 

 
 

Displayed when you are connected to a 
controller that supports position repair. 

The switch of the tools is displayed in 
version 1.8 or later of this software. 
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11.3.6. User-defined area parameter 

You can specify the region (cuboid) defined with two points in the robot XYZ coordinates and set the behavior 
for when the robot enters this region. You can set up to 8 User-defined area. 

 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[User-defined area]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-15 User-defined area parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.3.7. Free plane limit parameter 

You can set the overrun limit for using the robot on a free plane. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> [Free 
Plane Limit]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-16 Free plane limit parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 
11.3.8. Home position parameter 

Set the position of the escape point. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Escape Point]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-17 Home position parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.3.9. Robot additional axis parameter  

You can set information related to addition axes of robots. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Robot additional axis]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
 
(1) In the case of using version 3.01B or later 
You can set an addition axis by reading the profile of an electric actuator (SMC Ltd. THK Ltd. etc.). Please 
download the profile from the homepage of each company. 
 

 
Figure 11-18 Robot additional axis parameter (Version 3.01B or later)  

 
 
You can load the profile to selected axis by pressing the [Load profile] button. 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
You can read Additional Axis data saved in the file by pressing the [Read from file] button. 
You can save Additional Axis parameter to the file by pressing the [Save to file] button. 
You can edit the information of the selected axis by pressing the [Set] button. 
 

 
Figure 11-19 Robot additional axis parameter setting (Version 3.01B or later) 
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11.3.10. Collision detection parameter 

You can set information related to the robot's collision detection functions. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Collision detection]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-20 Collision detection parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.3.11. Warm-up operation parameter 

You can set information related to the robot's warm-up function. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Warm-up]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-21 Warm-up operation parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.3.12. Movement parameter 

You can set information related to the optimum acceleration/deceleration for robot operation and set 
compliance errors. 
The information that can be set concerning movement parameters depends on the robot controller connected. 

 
Table 11-3 The controller which you can set information related to optimum acceleration/deceleration for robot 

operation and set compliance errors 

 CR750/700 series CRn-500 series 
Maximum acceleration/deceleration  
correction ratio 

J2 edition or later 

Compliance error function settings H6 edition or later 
Optimum acceleration/deceleration  
setting 

G1 edition or later 

Direction of gravity 

Can be used with all versions

H4 edition or later 
 

Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Movement]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-22 Movement parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
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11.3.13. Work coordinate paramater 

Work coordinate parameters define the coordinate system for the work jog.8 work coordinates can define. 
This function can be used with Version 1.5 or later of this software. 

 
Table 11-4 The controller that can use the work jog 

Robot controller Software version of robot controller 
CR750-D/CRnD-700 Ver.N8 or later 
CR750-Q/CRnQ-700 Ver.P8 or later 

 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Work coordinate].  
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button.  

 
Figure 11-23 Work coordinate parameter 

 
Work coordinates are defined by “Origin WO”, “+X WX” and “+Y WY”. 
 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
These parameters cannot be set by the offline editing.  
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11.3.14. Parameters of Force control 

You can set parameters of force control in PC and robot controllers. 
The force control function can be used with Version 2.10L or later of this software. 
For details of these parameters, refer to the user’s manual of the force control function. 
 
 
11.3.14.1. Force sensor parameter 

From the project tree, double-click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Force control] -> [Force sensor]. 
Set the parameters, [Assign sensor], [Sensor coordinates], [Filter time constant], [Restriction], and [Tolerance 
level] which are used by the force control function. 
 

 
Figure 11-24 Force sensor parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
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11.3.14.2. Force control mode parameter 

From the project tree, double-click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Force control] -> [Force control mode]. 
Set the parameters, [Coordinate system], [Control mode of axes], [Stiffness coefficients], and [Dumping 
coefficients] which are used by the control mode of force control function. 
  

 
Figure 11-25 Force control mode parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
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11.3.14.3. Force control characteristics parameter 

From the project tree, double-click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Force control] -> [Force control characteristics]. 
Set the parameters, [Force gain], [Force cmd.], and [Force detection] which are used by the control 
characteristics of force control function. 

 
“Speed condition” tab is displayed in this software version 2.20W or later. The controller which can set the 
parameters [Mode switch judgment] and [Speed command] is as follows.  
 

Table 11-5 The controller which can set the parameters [Mode switch judgment] and [Speed command] 

Robot controller Software version of the robot controller 
CR750-D/CRnD-700 Ver.S3g or later 
CR750-Q/CRnQ-700 Ver.R3g or later 

 

 
Figure 11-26 Force control characteristics parameter (version 2.10N or earlier) 
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Figure 11-27 Force control characteristics parameter (version 2.20W or later) 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
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11.3.14.4. Force log parameter 

From the project tree, double-click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Force control] -> [Force log setting]. 
Set the parameters, [Configuration] and [FTP setting] which are used by the force control function. 
 

 
Figure 11-28 Force log parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
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11.3.15. Parameters of Collision avoidance 

You can set parameters of collision avoidance in PC and robot controllers. 
For details of these parameters, refer to the robot controller's operations manual, see "Detailed explanations 
of functions and operations". 
 
 
11.3.15.1. Collision avoidance area parameter 

From the project tree, double-click the target project [Online] -> [Parameter] -> [Movement parameter] -> 
[Collision avoidance] -> [Collision avoidance area]. 
You can set information related to the Collision avoidance area. 
This function can be used with Version 2.40S or later of this software. 
The controller which can set the parameters [Collision avoidance area] is as follows. 
 

Table 11-6 The controller and the robot model which can set the parameters [Collision avoidance area] 

Robot controller Software version of the robot controller Robot model 
CR750-Q/CRnQ-700 Ver.R3a or later (*1) RV-F, RH-F 

(*1) The version that corresponds to the cylinder model is Ver.R3m or later. 
 

 
Figure 11-29 Collision avoidance area parameter 

 
 

<a> 

<b> 

<c> 

<d> 
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You can switch the robot by the combo box<a>. 
You can switch the collision avoidance area type (robot/hand/work) by the combo box<b>. 
If you select one collision avoidance area from the list<c>, and click set button or double-click list, the dialog 
for the collision avoidance area setting is displayed. The selected collision avoidance area becomes displayed 
in blue color on the 3D model<d>. 
 
After you change the parameter values, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
 
The perspective of 3D model<d.> can be changed as follows. 
 

Table 11-7 3D Model Perspective Change Operations 

Viewpoint of changing Mouse operations on the graphic 
Rotation While clicking the left button, move left/right → Rotation around Z 

axis 
Move up/down → Rotation around X axis 
Move left/right while clicking the left + right buttons → Rotation 
around Y axis 

Move Move up/down/left/right while clicking the right button 
Enlargement/reduction Move up/down/left/right while clicking pressing [Shift] key and 

clicking the left button 
A similar operation can be used by the mouse wheel with Version 
3.01B or later of this software. 

 
If you operate slider of [Robot Operation], the robot of 3D model<d> is moved. 
 
When a tick mark (for true) is set in the [Display] checkbox and a hand file is set, the robot hand is displayed 
on 3D model<d>. Refer to "17.3.8 Hand" for designing the robot hand. 
 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
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11.4. Program Parameters 

 
11.4.1. Slot table parameter 

Slot tables set the operating conditions of each task slot during multi-task operation. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Program parameter] -> [Slot 
Table]. 
After you change the parameter value, you can rewrite the operating range parameter in the robot controller by 
clicking the [Write] button. 

 
Figure 11-30 Slot table parameter 

 
Select the task slot number you are changing and click the [Set] button. 

 
Figure 11-31 Slot table parameter setting 

 
When the modification window appears, set the program name, operating conditions, startup conditions and 
task priority, and then click [Write]. 
 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
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11.4.2. Program language parameter 

You can set the robot program language used in a robot controller (MELFA-BASIC V/MELFA-BASIC 
IV/Movemaster commands). From the project tree, double click the target project [Online] -> [Parameter] -> 
[Program parameter] -> [Program language]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-32 Program language parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
For the usable robot program languages, see "Table 7-1 Robot Program Languages for Each Controller". 

 
 
 
11.4.3. Command parameter 

You can set parameters related to robot programs. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Program parameter] -> 
[Command]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-33 Command parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 

About MELFA-BASIC V 
MELFA-BASIC V. can only be used with CRn-700 series robot controllers. 
 

About Movemaster commands  
The Movemaster commands are restricted by the robot models that can be used.  For details on 

whether you can use Movemaster commands with your robot, refer to its standard specifications. 

Caution 
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11.4.4. User error parameter 

You can set the message, cause, and recovery method for user errors set with a program. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Program parameter] -> [User 
error]. 

 
Figure 11-34 User error parameter 

 
Double click the error number from the list. The "User error parameter setting" edit screen is displayed. 

 
Figure 11-35 User error parameter setting 

  
Input the error number, error message, cause, and recovery method, then click the [OK] button. The user 
errors input to the list are displayed. 
At this time, input an error number from "9000" – "9200". 
After you confirm the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
Please note that the list display is not sorted by error number. 
 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 

Double click 
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11.5. Signal Parameters 

 
11.5.1. Output signal reset pattern parameter 

These parameters set the operation when resetting the general-purpose output signals such as the CLR 
instruction and dedicated input (OUTRESET). 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> [Output 
signal reset pattern]. 

 
Figure 11-36 Output signal reset pattern parameter 

 
Set a signal number, and then select one of [OFF]/[ON]/[Hold]. The value of the signal having the specified 
number displayed in the list changes.  After you changed the parameter value, you can rewrite the output 
signal reset parameter in the robot controller by clicking the [Write] button. 
 
Also, selecting a signal group (for example, "32-0") and then clicking the [Set] button changes 32 signals at 
once. 

 
Figure 11-37 I/O reset pattern parameter setting 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  

 
 
 

Read the parameter list of the connecting controller. 
Use this screen after reading the parameter list file of the connecting controller. And you can see 

the output signals corresponding to the function of the connecting controller. You can read the parameter 
list file on the “Parameter list” screen. 

Caution 



 

11-188  11-188 

 
11.5.2. Assigning Dedicated Input/Output Signals 

Assign signal numbers to functions in order to perform the remote operations to execute and stop robot 
programs, and display/operate the execution progress information and servo power supply status, etc.  
Set parameters while connected to the robot controller.  
 
 
11.5.2.1. General1 parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [General1]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button.    

 
Figure 11-38 Dedicated input/output signals assignment - General1 parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 
11.5.2.2. General2 parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [General2]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-39 Dedicated input/output signals assignment - General2 parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.5.2.3. Data parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Data]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-40 Dedicated input/output signals assignment - Data parameter 

 
“Temp. in RC output req” and “During output Temp in RC” parameter is available with Ver.1.6.1 or later of 
this software. Moreover, the software version of the controller which can use this parameter is as follows. 
 

Table 11-8 The controller which you can set the parameters about  
“Temp. in RC output reg.” and “During output Temp. in RC” 

 

Controller S/W Ver. of the controller 
CR750-D/CRnD-700 Ver.S1c or later 
CR750-Q/CRnQ-700 Ver.R1c or later 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 
11.5.2.4. Jog parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Jog]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-41 Dedicated input/output signals assignment - Jog parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
JOGNER(JOG command INPUT signal, During JOG OUTPUT signal) can be used with Version J2 or later of 
the CRn-500 series controller, or CR750/700 series controller 
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11.5.2.5. Hand parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Hand]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-42 Dedicated input/output signals assignment - Hand parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 
11.5.2.6. Warm up parameter 

The warm-up operation parameters can be set when you are connected to a CRn-500 series robot controller 
ofJ8 edition or later or a CR750/700 series robot controller. 
From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Warm up]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-43 Dedicated input/output signals assignment – Warm up parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.5.2.7. Start (each slot) parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Start (each slot)]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-44 Dedicated input/output signals assignment – Start (each slot) parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 
11.5.2.8. Stop (each slot) parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Stop (each slot)]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-45 Dedicated input/output signals assignment - Stop (each slot) parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.5.2.9. Servo On/Off (each robot) parameter  

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Servo On/Off (each robot)]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-46 Dedicated input/output signals assignment – Servo ON/OFF (each robot) parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 
11.5.2.10. Machine lock (each robot) parameter 

From the project tree, double click the target project [Online] -> [Parameter] -> [Signal parameter] -> 
[Dedicated input/output signals assignment] -> [Machine lock (each robot)]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-47 Dedicated input/output signals assignment - Machine lock (each robot) parameter  

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
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11.6. Communication Parameters 

 
11.6.1. RS-232 parameter 

These parameters set up the communication environment of the RS-232 interface of the robot controller. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Communication parameter] -> 
[RS-232]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-48 RS-232 parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
 



 

11-194  11-194 

 
11.6.2. Ethernet parameter 

You can set robot controller Ethernet information. 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Communication parameter] -> 
[Ethernet]. 
 
The “Ethernet” screen is different with versions of this software.  
 
(1) In the case of using version 3.00A or later 
Click a menu. The screen corresponding to the selected menu is displayed. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
11.6.2.1. IP address 

You can set the parameters related to IP address in the robot controller.  
 

 
Figure 11-49 Ethernet parameter – IP address (Version 3.00A or later)  

 
You can copy network settings of the computer to the screen by clicking the [Copy PC network settings] 
button. 
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11.6.2.2. Device & Line 

You can set the parameters related to devices and lines in the robot controller.  
 

 
Figure 11-50 Ethernet parameter – Device & line (Version 3.00A or later)  

 
Select the device to edit and click the [Set] button. The “Device parameter setting” screen is displayed.  
 

 
Figure 11-51 Ethernet parameter – Device parameter setting (Version 3.00A or later)  

 
 
If you select the [MELFA-3D Vision] or [Network Vision Sensor (2D)] item from the [Autoconfiguration] 
combobox, contents of the screen take on the value corresponding to the selected item. 
 
 



 

11-196  11-196 

 
11.6.2.3. Realtime monitor 

You can set the parameters related to the “Realtime monitor” function in the robot controller.  
The controller which you can use the “Realtime monitor” function is as follows.  
 

Table 11-9 The controller which you can set the parameters about the “Realtime monitor” function 

Robot controller Software version of the robot controller 
CR750-D/CRnD-700 Ver. S3q or later 
CR750-Q/CRnQ-700 Ver. R3q or later 

 

 
Figure 11-52 Ethernet parameter – Realtime monitor (Version 3.00A or later)  

 
 
11.6.2.4. Real-time external command 

You can set the parameters related to communication settings for the real-time external command in the robot 
controller.  
 

 
Figure 11-53 Ethernet parameter – Real-time external command (Version 3.00A or later)  

 
 



 

11-197  11-197 

 
(2) In the case of using version 2.50C or earlier 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 

 
Figure 11-54 Ethernet parameter (Version 2.50C or earlier)  

 
You can reference explanations of displayed parameters by pressing the [Explain] button.  
 
Select the device to edit and double click. A screen is displayed for setting a variety of device information. 

 
Figure 11-55 Device parameter setting (Version 2.50C or earlier)  

 
If you check the [Change the Parameter to connect Vision] checkbox, the items from "Port" downward take on 
the values for a network vision sensor.    

 
 
 

Using a CRn-500 series robot controller 
When using Ethernet with a CRn-500 series robot controller, the "Ethernet interface" option is required.

Caution 
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11.7. Field Network Parameters 

 
11.7.1. CC-Link parameter 

Set the information of CC-Link in the robot controller. This function can be used with Version 1.3 or later of this 
software. 

 
 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Field network parameter] -> 
[CC-Link]. 
After you change the parameter value, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 
 

 
Figure 11-56 CC-Link parameter 

 
You can reset the error of the CC-Link interface card by pressing the [Err. Cancel] button. After that the same 
error doesn't occur. It is valid while the power supply of the Robot Controller is ON. When the power supply is 
turned OFF, the error comes to occur. 
 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
 
 

CRn-500 series robot controller CRnD-700 series robot controller 

This function can only be used with a CRn-500 series or CRnD-700 series robot controller.  Also, this 
function can not be used with CRnQ-700 series robot controller. If you use CRnQ-700 series robot 
controller, please set it with the software of the PLC. 

Caution 
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11.7.2. PROFIBUS parameter 

Set the information of PROFIBUS in the robot controller. This function can be used with Version 1.3 or later of 
this software. 

 
 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Field network parameter] -> 
[PROFIBUS]. 
After you change the parameter value, you can rewrite the parameter in the robot controller by clicking the 
[Write] button. 

 
Figure 11-57 PROFIBUS parameter 

 
You can reset the error of the PROFIBUS interface card by pressing the [Err. Cancel] button. After that the 
same error doesn't occur. It is valid while the power supply of the Robot Controller is ON. When the power 
supply is turned OFF, the error comes to occur. 
 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
 
 

This function can only be used with a CRn-500 series or CRnD-700 series robot controller.  Also, this 
function can not be used with CRnQ-700 series robot controller. If you use CRnQ-700 series robot 
controller, please set it with the software of the PLC. 

Caution 
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11.7.3. PROFINET parameter 

Set the information of PROFINET in the robot controller. This function can be used with version 3.00A or later 
of this software.  

 
 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Filed network parameter] -> 
[PROFINET].  
After you change the parameter value, you can rewrite the parameter in the robot controller by clicking the 
[Write] button.  
 

 
Figure 11-58 PROFINET parameter 

 
You can reference explanation of displayed parameters by pressing the [Explain] button.  
 
When the PROFINET IO 2-Port module is mounted, in “Network base card information”, contents of the option 
card information are displayed. When the module is not mounted, nothing is displayed.  

 
Figure 11-59 PROFINET parameter (Network base card information)  

 

This function can only be used with CR750-D/CRnD-700 series robot controller.  Also, this function 
cannot be used with CR750-Q/CRnQ-700 series robot controller. If you use CR750-Q/CRnQ-700 series 
robot controller, please set it with the software of the PLC. 

Caution 
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11.7.4. DeviceNet parameter 

Set the information of DeviceNet in the robot controller. This function can be used with version 3.00A or later of 
this software.  

 
 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Filed network parameter] -> 
[DeviceNet].  
After you change the parameter value, you can rewrite the parameter in the robot controller by clicking the 
[Write] button.  
 

 
Figure 11-60 DeviceNet parameter 

 
You can reset the error of the DeviceNet interface card by pressing the [Err. Cancel] button. After that the 
same error doesn't occur. It is valid while the power supply of the robot controller is ON. When the power 
supply is turned OFF, the error comes to occur. 
 
You can reference explanation of displayed parameters by pressing the [Explain] button.  
 
 

This function can only be used with CR750-D/CRnD-700 series robot controller.  Also, this function 
cannot be used with CR750-Q/CRnQ-700 series robot controller. If you use CR750-Q/CRnQ-700 series 
robot controller, please set it with the software of the PLC. 

Caution 
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11.7.5. EtherNet/IP parameter 

Set the information of EtherNet/IP in the robot controller. This function can be used with version 3.00A or later 
of this software.  

 
 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [Filed network parameter] -> 
[EtherNet/IP].  
After you change the parameter value, you can rewrite the parameter in the robot controller by clicking the 
[Write] button.  
 

 
Figure 11-61 EtherNet/IP parameter 

 
You can copy network settings of the computer to the screen by clicking the [Copy PC network settings] 
button. 
 
You can reference explanation of displayed parameters by pressing the [Explain] button.  
 
 

This function can only be used with CR750-D/CRnD-700 series robot controller.  Also, this function 
cannot be used with CR750-Q/CRnQ-700 series robot controller. If you use CR750-Q/CRnQ-700 series 
robot controller, please set it with the software of the PLC. 

Caution 
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11.8. PLC Cooperation Parameters 

 
11.8.1. Multiple CPU parameter 

You can set the parameters related to the Multiple CPU to use the CR750-Q/CRnQ-700 series robot controller. 
These parameters can be set when you are connected to CR750-Q/CRnQ-700 series robot controller. 
This function is available from RT ToolBox2 Ver.1.1 or later. 

 
Set parameters while connected to the robot controller.  
From the project tree, double click the target project [Online] -> [Parameter] -> [PLC cooperation parameter] -> 
[Multiple CPU]. 
After you change the parameter value, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
 

 
Figure 11-62 Multiple CPU parameter 

 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
You can check the number of points input and range of total by pressing the [Check] button. 
 
Please refer to the manual of Universal model QCPU (QCPU User’s Manual (Multiple CPU System)) for 
details of Multiple CPU setting. 
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11.8.2. IO unit parameter 

You can set information related to the I/O unit of the PLC. 
Set parameters while connected to the robot controller. 
This function can be used with Version 2.10L or later of this software. 
 
Set parameters while connected to the robot controller.  
From the project tree, double-click the target project [Online] -> [Parameter] -> [PLC cooperation parameter] 
-> [IO unit]. 
 

 
Figure 11-63 IO unit parameter 

 
When a unit number in [Unit #] is specified, the parameter of the specified unit number is displayed in the PC 
IO unit. 
In the [IO sharing when using Multiple CPUs], it is set up whether XY signals read or they don’t read  
 
You can reference explanations of displayed parameters by pressing the [Explain] button. 
 
After you change the parameter values, you can rewrite the parameters in the robot controller by clicking the 
[Write] button. 
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11.9. Parameter printing 

You can print the parameter values held in a robot controller. 
 

Display the parameters to print, then click on the menu bar [Workspace] -> [Print]. The print screen is 
displayed, so check the printer, then click the [OK] button. Printing starts. 
Also, you can click on the menu bar [Workspace] -> [Print Preview] to look at the print image. 
 

 
Figure 11-64 Parameter Printing 

 

 
 

Install the printer beforehand. 
Install the printer beforehand.  For details on the installation method for the printer, refer to the 

operations manuals for your printer and computer. 

Caution 
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It is possible to print only the parameter changed from initial value. This function can be used with Version 1.3 
or later of this software. This function has the limitation in this software version and the software version of the 
connected controller. Please refer to the table as follows. 
 

Table 11-10 Compliant version of this function and controller 

Robot controller  
 CR750-D/CRnD-700 CR750-Q/CRnQ-700 CRn-500 

Software version of 
robot controller 

Ver.P6 or later Ver.N6 or later not use 

 
After selecting “Changed” in View group on the Parameter list screen, click [Workspace] -> [Print] on the 

menu bar.  The screen for the print is displayed.  Click [OK] button after confirming the printer.  The print 
is begun.  

Moreover, you can see the print image by clicking [Workspace]->[Print Preview] on the menu bar. 
 

 
Figure 11-65 Printing the parameter changed from initial value 
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11.10. Offline editing of parameters 

It is possible to make newly the parameters of robot and preserve them in the file without connecting this 
software to the robot controller. The file which read to the personal computer by the batch backup or the 
parameter backup can be edited directly, and it can be edited by copying. 

The file of these parameters edited by offline can be written to the robot controller by using the restoration 
function. 

This function can be used with the software Ver.1.4 or later. However, the function of restoring this 
parameter file to the robot controller can be used with the software Ver.1.1 or later. 

 
 
 
11.10.1. Compliant version 

The version of the robot controller and this software that corresponds to the offline editing of the 
parameter is as follows. 

 
Table 11-11 Compliant version of the robot controller 

 Subject robot controller Compliant version 

1 CR750-D/CRnD-700 series Ver.P6k or later 

2 CR750-Q/CRnQ-700 series Ver.N6e or later 

3 CRn-500 series Ver.K9 or later 

 
Table 11-12 Compliant version of this software 

 Function Version of RT ToolBox2 

1 Offline editing Ver.1.4 or later 

2 
The parameter file made by the offline 
editing is restored by the backup and 
the restoration function. 

Ver.1.1 or later 

 
 
 

 
 

Please use Ver.1.1 or later of this software,  
if you restore the parameter edited by offline. 

It is possible to restore the parameters edited by offline in the function of backup/restore. The 
robot controller might not operate correctly, if the parameters edited without connecting the robot 
controller were restored with the software earlier than Ver.1.1.  Please use this software Ver.1.1 or 
later to restore the parameter edited without connecting the robot controller. 

Caution 



 

11-208  11-208 

 
11.10.2. Creating the new parameter file 

 
For creating the new parameter file, select [Offline] -> [Parameter], then click the right mouse button. 
The right button menu is displayed, so click [New].  
 

 
Figure 11-66 Creating the new parameter file 

 
After inputting the backup folder name, click the [OK] button. 
Please refer to "11.10.4 Offline editing of parameter" for the edit of the parameter. 
 

 
 

 
 

Folder in which Parameter edited by offline are preserved. 
 

Because the parameter is composed of some files, the parameter edited by offline is preserved 
in one folder. 

The folder where the parameter files is stored in follows: 
/Workspace folder/project name/Offline Parameter 

Please change [Place of the backup folder] with the reference button when preserving it in a 
place other than the above. 

 

Caution 
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11.10.3. Edit of parameter backed up 

It is not possible to edit directly the parameter files read to the personal computer by "All files" or 
"Parameter" of the backup function.  Please edit these parameter files after copying them by "Copy from 
the Backup". The folder of the same name is made under [Offline]->[Parameter] in the project tree when it is 
copied. 

 

 
Figure 11-67 Edit of parameter backed up 

 
Please refer to "11.10.4 Offline editing of parameter" for the edit of the parameter. 
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11.10.4. Offline editing of parameter 

When the parameter file for the offline editing is made by "11.10.2 Creating the new parameter file" or “11.10.3 
Edit of parameter backed up”, the file name is displayed in "Parameter" of the project tree. Select the edited 
parameter folder, and click the right mouse button. Select the parameter to edit with the mouse. Please refer 
from "11.1 Editing from parameter list" to "11.7.2 PROFIBUS parameter" for the setting method of each 
parameter. 
 

 
Figure 11-68 Offline editing of parameter 

 
 
When the parameter was set outside the range of the value, it is not written in the file and it makes an error.  
 
 
 
 
 
 
 
 
 
 
 
 
 

About Offline editing of parameter screen. 
 

You cannot use a function which gets information from Robot controller such as instruct Button in 
the offline editing of parameter screen. 

 

Caution 



 

11-211  11-211 

 
11.10.5. Restoring the edited parameter to the robot controller 

 Open the target parameter in the project tree with [Offline] -> [Parameter], and select the parameter folder, 
and then click the right mouse button.  The right button menu is displayed, so click [Restore]. After the restore 
window is displayed, confirming the model of the robot and restore them. 
 

 
Figure 11-69 Restoring the edited parameter to the robot controller 

 
 

 
 
 

All parameters in the robot controllers are changed,  
when the parameters edited by offline are restored. 

All parameters in the robot controllers are changed, when the parameters edited by offline are 
restored.  These parameters are initialized when the parameters set beforehand in the robot 
controller is not in the file edited by offline. 

Caution 
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Moreover, it is possible to restore the edited parameter by using the restoration function of the backup. 
Select [Online]->[Backup] in the project tree, and click the right mouse button. The right button menu is 
displayed, so click [Restore].  After changing "Backup path" to the parameter folder edited by offline, restore 
them. The folder for the offline editing is as follows. 

Workspace folder/project name/Offline Parameter 
However, this function can be used with the software Ver.1.1 or later. 
 
 

 
Figure 11-70 Restoring of parameter file by using backup function 
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11.10.6. Deletion of parameter folder edited by offline 

Open the target parameter in the project tree with [Offline] -> [Parameter], and click the right mouse button. 
The right button menu is displayed, so click [Delete]. The delete contribution is displayed. 
 

 
Figure 11-71 Deletion of parameter folder edited by offline 

 
 

 
 

 
 
 
 

Once the parameter folder is deleted,  
it cannot be recovered. 

Caution 

You can not delete the parameter files being edited currently. 
It is not possible to delete the parameter folder when as much as one screen for the offline editing 

is opened. In that case, the error is displayed. 

Caution 
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12. Status Monitoring 
 
You can set various information in the currently connected robot controllers to be constantly displayed. 
The monitor functions are roughly divided into the following three. 
 

1. Robot movement monitor .......... Items related to robot movement are monitored. 
2. Operation monitor ....................... Items related to the robot's operation are monitored. 
3. Servo monitor ............................. The robot's servo system information is monitored. 

 
 

Table 12-1 Summary of Each Monitor 

 Monitor name Explanation 
Slot run state The operation state of each slot can be confirmed. 
Program monitor The program execution line set for each slot, the contents of the 

variable used in the program, and the robot current position, etc., can 
be confirmed. 

Movement State The current position information and hand open/close state of each 
connected mechanism can be confirmed. 

Error The currently occurring error can be confirmed. 
The history of the errors that have occurred can be confirmed. 

R
obot m

ovem
ent 

m
onitor 

3D Monitor You can display the robot and its movements in 3D to check them. 
General signals You can check the statuses of signals input to the robot controller 

from outside equipment and signals output from the robot controller 
to outside equipment. 
Pseudo-input and forced output of signals are also possible. 

Named signal The status can be checked by naming the status of the dedicated I/O 
signal that has been set in the robot controller, as well as each bit or 
within the range of 32 bits of the general-purpose signal. 
The signals are set via parameter setting (maintenance tool). 

Stop signal The stop signal input into the robot controller can be confirmed. 
Registers (CC-Link) You can monitor the input registers and output registers for the 

CC-Link functions. 
Pseudo-input and forced output of registers are also possible. 

S
ignal m

onitor 

IO unit monitor You can monitor XY devices of IO unit. 

Operating time The robot operation time (power ON, etc.) can be confirmed. 

O
perating 
m

onitor 
Production 
information 

The operating time of the program in the robot controller and the No. 
of program cycles can be confirmed. 
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12.1. Robot Operation Monitoring 

 
12.1.1. Slot operation status 

The state of the slots in the robot controller can be monitored. 
From the project tree, double click the target project  [Online] -> [Monitor] -> [Movement Monitor] -> [Slot 
Status].  
It is possible to stop All slots for which the start condition is "ALWAYS" by clicking [Stop All Program] button 
with Version 1.6 or later of software. 
It is necessary to stop all slots to edit the program for which the start condition is "ALWAYS". 

 
 

Figure 12-1 Slot Run Status 
 
The No. of displayed slots is determined with the parameters. 
 

Version 1.5.1 or earlier

Version 1.6 or later
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12.1.2. Program monitoring 

Information on the running program can be monitored. 
From the project tree, click the target project  [Online] -> [Monitor] -> [Movement Monitor] -> [Program 
Monitor], then double click the "Task slot" to monitor.  
 

 
Figure 12-2 Program monitor 

 
(1) Program information 

You can check the currently selected program name and operation status and the name of the currently 
connected robot model. 

 
 
(2) Program 

The currently selected program is displayed. The currently executing line is displayed inverted. 
 
 
(3) Variable monitor: 

You can check the names of variables being used in the selected program. You can select the variables to 
monitor with the buttons displayed at the bottom of the screen.  

 

(3) Variable monitor 

(1) Program information 

(2) Program 

(4) Add 

(6) Delete (7) Change (8) Load (9) Save (10) View(5) Select 
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(4) Adding variables 

This adds more variables to monitor. 

 
 

Figure 12-3 Add Variables 
 

Input the variable name or select it from the dropdown menu, set the variable type, then click the [OK] 
button. 

The variables being used in the program are displayed in a dropdown list. When you select variables from 
the dropdown list, the variable type is automatically selected. 

 
 
(5) Selecting variables 

You can batch select variables to monitor from the variable list used in the program. 
 

 
Figure 12-4 Variable Selection 

 
The "variables not to display" are displayed in the list on the left side and the "variables to display" are 

displayed in the list on the right side. From the "variables not to display" list, select the variables to monitor, 
then click the [Add->] button. The selected variables are added to the "variables to display" list. If you select 
variables from the "variables to display" list, then click the [<-Delete] button, the selected variables are 
deleted from the "variables to display" list and added to the "variables not to display" list. 

When you click the [OK] button, the variables registered in the "variables to display" list are displayed on 
the variables monitor and you can reference their values.  

 
(6) Deleting variables 

This deletes variables registered on the variables monitor from the monitor list. This operation does not 
delete the variables themselves from the program. 

 

A dropdown list 
is displayed. 
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(7) Changing variables 

You can change the values of variables registered on the variables monitor. 
On the variables monitor, select the variables to change the values, then click the [Change] button. 

 

    
Figure 12-5 Changing Variable Values 

 
After confirming the variable name, input the value of the variable, then click the [OK] button.    

 

 
 
 
(8) Load 

You can load variables to be monitored on the variables monitor from a file. 
When you click the [Load] button, you can load variable names and variable types and add them as 

variables to be monitored. 
 
 

(9) Save 
You can save as a file a list of the variables being monitored on the variables monitor. 
When you click the [Save] button, you can save the names, types, and values of the variables currently 

being monitored into a file. This file is saved in text format. 
 

Be careful when changing the value of a variable. 
When you change the value of a variable, the operation target position of the robot may change and 

result in a collision. This is particularly dangerous during robot operation, so check carefully before 
changing the value of a parameter. 

Caution 
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(10) View 

You can switch the values of the variables displayed on the variables monitor between hexadecimal 
display and decimal display. 

The variables that can be displayed in hexadecimal, see below. 
 

Table 12-2 16Variables that can be displayed in Hexadecimal 

Integer 
The displayed variable can be switched to the hexadecimal number / 
the decimal number. 

Float 
When it is 0 below the decimal point, it is possible to switch to the 
hexadecimal number / the decimal number. 
However, the value is the one within the range of -9999999 - 9999999.

String The hexadecimal number is not displayed. 
Location The hexadecimal number is not displayed. 

 
As for the value displayed by the hexadecimal number, “&H” is added to the head of the value. 
 
 
 
12.1.3. Movement status 

You can check the robot current position, destination position, hand open/close status, etc. 
* Destination position corresponds with RT ToolBox2 Ver1.1 or later. 
 

From the project tree, double click the target project [Online] -> [Monitor] -> [Movement Monitor] -> [Movement 
Status]. 

 
Figure 12-6 Movement Status 

 



 

12-220  12-220 

 
12.1.4. Errors  

The errors currently occurring in the robot controller are displayed.     
 
12.1.4.1. Referencing the current error 

From the project tree, double click the target project [Online] -> [Monitor] -> [Movement Monitor] -> [Error]. 
 

 
Figure 12-7 Error Screen 

 
[Details]   You can check details (cause and recovery method) on errors. 
[History]   You can reference the history of errors that have occurred. 
[Record]   You can reference the record of errors that have occurred. Note that this function can  

be used with Version 1.7 or later of this software and with Version R1j/S1j or later of. 
connected controller. 

 
 
12.1.4.2. Details 

You can check details (cause and recovery method) on errors. On the error screen, select an error, then 
either click the "Details" button or double click the error. 

 
Figure 12-8 Error Details Screen 

 
 

Click or double click the [Details] button. 

Only Version 1.7 or later.



 

12-221  12-221 

 
12.1.4.3. History information 

The history of errors that have occurred in the past can be referred to. 
You can check the error history in the robot controller for each error level (high level, low level, caution). 

You can also save the error history into a file. 
 
Click the [History] button. After selecting the level to reference, click the [OK] button. 

 
Figure 12-9 History Information Error Level Setting 

 

 
Figure 12-10 Error History 

 
This display is not constantly displayed. To refresh information, click the [Refresh] button. 
 

(1) Error level (display switching) 
You can redisplay the displayed error history for each error level. 

 
(2) Details 

After selecting a displayed error, you can check the cause and recovery method for the error by clicking 
this button.  
You can also check details by double checking a displayed error. 

 
(3) Save 

This saves the displayed error history information into a file.  For the saved error history information, 
select "Read from file" with "Figure 12-9 ". Refer to "Figure 12-11 " on the screen, after you selected 
“From history file”. 
This file is saved in text format. You can also print it with Notepad or other general text editors. 
The file name of the error history file is set by, "Controller's serial number"_"Present data"_"Present time". 
 
Example of file name: AR0703001_20100924_092623.txt 

 
(4) Refresh 

If you refresh error history, click the [Refresh] button. 

(1) Error lebel 
(display switching) 

(2) Details (3) Save (4) Refresh 
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Figure 12-11 Error History Information Read from File 
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12.1.4.4. Record information 

The record of errors that have occurred in the past can be referred to. 
You can check the error record in the robot controller for each error level (high level, low level, caution). 

You can also save the error record into a file. 
 
 

 
 
The software version of the controller which can use this function is as follows. 
 

Controller S/W Ver. of the controller 
CR750-D/CRnD-700 Ver.S1j or later 
CR750-Q/CRnQ-700 Ver.R1j or later 

 
Click the [Record] button. After selecting the level to reference, click the [OK] button. 

 
Figure 12-12 Record Information Error Level Setting 

 

 
Figure 12-13 Error record 

 
This display is not constantly displayed. To refresh information, click the [Refresh] button. 
 

(1) Error level (display switching) 
You can redisplay the displayed error record for each error level. 

(1) Error level 
(display switching) 

(2) Details (3) Save (4) Refresh 

Timing from which error information is registered in error record 
When you reset the error, error information is registered in the robot controller's error record file. 
Please note that the occurring error is not registered in error record when the power supply is 

turned off without doing error reset. 

Caution 
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(2) Details 

After selecting a displayed error, you can check the details of occurred history of the selected error can be 
confirmed. 
You can also check details by double checking a displayed error. 
However, detailed information cannot be confirmed when reading from the error record file. 

 
Figure 12-14 Details of occurred history of error 

 
(3) Save 

This saves the displayed error record information into a file.  For the saved error record information, 
select "Read from file" with "Figure 12-9 ". Refer to "Figure 12-15" on the screen, after you selected 
“From record file”. 
This file is saved in text format. You can also print it with Notepad or other general text editors. 
The file name of the error record file is set by, "Controller's serial number"_"Present data"_"Present 
time"_”Character string that shows error record, "REC".”. 
 
Example of file name: AR0703001_20100924_092623REC.txt 

 
(4) Refresh 

If you refresh error record, click the [Refresh] button. 
 

 
Figure 12-15 Error Record Information Read from File 
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12.1.5. 3D Monitor  

You can display the robot and its movements in 3D to check them. 
From the project tree, either double click the target project [Online] -> [<Robot model name>] or select [3D 
Monitor] with the mouse right button menu. The robot 3D display screen is displayed. If the "display travel 
table setting" is made for the project, the travel table is also displayed. 
 

  
Figure 12-16 Starting Robot View 

 
The robot model that displays in 3D monitor can be selected from "Detailed model" and "Simple model" with 

Version 3.20W or later of this software.  
It displays by "Detailed model" in the initial state. Please refer to the edit of "5.7 workspaces" for the method 

of the change to "Simple model".  
It is not possible to display by "Detailed model" with Version 3.10L or earlier of this software. 
 

 
Figure 12-17 Kind of robot model 

 
Recommended environment to display "Detailed model" is as follows. 

 
Item Recommended environment 

CPU Core2 Duo, Core i3 3 GHz or higher. 
Main memory 2 GB min. 

 

Detailed model Simple model 

Either double click the robot model name or 
select [3D Monitor] with the mouse right 

button menu. 
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You can change the robot view perspective with mouse operation. 

 
Table 12-3 Robot View Perspective Change Operation 

Perspective to change Graphic mouse operation  
Perspective rotation While clicking the left button, move left/right→ 

Rotation around Z axis 
Move up/down→Rotation around X axis 
Move left/right while clicking the left + right buttons→ 
Rotation around Y axis 

Perspective movement Move up/down/left/right while clicking the right button 
Graphic 
enlargement/reduction  

Move up/down/left/right while clicking pressing [Shift] key and 
clicking the left button 
A similar operation can be used by the mouse wheel with Version 
3.01B or later of this software. 

 
You can change the enlargement/reduction mode with the following buttons of the toolbar, with Version 3.01B 

or later of this software. 
 

Table 12-4 Change the enlargement/reduction mode in robot view 

Button Explanation of enlargement/reduction mode 

 
If you select this button, enlargement/reduction toward 
origin to the Robot View. 

 
If you select this button, enlargement/reduction toward 
screen center to the Robot View. 

 
The change of the enlargement/reduction mode is applied in the operation of the following screens too. 

- 11.3.15.1Collision avoidance area parameter 
- 17.3.8Hand 
 
 
3D monitor screen might not be normally displayed according to the environment used. (For instance, the 

entire screen becomes black.) 

In that case, please click  button of the toolbar. 
 

When "Detailed model" is displayed with the personal computer that 
does not fill recommended environment, 3D monitor might not be able 
to be displayed normally. In that case, please change to "Simple 
model". 

Caution 
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12.2. Signal Monitoring 

 
12.2.1. General signal 

You can check the statuses of signals input to the robot controller from outside equipment and signals 
output from the robot controller to outside equipment.  

From the project tree, double click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [General 
Signals]. 

The upper level displays the status of input signals and the lower level displays the status of output 
signals. 

A continuous range of signals to display can be set freely with [Monitor Settings]. 
Pseudo-input and forced output of registers are also possible. 

 

 
Figure 12-18 General Signals 

 
 
 
12.2.1.1. Monitor settings 

For the displayed signals, the continuous range can be set freely. 
Set the lead numbers for the input signal number and output signal numbers to display, set their respective 
display ranges on the line, and then click the [OK] button. 

 
Figure 12-19 General Signal Monitor Settings 
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12.2.1.2. Pseudo-input 

Pseudo-input means signals that are input to the robot controller from the computer, not from outside 
equipment. 

Click the [Pseudo-Input] button. A screen for inputting pseudo signals is displayed. 
 
 

 
 

 
Figure 12-20 Pseudo-Input 

 
① First, read the signals you want to pseudo input. 

You can set 32 signals at the same time. Input the head number for the signals you want to read, and then 
click the [Set] button. 

② The input statuses of the 32 signals starting from the specified head signal number are displayed. Set the 
pseudo-input status, and then click the [Bit Pseudo-INPUT] button. 

③ You can specify the hexadecimal values and make pseudo input for the 32 signals starting from the head 
signal number. 
Input the values in hexadecimal, and then click the [Port Pseudo-INPUT] button. 

While the robot controller is in pseudo-input mode, signal input from 
outside devices is not accepted. 

 

To use pseudo-input, put the robot controller into pseudo-input mode. While the robot controller 
is in pseudo-input mode, the robot controller does not accept signal input from outside devices. 

Click the [Pseudo-Input] button.  The confirmation message below is displayed before the 
robot controller goes into pseudo-input mode. 

 
 

To release a robot controller from pseudo-input mode, switch the 
power for the robot controller Off, then On again. 

Caution 
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12.2.1.3. Forced output 

You can force signals to outside equipment from robot controllers. 
Click the [Forced Output] button. A screen for forcibly outputting signals is displayed. 
 

 
Figure 12-21 Forced Signal Output 

 
① First, read the signals you want to forcibly output. 

You can output 32 signals at the same time. Input the head number for the signals you want to read, and 
then click the [Set] button. 

② The output statuses of the 32 signals started from the specified head signal number are displayed. Set the 
output status, and then click the [Bit Forced OUTPUT] button. 

③ You can specify the hexadecimal value and force output for the 32 signals starting from the head signal 
number. 
Input the values in hexadecimal, then click [Port Forced OUTPUT] button. 

 
 

 
 
 

Forced signal output 
- Signal numbers assigned (used) as dedicated output signals cannot be forcibly output. 
- Forced output is possible if the robot controller mode is either [AUTOMATIC] or [MANUAL] (for a 

CRn-500 series robot controller, [TEACH], [AUTO (OP)], OR [AUTO (EXT.)]), but if even one 
program is running, forced output is not possible. (Except an ALWAYS program) 

Caution 
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12.2.2. Named signals 

You can give names to general input/output signals and check their statuses. 
With "Named signals", you can check the status of dedicated input/output signals and named general 

input/output signals. When starting up, you can load a definition file for named signals in the robot controller. 
From the project tree, double click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [Named 
Signals]. 

 
Figure 12-22 Named Signal 

 
[Add] : This registers a new general input/output signal name. 
[Edit] : This changes the setting for an existing general input/output signal selected in 

the list. 
[Delete] : This deletes a signal selected in the list. 
[Load] : This loads a file defining saved named signals in the robot controller and in the 

computer. 
[Save] : This saves the information on the set named signals to the robot controller or 

computer. 
[Delete signal 
file in robot] 

: This deletes the named signal information in the robot controller. 

 
 
12.2.2.1. Adding new named signal or revising one 

To add a new named signal, click the [Add] button.  To revise one, select the signal to be revised from the list 
and click the [Edit] button. 

 
Figure 12-23 Signal Name Editing  

 
Input the general signal numbers and names, select the signal type and display method, then when adding 

a new named signal, click the [Add] button. The set signal is added to the list. 
The [Add] and [Change] buttons do not close the "Signal name edit" screen, so you can continue to add more 
signals. 
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12.2.2.2. Deleting a named signal 

Select the signals to delete from the list. You can select multiple signals by clicking them while holding down 
the [Ctrl] key or the [Shift] key on the keyboard.  

However, dedicated input/output signals can not be deleted. 
Also, you can not delete input signals and output signals at the same time.  Finally, delete the select signals 
in the list with a mouse click. 
 
 
12.2.2.3. Named signal definition information reading 

When you click the [Load] button, a message asking you to confirm that you want to delete a registered 
general input/output signal is displayed. 
This message asks you to confirm that you want to clear the current general input/output signal display. 

 
Figure 12-24 Deletion Confirmation Message for Registered General Input/Output Signal 

 
If you select [Yes] on this confirmation screen, the "Select locate" screen asking you to select the load 

source is displayed. 
 
 

 
Figure 12-25 Device Selection 

 
Select the device to load from, then click the [OK] button. 
If you select the local device, the screen for selecting a file in the computer is displayed. 
If you select the robot controller, the named signal definition file is loaded from the robot controller. 

 
 
12.2.2.4. Saving definition information for named signals to a controller 

When you click the [Save] button, the "Select locate" screen asking you to select the save destination is 
displayed. 
 

 
Figure 12-26 Device Selection 

 
Select the device to save to, then click the [OK] button. 
If you select the local device, the screen for selecting a file in the computer is displayed. 

If you select the robot controller, the named signal definition file is saved to the robot controller. 
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12.2.3. Stop signal 

You can reference the statuses of stop signals (stop/not stop) input to the robot controller. 
From the project tree, double click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [Stop Signals]. 
 

 
Figure 12-27 Stop Signal 
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12.2.4. Register (CC-Link) 

 

 
 
You can check the statuses of registers input to the robot controller from outside equipment and registers 

output from the robot controller to outside equipment.  
From the project tree, double click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [Register 

(CC-Link)]. 
The left side of the screen displays the status of input registers and the right side displays the status of 

output registers. 
A continuous range of registers to display can be set freely with [Monitor Settings]. 

Pseudo-input and forced output of registers are also possible. 
 

 
Figure 12-28 Registers (CC-Link) 

 
 
12.2.4.1. Monitor setting 

A continuous range of registers to display can be set freely. 
Set the lead numbers for the input register number and output register numbers to display, set their 

respective display ranges on the line, then click the [OK] button.  

This can only be used if the CC-Link option card is mounted 
 in the robot controller. 

 

This function can only be used with a CRn-500 series or CRnD-700 series robot controller with the 
CC-Link option card mounted.  Also, this function can no be used with CRnQ-700 series robot 
controllers. 

Caution 
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Figure 12-29 Registers (CC-Link) Monitor Settings 
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12.2.4.2. Pseudo-input  

Pseudo-input means registers that are input to the robot controller from the computer, not from outside 
equipment. 

Click the [Pseudo-Input] button. A screen for inputting pseudo signals is displayed. 
 

 
 

 
Figure 12-30 Pseudo-Input 

 
(1) Read the signal you want to pseudo input. 

You can set 16 registers at the same time. Input the head number for the signals you want to read, then 
click the [Set] button. The input statuses of the 16 registers starting from the specified head signal 
number are displayed.  

(2) Set the pseudo-input status, and then click the [Input] button. The set register values are pseudo input to 
the robot controller. 

(3) You can display and make pseudo input in hexadecimal for register values. If you have selected [Hex], 
input values as hexadecimals. 

 
When you click the [Refresh] button, the latest register information is displayed. 
 
 

While the robot controller is in pseudo-input mode, register input 
from outside devices is not accepted. 

 

To use pseudo-input, put the robot controller into pseudo-input mode. While the robot controller 
is in pseudo-input mode, the robot controller does not accept register input from outside devices. 

Click the [Pseudo-Input] button.  The confirmation message below is displayed before the robot 
controller goes into pseudo-input mode. 

 
 

To release a robot controller from pseudo-input mode, switch the 
power for the robot controller Off, then On again. 

Caution 
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12.2.4.3. Forced Output 

 
You can forcibly output register values to outside equipment from robot controllers. 
Click the [Forced Output] button. A screen for forcibly outputting registers is displayed. 

 
 

 
Figure 12-31 Forced Signal Output 

 
(1) First, read the registers you want to forcibly output. 

You can output 16 registers at the same time. Input the head number for the registers you want to 
forcibly output, then click the [Set] button. The output statuses of the 16 registers starting from the 
specified head register number are displayed. 

(2) Set the output status, then click the [OUTPUT] button. The specified register values are forcibly output 
from the robot controller. 

(3) You can also display and forcibly output register values in hexadecimal. If you have selected [Hex], input 
values as hexadecimals. 

 
When you click the [Refresh] button, the latest register information is displayed. 
 

 
 
 

Forced register output 
Forced output is possible if the robot controller mode is either [AUTOMATIC] or [MANUAL] (for a 

CRn-500 series robot controller, [TEACH], [AUTO (OP)], OR [AUTO (EXT.)]), but if even one program 
is running, forced output is not possible. (Except an ALWAYS program) 

Caution 
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12.2.5. IO unit monitor 

You can monitor XY device variables of IO unit. 
From the project tree, double-click the target project [Online] -> [Monitor] -> [Signal Monitor] -> [IO unit]. 
The status of input signals are displayed on the upper table, and the status of output signals are displayed 

on the lower table. 
The signal values can display a 16-bit integer with a mark, or 32-bit integer with a mark by the decimal 

number or the hexadecimal number. 
The signasl to display can set up the continuous range freely with [Monitor setting]. 
This function can be used with Version R3 or later of CR750-Q/CRnQ-700 robot controllers and Version 

2.10L or later of this software. 
 

 
Figure 12-32 IO unit monitor 

 
 
12.2.5.1. Monitor setting 

Click the [Monitor setting] button. The setting screen of PLC IO unit monitor is displayed. 
Set the starting number of each device and set the number of lines to display. And, set the data size in 

display singles and the display method. 
After setting, click the [OK] button. 
 

 
Figure 12-33 IO unit seting screen 
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12.3. Production Condition Monitoring 

 
12.3.1. Operation hours 

You can check the robot work time, battery usage time, etc. 
From the project tree, double click the target project [Online] → [Monitor] → [Operation Monitor] → 

[Operation Time]. 

 
Figure 12-34 Operating Hours 

 
You can initialize the battery remaining time with [Maintenance] → [Initialize]. For details on operation methods, 
see "13.2.4 Initializing the battery remaining time". 
 
 
12.3.2. Production information 

You can check the latest tact time, run time, cycle count, and average tact time for each program in the robot 
controller. The latest tact time, run time, and average tact time can be measured up to 1193 hours (about 49 
days). 
From the project tree, double click the target project [Online] → [Monitor] → [Operation Monitor] → [Production 
Information]. 

 
Figure 12-35 Production Information 

 
The production information is not constantly updated. Click the [Refresh] button as necessary. 
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13.  Maintenance  
 

With maintenance, you can maintain the robot in various ways, including setting origin data and initializing 
various informations. 

 

13.1. Setting Origin Data 

You can save robot origin data to a file, edit it, and transfer it to a robot controller. 
 
Set origin data while connected to the robot controller.  
From the project tree, double click the target project [Online] → [Maintenance] → [Origin Data]. 

 

 
Figure 13-1 Starting up the Origin Data Setting Screen 

 
 

 
Figure 13-2 Origin Data Screen 

 
 
 
* About robot controller run modes when origin data is read/written 

 
With CRn-500 series robot controllers, when robot origin data is read/written using this software, there are 

restrictions on the controller run mode according to the robot controller software version. 
Reference the table below. 

About controller modes in which origin data can be read/written 
The controller modes (TEACH/AUTO (Op.)/AUTO (Ext.)) in which origin data can be read/written 

depend on the CRn-500 series robot controller version.  For details, see "Table 13-1 Origin Data 
Reading Robot Control Operation Mode" and "Table 13-2 Origin Data Writing Robot Control 
Operation Mode". 

Caution 
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(1) Reading 

Table 13-1 Origin Data Reading Robot Control Operation Mode 

Operating mode CRn-500 series robot controller
TEACH Auto (OP) Auto (Ext) 

J1 edition or later ○ ○ ○ 

H7 edition or earlier × × ○ 

○: Reading possible, ×: Reading not possible 
 
 
(2) Writing 

Table 13-2 Origin Data Writing Robot Control Operation Mode 

Operating mode CRn-500 series robot controller
TEACH Auto (OP) Auto (Ext) 

J1 edition or later ○ ○ ○ 

G9 edition – H7 edition ○ × ○ 

G8 edition or earlier ○ × × 

○: Writing possible, ×: Writing not possible 
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13.1.1. Origin data input technique 

You can save robot origin data to a file, edit it, and transfer it to a robot controller. 
Click the origin data screen "origin data input technique" to display the screen. 

 

 
Figure 13-3 Origin Data Input Technique Screen 

 
 

[Write] : Writes the origin data displayed on the screen to the robot controller. 
[Save to file] : The displayed origin data can be saved to a file. 
[Read from a file] : Stored origin data can be read from a file and displayed on the screen. 
[Refresh] : Reads the origin data from a robot controller and displays the latest 

status. 
 

 
 

 
 
 

About DJNT (origin error) parameters 
DJNT shows the origin position error. When revising the origin position using the position repair 

tool, the value is set in DJNT. (When not revising the origin position using the position repair tool, 
all the elements become 0. However, for RV-4A, the values are entered beforehand.)  

DJNT is not released to general customers, so the values can not be directly changed. 
 

About DJNT parameter display 
Sometimes DJNT parameters are not displayed for certain robots (for example, robots that do not 

support the position repair function). 

Memo 

Input the correct values for the J7 and J8 origin data. 
For the J1-J6 axis origin data, the compatibility of values in the robot controller are checked but 

the J7 and J8 origin data are not checked. Always input correct values. 
The J7 and J8 axis origin data is only displayed when there is a supported additional axis. 

Caution 



 

13-242  13-242 

 
13.1.2. Mechanical stopper technique  

This uses the robot mechanical stoppers to set the robot origin. 
Click the origin data screen [Mechanical stopper] button to display the screen. 
 
After moving the robot to a mechanical stopper origin position, select the axis to set the origin for with the 

checkbox, and then click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. For some robot controller software 
versions, this is sometimes not displayed. 
 

 
Figure 13-4 Origin Setting (Mechanical Stopper) Screen 

 
 
13.1.3. Tool technique 

This uses the origin setting tool to set the robot origin. 
Click the origin data screen [Tool] button to display the screen. 
 
After moving the robot to the tool origin position, select the axis to set the origin for with the checkbox, and 

then click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. For some robot controller software 

versions, this is sometimes not displayed. 
 

 
Figure 13-5 Origin Setting (Tool Technique) 
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13.1.4. ABS origin technique 

This uses the robot's ABS origin position robot to set the robot origin. 
Click the origin data screen [ABS] button to display the screen. 
 
After moving the robot to the ABS origin position, select the axis to set the origin for with the checkbox, and 

then click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. For some robot controller software 

versions, this is sometimes not displayed. 
 

 
Figure 13-6 Origin Setting (ABS Origin Technique) Screen 

 
 
13.1.5. User Origin Technique  

This uses the robot user origin to set the robot origin. 
Click the origin data screen [User origin method] button to display the screen. 
 
After moving the robot to the user origin position, use the checkbox to select the axis to set the origin of, and 

then click the [Set origin] button. 
"Last" displays the origin setting technique used the previous time. For some robot controller software 
versions, this is sometimes not displayed. 
 

 
Figure 13-7 Origin Setting (User Origin Technique) Screen 
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13.1.6. Origin Parameter Backup 

You can back up the parameters that make up the origin data. Also, you can transfer the backed-up data to 
a robot controller. 

Click the origin data screen [Backup origin parameter] button to display the screen. 
 

 
Figure 13-8 Robot Origin Parameter Backup Screen 

 
 

[Save to file] : This saves origin parameters read from a robot controller (displayed 
parameters) to a file. 

[Select file for writing 
to robot] 

: Transfer origin parameters stored in a file to a robot controller. 
When transferring to a CRn-500 series robot controller with edition H7 or 
earlier, set "Teach" mode. 

 

 
 
 

When the password is registered in “Parameter” by robot controller's 
security function, it is not possible to restore the origin data string to the robot 
controller by "origin parameter backup" screen. 

When the password is registered in “Parameter” by robot controller's security function, it is not 
possible to restore the origin data string to the robot controller by "origin parameter backup" screen. 

 
○ : Enable、 × : Disable 

Item to which password of security function is registered.   
Program Parameter File 

Restore the origin data ○ × ○ 

 
Please delete the password of robot controller's security function when you operate these. Please 

refer to "13.7.3 Delete the Password" for the method of deleting the password.  
The setting(register the password) and the release(delete the password) of robot controller's 

security function can be used with this software version 2.0 or later. Please refer to "Table 13-15 
Compliant version of this function and controller" for robot controller's compliant version. 

Caution 
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13.2. Initialization 

This initializes information in a robot controller. 
Here, you can initialize the following information in a robot controller. 
(1) Set the robot controller clock  
(2) Initialize all programs in the robot controller 
(3) Initialize the remaining battery time in the robot controller 
(4) Check the serial number in the robot controller and set the serial number for the connected robot 

(Serial number checking and setting can only be used with CR750/700 series robot controllers.) 
 
13.2.1. Starting 

Use the initialization function while connected to the robot controller.  
From the project tree, double click the target project [Maintenance] → [Initialize]. 

 

 
Figure 13-9 Starting Initialization Screen 

 
 
 
13.2.2. Setting the time in the robot controller 

You can set the robot controller clock. 
On the initialization screen, click the [Set time] button. 

 

 
Figure 13-10 Time Setting Screen 

 
Set the new date and time, then click the [OK] button. 
You can set the current date and time from your computer by clicking the [Get PC time] button. 
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13.2.3. Deletion of all robot programs 

This deletes all the programs in the robot controller. 
On the initialization screen, click the program group [Initialize] button. 

A confirmation screen is displayed, so input "Yes", then click the [OK] button. 

 
Figure 13-11 Confirmation Screen for Program File Initialization 

 

When the password is registered in “program” by robot controller's 
security function, it is not possible to delete all the programs in the robot 
controller. 

 

When the password is registered in “program” by robot controller's security function, it is not 
possible to delete all the programs (initialize the programs) in the robot controller.  

○ : Enable、 × : Disable 
Item to which password of security function is registered.   

Program Parameter File 

Deletion of all robot programs. × ○ ○ 

 
Please delete the password of robot controller's security function when you operate these. 

Please refer to "13.7.3 Delete the Password" for the method of deleting the password.  
The setting(register the password) and the release(delete the password) of robot controller's 

security function can be used with this software version 2.00A or later. Please refer to "Table 
13-15 Compliant version of this function and controller" for robot controller's compliant 
version

Caution 
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13.2.4. Initializing the battery remaining time 

 
This initializes the remaining battery time in the robot controller. 
On the initialization screen, click the remaining battery time [Initialize] button. 
A confirmation screen is displayed, so input "Yes", then click the [OK] button. 

 
Figure 13-12 Confirmation Screen for Battery Time Remaining 

 
 
13.2.5. Serial number 

 
This checks the serial number in the robot controller and sets the serial number for the connected robot 

On the initialization screen, click the serial number group [Set] button. 
 
This function can only be used with CR750/700 series robot controllers. 
The first time you start up a CR750/700 series robot controller after purchase, the C0150 warning (robot 

main unit serial number not set) is generated. On this screen, set the robot main unit serial number. 
 

 
Figure 13-13 Serial Number Input Screen 

Do not initialize unless the battery has been replaced. 
Be careful.  If you initialize the remaining battery time other than when the battery is replaced, it 

becomes impossible to reference a correct reading for the remaining battery time. 

Caution 
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13.3. Maintenance Forecasting 

With "Maintenance forecasting", you can reference the parts replacement timing (greasing and battery and 
belt replacement) from operation data collected up till now in the robot controller. 
 

 
 
13.3.1. Specifications 

With CRn-500 series robot controllers, there are restrictions on the maintenance forecast functions according 
to robot models and versions supported. The robot controller software versions and models supported by the 
maintenance forecast function are as follows. 
 

Table 13-3 Supported models and software versions 

No. Robot 
CR750/700 series 
Robot controller 

CRn-500 series 
Robot controller 

1 
RV-6S  series 
RV-12S series 

Ver. J2 or later 

2 
RV-3S  series 
RV-3SJ series 

Ver. K1 or later 

3 
RH-6SH  series 
RH-12SH series 
RH-18SH series 

Ver. K4 or later 

4 RV-2S series 

The supported 
models are not 

restricted 

- 

 
 
13.3.2. Starting 

Use the maintenance forecast function while connected to the robot controller.  
From the project tree, double click the target project [Online] → [Maintenance] → [Maintenance Forecast]. 

 
Figure 13-14 Starting Maintenance Forecasting 

 

The results of calculations in Maintenance Forecast merely show 
reference values. 
Please execute the daily inspection and the periodic inspection to 
prevent the breakdown beforehand, and to secure safety. 

Caution 
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13.3.3. Forecasting 

You can reference the "time until battery replacement", "time until regreasing, and time until belt 
replacement".  

 
Figure 13-15 Forecast Screen 

 
By clicking the [Refresh] button, you can reacquire information on maintenance from the robot controller. 
 
 
(1) Battery  
If the number of remaining hours of battery life has reached 

 
the hours and bar graphs are displayed in orange. 

(The battery replacement time is calculated during the time when the controller’s power is not on.) 
 
 
(2) Grease 
If the hours until replenishment time has reached 

 
the hours and bar graphs are displayed in orange. 
 
 
(3) Belt 
If the hours until belt replacement time has reached 

 
the hours and bar graphs are displayed in orange. 
 
 
(4) Display unit 

You can switch the display units for "Grease" and "Belts" between hours and days.  When days are 
selected as the display unit, the number of days of operation is calculated from the number of operating hours 
per day and that number of days is displayed. 
 
 

(Hours until replenishment time) < ([The remainder days until presumed maintenance time] on 
the Setup screen) x ([Operation time of a day]), 

(Remainder time) < [The remainder days until presumed maintenance time] on the Setup screen) 
x (24 - [Operation time of a day])

(1) Battery 

(2) Grease 

(3) Belt 

(4) Display units
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13.3.4. Settings 

Here, you can set the timing for collecting information concerning maintenance forecasts, the notification 
method, etc. 

 
Figure 13-16 Setup 

 
When the [Write parameters] button is clicked after setting each item, the setting values are written into the 

controller. All items other than the signal numbers of dedicated outputs take effect after they are written into 
the controller. If a dedicated output signal has been changed, it is necessary to power on the controller again. 

 
For details on the setting items, see "Table 13-4 Description of the Setup Screen". 

 
 

Information needed to “Maintenance Forecast” is not accumulated 
while the Maintenance forecast is being invalidly set. 

Factory preset value is invalidity. When the 

Maintenance Forecast is invalidated, 

information of Maintenance Forecast is not 

accumulated. When switched effectively from 

invalidity again, the reservoir of information is 

continued from the last value. If you have 

invalidated the Maintenance Forecast for a long 

term, the correct maintenance times cannot be 

calculated. 

Caution 

invalidity
Information is accumulated.

Maintenance Forecast
     Effective

Reservoir of information

time

 
 

(1) Enables maintenance 
forecasting 

(2) Information 
collection level 

(3) Notice interval 

(4) Warnings 

(5) Output dedicated 
output signal 

(6) Operating time 
per day 

(7) Remainder 
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Table 13-4 Description of the Setup Screen 

Item Explanation 
Factory 
preset 
value 

(1) Maintenance Forecast is 
made effective. 

If this is checked, the Maintenance Forecast function takes effect. 
* If a checkmark is removed, the collection of the information for 

Maintenance Forecast stops, and the correct maintenance times 
cannot be calculated. 

Check 
ON 

(2) Collection level of information Five levels can be specified to collect the information about the 
maintenance. 
* As an information collection level gets higher, the accuracy of the 

maintenance improves, but it affects the tact time more. 

1 
(Recomm 

ended) 

(3) The interval of the forecast Specify the interval to notify the maintenance time. 6 hours 
How to inform When the grease replenishment, belt replacement and other maintenance times 

have reached, they can be notified by generating a warning or outputting a 
dedicated signal. As for the battery replacement time, one of warnings, C7500, 
C7510 and C7520, is generated, regardless of whether or not [Warning] under 
[How to inform] is checked. 

A warning to be generated varies depending on each situation. 
(4) Warning If this item is checked, the maintenance time is notified as a warning. 

The warning numbers are listed as follows: 
Grease   : C753* (* is the axis No.) 
Belt      : C754* (* is the axis No.) 

Check 
ON 

(5) Output Signal If this item is checked, signal numbers can be entered. If this item is 
checked and a signal number is entered correctly, the maintenance 
time is notified using the output of the designated signal. 

Check 
OFF 

(6) Assumption operation 
time of a day 

Enter an estimated robot operation hours per day. 16 hours

 

(7) The remainder days until 
presumed maintenance 
time 

Specify the number of days remaining until presumed maintenance 
time to be used as a reference to notify the maintenance time. 

14 days
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13.3.5. Reset screen 

The information (about battery, grease and belt) for Maintenance Forecast kept in the controller can be reset. 
 

 
Figure 13-17 Reset 

 
 

Table 13-5 Description about each reset 

Types of resets Explanation Note 
At the time of 
battery exchange 

It is used when an alarm urging to replace 
the batteries (C7500, C7510 or C7520) 
occurs and the batteries have been replaced.
Be sure to reset the battery remaining time 

after a battery has been replaced. 

  

At the time of 
grease 
replenishment 

When an alarm urging to perform periodic 
inspections and replenish grease (alarm 
numbers in the 7530s) occurs, replenish the 
grease and reset the replenished axis. 

Axes are reset in units of joint 
axes. Multiple joint axes can be 
reset at the same time. 

At the time of belt 
exchange 

When an alarm urging to perform periodic 
inspections and to replace the belt when it is 
damaged (alarm numbers in the 7540s) 
occurs, replace the belt and reset the axis for 
which the belt is replaced. 

Axes are reset in units of joint 
axes. Multiple joint axes can be 
reset at the same time. 

 
These reset operations can be executed using the teaching box. See the following section for further 

details. 
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When the [Log] button is clicked in the upper-right corner of the window, the previous reset date/time and 

reset count can be checked. 
However, the battery reset count is not displayed. 

If no reset has not made previously, “----/--/-- --:--:--“ is displayed. 
 

 
Figure 13-18 Log of Resets 
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13.3.6. Resetting maintenance forecast information with teaching box 

When an alarm urges to replace the batteries, replenish the grease, or to replace the belt based on the 
Maintenance Forecast function and these parts are replaced or replenished, the information that has been 
accumulated within the controller needs to be reset for the axis where such replacement or replenishment has 
been performed. 

The information that has been accumulated within the controller can be reset using not only this software, 
but also the teaching box. 

 
(1) Resetting the time of battery remaining 

Table 13-6 Resetting the time of battery remaining 

 Explanation Operation 
the time of 
battery remaining 

It is used when an alarm urging to 
replace the batteries (C7500, C7510 or 
C7520) occurs and the batteries have 
been replaced. 
Be sure to reset the battery remaining 
time after a battery has been replaced. 

From the teaching box (R32TB) menu screen, 
execute "5. Settings and Initialization" → "1. 
Initialization" → Battery. 

 
For details on the method for initializing the battery remaining time using the teaching box, in the robot 

controller's operations manual, see "Detailed explanations of functions and operations". 
 
 

(2) Resetting the grease and belt information 
The grease and belt information can be reset by entering parameters to the controller. 
The following is the list of parameter names and the values to be entered. 
 

Table 13-7 Resetting the grease and belt information 
 Explanation Parameter Value 

Grease 
information 

When an alarm urging to perform 
periodic inspections and replenish 
grease (alarm numbers in the 7530s) 
occurs, replenish the grease and 
reset the replenished axis. 

MFGRST 

Belt 
information 

When an alarm urging to perform 
periodic inspections and to replace 
the belt when it is damaged (alarm 
numbers in the 7540s) occurs, 
replace the belt and reset the axis for 
which the belt is replaced. 

MFBRST 

0      : Reset information on all 
axes 

 
1 to 8  : Reset information on the 

specified axis 

(* These parameters cannot be read not to input all characters in the teaching box.) 
 
The grease or belt information will be reset immediately after a parameter name and the value are 

entered. (In this case, the controller power does not need to be restarted.) If a value other than 0 is entered, 
the reset process will be executed for each axis. 
Repeat the parameter input operation when resetting information on two or more axes. 

Also note that the value read is always 0 regardless of the previously entered value. If you continue the 
input operation in this state, all axes will be reset. Exercise with caution. 
 
See “Controller INSTURCTION MANUAL – Detailed explanations of functions and operations” for how to 

input parameters using the teaching box. 
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13.3.7. Others 

The information for Maintenance Forecast kept in the controller can be backed up and/or restored. 
 

 
 
 
 

 
Figure 13-19 Others 

 

The backup and restore operations are performed when the 
controller (CPU) is replaced. 
When the controller (CPU) is replaced, perform both backup and restore operations in a batch 

using the Backup/Restore tool. Also, be sure to back up the information for Maintenance Forecast 
before replacement, and restore the backed up information after replacement. 

Please Backup/Restore between controllers of the same version. When the version is different, the 
error might occur. 

After the controller (CPU) has been replaced, if the information for Maintenance Forecast is not 
restored, or it is restored after a substantial time has elapsed since the time of backup, please note 
that the reliability of Maintenance Forecast will be degraded. 

Caution 
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13.4. Position repair Function 

The position repair function is restricted by the usable models and controller software versions.  See "Table 
13-9 Supported Robot Controllers and Model". 
 

The "position repair function" is used when a tool is deformed by a collision or the origin is out of place 
because the motor has been replaced. Just reteaching part of the position data within the robot program 
makes it possible to use the previous position data in the controller. (Position repair generates parameters to 
correct the position deviation and corrects all the position data in the robot controller.) 

However, please understand that there are some cases that position repair can not restore, such as 
applications requiring high precision and major mechanical damage to a robot from a collision. 
Also, restrictions on a robot's degrees of freedom can make it impossible to recover with position repair.  
Since vertical 5-axis robots and horizontal 4-axis robots are restricted as shown in "Table 13-8 The limit by 
degree of freedom", positional deviations related to these restrictions can not be corrected with this function.  
In this case, either reteach manually or correct the deviating section (for example, by replacing a bent hand). 
 

Table 13-8 The limit by degree of freedom 

No. Robot model The limit by degree of freedom 

1 Vertical 5-axis robot 
It can’t move in the direction of C element of the Cartesian 
position. 

2 Horizontal 4-axis robot 
It can’t move in the direction of A, B element of the 
Cartesian position. 

 
 
 
 

 

When the password is registered in “parameter” or “file” by robot 
controller's security function, it is not possible to operate Position repair 
Function. 

 

When the password is registered in “parameter” or “file” by robot controller's security function, it is 
not possible to operate Position repair Function. 

○ : Enable、 × : Disable 
Item to which password of security function is registered.   

Program Parameter File 

Position repair Function ○ × × 

 
Please delete the password of robot controller's security function when you operate these. 

Please refer to "13.7.3 Delete the Password" for the method of deleting the password.  
The setting(register the password) and the release(delete the password) of robot controller's 

security function can be used with this software version 2.0 or later. Please refer to "Table 13-15 
Compliant version of this function and controller" for robot controller's compliant version. 

The position repair function is only supported 
 by MELFA-BASIC IV and MELFA-BASIC V. 

The position repair function is only supported by MELFA-BASIC IV and MELFA-BASIC V. It cannot be 
used with Movemaster commands. 

Caution 

Caution 
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13.4.1. Specifications 

The robot models and robot controller versions with which the position repair function can be used are as 
follows. 
 

Table 13-9 Supported Robot Controllers and Models 

No. Robot model 
CR750/700 
series Robot 

Controller 
CRn-500 series Robot Controller 

1 Vertical 6-axis robot 
Version J2 or later 

Only correction of origin data is supported in 
versions prior to J2. 

2 Vertical 5-axis robot 
Version K1 or later 

Only correction of origin data is supported in 
versions prior to K1. 

3 
Horizontal 4-axis 
robot 
(RH-SH series only) 

The supported 
models are not 
restricted by the 

version Version K4 or later 
Any versions prior to K4 are not available. 
Moreover, This function cannot be used for the 
RH-AH series robot. 

 
 
 
 
13.4.2. Starting  

Use the position repair function while connected to the robot controller.  
From the project tree, double click the target project [Online] → [Maintenance] → [Position repair]. 

 

 
Figure 13-20 Starting Position Repair 
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13.4.3. Flow of operations  

The position repair takes the form of a wizard. You can automatically generate the parameters by proceeding 
with operations according to the instructions on each screen. You can directly set parameter values. 
 

Specify the target robot 

Specify the program to use for parameter 

generation (within robot controller) 

Move robot to re-teaching position 

(Use the teaching box) 

Specify the parameters to be generated 

Enter parameter values 

Parameter generation 

Write parameters to robot controller 

Execute re-teaching calculation 

Write parameters to robot controller 

Repeat as necessary

Automatic parameter 

generation 

(Normal operation) 

If setting parameters 

Re-teaching Work Procedure 

Backup the parameters before 

Back up the selected program 

Restart robot controller power  

Restart robot controller power 

 
Figure 13-21 Operation Flow 

 
The explanation follows the normal operations flow.  For the explanation when setting parameter values, see 
"13.4.16 Revision parameter editing". 



 

13-259  13-259 

 
13.4.4. Introduction  

 

 
Figure 13-22 Starting Use Window 

 
This is an explanation of the position repair function.  Read it carefully, then click the [Next] button. 
 
 
13.4.5. Communications settings 

 

 
 
Check the communication settings and connected to the robot controller, click the [Next] button.  For the 
setting method, see "6 Connecting with the Robot". 
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13.4.6. Robot selection and parameter backup 

 

 
Figure 13-23 Robot and Backup Parameters Selection Window 

 
Select the robot to execute the re-teaching. 

The Robot is displayed as follows. 

 
 
To backup parameters, click [Backup].   
The dedicated backup screen starts.  For more details on backups, see "15 Backup and Restore". 
Backed up parameter files can be written back to a robot controller using the "backup/restore" functions of this 
software. 
 
When the preparations are completed, click the [Next] button. 

 
 
 

Parameter Backup  
During its operation, this software overwrites parameters to the robot controller. 
It is recommended that the parameters be backed up at this point to allow the controller to revert to 

the original parameters. 

Memo 

Ver.1.1 or earlier Controller number : Controller Name + Mechanism Name #Mechanism No. 

Ver.1.2 or later Controller number : Mechanism Name #Mechanism No. 

Displayed only in multi-mechanism mode. 
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13.4.7. Revision parameter generation procedure selection 

 

 
Figure 13-24 Select generation procedure of revision parameter Window 

 
In the next step, the software can either automatically generate parameters or accept manually entered 

parameter values. Normally, [Generate revision parameter automatically] is selected. 
 

Select [Generate revision parameter automatically] and click [Next] to proceed to “Select Program” 
window. 

Select [Edit the value of revision parameter directly] to proceed to “Edit Revision Parameter” window. 
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13.4.8. Program selection 

 

 
Figure 13-25 Select Program Window 

 
Select the robot program to use for revision parameter generation, then click the [Next] button. 
Here, perform the reteaching using the XYZ-coordinate position data in the selected program. 
 
For details on the required position data numbers, see "Table 13-10 Selecting Revision Parameters". 
 

 
 

 

The points on selecting the program 

Select the program with the positions of various location and posture. 
Moreover, higher accuracy of revision parameters can be obtained by selecting the following type 

of position data program. 
・ Program with positions that are easy to re-teach 
・ Program with positions that require high precision 

Memo 
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13.4.9. Program reading and backing up 

 

 
Figure 13-26 Read and Backup Program Window 

 
To backup a program, click [Backup].   

The special screen for backup is started. For details on backups, see "15 Backup and Restore".   
You can use the backup/restore functions in this software to write a backed up parameter file back into a 

robot controller. 
 

When the preparations are completed, click the [Next] button. 
 

 
 
 
 

Robot Program Backup 

During its operation, this software may overwrite robot controller program (position data). 
It is recommended that the program be backed up at this point to allow the controller to revert to the 

original program. 

Memo 
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13.4.10. Tool setting check 

 

 
Figure 13-27 Check of Setting Tool Window 

 
Parameter values set in the present robot controller for tool data are displayed. The row for the tool selected 

by the tool number (MEXTLNO) is highlighted in red. 
Please check if the tool data and tool number used during teaching is set. 
If necessary, change the value from parameter setting in teaching box. Click [Renew List] to update the 

contents of the display. 
(If the CRn-500 series robot controller’s version is older than J2, only the standard tool (MEXTL) will be 
displayed.) 
 
Click [Next] when ready to proceed. 
 

 
 

 
 

Do not change tool data or base data. 
After this window, do not change tool data or base data. 
If they are changed during re-teaching operation, re-teach calculation cannot be done correctly. 
When correcting tool data, if teaching was performed switching back and forth between multiple 

tools, perform re-teaching operation for each tool. 

Caution 
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13.4.11. Revision parameter selection 

 

 
Figure 13-28 Select Revision Parameter Window 

 
Select the revision parameter that becomes the target for re-teaching calculation. 
 

Revision parameter will be selected automatically if an item is selected from [Select revision parameter]. 
Choose [Select all] to select all the revision parameters. If you wish to specify a particular combination of 

revision parameters, choose [Select arbitrarily] and specify the revision parameters. 
 

Vertical 6-axis robot 
If the CRn-500 series robot controller’s version is older than J2, only 
[Error of joint axis] can be selected. 

Vertical 5-axis robot 
If the CRn-500 series robot controller’s version is older than K1, only 
[Error of joint axis] can be selected. 

Horizontal 4-axis robot 
(RH-SH series only) 

The CRn-500 series robot controller’s any versions prior to K4 are not 
available. 
(This function cannot be used for the RH-AH series robot.) 

The supported models are not restricted by the version in CR750/700 series robot controller. 
 

Click [Details] to see the description of the difference between checking and not checking [Use the posture 
elements of position data]. 
 

In the following section, details regarding revision parameters and posture elements of position data are 
explained. 
 
After choosing the revision parameters, click [Next]. 
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13.4.11.1. Revision parameters 

Parameters revised by items selected with "Select revision parameters" become as in "Table 13-10 Selecting 
Revision Parameters". 
 

 
 
 

 
 
 
 

Some elements cannot be calculated according to 

the robot type and the combination of revision parameters. 
In this function, the amount of the gap of the robot is calculated as a correction value, and the 

revision parameter is generated. However, some elements cannot be calculated (the value becomes 
0) as the following two kinds of cases. 

 
 
* The case which cannot be calculated by the limits of degree of freedom of robot 

Some elements of revision parameter cannot be reflected because the Vertical 5-axis robot and 
horizontal 4-axis robot have the limitation. 

 
* The case which condensed by the combination of robot mechanism and revision parameter

Some elements of revision parameter become the value on the same rotation axis according to the 
combination of robot mechanism and revision parameter. In such case, calculated value of gap is 
condensed to the one element of revision parameter. 

At this case, though the other element becomes 0, it condenses in other elements and it is 
corrected. So it is not necessary to reflect it again. 

Memo 
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Table 13-10 Selecting Revision Parameters 

Minimum number of teach 
points 

No. Item Description 
Revised 

Parameter Vertical 
6-axis 
robot 

Vertical 
5-axis 
robot 

Horizo
ntal 

4-axis 
robot

1 
Error of 

joint axis 

Rectifies origin data when joint axis moves or when 
motor is replaced. 
Specify the target axes using the check boxes. 
The number of teaching points is different according 
to how the axis was specified. 

Origin data 

 

1 to 6 
points 

1 to 5 
points

1 to 4 
points

2 

Tool 
exchange 

or 
modified 

Rectifies attachment error when robot tool is 
exchanged. In addition, rectifies tool data error when 
the tool is transformed due to interference between 
robot and peripheral devices. 

Vertical 5-axis robot: 
* Only Z element of position data is corrected. 

  

Tool data 

 

3 to 6 
points 

1 point
3 to 4 
points

3 
Transfer 
the robot 

Rectifies base data of robot position setup when the 
robot is transferred to another location. 

Vertical 5-axis robot: 
* Only X, Y, Z elements of position data are 
corrected. 

  

Base Data 

 

6 points 
3 

points
4 

points

4 
Exchange 
the robot 

When robot is exchanged with the tools on, rectifies 
origin data error and base data of robot position 
setup. 
Only for horizontal 4-axis robot, attachment error is 
also rectified. 

Vertical 6-axis robot: 
* Origin data J1 is included in base data. 
Vertical 5-axis robot: 
* As to base data, only X, Y, Z elements are 

Corrected. 
Horizontal 4-axis robot: 
* Origin data J1 and J3 are included in base data. 
* Origin data J3 and J4 are included in tool data. 
* Select which to be requested because Z elements 
of tool data and base data are not corrected at the 
same time. 

 
  

Base data 
Origin data 
 
Tool data 
(4-axis robot 

only) 
 

 
(5-axis and 
6-axis robot) 

 

 
(4-axis robot) 

10 to 
11 

points 

7 to 8 
points

7 to 8 
points

5 Select all 

Selects all revision parameters. 
 

Vertical 6-axis robot: 
* Origin data J1 is included in base data. 
* Origin data J6 is included in tool data. 
Vertical 5-axis robot: 
* As to tool data, only Z element is corrected. 
* As to base data, only X, Y, Z elements are 

corrected. 
Horizontal 4-axis robot: 
* Origin data J1 and J3 are included in basedata. 
* Origin data J3 and J4 are included in tooldata. 
* Select which to be requested because Z elements 
of tool data and base data are not corrected at the 
same time. 

 
  

Origin data 
Tool data 
Base data 

 

13 to 
16 

points 

8 to 9 
points

7 to 8 
points
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Minimum number of teach 
points 

No. Item Description 
Revised 

Parameter Vertical 
6-axis 
robot 

Vertical 
5-axis 
robot 

Horizo
ntal 

4-axis 
robot

6 
Select 

Arbitrarily 

Specify revision parameters. 
Vertical 6-axis robot: 
* Since origin data J1 is included in base data, if 
base data is selected, turn off the Checkbox of 
origin data J1. 

* Since origin data J6 is included in tool data, if tool 
data is selected, turn off the Checkbox of origin 
data J6. 

Vertical 5-axis robot: 
* As to tool data, only Z element is corrected. 
* As to base data, only X, Y, Z elements are 
corrected. 

Horizontal 4-axis robot: 
* If base data is selected, turn off the Checkboxes 
of origin data J1 and J3. 
Origin data J1 and J3 are included in base data. 

* If tool data is selected, turn off the Checkboxes of 
origin data J3 and J4. 
Origin data J3 and J4 are included in tool data. 

* If tool data and base data are selected together, 
select which Z element to be requested, because 
Z elements of tool data and base data are not 
corrected at the same time. 

  
  

   

* Revision parameter names correspond to the following. 
Origin data: DJNT 
Tool data: MEXDTL, MEXDTL1 to 4 (Parameter of the tool selected by tool number) 
Base data: MEXDBS 
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13.4.11.2. Position data posture components 

Position data of MELFA-BASIC IV consists of tip position (X, Y, Z) and tip posture elements (A, B, C) (*1). 
This section describes the cases where [Use the posture elements of position data] is checked and not 

checked. 

 
 
 

(1) [Use the posture elements of position data] is checked  
Not just the robot tip position (X, Y, Z) but also the tip posture elements are used for position correction 

calculation. 
Precision of generated revision parameter improves if the tip posture elements are also re-taught correctly. 
However, if the tip posture elements are not re-taught correctly, as shown in the diagrams below 

(re-teaching positions P1 and P2), error occurs in position correction calculation, decreasing the precision of 
the calculation result. 

If posture elements are
re-taught accurately

Re-teaching
position P1

Re-teaching
position P2

Original position and posture

Position and posture before
re-teaching

Position and posture after
re-teaching

Re-teaching position

Original position
and posture

Re-teaching
position P3

If posture elements are not re-taught accurately

 
 
 

(2) [Use the posture elements of position data] is not checked  
Posture elements in the position data taught during re-teaching are not used for position correction 

calculation. 
If it is not necessary to match exactly the tip posture elements during re-teaching, clear the checkbox 

[Use the posture elements of position data]. In such case, position correction calculation is performed using 
only the tool tip position data (X, Y, Z), ignoring the error from posture deviation. This increases the 
precision of location correction. 

However, there are some restrictions.  For details, see "Table 13-11 About Posture Elements of 
Re-teaching Position Data". 

 
 

(*1) The posture elements of position data 

In case of the vertical 6-axis robot, the posture elements of position data are (A, B, C). 
In case of the vertical 5-axis robot, the posture elements of position data are (A, B). 
In case of the horizontal 4-axis robot, the posture element of position data is (C). 

Memo 
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Table 13-11 About Posture Elements of Re-teaching Position Data 

Condition Merit Note 

When using posture elements of 
position data 

 

Precision of generated 
revision parameter 
improves if the tip position 
(X, Y, Z) and tip posture 
elements are re-taught 
correctly. 

During re-teaching, posture must 
be taught correctly. If posture 
data is incorrect, precision of 
revision parameter actually 
decreases. 
 

In case of the vertical 6-axis 
robot : 
* Posture elements (A, B, C) of 
tool revision parameters cannot 
be obtained. 

* J6 axis of origin revision 
parameter cannot be obtained 
if both X and Y components of 
the tool parameter are 0.0. 

In case of the vertical 5-axis 
robot : 
* J6 axis of origin revision 

parameter cannot be 
obtained. 

When not using posture elements of 
position data 

 

During re-teaching, 
revision parameters can be 
generated simply by 
correctly teaching position 
(X, Y, Z). 
(Posture elements need 

not be accurate.) 

In case of the horizontal 4-axis 
robot : 
* Posture elements (C) of tool 
revision parameters cannot be 
obtained. 

* J4 axis of origin revision 
parameter cannot be obtained 
if both X and Y components of 
the tool parameter are 0.0. 
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13.4.12. Reteaching work 

 

 
Figure 13-29 Reteach Work Window 

 
[Remainder] 

 

Displays the number of remaining points until revision parameters are 
generated. 
However, at some positions, re-teaching may not decrease the number 

of remaining points. 
[Re-teach] button Specifies the positions selected in the list and opens “Re-teach the 

position” screen. 
[Clear] button Clears the re-teaching information for positions selected in the list. 

[Check of tool data] Displays current tool data setting in the robot controller. 
 
 

 
 

Position data for the program selected are displayed. 
Select the position to re-teach from the list and repeat re-teaching to generate revision parameters. 
 

Re-teaching work procedure can be described as follows. While the “Re-teach the position” screen is open, 
move the robot to the re-teaching position and click the [Load current position] button on the screen. 

 

Position data of the targeted program is write-protected. 
During showing this window, the position data of the targeted program in the controller is 

write-protected. If this tool is interrupted when not communicating with the controller, the position data 
cannot be unprotected. Please release the protect by using the Teaching Box or Program manager of 
this software. 

Caution 
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Figure 13-30 Re-teach the position Screen 

 
 

 

Revision parameter generation

Re-teaching 

Repeat 

Click [Re-teach] button Re-teach the position Screen opens

Move the robot to re-teaching position 
(Use the teaching box to move) 

Click [Load current position] button

Select the position to re-teach from the list

(Re-teaching calculation) Position Re-teaching window closes

Re-teach the position Screen

 
Figure 13-31 Re-teaching Work Procedure 

 
Row for re-taught position will be highlighted in light blue. 

Re-teaching does not change the position data values shown in the list. 
 
 

 
 
 

 
 

Do not perform position correction using the teaching box. 
When you move the robot to the re-teaching position using the teaching box, be careful not to 

correct the position. 
During re-teaching, position data of the applicable program in the controller is write-protected. 

Caution 
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It is possible to change the revision parameters to be generated. 
Go back one step to the “Select revision parameter” window to change the setting. Note that if you return 

one more step to “Check of setting tool” window, all information set by re-teaching work will be cleared. 
 

 
 
 

When go back to “Check of setting tool” window, all information set 
by re-teaching work will be cleared. 

Caution 

The cautions when using a robot with the additional axis. 
When restoring the position with a robot with a travel axis, reteach at a position where the travel 

position becomes the same as in the original position travel axis data.  (Move the robot so that the 
travel axis data becomes the same as the original position.) If the retaught position travel axis data 
differs from the original travel axis data, it is impossible to find the correct revision parameters. 

Caution 

Select position data with a different posture element,  
when re-teaching two or more positions. 

Select position data with a different posture element, when re-teaching two or more positions. 
When position data of the same posture element are selected, there is a possibility that the 

parameter is not correctly calculated. 

Caution 

Do not change tool data, tool number, or base data. 
Do not change tool data, tool number, or base data during re-teaching. Re-teaching calculation will 

not be performed correctly. 
In correcting tool data, if teaching was performed switching back and forth between multiple tools, 

perform re-teaching operation for each tool. 

Caution 
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13.4.13. Writing parameters 

 

 
Figure 13-32 Write Parameters Window 

 
[Print] Prints the revision parameter information displayed in the list. 

[Save position data to file] Saves position data used in re-teaching as a robot program with 
positions only. Position data will be values converted by the 
revision parameters. 

 
Revision parameters and their values generated by re-teaching are displayed. 
Click [Next] button to write the parameters into the robot controller. 
 
 

 
 
 

If revision parameters could not be generated 

If revision parameters could not be generated, parameters are not displayed in the list. 
If you click the [Next] button, position data used in re-teaching is written into the robot controller. 
Since parameters are not generated, position data will not be converted. 
 
Parameters may not be generated under the following conditions. 
* When one of the specified re-teaching positions is of a significantly low precision 
* When one of the original position data is of a significantly low precision 
* When the difference between the original position data and the re-teaching position is too large 
* When tool data or base data was changed during re-teaching 
 
Clicking the [Back] button and redoing a part of the re-teaching may generate revision parameters.
Please delete the re-teaching information for the position data that meets one of the criteria 

mentioned above and perform re-teaching again. 

Caution 
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13.4.14. Controller power supply Off, On 

 

 
Figure 13-33 Re-start the power supply of the controller Window 

 
To activate the written parameters, turn off and then turn on the power of robot controller. 
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13.4.15. Exit 

 

 
Figure 13-34 Finish Window (After Re-teaching) 

 
When the writing of revision parameters is done, operation of this function is complete. 
 
 

 
 

 
 

 
 

Position data close to operation area boundaries may not be 
rectifiable. 

Around the operation area boundaries, position error may put a point outside the operation area, in 
which case this function cannot rectify the point. 

Caution 

Back up the parameters. 
This Function has changed the revision parameters. Back up the parameters before exit this 

window. 

Caution 

Perform an operation check before exit this function. 
Before exit this window, make sure that all position data works properly. 
If revision is not correct, click the [Return to re-teach] button to continue re-teaching. (However, if 

you exited from “Edit revision parameters” window, [Return to re-teach] button will not be shown.) 

Caution 
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13.4.16. Revision parameter editing 

 
When you select "Edit the value of revision parameter directly" with "13.4.7 Revision parameter generation 
procedure selection", this screen is displayed. 
 

 
Figure 13-35 Edit Revision Parameters Window 

 
[Print] Prints the revision parameter information displayed in the list. 
[Reset] Reset all changes. 

 
 

Displays values of current revision parameters in the robot controller. 
Select parameter from the list and double-click it to display the setting screen. Set the parameter values. 
(If the CRn-500 series robot controller’s version is older than J2, only the origin revision parameter (DJNT) 

is shown.) 
 

Click [Next] to write all parameters into the robot controller and proceed to “Re-start the Power Supply of 
the Controller” window. 
 
 

Double click 
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13.5. Tool automatic calculation 

With the “Tool automatic calculation”, the tool length is calculated automatically by teaching a same position 
by 3 to 8 points to the robot that is attaching an actual tool, and the value of a tool parameter (MEXTL) is set 
up.  

 
This function can be used with Version 2.20W or later of this software. Refer to “Table 13-12 Supported 

Robot Controllers and Models”.  
 

 
Figure 13-36 Summary the “Tool automatic calculation” 

 
 
13.5.1. Specifications 

The robot models and robot controller versions with which the “Tool automatic calculation” can be used are 
as follows.  
 

Table 13-12 Supported Robot Controllers and Models 

No. Robot model CR750/700 series Robot Controller CRn-500 series Robot Controller

1 Vertical 6-axis robot Version R3e/S3e or later 

2 Vertical 5-axis robot not use 

3 Horizontal 4-axis robot Version R3e/S3e or later 

not use 

 
 
13.5.2. Starting 

The “Tool automatic calculation” is used in the state with the robot controller connected.  
 
When the robot model and robot controller which have connected, correspond to this function, a [Tool 

automatic calculation] is displayed under [Maintenance] in the project tree. Double-click [Online] -> 
[Maintenance] -> [Tool automatic calculation] in the project tree.  

 

Teach a same position by 3 to 8 points to the robot that is attaching a tool 
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Figure 13-37 Starting the “Tool automatic calculation” 
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13.5.3. Flow of operations 

 

Select the target robot (<a>) 

Write the tool coordinate to robot controller (<e>)

Repeat as necessary 

(When a value is set to “Calculated tool coordinate”, 

a [Write] button (<e>) becomes effective) 

Select the tool number for setting (<b>) 

Select the line of “Auxiliary point” (<c>) 

Teach selection line (<d>) 

Move the robot to the auxiliary point 

(Use the teaching box) 

Enter checks to the check box of the line 

used to calculation (<c>) 

(After teaching, the check box is updated) 

Re-teaching Work Procedure 

 
Figure 13-38 Operation Flow 
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Figure 13-39 The “Tool automatic calculation” screen 

 
Select the robot (<a>) and the tool number (<b>).  
 
Move the robot which is attaching a tool. After selecting the line of “Auxiliary point” list (<c>), click a [Teach 

selection line] button (<d>). Teach a same position by 3 to 8 points with different posture.  
 
When a value is set to “Calculated tool coordinate”, a [Write] button (<e>) becomes effective. When the 

[Write] button (<e>) is clicked, the values of a tool parameter (MEXTL) are written to the robot controller.  
 
When a [Error information] button (<f>) is clicked, it is possible to check the gap from a teaching point.  
 

 
 
 

Teach the position with greatly different posture of the robot. 
If the teaching points look like each other, the tool coordinate might be not computable.  
(e.g. when only A axis is different)  

Caution 

<d>

<a> 

<b> 

<e> 

<c> 

<f>
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13.6. Servo Monitor 

This monitors servo information. 
 

Table 13-13 Supported robot 

Supported robot  
CR750/700 CR500 Simulation 

Ver.2.50C or earlier All robot All robot Not available Version 
Ver.3.00A or later All robot All robot RV-F/RH-F series 

 
The servo data items can be monitored by simulation as follows.  
 

Table 13-14 Supported servo data items by simulation 

 Items possible 
1 Position feedback ○ 
2 Position in 1 rotation × 
3 Fdt command × 
4 Position droop ○ 
5 Max. position droop ○ 
6 Position command ○ 
7 Speed command ○ 
8 Speed feedback ○ 
9 Speed MAX. ○ 
10 Current cmd ○ 
11 Current feedback ○ 
12 Max. current cmd1 ○ 
13 Max. current cmd2 ○ 
14 RMS current ○ 
15 Tolerable cmd- ○ 
16 Tolerable cmd+ ○ 
17 Axis load level ○ 
18 Max. axis load level ○ 
19 Encoder temp. × 
20 Motor power voltage × 
21 Motor power voltage (MAX) × 
22 Motor power voltage (MIN) × 
23 Regeneration level × 
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13.6.1. Position (ABS) 

Data concerning the position of each axis motor can be monitored.  
The following data can be monitored.  
 
- Position feedback 

Current motor rotation position is displayed by the pulse value of the encoder.  
- Position in 1 rotation 

Present position in one rotation of the encoder is displayed.  
(It is not displayed in the CR750/700 series controller. It always becomes 0.)  

- Fdt command 
The amount of the change of the position command between the control cycles is shown.  
(It is not displayed in the CR750/700 series controller. It always becomes 0.)  

- Position droop 
The amount of deflection at the motor rotation position to a position command is shown.  

- Max. position droop 
The maximum value of position droop after robot controller’s power supply is turned on is displayed.  
When the [Reset] button on the screen is clicked, this value is reset in 0.  

- Position command 
The command of the motor rotation position for the servo is displayed by the pulse value.  

 
Click [Reset] button to reset all Servo Monitor.  

This function can be used with Version 1.8 or later of this software. 
 

 
Figure 13-40 Servo monitor - ABS 
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13.6.2. Speed 

The following data concerting the rotational speed of each axis motor can be monitored.  
 
- Speed feedback 

A present motor speed is displayed by the unit of rpm.  
- Speed MAX.  

The maximum value of the speed feedback after robot controller’s power supply is turned on is 
displayed.  
When the [Reset] button on the screen is clicked, this value is reset in 0.  

- Speed command 
The command of the motor speed is displayed by the unit of rpm.  

 
Click [Reset] button to reset all Servo Monitor.  

This function can be used with Version 1.8 or later of this software. 
 

 
Figure 13-41 Servo monitor - Speed 
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13.6.3. Current 

Data concerning the current value of each axis motor can be monitored.  
The following data can be monitored.  
 
- Current cmd 

The current command of the motor is displayed.  
- Max. current cmd1 

The maximum value of the current command after robot controller’s power supply is turned on is 
displayed.  
When the [Reset] button on the screen is clicked, this value is reset in 0.  

- Max. current cmd2 
The maximum value of the current command for the last 2 seconds is displayed.  

- Current feedback 
A present value of the motor current is displayed.  

- Tolerable cmd-/+ 
The limitation value of the minus side and the plus side of the current command set to the motor is 
displayed.  

- RMS current 
Present RMS value of the motor current is displayed.  

 
Click [Reset] button to reset all Servo Monitor.  

This function can be used with Version 1.8 or later of this software. 
 

 
Figure 13-42 Servo monitor - Current 
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13.6.4. Load 

The load state of each axis motor and the temperature of the encoder (Only the robot that corresponds to 
the function of the encoder temperature) can be monitored.  

The following data can be monitored.  
 

- Axis load level 
A preset load ratio of each motor is displayed as an alarm level.  
The overload error occurs when this value reaches 100%.  

- Max. axis load level 
The maximum value of the axis load level after robot controller’s power supply is turned on is 
displayed.  
When the [Reset] button on the screen is clicked, this value is reset in 0.  

 
Click [Reset] button to reset all Servo Monitor. 
The encoder temperature is not displayed with the software before Version 2.00A. And the robot controller 

that corresponds to the function of the encoder temperature is as follows.  
 

Robot controller Software version of the robot controller 
CR750-D/CRnD-700 Ver.S3 or later 
CR750-Q/CRnQ-700 Ver.R3 or later 

 

 
Figure 13-43 Servo monitor - Load 
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13.6.5. Power 

The following data concerning robot controller’s main circuit power supply can be monitored.  
 
Motor power voltage 
A present power-supply voltage value is displayed.  
Motor power voltage (MAX)  
The maximum value of the motor power voltage in servo ON is displayed.  
When the [Reset] button on the screen is clicked, this value is reset in 0.   
Motor power voltage (MIN)  
The minimum value of the motor power voltage in servo ON is displayed.  
When the [Reset] button on the screen is clicked, this value is reset in 0.   
Regeneration level 
The regenerative current value of each axis is displayed as an alarm level.  
The excessive regeneration error occurs when this value reaches 100%.  
 

Click [Reset] button to reset all Servo Monitor.  
This function can be used with Version 1.8 or later of this software. 

 

 
Figure 13-44 Servo monitor - Power 
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13.7. Security function of the robot controller (Password Setup) 

It is possible to forbid to accessing the robot programs, parameters and files in the robot controller. 
The security function can be achieved by setting the password to the robot controller.  This function can be 

used with Version 2.00A or later of this software. And the software version of the robot controller which can be 
used is as follows. 
 

Table 13-15 Compliant version of this function and controller 

Robot Controller Software version of robot controller 

CR750-D/CRnD-700 series S3 

CR750-Q/CRnQ-700 series R3 

CRn-500 series not use 

 
The function that the password can be set is as follows. It is possible to setup the password to access of the 

program, parameters, and files individually. The factory default setting of "Password Setup" are off. 
 

Table 13-16 Function that access is limited. 

Type Limited functions Remarks 
・ Writing the programs. 
・ Reading the programs. 
・ Copying the programs. 
・ Renaming the programs. 
・ Deleting the programs. 
・ Writing the position data for SQ Direct.  
・ Reading the position data for SQ Direct. 
･ Deletion of all robot programs. 

 Program 

･ File Manager It is not possible to delete the file, or 
rename the file.  

・ Writing the parameters. It is possible to read the parameters 
from the robot controller. 

・ Position repair function. It is not possible to write the revision 
parameter created by “Position repair 
function” in the robot controller.  

･ Restore the origin data.  

Parameter 

･ Restoring the program information Program information is correctly 
restored though < Write the task slot# 
> error is displayed when program 
information is restored before this 
software version 1.8 or earlier. 

・ Backup 
・ Restore 

File 

・ Position repair function 

 

 
 

Use the registration, change, and the deletion of the password while connected to the robot controller. From 
the project tree, click on the menu bar [Online] → [Password Setup], or double click the target project [Online] 
→ [Maintenance] → [Password Setup]. 
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Figure 13-45 Password setup 

 
 

When the security function has been turned on in the controller, the mark  is displayed in the left of the 
button of the item to which access is forbidden. 

 
（for example：                 ） 



 

13-290  13-290 

 
13.7.1. Register the Password 

The password is registered to the robot controller. 
Click the "Register/Change" button of the item to which register the password in "Password Setup" screen. 

After inputting the password in the "Register/Change Password" screen, click the [OK] button. The input 
password is displayed by "*". 

 
Please input the password by 8 characters or more, and 32 characters or less. The character that can be 

used is as follows.  
 

Table 13-17 Character that can be used by password 

Character that can be used by password (8 characters or more, and 32 characters or less) 

Number ( from 0 to 9 ) 
Alphabet (from A to Z, and from a to z)

 
(Notes)The capital letter and the small letter of the 
alphabet are distinguished. 

 
 
 

 
Figure 13-46 Register Password  

 
 
 

 
 
 
 
 

Please note the management of the password enough.  

It becomes impossible to release the security function of the robot controller when the password is 
forgotten. Please note the management of the password enough. 

Caution 
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13.7.2. Change the Password 

The password being set in the controller is changed. 
Click the "Register/Change" button of the item to which change the password in "Password Setup" screen.  
After inputting a password set now and a new password in the "Register/Change Password" screen, click [OK] 
button. 
 

 
Figure 13-47 Change Password  

 
 

When the password is changed by "All" button, it is necessary to register the same password to all items.  
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13.7.3. Delete the Password 

The password being set in the controller is deleted. 
Click the "Delete" button of the item to which delete the password in "Password Setup" screen.  After 
inputting a password set now in the "Delete Password" screen, click [OK] button. 
 

 
Figure 13-48 Delete Password  

 
When the password is delete by "All" button, it is necessary to register the same password to all items.  
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13.8. File Manager 

You can copy, delete and rename the file in the robot controller. 
This function can be used with Version 2.20W or later of this software.  

 
Double-click [Online] -> [Maintenance] -> [File Manager] in the project tree.  

 

 
Figure 13-49Starting File Manager 

 
 

 
 

If the robot controller’s version is earlier than R3e/S3e: 
You cannot delete or rename the file without an extension. 

 
If the robot controller’s version is earlier than R3e/S3e: 

You cannot delete or rename the file of a name that is longer than 
16 characters. 

 
If the robot controller’s version is earlier than R3e/S3e: 

You cannot operate the file which '0' is attached at the head of a 
file name.  

Caution 
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When the password is registered in “program” by robot controller's 
security function, the file cannot be deleted, or cannot be renamed.  

When the password is registered in “program” by robot controller's security function, the file cannot 
be deleted, or cannot be renamed.  

○ : Enable、 × : Disable 
Item to which password of security function is 

registered. 
  

Program Parameter File 
Delete the file 
Rename the file 

× ○ ○ 

 
Please delete the password of robot controller's security function when you operate these. Please 

refer to "13.7.3 Delete the Password" for the method of deleting the password.  
The setting(register the password) and the release(delete the password) of robot controller's security 
function can be used with this software version 2.0 or later. Please refer to "Table 13-15 Compliant 
version of this function and controller" for robot controller's compliant version. 

Caution 
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13.8.1. File list display 

 
On the left and right lists, the lists are files of the displayed in the robot controller and the specified folder. 

 
(1) Setup of transmission You can select “PC->Robot” or “Robot -> PC”. 
(2) PC You can specify files in the personal computer. 
(3) Robot You can specify a robot controller that is currently connected 
(4) [Browse…] When you select [PC], you can specify any folder on the computer. 
 

 
Figure 13-50 File list display 

 
There are files which you cannot operate on this screen, such as robot programs, parameter files in the 

robot controller, etc. The file which cannot be operated is not displayed on a list. The file which cannot be 
operated on this screen is as follows. 
 

(2) PC 

(3) Robot 

(4) You can specify any 
folder on the computer. 

(1) Setup of  
transmission 
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Table 13-18 The file which cannot be operated on a file management screen, and its extension 

No. Files 
File name or 

extension  
1 Robot program files .MB4/.MB5/.prg 
2 Parameter files .PRM 

AError.log 
CError.log 
HError.log 

3 Error log files 

LError.log 
IOLogInp.log 4 I/O Log (Input/Output)  
IOLogOut.log 

5 Trap function log files(program execution log files) .trp 
6 Servo data log files 

(This file is reconstructed at the time of the power 
supply ON.) 

.sdl/.sdb 

7 Force control log file  
(This file is deleted at the time of the power supply 
OFF.) 

.fsl 

8 TTLERROR.DAT 
9 

Error record log files 
ERRORLOG.CSV 

10 Command information file COMMANDS.XML 
11 System files 

(Backup information etc.) 
.SYS 

12 Serial information file  
(This file is created at the time of backup) 

.ser 

 
 
13.8.2. Copy 

The files are copied. 
Select the transmission source file names from the list at the left, and designate the transmission 

destination folder on the right side. The multiple transmission source files can be selected at the same time 
Click [Copy] button after choosing the file to copy and setting up a transmission place. The file is copied 

after a copy confirmation message display. 
When the file of a same name exists in a transmission place, an overwrite confirmation message is 

displayed. 
 
13.8.3. Delete 

The files are deleted. 
Select the file to delete in the list. It is possible to select some files simultaneously.  All the files selected 

by a list of both right and left are deleted. Click [Delete] button after selecting some files in the lists. A 
deletion confirmation message is displayed. 

 
 
13.8.4. Rename 

The file is renamed. 
Select one file in the list. It is possible to select a file from both of the lists. Click [Rename] button, and input 

new file name in “Setup for Rename” dialog. 
 

 
Figure 13-51 Setup for Rename 
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13.9. 2D vision calibration 

This section explains 2D vision calibration function. 

13.9.1.  Summary 

(1) Summary 
2D vision calibration is the function to determine the relation between the vision sensor’s coordinate and 
the robot’s coordinate. You can have up to 8 switchable vision calibration data. 

 
Figure 13-52 Summary of 2D vision calibration 

 
This function is available from RT ToolBox2 Ver.3.20W or later. Moreover the software version of the 
controller which can use this function is as follows. 

 
Table 13-19 Supported robot controllers and model 

No. Model CR750/700 CRn-500 
1 Vertical 6-axis robot R5/S5 or later. 
2 Vertical 5-axis robot R5/S5 or later. 
3 Horizontal 4-axis robot R5/S5 or later. 

Not available. 

 
(2) System component 

The figure below shows the system component.  
Please perform the connection of the equipment before using this function, and refer to the instruction 
manual of your vision sensor. 

 

R32TB/R33TB or 

R56TB/R57TB 

PC 

Robot 

CRnD / CRnQ-700 

Q172DRCPU 

CR75x-Q / CR75x-D 

Vision sensor

Ethernet （TCP/IP） 

Windows / RT ToolBox2 

Robot controller 

 
Figure 13-533 System component of 2D vision calibration 

 
13.9.2.  Operating procedure of 2D vision calibration 

This section explains operating procedure of vision calibration 
 

(1) Starting 2D vision calibration 
Use this function while connecting with the robot controller. 

Robot’s coordinate Vision sensor’s coordinate 

Determining 
 the relation 
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Double-click the target project [Online] -> [Maintenance] -> [2D Vision Calibration] on the project tree to 
start 2D vision calibration. 

 

 
Figure 13-544 Starting 2D vision calibration 

(2) Select calibration number 
Select a tab of arbitrary number. 
The maximum number of calibration settings tab switchingly usable is 8 

 

 
Figure 13-555 Calibration number tab 

(3) Teaching points 
Click a row which you want to teach a point, to move the cursor. 
Position the tool center point at the calibration marker. 
Click [Get the robot position] button to get the current robot position.  
Then Robot.X and Robot.Y in the selected row are filled in and [Enable] checkbox is checked 
automatically. 
You cannot edit teaching points before clicking [Get the robot position] button. 
Measure the position of the calibration marker by vision sensor.  
Enter X, Y pixel coordinate position in Camera.X and Camera.Y respectively.  
For the method for getting pixel coordinate, refer to your vision sensor’s manual. 

 
Figure 13-56 Input teaching points 

 
If the combination of vision sensor’s coordinate and robot’s coordinate is wrong or teaching points are 
closely spaced, an incorrect calibration data may be calculated. 
Vision calibration needs a minimum of 4 teaching points. For accurate calibration, 9 or more points 
arranged separately are recommended.   

 
Figure 13-577 Example of 9 markers in camera vision (Image) 

 

Automatic input Manual input 
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(4) Calculate vision calibration data 

When 4 or more data on the list of [Teaching points] are enable, [Calculate after selecting 4 points or more] 
button becomes enable. Click the button to calculate vision calibration data and display the data in [Result 
homography matrix]. 

 

 
Figure 13-588 Calculating vision calibration data 

 
(5) Write to robot 

Click [write to robot] button to write the calculated vision sensor calibration data [VSCALBn] (“n” is 
calibration number) to robot controller.  
As shown in the figure below, the value of the calculation result of the calibration are displayed at the top, 
the now setting value in the controller are displayed at the bottom for confirmation. 

 
Figure 13-599 Writing to robot 

 
(6) Saving a file 

Click [Save] button or [Save as ...] button to save teaching points and the calculated result as a camera 
calibration coordinate file.  An extension of camera calibration coordinate file is “ccc”. 
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(7) Other function 
・Move robot to selected point 

 
Click [Move robot to selection point] button to move robot to the position selected on the list of [Teaching 
points].  
Select trajectory from Mov (Joint interpolation movement) and MVS (Linear interpolation movement). 
You can specify offset (unit [mm]) in the tool coordinate system. For example, when Z direction of offset is 
specified “-50”, the robot moves to the position which is shifted 50mm toward Z direction in the tool 
coordinate from teaching point.  
Note that the orientation of tool coordinate system differs between vertical robots and horizontal robots. 

 

 
Figure 13-60 Move the robot to selected point 

 
 
13.9.3.  2D vision calibration screen 

This section explains each button on 2D vision calibration screen.  

 
Figure 13-61 2D vision calibration screen 

The robot may operate at 100% speed. Watch out for the 
safety around the robot. 

Also, prepare a T/B at hand and use the robot in a status in 
which an emergency stop can be made at any time. 

Danger 

（2） （3） 

（4） （5） （8） （9）

（10） （11） 

（1） 

（6） （7）

Check to be used for calculation. 
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(1) New 

Add new 2D vision calibration settings. 
The current settings displayed on the screen are removed. 
 

(2) Open… 
Load a Camera calibration coordinate file saved on your PC. 
The current settings displayed on the screen are removed. 
 

(3) Save / Save as … 
Save the current calibration settings as a Camera calibration coordinate file. 

 
(4) Get the robot position 

Get the current robot position (XYZ coordinate). 
 

(5) Calculate after selecting 4 points or more 
Calculate the calibration data using teaching points whose [Enable] checkboxes are checked. 
The calculated result is displayed in [Result homography matrix]. 

 

(6)  
Move the selecting cursor.  
 

(7)  
Delete a row selected on the list of [Teaching points]. 

 
(8) Write to robot 

Write the value of [Result homography matrix] to the robot controller. 
The current value of calibration data on the robot controller is displayed in [Current homography matrix]. 

 
(9) Move robot to selection point 

Display [Move robot to selection point] screen for a selected row on the list of [Teaching points].  
.  

(10) Mov 
Move the robot to specified position with joint interpolation. 

 
(11) Mvs 

Move the robot to specified position with linear interpolation. 
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14.  Option Card  
You can check information on option cards mounted in the robot controller. 
 
When you open [Option Card] on the project tree, the slots in which option cards are currently mounted and 

the option card names are displayed. If you place the mouse cursor on an option card name, the information 
for that option card is displayed. 

If no option card is mounted on the robot controller, nothing is displayed. 
 

 
Figure 14-1 Option Card Information 
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15.  Backup and Restore 
 

You can back up information in a robot controller to the computer. 
You can also restore backup information saved to the computer back into a robot controller. 
 

Backup 

(Robot -> Personal computer) 

Saves the backup data on the robot controller to the personal 

computer. 

Restore 

(Personal computer -> Robot) 

Transfers the backup data saved on the personal computer to the 

robot controller. 
 

 

 
 

 

Precautions when executing a backup/restore operation during the 
replacement of a controller (CPU) that supports Maintenance 
Forecast 

 

When executing a backup/restore operation during the replacement of a controller (CPU) 
that supports Maintenance Forecast, also perform the backup/restore operation using the 
Maintenance Forecast tool. 

 
After a backup operation is performed on a controller that supports Maintenance Forecast, the 

following message is displayed: 

 
Figure 15-1 Backup When Maintenance Forecasting Information Is Enabled 

 
* When using a CRn-500 series robot controller, maintenance forecasting is supported for software

versions J2 and later. 

 

  
   

  

   Caution 

Please do not pull out the cable while communicating.  
 

Please never pull out the cable while communicating with the robot controller. If the 
communication cable is removed while communicating, the status of the robot controller or the 
personal computer might become abnormal. Please remove the cable when the status is not 
“Online” or this software exited. 

Also when communicating by using the USB, 
please do not pull out the USB cable  
  until the communication is completed. 

Caution 
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When the password is registered in “file” by robot controller's security 
function, it is not possible to back up information in a robot controller to the 
personal computer, or to restore backup information saved to the computer 
back into a robot controller.  

 

When the password is registered in “file" by robot controller's security function, it is not possible 
to back up the information in the robot controller to the personal computer or to restore backup 
information saved to the computer back into a robot controller. 

○ : Enable, × : Disable 
Item to which password of security function is registered.   

Program Prameter File 

All files ○ ○ × 

Program ○ ○ × 

Parameter files ○ ○ × 

backup 

System program ○ ○ × 

All files ○ ○ × 

Program ○ ○ × 

Parameter files ○ ○ × 

R
estore 

System program ○ ○ × 

 
Please delete the password of robot controller's security function when you operate these. 

Please refer to "13.7.3 Delete the Password" for the method of deleting the password.  
The setting (register the password) and the release (delete the password) of robot controller's 

security function can be used with this software version 2.0 or later. Please refer to "Table 13-15 
Compliant version of this function and controller" for robot controller's compliant version. 

Caution 
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15.1. Backup(Robot -> PC) 

You can save information in a robot controller to a file in the computer. 
Use the backup function while RT ToolBox2 connected to the robot controller.  

 
There are two methods for saving data as follows. 
<1> Saving data from one robot controller. 
<2> Saving data by batch processing from all robot controllers which connected with this software. 

(Note that this function can be used with Version 1.3 or later of this software.) 
 

 
 

 
 
 

Cautions when backup is interrupted 
 

Backup again when the communication fault occurs while backing up or the backup is interrupted 
clicking the “cancel” button. 

 
"[NG]" is added to the head of folder name when the backup is interrupted. Do not restore the 

backup folder because the folder’s information is imperfect. There is a possibility that the controller 
doesn't start when restoring is continued. When you select the folder whose name has “[NG]” when 
restoring, the warning dialog as follows is displayed. Select “No” normally. 

This function is available from RT ToolBox2 Ver.1.3.1 or later. 
 

 

Caution 

Cautions for backups 
 

When backing up system status variable values and program external variable values, switch the 
robot controller power Off, then On again, then perform the backup operations. 

 
The files BKUP.SYS and MECHA.SYS are automatically created in the specified folder. These files 

record the saved robot controller mechanical information and save format. Be careful.  If you delete 
or rewrite these files, this may make it impossible to restore them to the robot controller. 

 
The objective of backup data is to back up robot controller information. However, with this software 

version 1.2 or later, it is possible to open a backed up program with program editor. Please refer to 
"8.2.4 Opening a program in the backup data" in this manual for details. 

Caution 
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15.1.1. Saving data from one robot controller 

 
(1) From the project tree, open the target project [Backup]. In the backup tree, "All file", "Program information", 

"Parameter files", and "System program" are displayed. 
 

 
Figure 15-2 Backup Project Tree Diagram 

 
All Files Saves all files (robot program, parameter files, etc.) in the robot controller into 

the designated folder. 
Program Saves the robot program file into the designated folder. 
Parameter Files Saves the parameter files into the designated folder. 
System Program Saves the system base program file into the designated folder. 

 
(2) Double click the items to backup. 

 
Figure 15-3 Backup (When Batch Is Selected) 

 
[Parameter List Files] : This is used to edit the parameter information saved by backup in offline 

mode, and is not required for backup. If this is not checked, the time 
required to save all files will be shortened. 

 
(3) Specify the backup destination. The default value is the folder that created the workspace/project 

name/Backup/today's date and time. 
You can change the backup destination folder with the […] button at the right of the displayed backup 

destination. 
 

You can back up other items at the same time too by putting checkmarks in their checkboxes. In this case, 
the data is backed up to the selected backup destination, with the identifier by the backup type is added to 
the folder name. The identifiers are as follows. 
  All…ALL   Program information…PRG   Parameter information…PRM   System program…SYS 

Double click 
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The folder name at this time is displayed on the right side of the respective backup items. 

 
Figure 15-4 Backup (When Multiple Selected) 

 
(4) Specify the back destination, then click the [OK] button. 

The confirmation screen is displayed. When you confirm, then click [Yes], the backup is started. 

 
Figure 15-5 Backup Confirmation Screen 

 
When the backup is completed, the backup data is displayed at [Backup] on the project tree. 

 
Figure 15-6 Display of Backup Information 

 



 

15-308  15-308 

 
15.1.2. Saving data from all robot controllers(Online Project Backup) 

It is possible to save data by batch processing from all robot controllers which connected with RT ToolBox2. 
This function can be used with Version 1.3 or later of this software. 
 

(1) After selecting the name of workspace, click the right button of mouse. Or, after selecting the "Backup" of 
the project that is online, click the right button of mouse. Select "Online project backup" in the right 
mouse button menu. The screen to select the item of backup is displayed. 

 
Figure 15-7 Online Project Backup 

 
 

(2) Select the item of backup in "Backup" group. Input a folder name of the backup destination to "Folder 
Name", and click [OK] button. 
The input folder name is added to "Backup" of each project. 
 
The confirmation screen of the backup is displayed. After confirming, click [Yes] button. Then the 
communications for saving data is begun. 

 

 
Figure 15-8 Confirmation screen of "online project backup" 
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(3) When the batch processing for saving data from all robot controllers is completed, the saving data is 

displayed in [Backup] of the project tree. 

 
 

Figure 15-9 The information of saving data from all robot controllers by batch processing. 
 

 

Backup data 
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15.2. Restore (PC -> Robot)  

You can take information back up to the computer and transfer it to robot controller information. 
Use the restore function while connected to the robot controller.  

 
 

(1) From the project tree, open the target project [Backup]. In the backup tree, the information back up for "All 
file", "Program information", "Parameter files", and "System program", respectively, is displayed. 

 
Figure 15-10 Backup Project Tree Diagram 

 
(2) Select the information listed on the controller, then click the right mouse button. From the right mouse 

button menu, select [Restore]. 

 
Figure 15-11 Restore 

All Files : Transfers all files (except BKUP.SYS and MECHA.SYS) in the designated 
folder to the robot controller after all information in the robot controller is cleared 
(initialized). 

Program : Transfers the robot program file in the designated folder to the robot controller. 
Parameter Files : Transfers the parameter file in the designated folder to the robot controller. 
System Program : Transfers the system base program file in the designated folder to the robot 

controller. 
Change Robot Origin 
Data 

: This is backup information and it only valid when All or Parameter files is 
selected.  Operations for when this checkbox is checked and when it is not are 
as in "Table 15-1 ". 

Change Robot Arm 
Serial Number 

: If you check this checkbox, the robot main unit serial number is also rewritten. 

Restore the file 
manager’s data 

: If you check this checkbox, the data treated with file manager (refer chapter 
13.8) is also restored. This function can be used with Version 3.00A or later of 
this software. 

 

Caution of when data backed up by selecting "All files" 
 is individually restored. 

In version 1.2 or later of this software, it is possible to restore the each item (Program, Parameter 
files and System program) of data backed up by selecting "All files". 
At this time, the data files of the specified item are transferred to the robot controller, without making 
all information in the robot controller cleared (initialized). 

Caution 
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Table 15-1 Operations for "Change Robot Arm Serial Number Too" 

Controller  
Check ON 

 

Check OFF 

 

CR750/ 
700  

series 
 

or 
 

CRｎ-500 
series 

J2 edition 
or later 

 
 

Restore 
files 

<after restore>

controller 

 

 Origin data(A) 

 parameters for 
position repair (A) 

 Parameters(A) 

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B)

 Parameters(B)

controller

 

 Origin data(B)

 parameters for 
position repair (B)

 Parameters(B)

<before restore> 

An initial value will be used if the file to
be restored does not have any 
revision parameter for position repair.

Transfers a backed up file as is. The origin 
data is replaced. 

 

 
 

Restore 
files 

<after restore>

controller

 

 Origind ata(A)

 

 Parameters(A)

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B) 

 Parameters(B) 

controller 

 

 Origin data(A)

 parameters for 
position repair (A)

 Parameters(B)

<before restore>

parameters for 
position repair (A)

 
 
 

A backed up file is transferred. However, as  
for the origin data and the parameters for 
recovering positions, the information inside the 
controller is retained. 

CRｎ-500 
series 

H7 edition 
or earlier 

 

<after restore>

controller 

 

 Origin data (A) 

 Parameters(A) 

controller 

 

 Origin data (B)

 

 Parame ters(B)

<before restore> 

Revision parameters for position 
repair will not be written 

Restore 
files 

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B)

 Parameters(B) 

Transfers a backed up file as is.  The origin 
data is replaced. 

 

Restore 
files 

<after restore>

controller 

 

 Origin data(A)

 Parameters(A)

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B) 

 Parameters(B) 

controller 

 

 Origin data(B)

 

 Parameters(B)

<before restore>

Revision parameters for position 
repair will not be written. 

A backed up file is transferred.  However, as 
for the origin data, the information inside the 
controller is retained. 

 
 

Be careful.  If communication is cancelled during a series of restore processing, the position revision 
parameters generated with the "Position repair" function and the origin data may be changed. 
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Do not restore the backup information whose name has “[NG]” 
 

Do not restore the backup information whose name has “[NG]” because the folder’s information is 
imperfect. 

 
"[NG]" is added to the folder name when the communication fault occurs while backing up or the 

backup is interrupted clicking the “cancel” button. Do not restore the backup folder because the 
folder’s information is imperfect. There is a possibility that the controller doesn't start when restoring 
is continued. When you select the folder whose name has “[NG]” when restoring, the warning dialog 
as follows is displayed. Select “No” normally. 

This function is available from RT ToolBox2 Ver.1.3.1 or later. 
 

 

Caution 

Precaution for Restore 
 

If a batch restoration or a program restoration is executed when the program is being started, the 
program will automatically be stopped. 

At this time, if there is an error in the controller, 
 the program in operation cannot be stopped, and 
 the message shown on the right will be displayed. 

Although a restoration process can be executed even 
 in such a case, the program currently selected or the 
 program that is started by ALWAYS cannot be re-written. 
 If it is possible to remove the cause of the error, 
 reset the error and execute the restoration process again. 

Caution 
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15.3. Deleting Backup Data 

You can delete the backed up information. 
Select the information to delete, then click the right mouse button. From the right mouse button menu, select 
[Delete]. 
 

 
Figure 15-12 Deleting Backup Data 

 
It is also possible to delete all the backup data.   
Right click [Backup] for the target project.  From the right mouse button, click "Delete All". 
 

 
Figure 15-13 Deleting All the Backup Data 

 

 
 
 

Be aware that once backup data is deleted, you can not restore it. 

Caution 
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16. Tool function 
 

16.1. Force control log file viewer 

Force control log file viewer is the function to display the graph of log data of force control in PC and robot 
controllers. 
From the project tree, double-click the target project [Tool] -> [Force control log file viewer]. 
 

 
Figure 16-1 Force control log file viewer 

 
This screen can be used when connected with a machine compliant with the force control function. 
For details, refer to the user’s manual containing complete description of the force control function. 

Double-click. 
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16.2. User definition screen 

It is possible to edit the user definition screen which can be operated by highly efficient T/B.  
You can make the customized screen by arranging the parts such as the button and the lamp that 

synchronize with the I/O signal. You can make two or more pages of definition screens. These pages are 
managed by a file (called “User definition screen file”) as one group. It is possible to create two or more user 
definition screen files. 

 
You can make the customized screen on T/B by arranging the parts such as the button and the lamp that 

synchronize with the I/O signal. You can make two or more pages of definition screens. 
 

 
 

This screen can be used by the following usages. 
- This screen is used as an operation monitor. 
- When the state of T/B is enabling, the peripheral devices such as conveyers is made to work by the 

button on the screen. 
 
T/B which you can use an user definition screen, and its software version are as follows. 
 

Table 16-1 T/B which you can use an user definition screen, and its software version 

T/B Software version of T/B 
R56TB Version 2.2 or later 
R57TB Version 2.2 or later 

 
 
This function can be used with Version 2.20W or later of this software. 
 
Parts that can be displayed on the user definition screen are as follows. 
 

List 16-2 List of parts 

 Parts Explanation 
1 Button The signal can be output from the robot controller by clicking 

the button. 
The signal can be output only in T/B Enabling state. 

2 Lamp The lamp can be turning on/off by the state of the I/O signal. 
Variable The value of the specified variable can be displayed. 
Exe lines The executing program lines can be displayed. 
Program name The executing program name can be displayed. 
Exe line num. The executing line number of the program can be displayed. 
Cur pos Current positional data of the XYZ coordinate system can be 

displayed. 

3 Robot 
information 

Cur jnt Current positional data of the joint coordinate system can be 
displayed. 

4 Label The character string can be displayed. 
 

User definition screen file 
 (ｙｙｙｙｙ.uds) 

 

Editing User definition screen

User definition screen

User definition screen file 
(xxxxx.uds) 

User definition screen 
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16.2.1. Creating a new User definition screen file 

In order to create an user definition screen, it is necessary to create an user definition screen file.  
After selecting [Tool]->[User definition screen] in the project tree, click the right button of mouse and select 

the "New” of right button menu. Click [OK] button after inputting a new file name. The user definition screen file 
created newly is added to the bottom row of [user definition screen].  

 

 
Figure 16-2 Creating a new User definition screen file 

 
 

 
 
 

About User definition screen files 

It is possible to create a user definition screen file name freely. But a user definition screen file is 
used as folder names in Windows, so you can not use characters that can not be used in Windows 
folders names ( \ / : * ? “ < > | ). 

An error occurs when the inputted user definition screen file already exists.  
 

About the extension of an user definition screen file 

The extension of the user definition screen file is “.uds”. When an extension is omitted, or when 
the wrong extension is inputted, .uds extension is attached automatically. 

Caution 
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16.2.2. Editing the page of user definition screen 

Double-click [Tool] -> [User definition screen] -> [“User definition screen file”]->[“Page name”] in the project 
tree. The edit dialog of an user definition screen is displayed. 

 
When you create a new user definition screen, after selecting [Tool]->[User definition screen] -> [“User 

definition screen file”]-in the project tree, click the right button of mouse and select the "New” of right button 
menu. A new “User definition screen” is displayed.  

 

 
Figure 16-3 Editing the existing user definition screen 

 
 

 
Figure 16-4 creating a new user definition screen 
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The grid line (<a>) is displayed in the edit display of the user definition screen.  Each part can be registered 
with the block unit (<b>) delimited in this grid line. 

 

 
 

<1> Name : Page name is set. The name can be input by [Edit] button. 
<2> Line : The ruled line is drawn on "User definition screen". 
<3> Save : The content of the edit is preserved. 
 

<a>
<b> 

<1> <2> <3> 
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16.2.2.1. Button 

(1) Click the position (block) in which the button is made (<a>). Left side of the button is arranged in this 
position. 

(2) After "Select item" window is displayed, click [Button] button (<b>). 
(3) Set the button name, button size and the kind of button on "Create button" windows. 
(4) The movement of when the button is clicked is set by [Set] button (<c>).  The set content is displayed 

in "Movement setting" (<d>). 
(5) After the setting is completed, click [OK] button (<e>). 

 

 
 
 

<1> Name : The name of the button is set.   
The button name can be input by [Button name edit] button. 
The button name can be displayed by two lines by checking "2 lines". 

<2> Size : The width of the button can be set. 
The width of the button that can be set is 1/2/3. 

 

<3> Button type : The kind of the button can be set.  
Alternate When the button is clicked once, the button keeps ON state. And 

when the button is clicked again, it returns to OFF state. 
The signal output is kept too. 

Momentary The button keeps ON state while it is being pushed. 
 

<a>

<b> 

<1> 

<2> 

<3> 

<4> 

<e>

<c>

<d>
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<4> Movement setting : The condition and the signal output operation when the button ON can be set. 
 
The condition can be selected as follows. Please set the signal number etc. when 
you make the signal state the condition. When the button is ON or OFF, the 
condition is judged. 

- Unconditionally 
- State of the specified Input signal 
- State of the specified output signal 

 
The signal output operation can be selected as follows. Please set the signal 
number etc. when you output the signal. 

- Done nothing 
- Output the specified output signal 

 
Operation setting can be set up to two. 
Two operation settings operate individually by using each condition. 
Moreover, when High and Low are set to output to the same signal, and both 
conditions become true, the Condition2 is given priority. 
If the operation is set signal output, when the button is OFF, the signal is output in 
the state opposite High/Low state at the time of ON. 

 
 
Example of setting the movement of button 

For example:  
The button that output signal number 20 to High when input signal number 20 is High. 

(1) A default value of “Button operating condition” 
window is shown in a right picture. 

 

 
 

(2) Set the condition of operation. 
Click <d>, and select the signal type. 
When things except "Unconditionally" are 
selected, the input area of signal number and 
the combo box to select the state are displayed.
Now, select "input signal". 

 

 
 

<d>
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(3) Input "20" to signal number (<f>). 
Click the state of the signal (<g>), and select 
"High".  
Now, select "Input signal". 

 

 
(4) Select "High" as signal operation of when 

clicking on a button (<h>). 
 

(5) The input area of output signal number is 
displayed.  
Input "20" to the signal number (<i>).  

 
(6) After the setting is completed, click [OK] button 

(<k>). 
 

 
  

 
 
 
 

<i> 

<k>

<h>

<f> 

<g>
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16.2.2.2. Lamp 

(1) Click the position (block) in which the lamp is made (<a>).  The lamp is arranged at this position. 
(2) After “Select item” window is displayed, click [Lamp] button (<b>). 
(3) Select the lighting color of the lamp on “Create lamp” window. 
(4) Click [On/Off condition] button (<c>), and set the lighting condition and the turning off condition on 

"The lamp on/off condition” window.  
After setting the lighting condition and the turning off condition, click [OK] button (<f>).  The set 
content is displayed (<d>) in the right of the [On/Off condition] button. 

(5) After setting the lamp color and lighting condition and the turning off condition, click [OK] button 
(<g>). 

 

 
 

<1> Lamp color : The lighting color of the lamp can be selected. 
<2> Setting : The condition of turning on / turning off the lamp can be set. 

If only one condition is set, the lamp is operated like the other condition is set the 
opposite High/Low state to the same signal number. 
Moreover, when both the ON condition and the OFF condition are true, the ON condition 
is given priority. 

 

<a> 

<b>

<1> 

<2> 

<g> 

<f> 

<c> 

<d>
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Example of setting lamp ON/OFF 

For example: 
Lamp that is turned on when the input signal number 20 is High, and is turned off when the input signal 

number 20 is Low.  
(1) A default value of “The Lamp on/off 

condition” window is shown in a right 
picture. 

 

 
 

(2) Set “On condition”.  
Click <h>, and Select the signal type. 
Now, select “input signal”.  
 

 

 
 

(3) Input “20” to signal number (<i>). 
 

 

 
(4) Select "High" (<k>), as a state of 

signal to light the lamp. 

 
 

(5) Similarly, set the condition for turning 
off the lamp, and click [OK] button (<l>).

 

 

<h>

<i>

<k> 

<l>
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16.2.2.3. Variable 

The value of the specified variable is displayed. 
 
(1) Click the position (block) in which the variable is displayed (<a>).  Left side of the variable is arranged in 

this position. 
(2) After "Select item" window is displayed, click [Robot information] button (<b>). 
(3) Select "variable" (<c>) as the type on “Create robot information” window. 
(4) After setting the information of the variable, click [OK] button (<d>). 

 
 

<1> Size : Set the width of box in which the variable is displayed. The value from 1 to 16 
can be set. 

<2> Slot : Select task slot number for which the variable is used. 
The range of slot number that can be set is different according to the system 
that uses it. 

<3> Name : Set the variable name. Robot Status Variable also can be set. 
<4> Variable type : Select the variable type. 
<5> Edit : Select the edit permission of the variable. 

When set Enable, while displaying this screen, you can change the value of 
this variable by touching this parts and displaying the input value screen. 
(Only at T/B state is enabling.) 

<6> Arrangement : Select the position in which the variable is arranged. 
<7> Color : Select the background color of the area where the variable is displayed. 

<a>

<b>

<1> 

<c> 

<d> 

<2> 

<3> 

<4> 

<5> 

<6> 

<7> 
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16.2.2.4. Program execution content 

The content of the program being executed is displayed. The amount of 7 lines, the execution line, upper 3 
lines and lower 3 lines, are displayed. 
 
(1) Click the position (block) in which the content of the program is displayed (<a>).  Left side of the content 

of the program is arranged in this position. 
(2) After "Select item" window is displayed, click [Robot information] button (<b>). 
(3) Select "Exe line" (<c>) as the type on “Create robot information” window. 
(4) After setting the information on the content of the program, click [OK] button (<d>). 
 

 
 

<1> Size : Set the width of box in which the content of program is displayed. The value 
from 1 to 16 can be set. 

<2> Slot : Select task slot number for which the program is executed. 
The range of slot number that can be set is different according to the system 
that uses it. 

<3> Color : Select the background color of the area where the content of program is 
displayed. 

<a> <b>

<1> 

<c> 

<d> 

<2> 

<3> 

When User definition screen (TB) is shown 
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16.2.2.5. Program name 

The name of program being executed is displayed. 
 
(1) Click the position (block) in which program name is displayed (<a>). Left side of the box is arranged in this 

position. 
(2) After "Select item" window is displayed, click [Robot information] button (<b>). 
(3) Select "Program name" (<c>) as the type on “Create robot information” window. 
(4) After setting the information of program name, click [OK] button (<d>). 
 

 
 

<1> Size : Set the width of box in which program name is displayed. The value from 1 
to 16 can be set. 

<2> Slot : Select task slot number for which the program is executed. 
The range of slot number that can be set is different according to the 
system that uses it. 

<3> Arrangement : Select the position in which the program name is arranged. 
<4> Color : Select the background color of the area where the program name is 

displayed.  

<a>

<b>

<1> 

<c>

<d> 

<2> 

<4> 

<3> 

When User definition screen (TB) is shown 
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16.2.2.6. Execution line number of program 

The line number of program being executed is displayed. 
 
(1) Click the position (block) in which execution line number is displayed (<a>). Left side of the box is 

arranged in this position. 
(2) After "Select item" window is displayed, click [Robot information] button (<b>). 
(3) Select "Exe line num" (<c>) as the type on “Create robot information” window. 
(4) After setting the information of execution line number, click [OK] button (<d>). 
 

 
 

<1> Size : Set the width of box in which execution line number is displayed. The value 
from 1 to 16 can be set. 

<2> Slot : Select task slot number for which the program is executed. 
The range of slot number that can be set is different according to the system 
that uses it. 

<3> Arrangement : Select the position in which execution line number is arranged. 
<4> Color : Select the background color of the area where execution line number is 

displayed. 

<a> <b>

<c>

<d> 

<1> 

<2> 

<4> 

<3> 

When User definition screen (TB) is shown 
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16.2.2.7. Current position data (the XYZ coordinate system) 

The current position data of robot is displayed with each XYZ coordinate system axis. 
If you want to display the current position data (the XYZ coordinate system) all together, please use 

“Variable” type and set the Robot Status Variable “P_CURR”. Please refer to “16.2.2.3 Variable" for details. 
 
(1) Click the position (block) in which the current position data is displayed (<a>). Left side of the box is 

arranged in this position. 
(2) After "Select item" window is displayed, click [Robot information] button (<b>). 
(3) Select "Cur pos" (<c>) as the type on “Create robot information” window. 
(4) After setting the information of the current position data (the XYZ coordinate system), click [OK] button 

(<d>). 

 
 

<1> Size : Set the width of box in which the current position data (the XYZ coordinate 
system) is displayed. The value from 1 to 16 can be set. 

<2> axis : Select the displayed axis of the current position data (the XYZ coordinate 
system). 

<3> Robot # : Select the robot number which displays the current position data. 
<4> Arrangement : Select the position in which the current position data (the XYZ coordinate 

system) is arranged. 
<5> Color : Select the background color of the area where the current position data (the 

XYZ coordinate system) is displayed. 

<a> 

<b>

<c> 

<d> 

<1> 

<2> 

<5> 

<4> 

<3> 

When User definition screen (TB) is shown 
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16.2.2.8. Current position data (the joint coordinate system) 

The current position data of robot is displayed with each joint coordinate system axis. 
If you want to display the current position data (the joint coordinate system) all together, please use 

"Variable" type and set the Robot Status Variable "J_CURR". Please refer to "16.2.2.3 Variable" for details. 
 
(1) Click the position (block) in which the current position data is displayed (<a>). Left side of the box is 

arranged in this position. 
(2) After "Select item" window is displayed, click [Robot information] button (<b>). 
(3) Select "Cur jnt" (<c>) as the type on “Create robot information” window. 
(4) After setting the information of the current position data (the joint coordinate system), click [OK] button 

(<d>). 

 
 

<1> Size : Set the width of box in which the current position data (the joint coordinate 
system) is displayed. The value from 1 to 16 can be set. 

<2> axis : Select the displayed axis of the current position data (the joint coordinate 
system). 

<3> Robot # : Select the robot number which displays the current position data. 
<4> Arrangement : Select the position in which the current position data (the joint coordinate 

system) is arranged. 
<5> Color : Select the background color of the area where the current position data (the 

joint coordinate system) is displayed. 

<a>

<b>

<c>

<d> 

<1> 

<2> 

<5> 

<4> 

<3> 
When User definition screen (TB) is shown 
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16.2.2.9. Label 

The label can be displayed at the specified position. 
 

(1) Click the position (block) in which the label is made (<a>).  The label is arranged in this position. 
(2) After "Select item" window is displayed, click [Label] button (<b>). 
(3) After setting the label on “Create label” window, click [OK] button (<c>). T 
 

 
 

<a> 

<b>

<c> 
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16.2.2.10. Save and end of editing user definition screen 

After the editing of user definition screen is completed, click [Save] button (<a>). 
To end the edit, click [x] (<b>). 

 
 
16.2.3. Edit of existing parts 

Edit of existing parts is as follows: 
(1) Click a part which is edited (<a>). 
(2) After "Edit menu" window is displayed, Click [Edit] button (<b>). 
(3) The edit displays of selected parts are displayed. After changing contents, click [OK] button (<c>). 

 

 
 
 

<a> 

<b>

<c>

<a> 

<b> 
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16.2.4. Copy/Paste of parts 

Parts can be copied. 
 

(1) Click the part to copy, and select it (<a>). 
(2) After "Edit menu" window is displayed, click [Copy] button (<b>).  
(3) Click the position (block) where the part is copied onto (<c>). 
(4) After "Select item" window is displayed, click [Paste] button (<d>). 

At this time, the position (block) where the part is copied onto is green. 

 
 
 

<a> 

<b>

<c> 

When you click a click [Paste] button,  
a copy confirmation massage is displayed. 

<d>
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16.2.5. Movement of parts 

Parts can be moved. 
  

(1) Click the part to move, and select it (<a>). 
(2) After "Edit menu" window is displayed, click [Move] button (<b>).   
(3) Click the position (block) where the part is moved to. 

At this time, the current position (block) of part is red, and the position (block) where the part is moved 
onto is green. 
 

 
 
 

<a> 

<b>

<c> 

When you click a move destination place,  
a move confirmation massage is displayed. 
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16.2.6. Deletion of parts 

Parts can be deleted. 
 

(1) Click the part to delete, and select it (<a>). 
(2) After "Edit menu" window is displayed, click [Delete] button (<b>). 
(3) Click [Yes] button on the confirmation message. 
 

 
 
 
16.2.7. Change of page name 

Page name can be changed by inputting in <a> under the left of the window. 

 

 
 
 

<a> 

<b>

<a>

 
When page name that has already been registered is input, it becomes an error. 

Caution 
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16.2.8. Edit of ruled line 

The ruled line can be drawn on the user definition screen. 
 
16.2.8.1. Drawing the ruled line 

(1) Click [Line] button (<a>) on the window. 
(2) The button (“[Top],[Bottom],[Left],[Right]”) (<b>) for the ruled line is displayed in the right of [Line] button. 

These buttons to draw the ruled line disappear when [Line] button (<c>) is clicked again. 
 

 
(3) Select the kind of ruled line (<d>). Only one kind of the ruled line can be selected.  

 
(4) Click the block (<e>) where the ruled line is drawn. The ruled line of the specified position on the selected 

block can be drawn. 

 
(5) After editing the ruled line, click [Line] button (<f>) again. 
 
 

<d>

<e>

<f>

<a>

<b><c> 
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16.2.8.2. Erasing the ruled line 

(1) Click [Line] button (<a>) on the window. 
(2) The button (“[Top],[Bottom],[Left],[Right]”) (<b>) for the ruled line is displayed in the right of [Line] button. 

These buttons to draw the ruled line disappear when [Line] button (<c>) is clicked again. 

 
(3) Select the kind of ruled line (<d>). Only one kind of the ruled line can be selected. 

 
(4) Click the block (<e>) where the ruled line is erased. The ruled line of the specified position on the selected 

block can be erased. 

 
(5) After editing the ruled line, click [Line] button (<f>) again. 
 

<d>

<e> 

<f> 

<a>

<b><c>
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16.2.9. Deletion of user definition screen 

It is possible to delete the existing "User definition screen". 
There are two methods in deletion of an user definition screen. 
 
(1) Deleting the user definition files. In this case, all the user definition screens in a user definition screen file 

are deleted. 
(2) The selected user definition screen from the inside of a user definition screen file is deleted. 
 
However, the user definition screen during editing cannot be deleted.  

 
 
 
16.2.9.1. Deletion of user definition screen file  

All the user definition screens in a user definition screen file are deleted. 
 
After selecting [Tool]->[User definition screen]->[“User definition screen file”] in the project tree, click the 

right button of mouse and select the "Delete” of right button menu. A confirmation message is displayed, click 
[OK] button. All of the selected user definition screen file and the user definition screen in it are deleted. 
 

The user definition screen during editing cannot be deleted. 
 

 
Figure 16-5 Deletion of user definition screen file 

 

All the user definition screens (in this case, 
Page1 to Page6) in an "Panel_ 01.uds" file 
and the file are deleted. 
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16.2.9.2. Deletion of page  

The selected user definition screen page in the user definition screen file is deleted . 
 
After selecting [Tool]->[User definition screen]->[“User definition screen file”]->[“User definition screen 

page”] in the project tree, click the right button of mouse and select the "Delete” of right button menu. A 
confirmation message is displayed, click [OK] button. The selected user definition screen page is deleted. 

 
The user definition screen during editing cannot be deleted. 

 
 

 
Figure 16-6 Deletion of page 
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16.2.10. Import of the user definition screen 

It is possible to import the user definition screen file created in other work space and projects. 
There are two methods for import. 
 
(1) Importing the user definition screen files. 

In this case, all the pages in the user definition screen files are imported. 
(2) Importing the selected pages in the user definition screen file. 
 
 

 
16.2.10.1. Importing the user definition screen files. 

All the pages in the user definition screen files are imported. 
 
After selecting [Tool]->[User definition screen]-in the project tree, click the right button of mouse and select 

the "Import” of right button menu. “Select import user definition screen file” screen is displayed. After selecting 
the importing files, Click the [OK] button. The selected user definition screen file and all the pages in the file 
are imported to the current project. Two or more user definition screen files can be imported simultaneously. 
When the same name file is existing in the project, the confirmation message of overwrite is displayed. 

 

 
Figure 16-7 Importing the user definition screen files 

 

The default folder when starting this software is "My 
Documents". During this software starting, it is the 
folder which performed the last import. After ending 
this software, it returns to a "My Documents." 
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16.2.10.2. Importing the page of the user definition screen 

Importing the selected pages in the user definition screen file. 
 
After selecting [Tool]->[User definition screen]->[“User definition screen file”] in the project tree, click the 

right button of mouse and select the "Import” of right button menu. “Select import user definition screen file” 
screen is displayed. After selecting the importing files, click [OK] button. “Select import user definition screen” 
screen is displayed, and all the pages in the selected file are displayed. After selecting the importing pages, 
click [OK] button. The selected the pages in the file are imported to the current project. Two or more pages can 
be imported simultaneously. The imported pages are added to the lowest row. 
 

 
Figure 16-8  Importing the page of the user definition screen 

 
When the same name file is existing in the project, the confirmation message of overwrite is displayed. 
When you click the “Overwrite” button, all the pages in the file will replace.The page name can be changed 

and imported. 
 

The default folder when starting this software 
is "My Documents". During this software 
starting, it is the folder which performed the 
last import. After ending this software, it 
returns to a "My Documents." 
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16.2.11. Export of the user definition screen 

It is possible to export the user definition files in the current project so that it can be used in other project. 
The user definition screen is exported by a file 
 
After selecting [Tool]->[User definition screen] in the project tree, click the right button of mouse and select 

the "Export” of right button menu. “Select export user definition screen file” screen is displayed. After setting 
the export path and selecting exporting file, click [OK] button. The selected user definition screen file is copied 
in "export path" folder. Two or more pages can be exported simultaneously. 

 

 
Figure 16-9 Export of the user definition screen 

 
 
When the same name file is existing in the "export path" folder, the confirmation message is displayed. 
When you click the “Overwrite” button, all the pages in the file will replace. The page name can be changed 

and exported.  
 

 
Figure 16-10 Export of the user definition screen- confirmation message 

 
 

The default folder when starting this software is "My 
Documents". During this software starting, it is the 
folder which performed the last export. After ending 
this software, it returns to a "My Documents." 
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16.3. Oscillograph 

The oscillograph function is explained. 
 

 
 
16.3.1. Outline 

The oscillograph can display the graphical representation of a robot's various internal data. 
The data acquired from the robot can be saved at a CSV file. By specifying a preservation interval, prolonged 
data recording is possible. A program name, an execution row number, and an input-and-output signal are 
also simultaneously recordable on a CSV file. 
 
16.3.2. Communication method 

The following two systems are among the communication methods which acquire various internal data from 
a robot. 

 
16.3.2.1. Ordinary communication 

It is a communication method which uses a communications server.  
Therefore, it can be used if it is the environment where a communications server is connectable. 
The feature is explained. 
 

Table 16-3 Ordinary communication 

item explanation 
Recoding numbers 30,000 

（When intervals to receive are 100msec, about 50-minute 
room arrangement profit is possible.） 

Data kind Fixed number 
Intervals to receive 50, 100, 200, 500, 1000, 2000, 5000, 10000, 30000msec 

 
16.3.2.2. High speed communication 

The high-speed communication can use a real-time function, and can acquire data at intervals of 
7.1msec.The real time monitor function cannot be used if it is not the environment which a robot controller can 
connect with a personal computer by Ethernet. 

If you can’t get data from a robot controller, please confirm “Communications (Ethernet)” (4) in Chap. 21.1 
"Q&A”. 
The feature is explained. 

 
Table 16-4 High speed communication 

item explanation 
Recoding numbers 80,000 

（About 9-minutes） 
Data kind maximum of 4 data selection 

The continuous signal of 32 points(IN/OUT) 
Intervals to receive Highest 7.1msec 
Robot software version S4b,R4b or later 

 
When the simulator starts, a real-time function can be used only for the first project since this software 

Ver.3.01B. 

 
Since an oscillograph function needs the memory and CPU power of a personal computer, the screen 
to open has been restricted to a maximum of 8 screens. If many screens which need memories, such 
as program editor and parameter editor, are opened, please keep in mind that a memory may be 
insufficient

Caution 
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16.3.3. Acquirable data 

The list of the data that can be acquired from the robot is shown below. 
 

Table 16-5 Oscillograph data list 
Notation on the graph Unit Explanation High Ord

Current feedback [Arms] Present value of the motor current. ○ ○ 

Max current cmd2 [Arms] 
The maximum value of the current command for 
the last 2 seconds. 

- ○ 

Max current cmd1 [%] 
The maximum value of the current command after 
robot controller’s power supply is turned on. 

- ○ 

Axis load level [%] 
A preset load ratio of each motor is displayed as an 
alarm level. 

○ ○ 

Max axis load level [%] 
The maximum value of the axis load level after 
robot controller’s power supply is turned on is 
displayed. 

- ○ 

Position feedback [Pulse] 
Current motor rotation position is displayed by the 
pulse value of the encoder. 

○ ○ 

Joint position(CMD) [mm deg] Joint position (command) ○ ○ 
XYZ position(CMD) [mm deg] XYZ position (command) ○ ○ 
Joint position (FB) [deg] Joint position (feedback) ○ - 
XYZ position (FB) [mm deg] XYZ position (feedback) ○ - 

Position droop [Pulse] 
The amount of deflection at the motor rotation 
position to a position command is shown. 

○ ○ 

Speed (FB) [rpm] 
The feedback of the motor speed is displayed by 
the unit of rpm. 

○ ○ 

Voltage [V] A present power-supply voltage value is displayed. ○ ○ 

RMS current [Arms] 
Present RMS value of the motor current is 
displayed. 

○ - 

Regeneration level [%] 
The regenerative current value of each axis is 
displayed as an alarm level. 

○ ○ 

Encoder temperature [deg C] 
Temperature of the encoder of each axis 
Correspondence since F series. 

○ ○ 

Current command [Arms] The current command of the motor. ○ ○ 

Tolerable command + [Arms] 
The limitation value of the plus side of the current 
command set to the motor. 

○ ○ 

Tolerable command - [Arms] 
The limitation value of the minus side of the current 
command set to the motor is displayed. 

○ ○ 

Force sensor data [N Nm] The input value from a force sensor. ○ - 
Force pos CMD(XYZ) [mm rag] Force sense position command(XYZ) ○ - 

COL threshold + 
[0.1%] 

rated 
current 

The higher rank side detection threshold of a 
collision detection function (plus side) 

○ - 

COL threshold - 
[0.1%] 

rated 
current 

The higher rank side detection threshold of a 
collision detection function (minus side) 

○ - 

COL presumed torque 
[0.1%] 

rated 
current 

Presumed torque of the collision detection function.
○ - 

COL torque 
[0.1%] 

rated 
current 

Actual torque of the collision detection function. 
○ - 

 Tool point speed(FB) [mm/s] Speed of a tool center point（feedback） ○ - 

Remaining distance(FB) [mm] 
The remaining distance to the target position (in 
mm) while the robot is moving（feedback）. 

○ - 

Tool point speed(CMD) [mm/s] 
Speed of a tool center point（command） 
Same as status variable values “M_RSpd” 

○ - 

Remaining distance(CMD) [mm] 
The remaining distance to the target position (in 
mm) while the robot is moving（command）.  
Same as status variable values “M_RDst”.  

○ - 

R
ob

ot
 in

fo
rm

at
io

n 

Gap of CMD and FB [mm] 
The gap of a command position and a feedback 
position. 
Same as status variable values “M_Fbd”. 

○ - 
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Transport factor(CMD) [%] Speed of a tool center point（feedback） ○ - 

Acceleration state(CMD) 

- The current acceleration/deceleration status.
（command） 
[0=Stopped,1=Accelerating, 2 = Constant speed, 3 
= Decelerating] 
Same as status variable values “M_AclSts”. 

○ - 

Controller temperature [deg C] Controller temperature ○ ○ 
INPUT - Consecutive input signal for 32 points ○ - 
OUTPUT - Consecutive output signal for 32 points ○ - 

※High :High speed communication Ord :Ordinary communication 
 
 

 
16.3.4. Starting 

From the project tree, double-click [Tool] -> [Oscillograph]  
 

 
Figure 16-11 Starting the Oscillograph 
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16.3.5. Communication settings 

Please display the Communication setting dialog by clicking the [Communication…] button. 
Ordinary communication can be used as choosing the [Communications server].  
High speed communication can be used as choosing the [Real time monitor]. 

  
Figure 16-12 Communication setting dialog 

 
The interval to receive is chosen in the ordinary communication via a communications server. 

In the High speed communication which uses the real time monitor function, the start number of a maximum of 
four kinds, and an input signal/output signal is specified for the data to acquire. 
To use high-speed communication, it is necessary to validate real-time monitor mode on an Ethernet 
parameter screen. 
 

 
Figure 16-13 Real time monitor mode setting  

 

 

 
・To display a program name and an execution row number by high-speed communication, it is 
necessary to include "robot information" in demand data. 
・In "Ordinary communication", IN and OUT signals are unacquirable. 

Caution 
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16.3.6. Start／Stop 

Please check before a start that the target project is in an on-line state. 

If it clicks a [Start]( ) button, data will be acquired from a robot and drawing of a graph will be started. 

A click of a [Stop] ( ) button will stop acquisition of data. 
 
 

16.3.7. Graph setting 

The [Graph...] button of an oscillograph screen can be clicked and the item displayed on a graph can be set 
up. The graph setup can be changed also in data acquisition. 

 
 

Figure 16-14 Graph setting dialog 
Table 16-6  Setting Items 

Item Explanation 
Refresh time Select the interval of time to refresh the graph. 
Display points Specify the number of points displayed in the graph with fixed number or time scale. 
Horizontal Axis Select the horizontal axis of the graph from acquisition data or time. 
Graph Output Select the category of data displayed to the graph. 
1-1 -> 2-8 Select the data displayed to each graph. 

 
 
Moreover, display/non-display of the data selected by the graph setting screen can be switched from the 

lower left list of the oscillograph screen. 
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Figure 16-15 Switch of display/non-display of graph 

 
 

16.3.8. Graph range setting 

The [Range...] button of an oscillograph screen can be clicked and the range of the display of the vertical 
axis of each data can be set. When [Auto adjust] is checked, the range of the display of the vertical axis in the 
graph is automatically adjusted.  

 
 

 
Figure 16-16 Graph range setting dialogue 
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The [Edit...] and [Reset] can make two data or more a target at the same time. 
 

 
Figure 16-17 Range editor of the graph 

 
 
16.3.9. Data reproducing / confirmation 

The [Detail...] button of an oscillograph screen can be clicked and the data displayed in the graph can be 
confirmed by the numerical value. When the data acquisition is executing, the current value is displayed in 
[Data]. 
The data column is displayed by the same color as the graph with Version 3.10L or later of this software. 

 

 
Figure 16-18 Detailed data dialogue 



 

16-349  16-349 

 
Moreover, drawing of the graph can temporarily be interrupted by clicking [Stop drawing] while executing 

data acquisition. In that case, the reproduction display of the acquired data is possible by slider operation. 
 

 
Figure 16-19 Inside of data acquisition 

 
The cursor is displayed while operating the slider. the current value is displayed in [Data] of detailed data 

dialogue. The value of the selected position is displayed in [Data] in detailed data dialogue. 
 

 
Figure 16-20 Cursor movement by slider operation 
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16.3.10. Data saving／Log setting／Log file reading 

The [Data save] ( ) button of an oscillograph screen can be clicked and the data acquired by the point 
in time can be saved by a CSV file format. 

 
The newest data can be written out to a log file for every interval for a definite period of time. Click the [log 

file] ( ) button of an oscillograph screen, and [Log file operation] dialog is displayed. The time interval 
written in a log file is specified by a [Select the interval log] combo box.  
Click a [Set] button and it completes a setup of a log file. 

 
Figure 16-21 Log file operation 

 
The folder of data storage / log file name, and its preservation place is as follows. 
 

Table 16-7 Data saving file name / Log file name / Data saving folder 

項目 説明 

Data saving file name Store<time stamp>.csv 
 
The <time stamp> shows the time which clicked the [Data save] button.  
“<A.D(4chars)>< month(2chars)><day（2chars）> -  
<time(2chars)><minutes（2char）><second（2chars）>” 
 
Example： 
Store20130911-183525.csv 

Log file name Log<time stamp>.csv 
 
The <time stamp> shows the time at the time of a data acquisition start. 
 
Example： 
Log20130911-183525.csv 

Data saving folder “Workspace \ Project \ Oscillograph \ Log” 
 
The preservation folder of the log file can be changed. 

 
The data file and log file which were saved can click [Load Log file] button, and can display it on a graph. 
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16.3.11. Graph image saving 

The [Image save] ( ) button of an oscillograph screen can be clicked and the graph currently displayed 
can be saved in bitmap image 

The image file name and the image saving folder name are as follows. 
 

Table 16-8 image filename & Image saving folder 

項目 説明 

Image file name Img<time stamp>.bmp 
 
The <time stamp> shows the time which clicked the [Image save] button.  
 
Example： 
Img20130911-183525.csv 

Image saving folder “Workspace \ Project \ Oscillograph \ Image” 
 
 
16.3.12. Gray scale 

When the check box of the gray display is turned on, the graph is displayed by the gray scale.  
This function can be used with Version 3.01B or later of this software. 
 

 
 

The display of a graph will be confused if operation which needs 

 a CPU power is carried out. 

When operation which needs a CPU power is carried out, it becomes impossible to receive the 
communication from a robot normally. 

Please keep in mind that a graph is mainly notably confused by the next operation. 
 
・Data saving operation 
・Image saving operation 
・Graph setting operation 

Caution 
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17. Simulation 
 

This chapter explains the simulation operation methods. 
 

 
 
 
 

Simulation can not be used with the mini edition. 
The simulation function only supports the "RT ToolBox2" standard edition.  It can not be used with 

the mini edition. 
 

Simulation can not be used with Movemaster commands. 
Be aware that even with the standard edition, the simulation function can not be used when 

Movemaster commands are selected.  
 

You can not communicate with the robot controller during a 
simulation. 
You can not communicate with the robot controller during a simulation.  To communicate with the 

robot controller, click on the menu bar [Online] → [Offline] to end the simulation, then again click on the 
menu bar [Online] → [Online] to connect the robot controller.  

 

With an actual robot, an overload error might occur. 
Be aware that even if you run the simulation with the work and hand weight set and this works 

properly in the simulation, when you actually operate with the robot, an overload may occur and make 
operation impossible.  

 

If there is an input signal wait in the program, use pseudo-input. 
When you execute a program in simulation and there is an input signal wait in the program, the 

program does not move to the next step until that command is executed.  Therefore, if there is an input 
signal wait, use the pseudo-input function from the signal monitor.  

Caution 
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17.1. Starting a Simulation 

Click on the menu bar [Option] → [Simulator]. At that time, if there are two or more projects in the workspace, 
the screen for selecting the screen to conduct the simulation is displayed. 
- You can simulate eight projects or less. 
-  

 
Figure 17-1 Project Selection When Simulation is Started 

 
[Select All]  Select all projects at a time. 
[Release All]  Release all projects at a time. 
 
Select the project to start the simulation, and then click the [OK] button.  

 

 
 
You can also start a simulation through operations from the tool bar.    

 
Figure 17-2 Explanation of Toolbar  

 
 
When the simulation start-up is complete, the operation screen for the simulation is displayed on the screen. 
Also, the virtual controller for the simulation is automatically started stored in task tray. (Figure 16-3) 

 

 
Figure 17-3 Virtual Controller stored in task tray 

 
The simulation is run by this virtual controller. The virtual controller ends automatically when the simulation 

ends. Do not end the virtual controller manually. 
3D monitor is automatically started when the simulation starts, with Version 1.7 or later of this software. The 
explanation of 3D monitor, see "17.3 Robot View (3D Monitor)". 

Switch to "Offline". 
 
Switch to "Online". 
 
Switch to "Simulation". 

In case of several projects, simulators may be unable to be 
started. 

It may be caused by a low-performance computer. Please check your computer. 

Caution 



 

17-354  17-354 

 
17.1.1. About the warning at first-time startup simulation 

After installing RT ToolBox2 of Version 1.6 or later, when you first start the simulation, the following warning 
screen may be shown. If the screen is shown, confirm the corresponding to environment checkbox is set ON, 
and click [Allow access]. You need to select [Allow access] button to use all function of the simulation. 

 

 
Figure 17-4 The warning screen at first-time startup simulation 
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17.2. Explanation of the Simulation Operation Screen 

Use [Operating panel] screen for operating a simulator. 
Refer to “2.4 About Operation panel” to understand how to operate “Operation panel”. 
 
You can operate as follows to all simulations which is executing by using the tool bar. 
 

 
Figure 17-5 Tool Bar for simulation 

 

Servos of all simulations are turn ON. 
Servos of all simulations are turn OFF. 
Start program of all simulations. 
Stop program of all simulations. 
Programs reset of all simulations. 
Finish program of all simulations. 
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17.3. Robot View (3D Monitor)  

You can display the robot whose simulation you are running and its movements in 3D to check them. 
Moreover, you can display robots of several projects and their movements in 3D on one screen. 
 
It is possible to display the robot's model name and robot path in this software version 2.20W or later. 

 
 
17.3.1. Robot View (3D Monitor) Start 

 
With the simulation running, from the project tree, either double-click [Online] -> [<Robot model name>] or 

select [3D Monitor] with the mouse right button menu. The 3D display screen for the set robot is displayed. 
In this software version 3.20W or later, the 3D monitor can be displayed in the offline mode. Double-click 

[Offline] -> [<Robot model name>]. In the offline mode, the robot is standing still.  
 

When the robot view (3D monitor) is started, [3D View] is displayed in the menu bar. 

 
Figure 17-6 Robot View Start 

 
The robot view perspective can be changed by mouse operation. 
 

Table 17-1 Robot View Perspective Change Operations 

Viewpoint of changing Mouse operations on the graphic 
Rotation While clicking the left button, move left/right → Rotation around Z 

axis 
Move up/down → Rotation around X axis 
Move left/right while clicking the left + right buttons → Rotation 
around Y axis 

Move Move up/down/left/right while clicking the right button 
Enlargement/reduction Move up/down/left/right while clicking pressing [Shift] key and 

clicking the left button 
A similar operation can be used by the mouse wheel with Version 
3.01B or later of this software. 

 
 

When using 3D monitor, we recommend you to use the high personal 
computer of performance. If the low personal computer of performance is 
used, JOG operation may not be able to be performed normally. 

Caution 

Double click the robot type name 
or  

select [3D Monitor] with the mouse right 
button menu. 
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17.3.2. Displaying robots of more than one projects in 3D 

 
With the simulation running, from the project tree in the workspace, double-click [3D Monitor]. All robots set 

by “Select the projects” screen (Figure 16-1) are displayed.  
This function can be used with Version 2.10L or later of this software. 
In this software version 3.20W or later, the 3D monitor can be displayed in the offline mode.  

 
Figure 17-7 Displaying multiple projects 

 
The robot view perspective can be changed by mouse operation with the same usages as 3D monitor of each 
project. 
 

Table 17-2 Robot View Perspective Change Operations 

Viewpoint of changing Mouse operations on the graphic 
Rotation While clicking the left button, move left/right → Rotation around Z 

axis 
Move up/down → Rotation around X axis 
Move left/right while clicking the left + right buttons → Rotation 
around Y axis 

Move Move up/down/left/right while clicking the right button 
Enlargement/reduction Move up/down/left/right while clicking pressing [Shift] key and 

clicking the left button 
A similar operation can be used by the mouse wheel with Version 
3.01B or later of this software. 

 

Double-click 
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17.3.3. Click movement of the robot 

After starting the simulation, if you click the object in the 3D monitor screen with Ctrl key, the robot move to the 
position where you clicked. 
 
If there is no object where you clicked or the robot can’t move to the place where you clicked, the robot doesn’t 
move. 
The robot move keeping the posture and multi-rotation flag. Then the robot doesn’t move depending on the 
posture and multi-rotation flag. 
This function doesn’t work during the robot is running. 
This function can use the following robot type. 

 Robot models 
The robot models which can use 
click movement. 

RV-F, RH-F, RV-S, RH-S, RV-A, RH-A, RP-A, RV-T, RH-L 

The robot models which can’t 
use click movement. 

RH-G, RC-G, RH-U 

 

   
Figure 17-8 Operation of click movement 

 

   
Figure 17-9 Operation of click movement (3D monitor of more than one projects) 

 
The robot selecting [The robot to move] is moved on 3D monitor of more than one projects. 
 
 

Click with 
Ctrl key 

Click with 
Ctrl key 
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17.3.4. Robot display option 

Click the menu bar [3D View] -> [Robot display option]. The robot display option screen is displayed. 
 

 
Figure 17-10 Robot display option setting screen 

 
Items that can be set by the connection state, is as follows.  

Connection state Items 
Offline Online Simulation 

Window x x x 
Robot model *1 *1 x 
Robot information x x x 
Collision area - *2 *2 
User-defined area - x x 
Free plane limit - x x 
Spline curve x x x 

x: applicable, -: not applicable, *1: partially applicable, *2: available only when function is enabled 
 
 Project 

Select a project to set the robot display option from several projects. 
This is not displayed when selecting the robot display option from each project. 
Also, in Window item, this is not displayed.  
 

 

Version 3.10L or earlier Version 3.20W or later 
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17.3.4.1. Window 

 Panel 
Select the [Panel] checkbox, the panel to change the perspective is displayed.  

 
Figure 17-11 Display of the panel 

 
 Floor 

Select the [Floor] checkbox, or click  button of the toolbar, the floor is displayed in the 3D monitor. The 
length of one grid of the floor is 500[mm] x 500[mm].  

This function can be used with version 3.01B or later of this software.  

 
Figure 17-12 Display of the floor 
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 Coordinate axes 

Clear the [Coordinate axes] checkbox, coordinate axes of the 3D monitor will hide.  
This function can be used with version 3.20W or later of this software.  

 
Figure 17-13 Hide coordinate axes 

 
 Background color 

Click the [Background color] button, or  button of the toolbar, the background color of the 3D monitor 
can be changed.  

This function can be used with version 3.01B or later of this software.  

 
Figure 17-14 Changing the background color 
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17.3.4.2. Robot model 

 Robot model 
Clear the [Robot model] checkbox, the robot model will hide in the 3D monitor.  
This function can be used with version 3.20W or later of this software.  

 
Figure 17-15 Hide the robot model 

 



 

17-363  17-363 

 
 Flange direction 

Clear the [Flange direction] checkbox, the arrows that indicate the flange direction will hide in the 3D 
monitor.  

This function can be used with version 3.00A or later of this software.  

 
Figure 17-16 Hide the flange direction 
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 Tool 

Select the [Tool] checkbox, a tool of the controller selected now can be displayed in the 3D monitor.  
This function can be used with version 2.10L or later of this software.  

 
Figure 17-17 Display the tool 

 



 

17-365  17-365 

 
 Robot path 

Select the [Robot path] checkbox, the robot path is displayed in the 3D monitor.  
This function can be used only in a simulation.  
The robot path is displayed with green color. Some operations are displayed and the robot path is erased 

sequentially from an old one. 
 

 
 
When [Delete] button is clicked, the robot path is erased.  
 
The robot path has restriction in robot's model which can be used. The model which can be used is as 

follows. 
 Robot model 
The robot model which can use 
the robot path. 

RV-F, RH-F, RV-S, RH-S, RV-A, RH-A, RP-A, RV-T, RH-L 

The robot model which can not 
use the robot path. 

RH-G, RC-G, RH-U 

 
When the robot model which can not use the robot path is connected, "Robot Path" is not displayed on 

"Robot display option" screen. 
 
In this software version 3.20W or later, the thickness of the robot path can be changed.  
 

 
Figure 17-18 Display the robot path 

 

Under the following situations, the plot interval of the robot 
path might become long. 

- When the operation speed of the robot is fast. 

- When the performance of the computer is low. 

- When you start two or more simulators. 

- When you display the complicated CAD model in 3D 
monitor. 

- When another application is operating, etc. 

Caution 
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17.3.4.3. Robot information 

Select the [Project name]/[Robot model] checkbox, the project/robot’s model name is displayed in the 3D 
monitor. The robot’s model name is displayed near a robot’s flange position. When the project name and the 
robot’s model name are displayed, the project name is on the upper row and the robot’s model name is 
displayed lower row. It is possible to select the size of the character from three kinks.  

 
Figure 17-19 Display the project name and the robot’s model name 

 
 

17.3.4.4. Collision area 

Select the [Display the collision area] checkbox, the model of collision area is displayed in the 3D monitor.  
The model is displayed the color which is set in the [Color] button (a default is read).  

 
Figure 17-20 Display the collision area 
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17.3.4.5. User-defined area 

Select the checkbox, the user-defined area is displayed in the 3D monitor. The checkbox where the value is 
set to the parameter can be operated.  

 
Figure 17-21 Display the user-defined area 

 
 

17.3.4.6. Free plane limi 

Select the checkbox, the free plane limit is displayed in the 3D monitor. The checkbox where the value is set 
to the parameter can be operated.  

 
Figure 17-22 Display the free plane limit  
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17.3.4.7. Spline curve 

When the [Opened spline files] checkbox is selected (initial state), spline curves (blue) of open spline files 
and selected position data are displayed in the 3D monitor.  

 
Figure 17-23 Display the Spline curve of opened spline files  

 
Select the [Specified spline file] checkbox and select the spline file, the spline curve of selected spline file 

(aqua) is displayed in the 3D monitor.  
 

 
Figure 17-24 Display the spline curve of specified spline file  

 
This function can be used with version 3.20W or later of this software.  
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17.3.5. Layout 

The object of the hexahedron(rectangular parallelepiped), the column, and the sphere can be displayed on 
“3D Monitor”.  
 
This function can be used with Version 1.6 or later of software. 

A layout list screen is different by versions of this software. 
 
(1) In the case of using version 2.20W or later 
 

It is possible to manage the layout parts with a group. Moreover, it is possible to set the referenced part and 
move and rotate with every group. 

When a white space (for false) is set in the checkbox, the parts are not displayed. 

 
Figure 17-25 Layout list(version 2.20W or later) 

 
It is possible to move each part by drag and drop. 
 
Refer to the following table for explanation of the icon displayed on a layout list. 
 

Table 17-3 Icon of layout list 

icon explanation 

 The group to which each part belongs 

 A part of referenced layout 

 Parts other than the above 
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(2)  In the case of using version 2.10L or earlier 
 
The “Layout list“ window is displayed with the menu bar [3D View] -> [Layout]. The list of the layout parts 
registered beforehand is displayed on "Layout list" windows. 

When each checkbox in the left of names of the object is set off, the object becomes invisible.  
The order of the objects can be changed with the [Up] or [Down] button in the right of this window. 
 

 
Figure 17-26 Layout list (version 2.10L or earlier) 
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17.3.5.1.  Editing of Layout  

When the object is newly added, click [Add] button in "Layout" windows. When the object is changed, click 
[Edit] button after selecting the object in "Layout" windows. The “Layout edit” window is displayed. With the 
software version 1.7 or later, similar operation can be done by right-click. 

 
“(7) Group” and “(8) Referenced layout” are displayed with this software version 2.20W or later. 
  

 

 
Figure 17-27 Layout edit 

 
 Name 説明 
(1) Name The name of the object can be input. 
(2) Figure The figure type of the object can be selected. It is possible to select a hexahedron 

(rectangular parallelepiped), a column, a sphere, and 3D model.  
When "3D model" is selected, the data created by CAD can be read.  
“3D model” can be used with Version 2.20W or later of this software.  

(3) Color The color of the object can be selected. 
(4) Position The position of the object can be input. 
(5) Angle The posture of the object can be input. The angle is set in order of X, Y, Z axis. 

The order is different from the robot arrangement. 
(6) Size The size of the object can be input. 
(7) Group Set up the group which belongs. A group name can be chosen from a combo box.

When a new group name is inputted, a new group is added in the list. 
(This function can be used with Version 2.20W or later of this software.) 

(8) Referenced 
layout 

It is set up whether it is a layout used as the standard within a group. This 
referenced layout is used when moving and rotating the whole group. Refer to 
“17.3.5.5 Movement and rotation of the layout ”. 
A referenced layout can be set up only one within a group. When the referenced 
layout is already in the group, the conventional referenced layout is canceled and 
the parts set up newly serve as a referenced layout. 
(This function can be used with Version 2.20W or later of this software.) 

(9) Condition Set the condition to show / hide the layout parts. 
For more information, refer to “17.3.5.7 Layout condition edit”. 

 
 

(1) Name 

(2) Figure 

(3) Color 

(4) Position 

(6) Size 

(5) Angle 

(7) Group 

(8) Referenced layout 

(9) Condition 
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The explanation of each object is as follows. 
 

Table 17-4 Explanation of the layout 

 Window Explanation 
Hexahedron(rectangular parallelepiped) 

 

 
Column (Cone) 

 

 

* If a different value is set to an upper radius and a 
lower radius, it becomes a conic type. 

 

 

 

X

Z

Y

Position 
（X, Y, Z） 

Size 
（Upper radius）

Size
（Height） 

Size 
（Lower radius）

Angle（Y）

Angle（Z）

Angle
(X） 

Position 
（X, Y, Z） 

Size（X） 
Size（Y） 

Size（Z） 

Angle（Y）

Angle（Z）

Angle
(X） 

X

Z

Y
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 Window Explanation 
Sphere 

 

* There is no rotation in the sphere editing. 

3D model 

 

The position and a rotational reference position of 
3D model are reference positions at the time of CAD 
data creation.  

“3D model” can be used with Version 2.20W or 
later of this software.  

When 3D model is selected, the CAD file to read 
can be specified.  

The CAD file which can be read is as follows.  
file extension

STL (Stereolithography) file .stl 
OBJ (Wavefront format) file .obj 
3DS (3D Studio) file .3ds 
PLY (Stanford Triangle Format) 
file 

.ply 

VRML 2.0 (Virtual Reality 
Modeling Language) file 

.wrl 

When the file of OBJ form is read, the information 
on a texture is not reflected.  

The file of 3DS, PLY, and VRML 2.0 form can be 
used with Version 3.00A or later of this software 

Position 
（X, Y, Z）

Angle（Y）

Angle（Z）

Angle
(X） 

X

Z

Y

X

Z

Y

Position 
（X, Y, Z） 

Size 
（Radius）

Angle（Y）

Angle（Z）

Angle
(X） 
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 Window Explanation 
3D model (Continuation) 

 The unit of scale that display in 3D monitor can be 
specified with Version 3.00A or later of this software.

The millimeter is standard unit in 3D monitor. 
The unit of scale that can be specified is as 

follows. 
- Millimeter[mm] 
- Meter[m] 
- Inch[in] 
- Magnification specification (Magnification of 

1.0-10000.0 can be specified.) 
 

 

 
 
 
 
17.3.5.2.  Copy of the object  

The object of the layout can be copied. After selecting the object, click [Copy] button. With the software version 
1.7 or later, similar operation can be done by right-click. 

It is possible to copy the whole group in this software version 2.20W or later.  
 
 
 
17.3.5.3.  Delete of the object  

The object of the layout can be deleted. After selecting the objects, click [Delete] button. Click [Yes] button 
after the confirming message is displayed. With the software version 1.7 or later, similar operation can be done 
by right-click.  

It is possible to delete the whole group in this software version 2.20W or later.  
That once the objects are deleted, they cannot be recovered.  
 
 
 

If 3D model of big size is read, screen drawing processing will 
become heavy. 

Caution 
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17.3.5.4.  Editing of Layout group 

It is possible to  move and rotate the whole group, and rename the Layout group. 
Refer to “17.3.5.5 Movement and rotation of the layout ”.  
This function can be used with Version 2.20W or later of this software.  

 
Click [Edit] button after selecting the layout group which you change the name. Or select [edit] in the menu 

displayed when you click a mouse right button. A layout group edit screen is displayed.  
 

 
Figure 17-28 Layout group edit 

 
When a new group name is input, the name of the selected group is changed. When the existing group 

name is selected, all parts in the group move to the selected group. In this case, the original group in the list is 
deleted 
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17.3.5.5.  Movement and rotation of the layout  

 
(1) Movement and rotation of the parts of layout  

 
When you move or rotate the part of layout, change the position and rotational value in the edit screen of 

each part. Refer to “17.3.5.1Editing of Layout ”. 
 
 
(2) Movement and rotation of the layout group 

 
It is possible to move and to rotate all parts in the group at the same time in this software version 2.20W or 

later. 
Click [Edit] button after selecting the group which you move or rotate it. “Layout group edit” screen is 

displayed. You can do the same operation by clicking the right button of a mouse. 
Set up the position or the degree of rotation angle after selecting the group. All parts in the group are moved 

or is rotated. 
 
The layout group moves on the basis of the center of the whole group. The group moves in the direction of 

coordinates of a referenced layout part regardless of a robot's coordinate.  
 

 
Figure 17-29 Movement of the layout group 

 
 

A layout group rotates focusing on the center of the whole group. The group rotates in the direction of 
coordinates of a referenced layout parts.  
 

A part of referenced 
layout 

Direction to X
Direction to Y

Direction to Z

Directionto Y

Direction to X 

Direction to Z

The other parts

The outside of the group

The center of a group outside 

Upper surface figure 

Side view 

Direction toX

Direction to Z 

The center of a group outside 

Direction to Y
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17.3.5.6.  Save and Read the information of the layout. 

The objects of the layout can be preserved in the file. And, the objects of layout in the file can be read.  
By saving the file, layout parts can be used by another project. 
 
Click [Save] button when preserving them in the file. Click [Save] button after confirming the folder and the file 
name on “Save as” windows. 
 
Click [Read] button when reading them from the file. Click [Open] button after selecting the file on “Open” 
window.  
 
Please note that all objects of the current layout are deleted when the file is read.  
 

 
 

Caution for Saving As Workspace with MELSOFT Navigator   
 

When Saving As Workspace with MELSOFT Navigator version 1.28E, information of layout used in 
3D monitor for more than one projects don't be saved to new Workspace. Edit object of layout in the 
new Workspace again. 
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17.3.5.7. Layout condition edit 

“Layout condition edit” screen is shown by clicking [Edit] button on “Layout edit” screen. 
If you set I/O states to the layout parts, you can show or hide the parts. This function can be used in 
simulation. 
 

 
 

Figure 17-30 Layout condition edit 
 
If you set no condition, select [Default]. If you set some conditions, select [I/O (Valid only in simulation)]. 
 

(1) ON->OFF Set conditions from “show” state to “hide” state. The conditions can be set until 3. 
When all conditions are met, the layout parts are hidden. 

(2) OFF->ON Set conditions from “hide” state to “show” state. The conditions can be set until 3. 
When all conditions are met, the layout parts are shown. 

(3) Condition If you checked [Enable], you can set the condition. 
Check same number to set conditions. 

(4) I/O type Select [input signal], [output signal], [Register (CC-Link) Input], [Register (CC-Link) 
Output]. 

(5) Start signal # Set 0 or larger when you select [input signal] or [output signal]. 
Set 6000 or larger when you select [Register (CC-Link) Input] or [Register 
(CC-Link) Output]. 

(6) Bit size Set 1 - 32 when you select [input signal] or [output signal]. 
Set 1 - 2 when you select [Register (CC-Link) Input] or [Register (CC-Link) Output].

(7) Signal value Set the value which is compared with I/O state. 
Set the unsigned decimal value which is expressed in binary value with bit size 
specified (6) when you select [input signal] or [output signal]. 
Set the signed decimal value which is expressed in binary value with 1 register (16 
bit) or 2 register (32 bit) specified (6) when you select [Register (CC-Link) Input] or 
[Register (CC-Link) Output]. 

(8) Project Set the target project to check I/O status when you use 3D monitor for multiple 
projects. You need not to set this when you use 3D monitor for a project. 

 
 

(1) 

(2) 

(3) (4) (5) (8) (7)(6)
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17.3.6. Robot arrangement 

With the simulation running, click the menu bar [3D View] -> [Robot arrangement]. The robot arrangement 
window is displayed. 

You can set up each robot arrangement displayed in “3D monitor”. 
This function can be used with Version 2.10L or later of this software. 
 

 
Figure 17-31 Robot arrangement list 

 
The project list of online state is displayed. If the checkbox is set on, the robot is displayed on “3D monitor”. 
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(1)[Edit] 
  For displaying the robot arrangement screen, click a robot to edit with “Robot arrangement list”, and then the  
[Edit] button or double-click a robot to edit. 

 
Figure 17-32 Editing Robot arrangement list 

 
Edit the position and the angle and click the [Close] button. The angle is set in order of Z, Y, X axis. The 

order is the same as “Common coordinates for Collision avoidance” (RBCORD) parameter. The order is 
different from the layout object. 
 
(2)[Load] 
  Load a saved file of robot arrangement information. 
 
(3)[Save] 
  Save the contents of robot arrangement list displayed now at a file. 
 
 

Double-click 
here. 
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17.3.7. XYZ position variables 

It is possible to display the XYZ position variable on 3D monitor. 
This function can be used with Version 2.20W or later of this software. The line weight is changed with 

version 3.20W. 
 
When some XYZ position variables in a robot program are selected, these all of positions are displayed on 

3D monitor. 
When selection of the XYZ position variables is released, the positions on 3D monitor are vanished. 
It is possible to display the XYZ position variables on some 3D monitors. When both 3D monitor of a robot 

simple substance and the whole 3D monitor are displayed, the XYZ position variable is displayed in both 
screens. 

 
When two or more XYZ position variables in some programs in a project are selected, all selected position 

variable is displayed. When the XYZ position variables of the same name in some programs are selected, all  
selected position data is displayed. 

 
It is possible to display only XYZ position variables. Joint position variables cannot be displayed on 3D 

monitor. 

 
 

 
Figure 17-33 XYZ position  

 
The position data which can be displayed is as follows. 
 

Table 17-5 The position data which can be displayed 

Preservation place Kinds of program Remarks 

Movemaster command
A simulation cannot be used when Movemaster 
command is selected. 

MELFA-BASIC Ⅳ  
MELFA-BASIC V  

Robot program in 
the robot controller 

SQ Direct Only a CRnQ type can be displayed. 

Movemaster command
A simulation cannot be used when Movemaster 
command is selected. 

MELFA-BASIC Ⅳ  
MELFA-BASIC V  
SQ Direct  

Robot program in 
the project 

Backup programs  

Version 3.10L   Version 3.20W 
or earlier        or later 

A maximum of 50 XYZ position variables can be displayed in 3D monitor. 

Caution 
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17.3.8. Hand 

A robot hand can be displayed on the tool of the robot on 3D monitor. And can be selected them by signal 
state. 
This function can be used with Version 2.20W or later of this software. Selecting hand function can be used 

with Version 3.20W or later of this software. 
 
 

17.3.8.1. Hand file screen 

“Hand file” screen is shown by clicked [3D View] – [Hand] menu. The hand file which is shown in this screen 
will display as the hand of a robot in 3D monitor. Uncheck [Display] checkbox will not display hands at all. 
Uncheck the checkbox of each hand file will not display the file. 

 
Figure 17-34 Hand file 

 
 

- Add hand file register 
Click [Add] button when you add the hand file register. 
When you click [Add] button, the following screen is shown. Click [New] when you add a new hand file. Click 

[Existing] when you add an existing file. And select new or existing file. 

 
Figure 17-35 Add new or Existing hand file 

 
 

- Copy or Paste hand file register 
Click [Copy] or [Paste] when you copy or paste the existing hand file register. When you paste them, the 

dialog selecting the hand file name after copying is shown. 
1. If you copy the file and register another file name, select the copied file name. 
2. If you register the same file, click [OK] button as it is (Showing the file name before copying). 
 



 

17-383  17-383 

 
- Rename the title or hand file name 

Click [Rename] button when you rename the title of the hand file register or the hand file name. The 
following dialog will be shown, you can input either a title after the change or the file name after the change by 
clicking [...] button. And then, click the [OK] button. 

 
Figure 17-36 Rename 

 
 

- Delete hand file 
Click [Delete] button when you delete hand file or remove the existing hand file register. After clicking 

[Delete] button, the following dialog will be shown. Click [Remove] if you remove only a hand file register, don't 
delete a hand file. Click [Delete] if you delete a hand file and remove a hand file register, too. 

 
Figure 17-37 Remove or Delete hand files selection 

 
 

- Edit a hand file 
Click [Edit] button if you edit hand parts in a hand file. 
Editing method of a hand file, refer to “17.3.8.3 Hand”. 
 
 

- Set condition of hand file 
Click [Set condition] button when you set conditions of a hand file. If you set conditions to a hand file, you 

can show the file only in specified I/O status and tool #. 
Setting method of a hand file, refer to “17.3.8.2 Hand file condition screen”. 
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17.3.8.2. Hand file condition screen 

“Hand file condition” screen is shown by clicking [Set condition] button in “Hand file” screen. 
If you set conditions to a hand file, you can show the file only in specified I/O status and tool #. 

 

 
Figure 17-38 Hand file condition 

 
- Title 

Set the title of the selected hand file. The title will be shown the head of the hand file register list in “Hand 
file” screen. 

 
- Tool # 

Set the tool # for displaying the selected hand file. This condition is effective in both the simulation and 
connecting the robot controller. 

You can select [All], [0], [1].... If you select [All], the hand file will be shown regardless of the state of the tool 
#. However, if there is a hand file which is set the same tool # of current tool #, the hand file will be shown. 

 
- Condition 

Set the I/O conditions for displaying the selected hand file. This condition is effective only in the simulation. 
If you don't specify the I/O condition, select [Default]. If you specify the I/O conditions, select [I/O (Valid only 

in simulation)]. The conditions can be set until 3. When all conditions are met, the hand file is shown. 
 

(1) Condition If you checked [Enable], you can set the condition. 
Check same number to set conditions. 

(2) I/O type Select [input signal], [output signal], [Register (CC-Link) Input], [Register (CC-Link) 
Output]. 

(3) Start signal # Set 0 or larger when you select [input signal] or [output signal]. 
Set 6000 or larger when you select [Register (CC-Link) Input] or [Register 
(CC-Link) Output]. 

(4) Bit size Set 1 - 32 when you select [input signal] or [output signal]. 
Set 1 - 2 when you select [Register (CC-Link) Input] or [Register (CC-Link) Output].

(5) Signal value Set the value which is compared with I/O state. 
Set the unsigned decimal value which is expressed in binary value with bit size 
specified (4) when you select [input signal] or [output signal]. 
Set the signed decimal value which is expressed in binary value with 1 register (16 
bit) or 2 register (32 bit) specified (4) when you select [Register (CC-Link) Input] or 
[Register (CC-Link) Output]. 

 
 

(1) (2) (5)(4)(3)
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17.3.8.3. Hand 

Click [Edit] button on “Hand file” screen. The “Hand” screen is displayed. The parts of the hand registered are 
displayed on a "Hand" screen. Nothing is displayed when the hand is not created. 

When you set a white space (for false) in the checkbox of the parts on "Hand" screen, the parts of the hand 
are not displayed.  

 

 
Figure 17-39 Hand 

 

 
Figure 17-40 Hand (Version 3.10L or earlier) 

 
The origin of Hand screen (Figure 17-40) becomes the flange center of the robot. The parts arranged to + 
direction of Z pole is displayed in front of the flange of the robot. Arrange the parts like Figure 17-41. 
 

 
Figure 17-41 the way of arranging hand 

 

Example of making hand Vertical robot Horizontal 4-axis robot 
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- Editing of Hand 
 

Click [Add] button. Click [Edit] button when editing the existing parts. “Hand edit” screen is displayed. 
 

 
Figure 17-42 Hand edit 

 
It is possible to set up a Hexahedron(rectangular parallelepiped), a Column (Cone), a Sphere, and a 3D model. 
The setting method of each part article is the same as layout parts. Refer to “17.3.5.1 Editing of Layout ”. 
 
 
- Copy / Paste of the hand object 
 

It is possible to copy / paste the parts of hand displayed on “Hand” screen. Click [Copy] button after 
selecting the parts of hand in the list. Then click [Paste] button, the copy of the parts is added to the lowest row 
in the list. Two or more parts can be chosen and copied. 
 
 
- Delete of the hand object 
 
It is possible to delete the parts of hand displayed on “Hand” screen. Click [Delete] button after selecting the 
parts of hand in the list. The selected parts in the list are deleted. Two or more parts can be chosen and 
deleted. That once the objects are deleted, they cannot be recovered.  

 
 

- Load the hand file 
 
It is possible to read the hand information from a file, and to edit it. 
Click [Read] button in “Hand” screen and select the file. The hand information in the selected file is 

displayed on "Hand" screen. Please keep in mind that the information on the hand read now is deleted at this 
time. 

 
 

- Save the hand file 
 
It is possible to save the created hand information at a file. 
Click [Save] button in “Hand” screen and input the file name. The hand information saves at the file. It is 
possible to display the saved hand on "3D view" screen. 
Refer to "17.3.8.1 Hand file screen" for the display method of a hand.  
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17.3.9. Save AVI 

It is possible to record contents in the 3D monitor and save the AVI file.  
This function can be used with version 3.20W of this software.  
 

Click [3D View] -> [REC.] -> [REC.] of the menu bar (or  button of toolbar for the 3D monitor), the recording 
is started.  

 
Figure 17-43 3D monitor: Recording 

 

While recording, click [3D View] -> [REC.] -> [Pause] of the menu bar (or  button of toolbar for the 3D 
monitor), the recording is parsed.  

 
Figure 17-44 3D monitor: Pause 

 

While recoding or pause, click [3D View] -> [REC.] -> [Stop] of the menu bar (or  button of toolbar for the 
3D monitor), the recording is stopped. The dialog to save the AVI file is opened.  
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Figure 17-45 Save AVI file dialog 

 
 
17.3.9.1. REC. Option dialog 

Click [3D View] -> [REC.] -> [Options…] of the menu bar, the REC. Option dialog is displayed.  

 
Figure 17-46 3D monitor: REC. Option dialog 

 
・ Frame rate 

You can change the frame rate of the video data to save the avi file.  
Setting range: 30/20/10[FPS] 
* By raising the frame rate the video will be smoothed, but on the other hand, the file size will be 
large(recording time is short).  
 

・ Auto save 
If the [Auto save] checkbox is selected, when the recording is stopped, the avi file will be saved to the 
“Workspace \ Project \ Videos” folder automatically.  
* When the 3D monitor is opened from [3D Monitor] of the project tree, the avi file will be saved to the 
“Workspace \ @Videos@” folder.  
 

・ REC./Stop/Pause 
[REC.]/[Stop]/[Pause] button corresponds to each [3D View] -> [REC.] -> [REC.]/[Stop]/[Pause] of the 
menu bar.  

 
 

 

About the recording time 
The recording time is affected by the screen size of the 3D monitor and the frame rate.  
To extend the recording time, reduce the screen size or the frame rate. The maximum size of file 

that can be saved is 500MB.  

Caution 
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17.4. Robot Program Selection 

Select the robot program to run the simulation. Step operation or direct execution in the simulation is not 
possible unless a program is selected. 

In the simulation, from the project tree, with [Online] → [Program], execute "Open in debugging status" for 
the program from the right mouse button. 

If the robot program being simulated is not [Online], use program management to copy to the virtual 
controller. 
 

 
Figure 17-47 Program Selection for Simulation 

 
The specified robot program is opened in debugging status. The execution line cursor " " is displayed at 

the left end of the command statement edit area. The line on which this execution line cursor is displayed is 
the line currently being executed.  

The display of this execution line cursor can be switched on/off with the menu bar [Debug] → [Display/Do 
not display]. 
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17.5. Program Execution 

You can execute a program that has been opened in debugging status and that has been selected at 
Operation panel. 

 
Table 17-6 the difference of program execution and debugging 

 Program execution Program debugging 
Program selection Use [Select] button on Operation panel Open program by debugging mode
Program operation Use buttons on Operation panel Use buttons on “Step” 
Program starting condition The conditions specified to slot table Finish in 1 cycle (*1) 
(*1) Do not finish the program that to run indefinitely automatically. 
 

 
Figure 17-48 Program Execution 

 
To forcibly stop a program that is executing, click the [Stop] button on the simulation operation screen. 

 
 
 
 
 

17.6. Specifying the Starting Line for Program Execution 

You can freely specify the line in the program from which to start execution. Click [Jump] button on the 
simulation operation screen. Input the step number to start execution from at “Jump” screen. The current 
execution line moves to the specified step number. 
 

 
Figure 17-49 Program Execution Line Execution 

 

Step

Operation panel 

Select

Jump button Jump screen 
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17.7. Breakpoint Setting 

You can also use breakpoints in a simulation.  For details on the operation method for breakpoints, see "8.9.4 
Setting and deleting breakpoints". 
 
 

17.8. Step Operation 

A program that has been opened in debugging status can be executed step by step. 
Start the simulation, and then open the robot program in debugging status. Step operation in simulation is 

performed from the simulation operation screen. 
 

 
Figure 17-50 Simulation Operation Screen 

 
Operate with the [FORWD] button and [BACKWD] button in the [Step Execution] group on the simulation 

operation screen.  
Pressing the [FORWD] button executes the command on the current execution line and advances the 

current execution line by line. Pressing the [BACKWD] button executes the command on the current execution 
line and returns the current execution line by line. 

Step 
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17.9. Direct Execution 

You can input command statements and operate the robot directly. 
Click the simulation operation screen [Direct execution] button. 

 

 
Figure 17-51 Starting Direct Execution 

 
Input the command to execute into the command box, then either press the keyboard [Enter] key or click the 

[Execute] button. The input command is executed. At this time, if a position variable is specified in a move 
command or a like, the position variables defined in the currently open program are used. A position variable 
not defined in the program can not be used. 

A command that has been input once into the command box is added to the history and can be selected 
from the command box dropdown list. However, when the simulation is ended, the history and dropdown list 
commands are commanded 

 
Figure 17-52 Command Dropdown Liston Direct Execution Screen 

 
This operation is not possible during automatic running with the [Continuous Execution] button. 
 

 
 

When executing directly, select the program to execute. 
Direct execution can not be used unless a program is selected.  Always open a program in 

debugging status and put it in selected status. 

Caution 

D-EXEC 
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17.10. Jog Operation 

You can perform the jog operations displayed in the robot view in the simulation status. 
Click the simulation operation screen [Jog] button. The screen for jog operations is displayed at the bottom 

of the simulation operation screen. 
It is possible to move the robot by the “TOOL JOG” or “WORK JOG” with Version 1.6 or later of software. 
However, in the following cases, it is not possible to use the "WORK JOG" operation. 
- Without setting the "Work coordinate" parameter. 
- connecting with the CRn-500 series controller. 
 

 
Figure 17-53 Starting Jog Operation 

 
(1) Robot model select 

When multiple robots are set as connected, select the robot model to operate. 
 
(2) Hand align 

You can align the posture of a hand installed on the robot in units of 90 degrees. 
This function moves the value to the multiple of 90˚ that is closest to the A, B, and C components of the 

current position. 
 
(3) Move method 

Select the robot move method. Move method that can be selected is as follows. For a detailed 
explanation of each Jog Feed, see "Detailed explanations of functions and operations" in the robot 
controller's user's manual.  

 
Version 1.5.1 or earlier Version 1.6 to 1.6.1 Version 1.7 or later 

Joint 
XYZ 

Joint 
XYZ 

TOOL 
WORK 

Joint 
XYZ 

TOOL 
3-axis XYZ 

Cylinder 
WORK  

 
The robot current position display and the jog operation button display for each axis use the method 

selected here. Also, these displays depend on the axis configuration of the connected robot. 

Jog 

Jog operation 
screen 

(1) Robot model section

(3) Move method 

(4) Movement distance 
setting 

(6) Axis jog operation 
(5) Current robot position

(2) Hand align 

(7) Change TOOL 

(8) Change WORK

(9) Operation by slider 
bar 

(10) Position value specified move
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Figure 17-54 Screens for Jog Operation with Different Move Methods Selected 

 
 
(4) Distance setting for moving 

This selects the robot move distance. The robot move distances are "off", "High", and "Low". 
For a detailed explanation of the move distance, see "Detailed explanations of functions and 

operations" in the robot controller's user's manual. 
 
 
(5) Robot current position 

This displays the current robot position. 
 
 
(6) Jog operations on each axis 

This conducts jog operations on each robot axis. 

 Moves the selected robot axis in the "-" direction. 

 Moves the selected robot axis in the "+" direction. 

These buttons move the robot while the mouse button is held down. 
 

When "Joint" When "XYZ" When "TOOL" 

When "WORK” When "3-axis XYZ” When "Cylinder”
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(7) Changing TOOL 

Selecting the tool when moving the robot with the ”TOOL JOG”.  
The tool which can be selected is different depending on the software version of the robot controller 

connected. 
 

Table 17-7 The Tool which can be selected by each version 

 The Tool which can be selected 

Ver.1.5 or earlier Not use 

Ver.1.6 - Ver.1.7 “TOOL0” to “TOOL4” Version of RT 
ToolBox2  

Ver.1.8 or later 
It is different depending on the specification of 
the robot controller connected. 

 
 
 
 
(8) Changing WORK 

Selecting the WORK when moving the robot with the “WORK JOG”.  The WORK that can be selected 
is “WORK1” to “WORK8”. 

This function can be used with Version 1.6 or later of software. However, in the following cases, it is not 
possible to use the "WORK JOG" operation. 

- Without setting the "Work coordinate" parameter. 
- connecting with the CRn-500 series controller. 

 
 
(9) Operating by slider bar 

When you select Joint or XYZ jog, by dragging the slider bar, you can move the corresponding pole. 
This function can be used with Version 3.01B or later of software. 
The following matters might occur about the operation range of X, Y or Z pole of XYZ jog by your 

environment. 
 
1. The range of the robot is out of the range of slider bar. 
2. The range of the slider bar is too wide to operation. 
 
In this case, you can change the operation range of X, Y and Z pole at XYZ slider range screen which 

you can display by clicking the  button in the lower right corner of XYZ jog screen. 

 
Figure 17-55 XYZ Slider range screen 

When you use a vertical 6-axis robot, you can use the slider bar in other than A and B pole 
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(10) Position value specified move 
You can change the current position of the robot by specifying the position value directly. 
When you double click coordinate value display, “Edit current position” screen corresponding to Jog 

mode is shown. Input the coordinate value on the screen, then the robot move to the position. 
 
If the inputted position is out of range for the robot, the robot doesn’t move. 
This operation is ignored during running. 
If you use RV 5 axis robot, 6th axis in FLG2 can’t use. 
 
This function can be used this software Ver. 3.20W or later. 

 
 
 
 

Double click 
the control of 
position value 



 

17-397  17-397 

 

17.11. Simulation Robot Position Variable Editing 

You can edit position variables by moving the simulation robot and reading the position variables from the 
simulation robot posture. 

Move the robot to the target position with jog operations. 
Click the [Add] button or [Change] button for position variables in a program opened in debugging status to 
display the position edit screen, then click the [Read current position] button. You can read in the current 
position of the simulation robot. 
 
 
 
 

17.12. Tact Time Calculation 

You can use the simulation function to calculate the tact time for a program prepared and the axis load level. 
The robot that can calculate the axis load level is RV-F and RH-F series. 

 
Table 17-8 The Function of axis load level which can be used by each version 

 Series of robot. 

Ver.2.50C or earlier Not use Version of RT 
ToolBox2  Ver.3.00A or later RV-F,R-HF series 

 
 

 
 

Axis load level calculation 
The axis load level is expressing of the motor load numerically. 
 
The robot causes the overload error and stops to protect the motor when the axis load level 

exceeds 100%.The axis load level assumes that the robot repeated the same operation and is 
calculated. 

 
There is a possibility not to be able to operate continuously in an actual robot when the calculated 

axis load level is high. You should lower the operation frequency by the Dly command, and lower 
operation speed and the acceleration by Accel and the Ovrd command, etc. There is a possibility that 
the axis load level falls by changing the operation point. 

 
It is likely not to agree to the calculated axis load level completely because the axis load level of an 

actual robot is influenced in a robot individual difference, an environmental temperature, and the 
state etc. of the robot. Use this function as a rough yardstick for robot movement study. 

Caution 

Tact time calculation 
The calculated tact time varies with the capacity of the computer used and its load status and does 

not completely match the actual robot operating time (tact time). 
Use this function as a rough yardstick for tact time study. 
 
Under correct conditions, the results of tact time calculation with this software have an error of 

about ±3% compared to the actual robot operating time (tact time). 
 
For details on tact time deviation, see "17.12.3 Causes of tact time deviation". 

Caution 
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17.12.1. Conditions for tact time measurement 

Be aware of the following restrictions on tact time calculation. 
 

 

When XYZ position variables, the parts of layout or Robot information is 
displayed in 3D monitor, tact time may not be calculated correctly. 

Caution 

Do not start some simulators. 
It is not measured correctly because of a lot of load for your computer. 

Do not set ON a display of [Tool] and [Collision area]. 
It is not measured correctly because of a lot of load for your computer. 

Do not use a program that has signal input or robot status 
changes. 

For programs that have signal input from the outside or that have changes in robot status 
variables or the like, either comment out such sections or extract just the section you want to 
calculate the tact time for and calculate it. 
When studying the tact time for such a program, take this into account by adding an approximate 
input wait time to the calculation results. 

 

Do not use a program with an infinite loop. 
The tact time for a program that falls into an infinite loop cannot be correctly calculated. Confirm 

that the robot program does not fall into an infinite loop with a FOR statement or GOTO statement. 
 

Do not use M_TIMER(1). 
Do not use M_TIMER(1). This software's tact time calculation uses M_TIMER(1). If 

M_TIMER(1) is used during the program, the tact time can not be calculated accurately. Change 
the program to use any timer from M_TIMER(2) to M_TIMER(8) instead, then calculate the tact 
time. 

 

If a position array variable or joint array variable is included, also 
include the corresponding "Dim" declaration in the tact time 
calculation range. 

If a program whose tact time is being measured includes a position array variable or joint array 
variable, also include the corresponding "Dim" declaration in the tact time calculation range. 

 

Set the hand data correctly when you measure the axis load 
level. 

Please set the hand and work condition (mass, center of gravity, and shape) actually used 
correctly. When the setting is different from an actual robot, the axis load level cannot be correctly 
calculated. The setting of the hand and work condition is set by parameter HNDDAT*, WRKDAR *. 
The condition of the hand and work is specified by the Loadset command.  

 

Caution 
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Include the destinations for any GoTo or GoSub's in the tact time 
calculation range. 

For example, the tact time can not be calculated for a program like the following.  
The location displayed inverted in black in the program is set for tact time calculation.) 
 

 
 
 
 
 
 
 
 
 
 
 
 

Do not use a program with excluding commands of move. 
As for the program that doesn't accompany the movement of robots of the calculation 

processing and the divergence processing, etc. , tact time is not correctly calculated.  

Caution 

No destination selected 
for GoTo statement 

No destination selected 
for sub-routine 

1 xxx 
:   : 

10 Mov P01 
11 Mov P02 
12 Mov P03 
13 GoTo *L10 
14 END 
 

1 Mov P00 
:   : 

10 GoSub *SUB1
11 End 
12  : 
20 *SUB1 
21 Mov P01 
22 Return  
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17.12.2. Tact time measurement 

This explains tact time measurement. 
 
１． Start simulation. 

Start simulation.  For details, see "17.1 Starting a Simulation". 
 
 
２． Open the program. 

Open the program whose tact time you will calculate.  You can calculate the tact time for "offline" and 
"online" programs.  However, you can not calculate the tact time for a program that has been opened in 
debugging status.  Always open the program with "Open program".

 
 

For details on the operations for opening a program, see "8.2 Opening an Existing Program". 
 
 
３． Specify the range for measuring the program tact time. 

Drag the section to measure the program tact time for, then drag it to select it. 
 

 
Figure 17-56 Tact time Measurement Range Selection 

 
 
４． Click on the menu bar [Tool] -> [Tact time]. 

 
Figure 17-57 Toolbar "Tool" Menu 
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５． Check the range over which you will calculate the tact time. 

Open the program whose tact time you will calculate. Check the contents of this range, then click the [OK] 
button. 

 

 
Figure 17-58 Checking the Tact time Measurement Range 

 
 
The tact time calculation is started.  During tact time calculation, "Calculating tact time" is displayed on 

the simulation operation screen.  Do not perform any other operations until this display goes out. 
 

Figure 17-59 Simulation Operation Screen During Tact time Measurement 
 

 
６． The tact time measurement results are displayed. 

When tact time measurement is complete, the "Take time calculation results" screen is displayed.  The 
tact time measurement results are displayed in ms [milli seconds]. 

 

 
Figure 17-60 Tact time Measurement Results (The axis load level calculation is impossible.)  

 

The tact time calculation 
results are added 
sequentially. 
This information is cleared 
when the simulation is 
started again. 

The current tact time 
measurement results 
are displayed. 
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The axis load level (J1-J6 each axis) and the tact time are displayed for the robot that can measure the axis 
load level. 
The calculation result of the axis load is displayed with %. 
 

 
Figure 17-61 Tact time Measurement Results (The axis load level calculation is possible.) 

 

The current tact time 
measurement results 
are displayed. 
 

The current axis load level 
measurement results are 
displayed. 

The tact time and axis load 
level calculation results are 
added sequentially. 
This information is cleared 
when the simulation is 
started again. 
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17.12.3. Causes of tact time deviation 

With this software, you can use the simulation function to calculate the robot movement tact time. 
However, the calculated tact time varies with the capacity of the computer used and its load status and does 
not completely match the actual robot operating time (tact time). 
Use this function as a rough yardstick for tact time study. 
Also, there are the following causes for the tact time calculation results deviating from actual robot tact time. 
 
(1) An application other than "program editing" of this software is running. 

This software's tact time calculation has parts that are processed on the computer in the background. For 
example, if you are working running an application such as a Word document that is saved automatically, 
it takes more time for the background processing for this software and sometimes the correct tact time is 
not calculated. The tact time is increased.) 
When calculating the tact time with this software, first close other applications. 
Also, on this software itself, first close all the screens beside "Program edit". 

 
(2) This uses commands that depend on the robot main unit status and external equipment. 

There is no connection with the robot main unit or external equipment in this software's tact time 
calculation. Therefore, commands that are executed communicating with that equipment are executed as 
if ideal information were sent from that equipment. Therefore, the calculated cycle time is shorter than the 
actual cycle time. 
The commands to which this applies are shown in the following table. 

 Function Command Explanation 
1 Positioning 

completion wait 
FINE(*1) Monitors the robot's status until it 

reaches the target position. 
2 Compliance CMP JNT/POS/TOOL/OFF 

CMPG 
Monitors external force on the robot. 

3 Collision detection COLCHK、COLLVL Monitors external force on the robot. 
4 Servo control SERVO ON/OFF Monitors the servo amp status 

(*1) The Fine command be used with this software Ver.2.40S or later and selection RV-F/RH-F series. 
 
For example, if the servo On command is executed in the program, the actual robot takes a few seconds, 
but the simulation requires almost no time at all (500 ms or less). In order calculate the tact time precisely, 
program using only movement commands and none of the above commands. If you are executing a 
program you already have, either comment out such commands or extract and use just the part you want 
to measure. 

 
(3) This uses functions that depend on the CPU processing speed and OS. 

The tact time calculation in this software runs on Windows, but the robot controller control software runs 
on a real-time OS, so the internal operations are different. For example, with a real-time OS, the tact time 
may be increased by the postponement of calculations with a high load that could not be fully processed, 
but in this software's tact time calculations, such an increase in the tact time can not be calculated. 
Therefore, if you use the high-load functions below, the calculated tact time may be a few percent less 
than the actual tact time. 
The commands to which this applies are shown in the following table. 

 Function Cause of increased processing on actual robot 
1 CC-Link Because there is more signal processing with the CC-Link 

option than without it 
2 Multi tasking Because multiple robot programs are executed at the same 

time 
3 Added axes Because of the need to control the additional axes 
4 Maximum 

acceleration/deceleration control 
Because the optimum movement for the robot load is 
calculated 

5 Collision detection Because processing to detect collisions is executed (*1) 
6 Maintenance forecast Because the processing time is longer when the maintenance 

forecasting information collection level is raised (*1) 
In tact time calculation, the same results are calculated as for 
information collection level 1 (the factory default setting). 

(*1) On actual robots, the tact time is roughly 3-10% longer. 
 
By changing a robot program to eliminate the above factors, you can reduce the 
difference between the simulation tact time and that on the actual robot. However, 
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because the simulation executes the next movement command without waiting for 
static determinacy after movement or for the conditions to be established, the tact 
time calculated differs from the tact time on the actual robot. 
We recommend that you finally confirm operation on the actual robot. 
 
 
 

17.13. Ending Simulation 

To end the simulation, close the robot program in debugging status. Then click on the menu bar [Online] → 
[Offline] or click the tool bar "Offline". 

 
Figure 17-62 Toolbar "Switch to Offline" 

 
When the simulation ends, the virtual robot controller, robot view, and simulation operation screen end and 

the controller goes back offline. 
 

Switch to Offline. 
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18. MELFA-3D Vision  
 
Set the control unit of MELFA-3D Vision. This function can be used with Version 3.00A or later this software.  
Version 3.10L or later of this software corresponds to MELFA-3D Vision Ver.1.1. 
 
To add a control unit to set to the workspace, double click the [MELFA-3D Vision] – [Setup/Add] in the 

project tree.  

 
Figure 18-1 “Setting and Add Control Unit” window 

 
When the control unit is double clicked, the MELFA-3D Vision window is displayed.  
 

 
Figure 18-2 MELFA-3D Vision window 

 
For details, refer to the user’s manual containing complete description of the MELFA-3D Vision.  
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19. I/O Simulator 
 

19.1. Summary 

I/O simulator simulates the signal communication between robots. And this function can also interact with 
device of GX Simulator2.  
 
This function is available from RT ToolBox2 Ver.3.20W or later. (For details of GX Simulator2, refer to GX 
WORKS2’s manual.) 
 

 
 

19.2. Simulator settings 

Before starting I/O simulator, create a I/O simulator definition file. 
Double-click [I/O Simulator] -> [Simulator Setting] on the project tree to display [Simulator Setting] screen. 
Checking [Enable] checkbox, the signal connection is applied to I/O simulator.  

 
 
  
 
Right-click on the list of signal connection to display right button menu. 
 

 
Figure 19-2 Right button menu. 

 
 
(1) Add 

Add a new signal connection. 
Select a row and click the [Add] button to add a new signal connection.  

 
(2) Edit 

Edit a selected row of signal connection. 
For editing signal connections, refer to “19.3 Signal connection edit screen”. 
 

This Software supports only GX Simulator2. 
Caution 

（7） 

（8） 

（3） 

（2） 

Figure 19-1 Simulator setting screen （5） （6）

（2） 

（4）

（1） 

Check to apply the signal connection to I/O simulator. 

（1） 
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Figure 19-3 Add/Edit signal connection. 

 
(3) Delete 

Delete a selected row of signal connection. 
You can also delete multiple rows at the same time. 

 
(4) Up / Down 

Move a selected row of signal connection up/down. 
You can also move multiple rows at the same time. 
Signal connections are applied in descending order. 

 
(5) Load 

Load a I/O simulator definition file. 
Loading a file, signal connections displayed in the list are removed.   

 
(6) Save 

Save signal connections in a I/O simulator definition file. 
During the I/O simulator operating, you can choose whether to apply the save setting to the I/O 
simulator.   

 
(7) Copy / Paste 

Copy / Paste signal connections. 
You can copy / paste multiple rows in the same time. 

 
(8) Paste in reverse 

When both source and destination are robot, you can swap source for destination and paste the setting. 
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19.3. Signal connection edit screen 

On the simulator setting screen, Click [Add] button or [Edit] button to display signal connection edit screen.  
 

 
Figure 19-4 Signal connection edit screen 

 
(1) Simulation operation 

Select a desired behavior of Signal simulation. 
Select from [Signal value copy](default), [Only first], [Unconditional], [Specifying condition1], [Specifying 
condition 1 and 2]. 

 
    Each behavior is as follows. 
 
・Signal value copy 

Copy signal value to another device. 
 

  

(2) 

(3) 
(4) 
(5) 
(6) 

(8) 
(9) 

(1) 

(7) 

Figure 19-5 Signal value copy
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・Only first 
Specify an initial condition of signal value.   

 

 
 

 
・Unconditional 

Specify a signal state during simulation.  
 

  
 
 

Figure 19-6 Only first

Figure 19-7 Unconditional



 

19-411  19-411 

・Specifying condition1 / Specifying condition 1 and 2 
Specify 1 or 2 conditions and a signal value. The set value is applied when the set conditions are 

satisfied. 
 

 
 
 
(2) Signal type 

Specify a Signal type. 
Select from [PIO](default), [CC-Link(Link Relay)] and [CC-Link(Link Register)]. 

 
The following items differ according to [Simulation operation] and [Signal type]. 
 
(3) Source / Destination / Reference side / Setting side 

Select a source from a robot or a device of GX Simlator2. 
Select from [Project ID: Project name] (as many items as there are projects), [GX Simulator2 A], [GX 
Simulator2 B], [GX Simulator2 C] and [GX Simulator2 D]. 
GX Simulator2 is named “A”, “B”, “C”, “D” in the order of starting. 
 

 
Figure 19-9 Items of Source / Destination / Reference side / Setting side 

 
(4) Device 

When [Source] / [Destination] / [Reference side] / [Setting side] is GX Simulator2, select a device used in 
simulation. When it is robot, a device is fixed.  

 
Table 19-1 Selectable Devices 

[Source]/[Destination]/[Reference side]/[Setting side] [Signal Type] 
Robot GX Simulator2 

[PIO] 
[CC-Link(Link relay)] 

[Bit device] 

[CC-Link(Link register)] [Word device] 

[B(Bit device)]  
[D(Word device)] 

[L(Bit device)] 
[M(Bit device)] 

[R(Word device)] 
[W(Word device)] 

[Y(Bit device)] 
 

Figure 19-8 Specifying condition
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(5) IN / OUT 
Select input / output of signal. 
When [Source] / [Reference side] is robot, select [IN] or [OUT]. When [Source] / [Reference side] is robot, 
fixed by the [IN]. 
When it is GX Simulator2, this item is not visible.  

 
(6) Start # 

Specify a starting number of a device.  
For input range of this item, refer to Table 19-2 Input range of [Start #]/[End #]. 
 

(7) End # 
Specify an ending number of a device. 
When [Simulation operation] is [Signal value copy], the [End #] of destination is filled in automatically 
according to [Start #] and [End #] of source. 
For input range of this item, refer to Table 19-2 Input range of [Start #]/[End #].  

 
Table 19-2 Input range of [Start #]/[End #] 

[Source]/[Destination]/[Reference side]/[Setting side] [Signal type] 
Robot GX Simulator2 

[PIO] 0～40960 

[CC-Link(Link relay)] 6000～8047 

[CC-Link(Link register)] 6000～6255 

0～65535（0xFFFF） 

 
(8) Data type 

Specify the Data type of [Signal value]. 
Select from [Bin], [Dec] and [Hex]. 

 
(9) Signal value 

Specify the output signal value. The set value is treated in the specified [Data type]. 
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19.4. Starting I/O Simulator 

Before starting I/O simulator, create a I/O simulator definition file.  
For explanation of creating a I/O simulator definition file, refer to “19.2 Simulator settings”. 

 
Click [Start I/O simulator] button on toolbar to start I/O simulator during the simulation. 

 
 
    
Click [Start I/O simulator] button, and then the following [I/O simulator start] screen is displayed. 
 

 
 
 
Click the [Browse] button to select a I/O simulator definition file. The file used in the simulation can be checked 
on the [Simulator setting] screen. 
 
I/O simulator start, and the character “I/O Simulator” is displayed on the status bar. 
When GX Simulator2 is connected, the character “GX Simulator2” is also displayed. 

 
 

Connecting with GX Simulator2 

Starting I/O simulator 

Figure 19-10 Starting I/O simulator

Figure 19-11 I/O simulator start screen

Figure 19-12 Status bar during I/O simulator operating
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During I/O simulator operating, the icon of I/O simulator is displayed in the task tray. 

 
 

 
When the previously-used I/O simulator definition file exists, robot simulator and I/O simulator can start 
simultaneously. Check the checkbox [Start I/O Simulator with the definition file used last] on the [Select the 
project] screen which is displayed before starting the simulation.  
 

 
 
 
During the simulation, the signal value of robots can be checked on the signal monitors. For details, refer to 
“12.2.1 General signal” and “12.2.4 Register (CC-Link)”. To check the signal value of device of GX 
Simulator2, use GX Works2.  
 

19.5. Stopping I/O simulator 

Click [Stop I/O simulator] button on toolbar or click the icon of I/O simulator on the task tray and select [Exit] to 
stop I/O simulator during the simulation. 

 
 

 
When the simulation stops and the connection status is offline, I/O simulator stops simultaneously.  

 
 

Click the icon to open 
menu. 

Stopping I/O simulator 

Figure 19-13 Icon of I/O simulator

Figure 19-14 Start robot simulator and I/O simulator simultaneously

Figure 19-15 Stopping I/O simulator
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20. MelfaRXM.ocx Communications Middleware Setup  
 

20.1. Summary 

MelfaRXM.ocx is an ActiveX controller that communicates with CR750/700/500 series robot controllers. 
MELFARXM.ocx can only be used if you have purchased the standard edition of RT ToolBox2.  (Customers 
who have purchased the mini edition can not install MELFARXM.ocx.) 

When using only the RT ToolBox2 functions, there is no need to set up "MELFARXM.ocx". 
 

Using MELFARXM.ocx enables you to simply produce Windows applications connected to a robot controller 
on the customer's device. 
 

 
 
 
 

20.2. CD-ROM Contents 

The contents of the "RT ToolBox2" (standard edition) CD-ROM are as follows. 

 
Figure 20-1 CD-ROM Contents 

 
For details on MelfaRXM.ocx usage methods, refer to the user's manual on the CD-ROM. 
 

/: 

: 
: 

: 
: 

RT ToolBox2 installation files 

Communications 
middleware 
MelfaRXM.ocx 
related file 

This is cautions for using MELFARXM.ocx. 

MelfaRXM.ocx installation files 

This is the MELFARXM.ocx user's manual. 

The user's manual for using MelfaRXM.ocx and the cautions are on the RT ToolBox2 standard edition 
CD-ROM. 

The ways to communicate with CR750/700 series robot controllers are RS-232(CRnD-700), Ethernet 
and USB(CR750-D/CRnD-700). 

To communicate with CRnQ and GOT, RT ToolBox2 must be installed.  
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20.3. User's Manual Reading Guide 

The manual is in the CR-ROM as the Adobe PDF file. 
D:/Utility/MELFARXM/Doc/MelfaRXME.pdf 
* Example for the CD-ROM drive is "D:". 

 
(1) Preparation for viewing 

1) Preparing computer  
Prepare a computer that has a CD-ROM drive. 

2) Preparation of viewing software 
Viewing requires Acrobat Reader Ver 5.0 or higher. 
If neither Acrobat Reader (nor Adobe Reader) is installed, please download it from the 
Adobe Systems web site. (As of December 2007) 

URL: http://www.adobe.com 
 

(2) Viewing methods 
1) Starting From Windows Explorer 

When you start Windows Explorer, then select the file, Acrobat Reader (or Adobe Reader) 
starts and the user's manual is displayed. 

2) Starting directly from Acrobat Reader (or Adobe Reader)  
When you start Windows Explorer Acrobat Reader (or Adobe Reader), then select the file, 
the user's manual is displayed. 

 
 
 

20.4. Installation 

Perform installation according to the following procedure 
 

(1) Insert the program CD-ROM into the CD-ROM drive of your personal computer. Setup of “RT ToolBox2” 
automatically starts. Please click “cancel”. 
 

(2) Select [Run] from the [Start] button. 

 
Figure 20-2 Selecting [Run] 

 
(3) Check the drive name of the CD-ROM drive. Enter the following and click the [OK] button. 

"Drive name":/Utility/MelfaRXM/Setup.exe 
 (If the CD-ROM drive is "D", enter "D:/Utility/MelfaRXM/Setup.exe") 

 
Figure 20-3 [Run] Screen 
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(4) Installer starts and the Setup screen appears. Install according to the instructions that appear on the 
screen. 

The Product ID is needed when this "MelfaRXM.ocx" is installed. Input the Product ID same as the Product 
ID of "RT ToolBox2". "MelfaRXM.ocx" can be installed with the Product ID of standard version, but can not 
be installed with Mini version. 

 
Figure 20-4 Input Product ID 

 
The product is installed as in "Table 20-1 Files to be Installed". 

 
 

Table 20-1 Files to be Installed 
No. Description Install destination 
1 MelfaRXM.ocx 

2 
EZSocketRC.dll 

(communication DLL) 

3 
NarcServerApiM.dll 

(communication DLL) 

/Windows/System folder 
ex)  Windows 2000    :/Winnt/System32 

Windows XP     :/Windows/System32 
 
MelfaRXM.ocx and EzSocketRC.dll are registered in the registry. 

4 
RoboCom.exe 

(communication DLL) 

5 Instruction Manual 

6 Sample programs 

７ Redistribution files 

A folder specified during install operation (Normally, C:/ is used.) 

[MelfaRXM_Dev] 

ReadMe.tx .............. text file which indicated notes 
[RoboCom]............. folder of communication server 

[Doc]........................ folder of Instruction Manual 

[Sample] ................. folder of sample programs 

[BCB] .............Borland C++ Builder (5.0) 

[VB] ................Visual Basic (6.0) 

[VC++] ...........Visual C++ (6.0) 

[Redist]  

[Installer] ....... folder of system files Installer (for redistribution) 

[SysFiles] ...... folder of system files (for redistribution) 
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21.  Appendix 
 

21.1. Q&A 

This explains frequently asked questions in a Q&A format. 
 
Version 

(1) Where is the software version information? 

It is printed on the surface of your CD-ROM for this software. 
You can also check the version information on the screen displayed with this software's menu bar [Help] → 

[About RT Tool Box2]. 

    
Version 1.8 or earlier                Version 2.00A or later 

 
 

(2) Where is the robot controller software version information displayed. 

When this software is connected, you can check with the project tree, [Online] properties. 
The version information is also displayed on the title screen for the optional teaching box. 

 
 
Product ID 

(1) Where can I check the product ID? 

This software requires the product ID for installation. 
The package containing your software contains a sheet of paper on which is written the product ID. 
Also, after this software has been installed, you can also check the product ID on the screen displayed with the 
menu bar [Help] → [About RT Tool Box2]. 
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(2) I checked "About RT ToolBox2" from the menu, but the product ID is not displayed. 

Is "No Product ID!" displayed? 
If "No Product ID!" is displayed in the version information, the installation of this software may have failed. 
Unfortunately, you need to install the software again. 

 
 
Communications (general) 

(1) What are the means for communication with the robot controller? 

With a CR750/700 series robot controller, you can communicate via USB, Ethernet, and RS-232.  
With a CRn-500 series robot controller, you can communicate via Ethernet and RS-232. However, when 
using Ethernet with a CRn-500 series robot controller, the robot controller must have the optional Ethernet 
card. 
For details, see "6.1 Robots Connected and Types of Communication". 

 

(2) Where are the communications settings made? 

They are made on the project edit screen. For details, see "6.2 Connection Settings". 
For the robot controller side, change the communications parameters with the optional teaching box. For 
details, see "Detailed explanations of functions and operations" in the robot controller's user's manual. 
[Caution] The communication settings must be made on both this software and the robot controller. 
If you change the robot controller settings, you must change the settings in this software too. 

 

(3) I can not communicate with the robot controller. 

If you can not communicate with the robot controller, check the following. 
Also see "0Communications (RS-232)", "0Communications (Ethernet)", and "0Communications 
(USB)". 
 

Check item or cause Solution 
Is the connected robot controller selected 
correctly? 

Check if the correct project is selected with this software.
For details, see "5.14 Offline/Online/Simulation". 

Is the robot controller power supply On? Switch On the robot controller's power supply and check 
that the robot controller starts up normally. 

Is Communications Server 2 running? 
Communications Server 2 is started 
automatically when this software is started. 
Communication Server 2 is started as an 
icon. 

If you closed Communications Server 2 by mistake, 
close this software, then restart it. 

Are you connected to a robot controller 
except for CR750/700/500 series? 

Check the robot controller model name in its user's 
manual (or standard specifications or the like). 

Are the robot controller's network settings 
correct? 

The robot controller's network settings are made with 
parameters. Check the robot controller's network 
settings with the optional teaching box. 

Are the communications settings on this 
software correct? 

Set the correct communications settings. 
For details, see "6.2 Connection Settings". 

Is some other MELFA product running? 
For example is E/EN series computer 
support software or P/P or P/P-2 running? 

Close any MELFA product other than this software. 
For details, see "1.6 When Starting at the Same Time 
as Another Product". 
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Check item or cause Solution 

Red 

The problem may be that the robot 
controller is not connected correctly.  
Check the items in "(4) When 
Communications Server 2 is red 
(overall)". 

Green 

The problem may be that the robot 
controller and the computer have different 
communications settings.  Check the items 
in "(5) When Communications Server 2 is 
green (overall)". 

Yellow 
Check the items in "(6) When 
Communications Server 2 is yellow 
(overall)". 

Light blue

What color is Communications Server 2? 
Return Communications Server 2 to icon 
status and check the color displays for the 
line state. 

Blue 

Check the items in "(7) When 
Communications Server 2 is light blue or 
blue.(overall)". 

 
 

(4) When Communications Server 2 is red (overall) 

When Communications Server 2 is displayed red, check the following. 
 

Check item or cause Solution 
Is the communications cable connected 
correctly? 

Connect the cable correctly. 

Are you using the correct communication 
cable? 

Check the communication cable specifications. 
Be careful.  RS-232 cables and Ethernet cables can be 
either cross cables or straight cables. 
For the cable specifications, check your robot's 
"Standard Specifications". 

When connected with CRnQ 
communications, is the target CPU set 
correctly? 

Set the target CPU correctly. 
For details, see "6.2.4 GOT Communications 
Settings". 

 

(5) When Communications Server 2 is green (overall) 

When Communications Server 2 is displayed green, check the following. 
 

Check item or cause Solution 
Do the communications settings in this 
software and on the robot controller match?

The communications settings in this software and on the 
robot controller must match. 
The communications settings for this software are made 
on the project edit screen. For details, see "6.2 
Connection Settings". 
For the robot controller side, change the 
communications parameters with the optional teaching 
box. For details, see "Detailed explanations of 
functions and operations" in the robot controller's 
user's manual. 
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(6) When Communications Server 2 is yellow (overall) 

When Communications Server 2 is displayed yellow, check the following. 
 

Check item or cause Solution 
Is this software in the "Online" status? This software started up in the "Offline" status. When 

you put it into "Online" status, it communicates with the 
robot controller. 
For details, see "5.14 Offline/Online/Simulation". 

 
 

(7) When Communications Server 2 is light blue or blue.(overall) 

If Communications Server 2 is displayed light blue or blue, but communications are still not possible, check 
the following. 
 

Check item or cause Solution 
Is there a communications error in this 
software? 

Check the contents of the communications error and 
close the communications error window. 

Is a simulation underway? 
(Note) Only the standard edition has the 
simulation function. 

End the simulation. 

Is the screen server running on the 
computer? 

End the computer's screen server. 

Is the computer's hard disk is power save 
mode? 

End computer hard disk power save mode setting. 

 

(8) Communications with the robot controller are cut off mid-way through. 

If you can not communicate with the robot controller, check the following. 
 

Check item or cause Solution 
Is the screen saver set, hard disk power off 
set, system standby set, or system 
shut-down set? 

If any of these functions are running, they may cause a 
communications time-out, so do not use any of these 
functions. 

Is some other product running that uses 
communications? 
Or is any permanent resident software 
running that uses communications? 

A computer communications port can not be opened for 
two applications, so either close the other application or 
change the port that this software uses. 
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Communications (RS-232) 

If you can not communicate with the robot controller using RS-232, check the following. 
Also, see "0Communications (general)". 

 
Check item or cause Solution 

Red 

The problem may be that the robot controller 
is not connected correctly.Check the items in 
"(1) When Communications Server 2 is 
red (RS-232)". 

Green 

The problem may be that the robot controller 
and the computer have different 
communications settings.Check the items in 
"(2) When Communications Server 2 is 
green (RS-232)". 

Yellow See "0Communications (general)". 

Light blue

What color is Communications Server 2? 
Return Communications Server 2 to icon 
status and check the color displayed for the 
line state. 

Blue 

Check the items in "(3) When 
Communications Server 2 is light blue or 
blue.(RS-232)". 

 

(1) When Communications Server 2 is red (RS-232) 

If Communications Server 2 is displayed red with communications with the robot controller set to RS-232, check 
the following. 
 

Check item or cause Solution 
Is Communications Server 2 set for the 
correct communications port 
(COM1-COM10)? 
 

The default value for this software is COM1. On some 
computers, COM1 is not allocated to RS-232, but to an 
infrared port, modem, or the like. Also, when using 
RS-232 over USB, the port used for RS-232 may be 
other than COM1. 
Use the Windows device manager or the like to check 
the COM number allocated to RS-232 and change the 
"Port" setting in the communications settings to that port.

Is some other product running that uses the 
communication port? 
Or is any permanent resident software 
running that uses the communications port?

A computer communications port can not be opened for 
two applications, so either close the other application or 
change the port that this software uses. 

In the communications settings for this 
software, is the communications method set 
to TCP/IP or USB? 

Change the communications method to RS-232. 

 

(2) When Communications Server 2 is green (RS-232) 

If Communications Server 2 is displayed green with communications with the robot controller set to RS-232, 
check the following. 

 
Check item or cause Solution 

Do the communications settings in this 
software and on the robot controller match?
In particular, check that the protocol settings 
match. 

The communications settings in this software and on the 
robot controller must match. 
The default protocol for this software is "Procedural", but 
for CRn-500 series robot controllers, the default protocol 
is "Non-Procedural" 

 

(3) When Communications Server 2 is light blue or blue.(RS-232) 

If Communications Server 2 is displayed light blue with communications with the robot controller set to 
RS-232, check the following. 
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Check item or cause Solution 

Is anti-virus software running virus checks 
on RS-232 communications? 

Switch off virus checking for RS-232. 

When a computer starts up, sometimes this 
generates noise. 
This noise can cause a communications 
error in the robot controller. 

Either start the computer before connecting the cable or 
start the computer before starting the robot controller. 
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Communications (Ethernet) 

[Note]  When using Ethernet with a CRn-500 series robot controller, the robot controller must have the optional 
Ethernet card. 

 
If you can not communicate with the robot controller using Ethernet, check the following. 
Also, see "3. Communications (general)". 

 
Check item or cause Solution 

Red 

The problem may be that the robot 
controller is not connected correctly. 
See the items in "(1) When 
Communications Server 2 is red 
(Ethernet)". 

Green 

The problem may be that the robot 
controller and the computer have different 
communications settings. 
See the items in "(2) When 
Communications Server 2 is green 
(Ethernet)". 

Yellow See "0Communications (general)". 

Light blue

What color is Communications Server 2? 
Return Communications Server 2 to icon 
status and check the color displayed for the 
line state. 

Blue 
See "0Communications (general)". 

 

(1) When Communications Server 2 is red (Ethernet) 

If Communications Server 2 is displayed red with communications with the robot controller set to Ethernet, 
check the following. 

 
Check item or cause Solution 

In the communications settings for this 
software, is the communications method set to 
USB or RS-232? 

Change the communications method to TCP/IP. 

 

(2) When Communications Server 2 is green (Ethernet) 

If Communications Server 2 is displayed green with communications with the robot controller set to 
Ethernet, check the following. 

 
Check item or cause Solution 

Are the robot controller's network settings 
correct? 

Make the computer's network settings. 
Check that the IP address, gateway, subnet mask, and 
other network settings are correct. 
Check on the computer [Control Panel] – [Network 
Settings]. 
* For details on the network settings, please consult 

with your network administrator. 
Is the robot controller's IP address set 
correctly in the communications settings? 

Correctly set the IP address of the robot controller 
connected to. 
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(3) The communication time is taken very long when using the backup etc. 

In Windows Firewall setting, if inbound communication of Communications Server 2 (RoboCom.exe) is 
blocked, change to allow the connection. 

 
Check item or cause Solution 

If there are one or more “RoboCom” lines in 
[Inbound Rules] of [Windows Firewall] - 
[Advanced settings] screen, is [Allow the 
connection] selected of all these lines? 

If there are “RoboCom” lines selected [Block the 
connection], change them to [Allow the connection]. 

 
 
 

(4) Spline files cannot be saved.  

See "(3) The communication time is taken very long when using the backup etc.".  
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(5) The Oscillograph cannot be used when the communication method is set to High speed. 

In Windows Firewall setting, change to allow that RT ToolBox2 (MELFA_RT.exe) can receive. 
 

Check item or cause Solution 
Show the following screen by selecting 
[Control panel] -> [System and Security] -> 
[Windows Firewall] -> [Allow a program or 
feature through Windows Firewall] (for 
Windows7). 

 
Is there [RT ToolBox2] in [Allowed programs 
and features] list and allow the communication 
range of the use environment? 
 

If there is not [RT ToolBox2] in [Allowed programs and 
features] list, click [Allow another program] button. 
If [Allow another program] button is disabled, click 
[Change settings] button first. 

 
 
Select and add [RT ToolBox2] on [Add a program] 
screen. 

 
 
Set the check boxes according to the use environment 
of [Home/Work (Private)] and [Public] ON. 
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Communications (USB) 

If you can not communicate with the robot controller using USB, check the following. 
Also, see "0Communications (general)". 

 
Check item or cause Solution 

Red 

The problem may be that the robot 
controller is not connected correctly. 
Check the items in "(1) When 
Communications Server 2 is red 
(RS-232)". 

Green 

The problem may be that the robot 
controller and the computer have different 
communications settings. 
See "0Communications (general)". 

Yellow See "0Communications (general)". 

Light blue 

What color is Communications Server 2? 
Return Communications Server 2 to icon 
status and check the color displayed for the 
line state. 

 

Blue 

Check the items in "(2) When 
Communications Server 2 is light blue 
or blue (USB)". 

 

(1) When Communications Server 2 is red (USB) 

If Communications Server 2 is displayed red with communications with the robot controller set to USB, 
check the following. 

 
Check item or cause Solution 

In the communications settings for this 
software, is the communications method set to 
TCP/IP or RS-232 

Change the communications method to USB. 

Is the USB driver installed? Communicating with USB requires that the USB driver 
be installed. 
For details, see "1.5.3 USB driver 
(CR750-D/CRnD-700 series robot controller) 
installation", "1.5.4 CRnQ communications USB 
driver installation" and “1.5.5 CRnQ 
Communications USB driver for GOT transparent 
function / GOT communitation installation”. 

 

(2) When Communications Server 2 is light blue or blue (USB) 

With communications with the robot set to USB, if Communications Server 2 is displayed light blue or blue, 
but communications are still not possible, check the following. 

 
Check item or cause Solution 

Is the robot controller power supply Off? When connected on USB with CRnQ communications, 
if the robot controller power goes Off after a normal 
connection was established, the display remains light 
blue. 
Switch Offline with this software, switch the robot 
controller power On, then go back online. 

Is the communications cable connected 
correctly? 

When connected on USB with CRnQ communications, 
if the communications cable is disconnected after a 
normal connection was established, the display 
remains light blue. 
Switch Offline with this software, connect the 
communications cable, then go back online. 
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Robot program 

(1) Did you write the program with Movemaster commands? 

The robots that can use Movemaster commands are restricted.  Check in your robot's standard 
specifications to see whether it supports Movemaster commands. If your robot supports Movemaster 
commands, change the language used with "7 Robot Program Language Setting" in this document 

 

(2) Is it possible to use programs as is that we used with an E/EN series robot controller? 

Position data prepared with MELFA-BASIC III (for E/EN series) can not be used as is. Convert the position 
data with the "Program conversion" function. For details, see "8.11 Program Conversion". 
Also, some commands have changed. For details, see "Detailed explanations of functions and 
operations" in the robot controller's user's manual. 

 

(3) Is it possible to use R-250R series and R-300R series programs? 

R-250R series and R-300R series robot programs written in the MELFA II language can not be used as is. 
Write new programs. 

 
 
Program edit 

(1) When we check syntax, "Error in input command statement syntax" occurs frequently. 

 
Check item or cause Solution 

Is the command statement syntax correct? Program in correct syntax. 

Are double-byte spaces used? Use only single-byte spaces. 
Is the language to use set correctly? 
This software supports MELFA-BASIC IV, 
MELFA-BASIC V, and Movemaster 
commands, but there are terms that must be 
switched and set for whichever one of these 
you use. 

Set the robot program language you are using. 
For details, see "7 Robot Program Language 
Setting". 
 

Does the version of this software support your 
robot controller? 
For some robot functions, new commands are 
added. 

Please purchase a version that supports your robot 
controller. (Please contact the store you purchased 
from or one of our branches.) 
* A program can be written to the robot controller even 

if the syntax check finds many "syntax errors". 
 

(2) How should we change the robot program language setting? 

They are made on the project edit screen. For details, see "7 Robot Program Language Setting". 
The robot program language set here is enabled when you edit a program offline. Online programs are 
displayed in the robot program language set with the connected robot controller. 

 

(3) When you open a program, the robot program language is different from the one set for this 
project. 

Is there any online program open? 
Online programs are displayed in the robot program language set with the connected robot controller. The 
robot program language set with the project is enabled when you edit a program offline. 

 

(4) Is it possible to edit or copy a program that is running? 

You can neither edit nor copy a program that is running. Stop the program, then edit or copy it. 
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(5) How should we edit a program for which the start condition is "Always"? 

A program for which the start condition is "Always" is executed immediately after the robot controller power 
comes On. To edit such a program, use the following procedure. 

(1) Change the starting condition in the "Slot table (SLT *  * 1-32)" parameter to "Start (normal)".  
(Write this parameter to the robot controller.) 

(2) Reset the power supply for the robot controller. 
(3) Edit the target program and save it to the robot controller. 
(4) Return the starting condition in the "Slot table (SLT *  * 1-32)" parameter to "Always".  (Write this 

parameter to the robot controller.) 
(5) Reset the power supply for the robot controller. 

 

(6) Is it possible to change the font for a robot program displayed with the program edit tool? 

Yes. 
Change the font used with "8.5.4 Changing the font" in this document.  

 

(7) We are not using joint position variables (J variables), so is it possible to make the display area 
smaller? 

Yes. 
Change the display proportions with "8.5.1 Changing the display area" in this document.  

 

(8) Is it possible to edit a backed up program data with program editor? 

In version 1.2 or later, it is possible to open a backed up program data with program editor. Please refer to 
"8.2.4 Opening a program in the backup data" in this manual for details.  
When you use the software Ver.1.1 or earlier, please restore the backed up program to robot controller, 
then open it with program editor or copy it to the computer with program management, and edit it. 

 

(9) "Use defined external variable can not be used (481000000)" is displayed and the program can 
not be edited. 

This error is displayed if a user defined external variable is used even though the user base program is not 
defined. (Normally, a user base program is defined with the "PRGUSR" parameter, but if nothing is set in 
the "PRGUSR" parameter, this error occurs.) 
To use a user defined external variable, define the user base program. 
Also, for details on user base programs, see "Detailed explanations of functions and operations" in the 
robot controller's user's manual. 

 

(10) Is it possible to copy position data to another program? 

Yes. 
For details, see "8.6.4.4 Copy position data" and "8.6.4.5 Pasting position data" in this document. 

 

(11) Does it cause an error to not discriminate uppercase and lowercase letters when inputting 
commands? 

No. 
You can input either uppercase letters or lowercase letters with the program editor, but when the program is 
saved to a robot controller, the commands are converted correctly. 

 
Variable monitor 

(1) How are external variables (system status variables, program external variables, and user 
defined external variables) monitored? 

Use the program monitor. 
For details, see "12.1.2 Program monitoring" in this document. 
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Option card 

(1) How should one check what option cards are mounted in a robot controller? 

Check from the project tree. 
For details, see "14  Option Card" in this document. 

 
Parameter editing 

(1) No parameter list is displayed in the parameter editing tool. 

Download the parameter list from the robot controller. 
For details, see "11.1.4 Parameter list reading". 

 

(2) We changed a parameter, but the new value does not take effect. 

After you changed the parameter, did you switch the power for the robot controller Off, then On again? 
The new parameter value does not take effect until you switch the robot controller power Off, then On again. 
Switch the robot controller power Off, then On again. 

 
Backup/restore 

(1) Is it possible to edit a backed up program data with program editor? 

In version 1.2 or later, it is possible to open a backed up program data with program editor. Please refer to 
"8.2.4 Opening a program in the backup data" in this manual for details.  
When you use the software Ver.1.1 or earlier, please restore the backed up program to robot controller, 
then open it with program editor or copy it to the computer with program management, and edit it. 

 
3D Monitor 

(1) It takes time to update the screen display. 

It might take time to update the screen display when a lot of data displayed in 3D monitor. The time to 
update the display of the screen when the displayed data is reduced shortens. 
Moreover, when the performance of the computer is low, other screens may be unable to be displayed 

during 3D monitor display. 
If you selected the "Detailed model" of the robot, please change to "Simple model". Please refer to "5.7 

Changing a Workspace" in this manual for details. 
 

(2) The screen was not normally displayed. (For instance, the entire screen becomes black.) 

Please click  button of the toolbar. 
 
Other 

(1) Characters are displayed on the screen on top of each other or with some characters missing.

Is the font size in the computer screen settings something other than "Standard"? 
Use this software with the font size set to "Standard". For Windows XP, to make the screen settings, click 
[Control Panel] → [Display].  Now from the "Display Properties" window’s "Appearance" tab, set the font 
size with [Font Size]. 
 

(2) A program is not printed correctly. 

In some printer types, tab characters into a program may be printed correctly. 
Replace them with a space character with the program editing, or change a printer setting and use 

TrueType font. 
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